
Москва, 200

Цифровое видео

Полезные советы
и готовые инструменты

по видеосъемке, монтажу и авторингу

Джошуа Пол

Digital Video Hacks

Tips & Tools for Shooting, Editing,
and Sharing

Joshua Paul

Beijing, Cambridge, Farnham, Koln, Paris, Sebastopol, Taipei, Tokio



УДК 004.2
ББК 32.973.26�018.2

П49

П49 Äæîøóà ÏîëÄæîøóà ÏîëÄæîøóà ÏîëÄæîøóà ÏîëÄæîøóà Ïîë
Цифровое видео: Полезные советы и готовые инструменты по видеосъемке,
монтажу и авторингу: Пер. с англ. Осипова А. Ю. – М.: ДМК Пресс, 2007. –
400 с.: ил.

ISBN  5�94074�360�9

Прочтя эту книгу, вы научитесь:
• создавать новые проекты с применением самых передовых инструментов и

технологий, начиная от правильной установки камеры и заканчивая состав&
лением раскадровки;

• использовать методы остановки движения и времени, эффекты освещения,
цветовые фильтры, а также предметы домашнего обихода, чтобы сформиро&
вать определенное настроение для сцены;

• создавать увлекательные спецэффекты, такие, как масштабирование со спут&
ника, элементы сюрреализма, «эффект Матрицы» и др.

• добавлять различные звуковые эффекты, например, заменять ненужные диа&
логи, смягчать переходы и заполнять пробелы фоновым шумом;

• применять профессиональные функции, включая корректировку цвета, чист&
ку саунд&трека, вставку последовательностей изображений и закладок;

• распространять готовый материал различными способами, начиная от экс&
порта на видеопленку и DVD и заканчивая загрузкой данных в сеть Интернет
или даже на мобильный телефон;

• использовать сеть Интернет для добавления элементов интерактивности.
Принимать удаленное участие в конференциях, а также создавать свои видео&
блоги.

УДК 004.2
ББК 32.973.26&018.2

Original English language edition published by O’Reilly Media, Inc. Copyright © 2005 by O’Reilly
Media, Inc. All rights reserved.

Все права защищены. Любая часть этой книги не может быть воспроизведена в какой
бы то ни было форме и какими бы то ни было средствами без письменного разрешения вла&
дельцев авторских прав.

Материал, изложенный в данной книге, многократно проверен. Но поскольку вероятность
технических ошибок все равно существует, издательство не может гарантировать абсолютную
точность и правильность приводимых сведений. В связи с этим издательство не несет ответ&
ственности за возможные ошибки, связанные с использованием книги.

ISBN 0-596-00946-1 (àíãë.) Copyright © 2005 by O’Reilly Media, Inc.
ISBN 5-94074-360-9 (ðóñ.) © Ïåðåâîä íà ðóññêèé ÿçûê, îôîðìëåíèå, èçäàíèå,

ÄÌÊ Ïðåññ, 2007

Содержание

Вступление ......................................................................... 22

Об авторе.............................................................................. 22

Соавторы .............................................................................. 22

Благодарности ...................................................................... 25

Введение ............................................................................. 27

Как использовать данную книгу ............................................. 27

Как организована данная книга ............................................. 28

Обозначения, использующиеся в книге ................................. 29

Использование кодировки .................................................... 29

Как с нами связаться ............................................................. 30

Safari® Enabled ..................................................................... 30

У вас есть совет? ................................................................... 30

Глава 1

Подготовка. Советы 1–16 .................................................. 31

Совет 1 Успешное завершение проекта ............................... 32
Маркируйте свои данные ................................................... 32
Следите за своими дисками ............................................... 33
Проверяйте свои данные ................................................... 33
Создайте копию на бумаге ................................................. 33
Создание точки редактирования ......................................... 33
Зафиксируйте точку редактирования .................................. 34
Изменение параметров точки редактирования ..................... 34
Корректировка цвета и микширование ................................ 34



6 Цифровое видео 7Содержание

Что делать дальше? ........................................................... 35

Совет 2 Организуйте свой проект ......................................... 36
Организуем треки ............................................................. 36
Организация иконок и папок............................................... 37
Следите за свободным пространством ................................ 39
Резервное копирование ..................................................... 40

Совет 3 Нумеруйте свои кассеты .......................................... 40
Используйте свою систему ................................................. 40
Правильная нумерация ...................................................... 41
Нумерация по проекту ....................................................... 42
Нумерация по дате ............................................................ 42
Использование штрих-кодов .............................................. 42
Обновляйте данные ........................................................... 45

Совет 4 Кодируйте запись на пленке .................................... 45
Просмотр временной кодировки ......................................... 46
Определяем частоту смены кадров ..................................... 46
Создание закодированной записи ...................................... 47

Совет 5 Загрузка кассеты из электронной таблицы .............. 48
Внимательно проверьте ваши кассеты ................................ 49
Настройка электронной таблицы ........................................ 49
Настройка просмотра вашего материала ............................. 49
Загрузка материала .......................................................... 50
Экспорт списка оцифровки ................................................ 51
Импорт списка оцифровки ................................................. 51
Поиск по проекту............................................................... 52

Совет 6 Создание цифровой раскадровки ............................ 53
Рисуем раскадровку .......................................................... 53
Импорт рисунков .............................................................. 54
Добавление авторской речи ............................................... 55

Совет 7 Создание сценария из двух столбцов ...................... 56
Концепция сценария из двух столбцов ................................ 56

Настройка сценария из двух столбцов ................................. 57
Запись в сценарии с двумя столбцами ................................. 57
Редактирование в сценарии с двумя столбцами ................... 58

Совет 8 Сделайте свой ящик Apple ....................................... 59
Найдите компоненты ......................................................... 59
Собираем ящик................................................................. 59
Используем ящик Apple...................................................... 61

Совет 9 Сделайте свою информационную доску ................. 61
Собираем материалы ........................................................ 62
Использование информационной доски .............................. 63

Совет 10 Удаленное управление камерой ............................. 64
Замена устройства дистанционного управления .................. 64
Удаленное панорамирование на камере .............................. 65

Совет 11 Следите за тем, какой материал вы снимаете
на камеру .............................................................................. 66

Определите, какие кабели вам нужны .................................. 66
Настройка ........................................................................ 68
Записи ............................................................................. 69
Использование записей ..................................................... 70

Совет 12 Защитите камеры, которые находятся
вне помещения ..................................................................... 71

Совет 13 Научитесь быстро оцифровывать большой объем
материала ............................................................................. 73

Настройка систем ............................................................. 73
Оцифровка материала ....................................................... 74
Консолидация материала ................................................... 75
Специально для хакеров .................................................... 76

Совет 14 Сделайте синий экран для фона ............................. 76
Определитесь со своими потребностями ............................. 76
Собираем материалы ........................................................ 77
Установка деревянных планок ............................................ 78



8 Цифровое видео 9Содержание

Установка синего экрана .................................................... 79
Последние штрихи ............................................................ 79

Совет 15 Стабилизируйте свои снимки................................. 81
Сборка системы стабилизации ........................................... 81
Используем систему стабилизации ..................................... 82

Совет 16 Сделайте тележку для камеры ................................ 82
Воспользуйтесь роликовыми коньками ................................ 83
Берем напрокат кресло с колесиками .................................. 84
Как украсть игрушку у ребенка ............................................ 84

Глава 2

Освещение. Советы 17–25 ................................................ 85

Совет 17 Сделайте простой осветительный комплект........... 86
Собираем комплект ........................................................... 86
Использование комплекта .................................................. 87
Функциональность комплекта ............................................. 89

Совет 18 Пользуйтесь «рабочим освещением» ..................... 89
 Закупаем «рабочее освещение» ......................................... 89
Использование «рабочего освещения» ................................ 89
Управление «рабочим освещением» .................................... 91

Совет 19 Используем для освещения лампы с бумажными
абажурами ............................................................................ 93

Совет 20 Установите рассеивающий фильтр
на накамерный светильник .................................................... 94

Совет 21 Снимайте видео в полной темноте ......................... 95
Уменьшаем скорость затвора камеры ................................. 95
Добавляем скрытые источники освещения .......................... 96
Как получить оптимальный результат .................................. 98

Совет 22 Создание снимков на зеленом фоне ...................... 98
Где взять зеленый фон? ..................................................... 99
Освещаем зеленый экран .................................................. 99

Ведем съемку на зеленом фоне ........................................ 100

Совет 23 Ведем съемку через окно ..................................... 101

Совет 24 Отражение света от тени...................................... 102

Совет 25 Научитесь использовать прищепки
как настоящий профессионал ............................................. 104

Глава 3

Запись материала. Советы 26–38 ................................... 105

Совет 26 Создание сжатого видеоклипа с заходом солнца .. 106
Изучаем снимок .............................................................. 106
Настройка снимка ........................................................... 107
Как ускорить время? ........................................................ 107
Использование программного обеспечения с остановкой
воспроизведения ............................................................ 108

Совет 27 Установка камеры в автомобиле .......................... 109
Установка устройства The Cleat......................................... 109
Установка камеры ........................................................... 109
Запись видео .................................................................. 109
Снимаем камеру ............................................................. 111
Дополнительные рекомендации для хакеров ...................... 111

Совет 28 Отслеживайте кадры видео .................................. 112

Совет 29 Выполняйте конвертирование видео
в другой формат ................................................................. 114

Используем приложение Cleaner....................................... 114
Используем приложение FFmpeg ...................................... 115
Распространение вашего фильма ..................................... 116
Смотри также ................................................................. 117

Совет 30 Рассеивающий фильтр для портретной съемки ... 117

Совет 31 Конвертирование из формата PAL в NTSC ............ 118
Формат PAL .................................................................... 119
Конвертирование из формата PAL в формат NTSC .............. 119



10 Цифровое видео 11Содержание

Подготовка к конвертированию ........................................ 119
Используем приложение Atlantis для конвертирования ........ 122
Дополнительная информация для хакеров ......................... 123

Совет 32 Записываем изображение с телевизионного
экрана без мерцания........................................................... 124

Запись изображения на экране телевизора ........................ 124
Запись изображения с компьютерного монитора................ 126

Совет 33 Импорт материала с DVD ..................................... 128
Определитесь с вашим потребностями ............................. 128
Использование корректора времени ................................. 129
Использование адаптера ................................................. 129
Использование карты PCI ................................................. 130
Использование программного обеспечения ....................... 130
Вы должны знать, что именно вы используете .................... 131

Совет 34 Применение формата HDV для улучшения
качества цифрового DV-видео ............................................ 131

Что такое «высокое разрешение»? .................................... 131
Что представляет собой формат «HDV»? ............................ 131
Конвертирование HDV в форматы более низкого
разрешения.................................................................... 132

Совет 35 Снимаем фильм без камеры ................................ 133
Использование архивов ................................................... 134
Загрузка фильма ............................................................. 135

Совет 36 Остановка времени .............................................. 136
Обращаемся к прошлому ................................................. 136
Формируем эффект......................................................... 138

Совет 37 Конвертируем аналоговое видео
в цифровой формат ............................................................ 139

Определитесь с вашими потребностями ............................ 140
Запись на видеопленку .................................................... 141
Запись на жесткий диск ................................................... 142

Совет 38 Создание трехмерного видео .............................. 142
Создание трехмерного фильма с помощью методики
анаглифов ...................................................................... 143
Создание трехмерного фильма в режиме Pulfrich ............... 145

Глава 4

Редактирование. Советы 39–50 ...................................... 147

Совет 39 Редактировать цифровое видео стало проще ...... 148

Совет 40 Создание видео в программе
Windows Movie Maker ........................................................... 151

Как правильно записать видео .......................................... 151
Оптимальные настройки для записи видео......................... 153
Методики записи ............................................................ 156
Запись DVD-дисков ......................................................... 156
Смотри также ................................................................. 158

Совет 41 Создание фильма в программе iMovie .................. 158
Передача видео .............................................................. 158
Автоматическое создание фильма .................................... 160
Редактирование фильма .................................................. 160
Создание DVD................................................................. 162
Отходим от программы iMovie .......................................... 162

Совет 42 Вращение фильма по горизонтали
и вертикали ......................................................................... 163

Вращение видео ............................................................. 163
Редактирование видео в вертикальной проекции................ 165
Смотри также ................................................................. 165

Совет 43 Создание шаблона для редактирования............... 166
Создание шаблона .......................................................... 168
Использование шаблона .................................................. 168

Совет 44 Пользуйтесь телевизором, чтобы избежать
неприятных сюрпризов ....................................................... 169



12 Цифровое видео 13Содержание

Совет 45 Конвертирование файла с титрами в скрипт ........ 172
Мотивация ..................................................................... 172
Рассмотрим файл с титрами............................................. 173
Кодировка ...................................................................... 173
Дополнительные возможности ......................................... 174
Результат ....................................................................... 174

Совет 46 Как сделать изображение более
привлекательным для аудитории ........................................ 175

Раздельное редактирование ............................................ 175
Используем раздельное редактирование ........................... 176
Дополнительные возможности ......................................... 177

Совет 47 Создаем интерактивный видеокаталог................. 177
Создаем видео ............................................................... 178
Создание точки ссылки .................................................... 178
Смотри также ................................................................. 180
Дополнительные возможности ......................................... 180

Совет 48 Устраняем ошибки во временной кодировке
на записанной кассете ........................................................ 181

Как избежать ухудшения качества ..................................... 181
Два видеоустройства....................................................... 182
Оцифровка и вывод данных .............................................. 182
Заключение .................................................................... 183

Совет 49 Добавление закладок в фильм ............................. 184
Создание глав в программе QuickTime Pro ......................... 184
Создание закладок с помощью редактора

Windows Media File Editor .................................................. 189
Используем приложение Cleaner для создания закладок ..... 191
Дополнительные возможности ......................................... 192

Совет 50 Быстрая навигация по DVD................................... 193
Изменяем стандарты ....................................................... 194
Дополнительные возможности ......................................... 195

Глава 5

Звук. Советы 51–60 .......................................................... 197

Совет 51 Мобильная студия звукозаписи............................ 198
Ищем помещение для звукозаписи ................................... 198
Подготовка к записи ........................................................ 199
Поиск местоположения .................................................... 199
Редактирование звука ..................................................... 199

Совет 52 Уменьшаем шум от ветра в микрофоне ................ 200
Создание ветрозащиты ................................................... 200
Как сделать ветрозащиту из ничего ................................... 201

Совет 53 Как сделать шест для микрофона ......................... 201
Как найти шест ............................................................... 201
Покупаем микрофон ........................................................ 201
Измеряем кабель ............................................................ 202
Сборка ........................................................................... 203

Совет 54 Экспорт звука для микширования ........................ 204
Определите, что именно вам нужно ................................... 204
Подготовка к микшированию ............................................ 204
Экспорт звука ................................................................. 205
Импорт звука после микширования ................................... 205

Совет 55 Скрываем отсутствие звука с помощью
фонового шума ................................................................... 206

Как правильно выбрать время для записи фонового шума ... 206
Копируем фоновый шум из сцены ..................................... 206
Запись фонового шума после съемок ................................ 207
Запись фонового шума поверх аудиотреков ....................... 207

Совет 56 Как улучшить звучание аудиотрека....................... 207
Удаление звука в программе SoundSoap ............................ 208
Устраняем шумы и помехи в системе редактирования ......... 210
Используем аудиомикшер ................................................ 211

Совет 57 Вы можете обмануть вашу аудиторию .................. 211



14 Цифровое видео 15Содержание

Создание эффекта .......................................................... 211
Использование эффекта в настоящих проектах .................. 214

Совет 58 Бесплатная музыка .............................................. 215
Использование музыки в фильме ...................................... 215
Как найти бесплатную музыку ........................................... 216
Что значит быть музыкальным директором фильма ............. 216
Будьте честны с теми, кто вам помогает............................. 219

Совет 59 Управляем библиотекой музыки и звуковых
эффектов ............................................................................ 220

Организация вашей музыки ............................................. 220
Создание каталога аудиофайлов ...................................... 220
Поиск звуковых файлов ................................................... 222
Использование списков playlist ......................................... 223
Дополнительные возможности ......................................... 224

Совет 60 Добейтесь соответствия музыкальному ритму ..... 225
Выбор музыки ................................................................. 225
Импорт музыки ............................................................... 225
Маркируйте ритм музыки ................................................. 226
Используем аудиодиаграмму ........................................... 227

Глава 6

Эффекты. Советы 61–74 .................................................. 229

Совет 61 Как придать вашему видеоклипу «внешний вид
кинофильма»....................................................................... 230

Ведем съемку в режиме кинофильма ................................. 230
Используем обновление Magic Bullet ................................. 231
Используем инструменты Look Suite .................................. 231
Используем группу инструментов Misfire ........................... 235
Визуализация вашего проекта .......................................... 235

Совет 62 Как снять программу с прогнозом погоды ............ 236
Как найти информацию о погоде ....................................... 236

Редактирование изображений .......................................... 237
Создание отчета ............................................................. 238

Совет 63 Увеличенное изображение со спутника ................ 239
Как найти изображение нужной вам точки .......................... 240
Загрузка коллекции изображений ..................................... 240
Создаем эффект масштабирования .................................. 241
Дополнительные возможности ......................................... 242

Совет 64 Удаляем посторонний объект............................... 242
Быстрое устранение неполадок ........................................ 243
Находим замену .............................................................. 243
Настройка шкалы времени ............................................... 245
Удаление объекта............................................................ 245
Заполняем пробел .......................................................... 247

Совет 65 Создаем эффект инвертирования в программе
Movie Maker ........................................................................ 248

Создание эффекта .......................................................... 248
Загрузка и использование эффекта................................... 249
Дополнительные возможности ......................................... 249

Совет 66 Как добавить в видео специальные символы
в стиле фильма «Матрица» .................................................. 251

Загружаем приложение ASCIIMoviePlayer ........................... 251
Запускаем программу ASCIIMoviePlayer ............................. 252
Альтернативные методики ............................................... 253
Дополнительные возможности ......................................... 253

Совет 67 Создаем сюрреалистическую сцену..................... 253
Создаем передний план и фон .......................................... 254
Съемка сцены ................................................................. 255
Редактирование сцены .................................................... 256
Дополнительные возможности ......................................... 257

Совет 68 Изменяем текущее время суток для сцены ........... 257
Работаем с инструментами корректировки цвета ............... 257



16 Цифровое видео 17Содержание

Уменьшаем освещенность и цветность изображения .......... 259
Уменьшаем гамму ........................................................... 259
Изменение настроек черного цвета ................................... 259
Редактирование полутонов .............................................. 259
Изменение настроек белого цвета .................................... 260
Уменьшение насыщенности ............................................. 261

Совет 69 Создаем титры..................................................... 261
Подготовка флагов .......................................................... 261
Запись флагов ................................................................ 262
Настройка флагов ........................................................... 262
Дополнительные возможности ......................................... 264

Совет 70 Создание композиции с зеленым фоном ............. 265
Приступаем к созданию композиции ................................. 265
Смещаем снимок ............................................................ 267
Последние штрихи .......................................................... 268

Совет 71 Создаем тень для изображения с зеленым фоном.... 268
Создаем копию изображения ........................................... 269
Создаем оболочку для тени .............................................. 269
Смещение тени от персонажа ........................................... 270
Изменение параметров тени ............................................ 271
Дополнительные возможности ......................................... 271

Совет 72 Альтернативные концовки фильма, связанные
со временем ....................................................................... 272

Подготовка к созданию интерактивного фильма ................. 272
Создание проекта ........................................................... 272
Импорт ваших фильмов ................................................... 273
Завершаем создание фильма ........................................... 275
Дополнительные возможности ......................................... 275

Совет 73 Как изменить внешний вид композиции
после редактирования ........................................................ 275

Переходим к фильтрам .................................................... 276
Выбор фильтра ............................................................... 277

Сохраняем фильмы в отдельных файлах ............................ 279

Совет 74 Выделяем один цвет ............................................ 279
Работаем со слоями видео ............................................... 280
Создаем черно/белое изображение .................................. 280
Выбираем цвет ............................................................... 281
Выделяем цвет ............................................................... 281
Дополнительные возможности ......................................... 281

Глава 7

Распространение. Советы 75–89 .................................... 283

Совет 75 Копируем экран композиции................................ 284
Создаем копию композиции ............................................. 284
Расслабляемся и вводим текст примечаний ....................... 286
«Я знаю, когда нужно забирать у детей их рисунки» ............. 286
Дополнительные возможности ......................................... 287

Совет 76 Создание скинов.................................................. 287
Подготовка изображения для скина .................................. 287
Добавляем изображение в фильм ..................................... 287
Как воспроизвести фильм ................................................ 288
Выравниванием композицию и скин .................................. 289
Создаем маски для фильма со скинами ............................. 289
Совмещаем файлы .......................................................... 291
Дополнительные возможности ......................................... 292

Совет 77 Выбираем кодек .................................................. 293
Что такое кодек? ............................................................. 293
Основные видеоплееры ................................................... 296
Выбираем кодек.............................................................. 298
Альтернативные методики ............................................... 298

Совет 78 Воспроизводим видео с CD/диска
на DVD/плеере .................................................................... 299

Как записать ваш фильм на CD/диск ................................. 300



18 Цифровое видео 19Содержание

Воспроизведение VCD/диска ........................................... 301

Совет 79 Распространение фильма на DVD ........................ 301
Подготовка композиции ................................................... 302
Запись видео .................................................................. 302
Просмотр видео .............................................................. 310

Совет 80 Распространение DVD/проекта через сеть
Интернет (стрим) ................................................................ 312

Подготовка к распространению проекта через сеть
Интернет ........................................................................ 312
Настраиваем опции стрим ............................................... 313
Просмотр стрим.............................................................. 316

Совет 81 Используем блоги ................................................ 316
Создаем видеоблог ......................................................... 317
Размещаем видеоблог ..................................................... 318
Просмотр видеоблога ...................................................... 319

Совет 82 Размещение видео на Web/сайте ......................... 320
Экспорт видео ................................................................ 321
Конфигурируем параметры сжатия ................................... 321
Создание Web/страницы .................................................. 321
Размещаем файлы на сервере .......................................... 323

Совет 83 Выполняем кодировку видео для просмотра
в сети Интернет .................................................................. 323

Создаем видео для функции стрим ................................... 324

Совет 84 Как получить пожертвования через
страницу PayPal .................................................................. 328

Импорт вашего видео ...................................................... 328
Создаем событие Event Stream ......................................... 329
Создаем URL/адрес ........................................................ 329
Сжатие и распространение видео ..................................... 330
Дополнительные возможности ......................................... 331

Совет 85 Настраиваем телевизионную станцию
в сети Интернет .................................................................. 332

Загружаем приложение Darwin Streaming Server ................. 332
Установка сервера .......................................................... 332
Конфигурируем сервер.................................................... 332
Создаем список фильмов................................................. 336
Разрешаем подключение других пользователей ................. 338

Совет 86 Используем приложение BitTorrent
для распространения видео ................................................ 339

Загружаем приложение BitTorrent Client ............................. 340
Загружаем файл с расширением .torrent ............................ 340
Обмен файлами .............................................................. 341
Используем общую систему отслеживания ........................ 342
Смотри также ................................................................. 345

Совет 87 Как принять участие в удаленной конференции .... 345
Настраиваем воспроизведение ........................................ 345
Начинаем воспроизведение ............................................. 351
Архивируем видео ........................................................... 352

Совет 88 Воспроизведение видео на КПК ........................... 352
Запись материала ........................................................... 353
Экспорт материала для платформы Pocket PC .................... 354
Выбираем кодек и файловый формат ................................ 354
Отправка вашего видеофайла .......................................... 356

Совет 89 Воспроизведение фильма на мобильном
телефоне ............................................................................ 356

Используем приложение QuickTime Pro ............................. 356
Распространение вашего фильма ..................................... 359
Воспроизведение фильма ................................................ 360

Глава 8

Прочее. Советы 90–100 ................................................... 361

Совет 90 Записываем видеострим ..................................... 362
Поиск видеострим........................................................... 362



20 Цифровое видео 21Содержание

Открываем видеострим ................................................... 362
Сохраняем видеострим ................................................... 363
Просмотр видео после сохранения ................................... 364

Совет 91 Создаем фильм с помощью игрушек LEGO ........... 365
Подготовка ..................................................................... 365
Создаем обстановку для съемок ....................................... 366
Освещение ..................................................................... 366
Камера .......................................................................... 366
Мотор! ........................................................................... 366
Остаемся в рамках .......................................................... 368

Совет 92 Как «видеть сквозь стены» .................................... 369

Совет 93 Машина, взятая напрокат, и другие
автомобильные хитрости .................................................... 370

Проверка машины, которую вы берете напрокат ................. 370
Документация дорожно/транспортного происшествия........ 370
Зафиксируйте время события .......................................... 371

Совет 94 Сохраните ваши презентации на DVD................... 371
Решаем мелкие жизненные проблемы ............................... 371
Аудио и видео ................................................................. 372
Записываем презентацию PowerPoint на видео .................. 372
Завершаем запись DVD ................................................... 375
Дополнительные возможности ......................................... 375

Совет 95 Смотрим телевизионные каналы
на устройстве Palm Pilot ...................................................... 375

Загружаем видео с сайта ReplayTV .................................... 376
Создаем видео для воспроизведения на устройстве
Palm Pilot ........................................................................ 377

Совет 96 Резервное копирование файлов с компьютера
на цифровую пленку ............................................................ 378

Программное обеспечение для резервного копирования
на цифровую пленку ........................................................ 379
Резервное копирование файлов ....................................... 380

Восстанавливаем файлы .................................................. 382

Совет 97 Воспроизводим «фильмы» на устройстве iPod ..... 382
Начинаем работу............................................................. 383
Загружаем фильм ........................................................... 383
Экспортируем аудиофайлы .............................................. 383
Экспортируем фильм в последовательность изображений .. 385
Отправляем последовательность фотографий
на устройство iPod .......................................................... 386
Воспроизводим «фильм» на устройстве iPod ...................... 389
Дополнительные возможности ......................................... 390
Воспроизводим «настоящие» фильмы ............................... 390

Совет 98 Проведите домашнюю инвентаризацию .............. 391

Совет 99 Записываем небольшие видеофильмы
на камеру мобильного телефона ......................................... 392

Совет 100 Новый проект: снимите свой
документальный фильм ....................................................... 395

Выберите тему и изучите ее ............................................. 395
Добавляем в изображения элементы анимации .................. 396
Добавляем звук .............................................................. 398
Добавляем заголовки и завершаем работу ........................ 398



23Вступление

Вступление

Об авторе

Джошуа Пол обладает 10&летним опытом работы в области разработки программ&
ного обеспечения для кабельного и сетевого телевидения. Он был автором спе&
циальных программ для Fox Television, работал продюсером в компании Sony Pic&
tures Entertainment, а также участвовал в создании различных проектов для ком&
паний, расположенных в Лос&Анджелесе. Джошуа специализируется на проектах,
которые содержат оригинальный материал с камеры. На протяжении последних
лет он принимает активное участие в процессе развития цифрового видео в рам&
ках индустрии развлечений.

Кроме того, Джошуа является одним из основателей компании Overhyped Tech&
nologies, LLC (http://www.overhyped.com), которая предлагает программные ре&
шения для различных организаций. Услуги компании Overhyped позволяют про&
дюсерам управлять цифровым материалом в режиме реального времени и из лю&
бой точки земного шара. Программные решения Overhyped использовались при
создании таких телешоу, как «Extreme Makeover: Home Edition», «Growing Up
Gotti», «Nanny 911», и др. В качестве основателя компании Джошуа работает кон&
сультантом для многих клиентов и помогает им сориентироваться в сложном про&
цессе создания видеопроектов.

Джошуа является активным членом такой организации, как Producer’s Guild of
America, автором многих книг, а также лектором. Он обладает двумя патентами на
распространение цифровой видеопродукции. Свободное от работы время Джо&
шуа проводит со своей женой и сыном.

Соавторы

Далее мы перечислим людей, которые вложили свои усилия и свое время в созда&
ние данной книги:

• Ричард Бэгли (Richard Baguley) – это независимый журналист, который пи&
шет статьи о компьютерах и технологии. В прежние годы он работал старшим
редактором в журнале «PC World» в Сан&Франциско. Кроме того, Ричард
имеет опыт работы в таких американских журналах, как «Amiga Format»,
«Amiga Shopper», «Интернет Today» и «Интернет Magazine». Даже несмотря

на то, что после его ухода все вышеперечисленные издания были закрыты,
Ричард открыто заявляет, что это никак не связано с его выдающимися спо&
собностями. Кроме журналов и таких Web&сайтов, как PC&World и JIWire.com,
Ричард также является автором такого сайта, как Videotastic (http://www.
videotastic.com). Он проживает в Сан&Франциско со своей женой Кэт (Kath)
и своей любимой собакой Фестером (Fester), а также с большим количеством
кошек. Две кошки из семьи Ричарда сыграли роль моделей для иллюстраций
в этой книге;

• Майкл Дин (Michael Dean) сейчас редактирует одно из изданий O’Reilly,
а также работает автором в журнале «Make». Он написал такие книги, как
серию «$30 School», включая «$30 Film School», роман «Starving in the Com&
pany of Beautiful Women», снял фильм «D.I.Y. or Die: How to Survive as an
Independent Artist», а также совершил длительную поездку по США и Евро&
пе. Майкл снял фильм «Hubert Selby, Jr.: It/ll be better tomorrow», стал про&
дюсером фильма «DVD Living Through Steve Diet Goedde». Во время работы
в музыкальной индустрии он совершил турне по миру с рок&группой Bomb и
записал 13 пластинок в различных студиях, начиная с D.I.Y. и заканчивая
Warner Brothers. Майкл выступал с интервью на каналах NPR, BBC и NBC;
кроме того, обзоры по его книгам часто появляются в журнале «Maximum
Rock ‘n’ Roll». Майкл часто читает лекции, посвященные D.I.Y., созданию
фильмов и проектов;

• Артур Дж. Дастман (Arthur J. Dustman) занимается проектами в течение
трех лет. Для хранения оборудования ему уже пришлось выделить отдельное
помещение размером 5 × 5 м. В своей студии Артур использует HAL2000,
Adicon Ocelot с C&max, девять устройств Secu&16s, одно устройство Secu16&IR,
94 реле, микшер, девять микрофонов, девять устройств Xantech и многие дру&
гие системы. Артур самостоятельно создал большое количество интерфейсов
для различных устройств. Его девиз звучит так: «Вы можете автоматизиро&
вать любой процесс»;

• Престон Гралла (Preston Gralla) является автором 30 книг, посвященных
компьютерам и сети Интернет. Среди них «Windows XP Hacks», «Интернет
Annoyances» и «Windows XP Power Hound». Престон работает в этой области
в течение очень длительного времени. Он занимал должность редактора жур&
налов «PC Week» и «PC/Computing», работал в проектах ZDNet и CNet,
а также написал большое количество статей для журналов «PC Magazine»,
«The Los Angeles Times», «USA Today» и «Computerworld»;

• Ник Джашчисин (Nick Jushchyhsyn) имеет очень большой опыт работы в об&
ласти программирования и компьютерного дизайна (см. сайт http://www.
jushhome.com). На протяжении последних лет Ник работает в области созда&
ния спецэффектов для кино и видео. Сейчас он занимает должность дизайне&
ра по спецэффектам в компании Pixel Corps (http://www.pixelcorps.com);

• Марк Лой (Marc Loy) работает в мультимедиа&компании в городе Мэдисон.
В свободное время он пишет программы на языке Java. Марк по&прежнему
читает курсы лекций по Perl и Java; даже в дорогу он всегда берет с собой
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PowerBook и диски с видеопроектами. Он является автором книги «DVD
Studio Pro 3: In the Studio» издательства O’Reilly; вы можете связаться с ним
в сети Интернет по адресу: http://www.loyinc.com;

• Илья Людмирский (Ilya Lyudmirsky) в течение 15 лет работает режиссером и
продюсером. Он имеет очень большой опыт – ему приходилось занимать са&
мые разнообразные должности. Проекты Ильи Людмирского часто получали
различные награды. Кроме того, он является управляющим директором сво&
ей собственной компании, Blacklist Productions;

• Дон Марквард (Don Marquardt) занимается автоматизацией проектов более
30 лет (адрес его электронной почты kyham@k9soa.net). При каждом переезде
Дон находил себе новые игрушки. Сейчас у него дома есть абсолютно все, что
ему нужно. Всего там находится около 8 миль проводов, которые позволяют
подключить любое устройство. Даже его автомобиль подключен к сети Ин&
тернет. Его сайт (http://www.k9soa.net) открыт для любых посетителей. Если
вы зайдете на этот сайт, обязательно сделайте запись в гостевой книге;

• Тодд Огасавара (Todd Ogasawara) интересуется двумя темами: мобильными
системами и мобильными технологиями, причем особое внимание он уделяет
платформе Microsoft Windows Mobile (для Pocket PC и смартфонов). Со&
трудники компании Microsoft отметили его профессионализм и энтузиазм и
наградили его призом MVP (самый ценный профессионал) в категории «Мо&
бильные устройства». Кроме того, Тодд занимается усовершенствованием
коммерческих (Microsoft) и бесплатных продуктов. Сам Тодд называет свою
работу «Необычные технологии». Он является автором большого количества
статей, посвященных мобильным устройствам, а также мобильным телефо&
нам с камерами (http://www.oreillynet.com/wireless/). Раньше он работал
аналитиком в компании GTE/Verizon. Кроме того, Тодд занимает должность
менеджера форума в MSN (ZDNet) Telephony Forum и Windows CE Forum.
Не так давно он был менеджером проекта по созданию локальной сети Intra&
net штата Гавайи. Вы можете найти его статьи по адресу: http://www.Mobile&
Views.com. Кроме того, вы можете связаться с Тоддом по  электронной почте
PhoneCam@OgasaWalrus.com;

• Деррик Стори (Derrick Story) занимает должность управляющего редактора
сетей O’Reilly Network (http://www.oreillynet.com) и Mac DevCenter (http://
www.macdevcenter.com), причем вторую сеть он создал самостоятельно для
компании O’Reilly Media в декабре 2000 г. Он увлекается операционной сис&
темой Mac OS X, цифровой мультимедиа и программированием для мобиль&
ных устройств. Деррик является автором ряда книг издательства O’Reilly,
включая «Digital Video Pocket Guide», «Digital Photography Pocket Guide»,
«iBook Fan Book» и «PowerBook Fan Book». Кроме того, в соавторстве он на&
писал книгу «iPhoto 4: the Missing Manual» (издательства Pogue Press/O’Reil&
ly). В течение 15 лет он работал фотожурналистом, управляющим редакто&
ром Web Review, а также выступал на конференциях O’Reilly, CMP и IDG.
Деррик занимает должность директора компании Story Photography (http://
www.storyphoto.com), которая занимается цифровой фотографией;

• Джин Салливан (Gene Sullivan) – это писатель, музыкант, танцор и опытный
компьютерный пользователь. В область кинематографии он попал благодаря
своей жене, которая пригласила его на работу в проект UC Santa&Barbara
в качестве ассистента дизайнера. Джин имеет опыт работы в различных
фильмах и телешоу; сейчас он занимает должность IT&менеджера в компании
Evolution Film & Tape, Inc. Это независимая телевизионная компания в горо&
де Бурбанк (Burbank), штат Калифорния;

• Филипп Торроне (Phillip Torrone) работает редактором в журнале «Popular
Science Magazine», пишет статьи для сайта Engadget (http://www.engadget.
com), а также является автором большого количества книг, посвященных мо&
бильным устройствам и дизайну. Кроме того, он занимает должность редак&
тора в журнале «Make» и пишет статьи на сайте http://www.makezine.com.
Вы можете ознакомиться с проектами Филиппа по адресу: http://www.
flashenabled.com;

• Ричард Вулф (Richard Wolf) работает программистом в университете штата
Иллинойс в городе Чикаго. Его основная задача состоит в том, чтобы предос&
тавлять поддержку для пользователей Macintosh на любом уровне, начиная
от решения обычных будничных проблем и заканчивая разработкой комп&
лексных систем для университета. В свободное время он пишет программы
на языке PowerPC, а также составляет скрипты для пользователей Mac OS X.

Благодарности

Эта книга никогда не появилась бы на свет, если бы не любовь, поддержка и пре&
данность моей жены Кэрри (Carrie). Также я не смог бы написать эту книгу без
помощи членов моей семьи, моих друзей, сотрудников издательства O’Reilly, со&
авторов и всего Интернет&сообщества. Я очень хочу поблагодарить всех, кто мне
помогал… но для этого мне просто не хватит места.

Обращаюсь к своей жене: Кэрри, ты наполнила мою жизнь тем, чего мне так не
хватало. Без тебя я не стал бы тем, кем хотел стать. Ты мой лучший друг, моя опо&
ра и поддержка в этой жизни. Я не могу выразить словами те чувства, которые я
к тебе испытываю. Каждый день, проведенный с тобой, я ценю тебя все больше и
больше.

К моему сыну: Эйвери (Avery), я любил тебя с того дня, когда ты появился на
свет. Ты самое ценное, что у меня есть, и благодаря тебе я так счастлив. Твоя
улыбка освещает мою жизнь, а твой смех делает меня веселее.

К моей маме: спасибо за все, что ты для меня сделала. Ты поддерживала любое
решение, которое мне приходилось принимать (за исключением моего увлечения
философией), и больше мне ничего не нужно. Впрочем, ты всегда делала больше,
чем я мог бы попросить. Я тебя люблю.

К моему папе: ты вдохновляешь меня на работу, даже несмотря на то, что ты об
этом не знаешь. Нас разделает пространство и время, но мысленно я всегда с то&
бой. Я люблю тебя.
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К Дейву (Dave): благодарю тебя за поддержку, наставления и помощь. Я  с гор&
достью говорю о том, что ты часть моей семьи.

К моим родным: спасибо за вашу поддержку и помощь на протяжении всей
моей жизни.

К Сьюзан Нессанбаум&Голдберг (Susan Nessanbaum&Goldberg): ты помогала
мне направлять мою карьеру и всегда отвечала на мои вопросы. Кто знает, где бы
я сейчас был, если бы не ты? Спасибо.

К Майклу Фитсиммонсу (Michael Fitzsimmons): ты заметил, как я люблю рабо&
тать с компьютерами, и ты помог мне развить мои навыки. Спасибо тебе.

К Теду Стейнбергу (Ted Steinberg): ты мое вдохновение, мой друг. Спасибо
тебе за то, что ты тот, кто ты есть.

К сотрудникам компании Evolution Film and Tape: благодарю вас за то, что вы
выделили мне свободное время и позволили провести его с моей семьей. Отдельно
я хочу поблагодарить Дуга (Doug), Грега (Greg), Дина (Dean) и Кэтлин (Kath&
leen) за то, что они создали такую отличную компанию. Они сформировали стан&
дарт, которому нужно следовать.

К Джину Салливану (Gene Sullivan): спасибо тебе за то, что ты заглядывал мне
через плечо и помогал составлять разделы книги. Твои знания для меня поистине
бесценны.

К Деррику Стори (Derrick Story): благодарю тебя за то, что ты рассказал обо
мне своим коллегам. Если бы не ты, такая возможность никогда бы мне не откры&
лась. И спасибо за твою помощь.

К Брайану Сойеру (Brian Sawyer): каждый день мы говорили по телефону, об&
менивались электронными письмами и советами по поводу первых заболеваний
у наших детей… а также писали эту книгу. Спасибо за твое руководство. Мне при&
шлось получать новые знания, а ты сделал данный процесс безболезненным.

Тот факт, что эта книга была опубликована, обозначает, что я выполнил обеща&
ние, которое я дал своему дедушке в последние годы его жизни. Я надеюсь, что это
так…

Введение

Эта книга  предназначена для того, чтобы предложить каждому, начиная от но&
вичка и заканчивая профессионалом, новый способ восприятия цифрового видео.
Если вы ищете новую технологию для своего проекта, пытаетесь решить обычную
проблему или просто увлекаетесь видео, здесь вы найдете много полезной инфор&
мации. Благодаря этой книге вы научитесь работать со сложными проектами и
избегать распространенных и неприятных ошибок.

Как использовать данную книгу

При желании вы можете прочитать книгу от начала и до конца. Однако отметим,
что каждый раздел является описанием отдельной методики, поэтому вы можете
сразу перейти к наиболее интересной теме. Если вы нуждаетесь в помощи, обра&
титесь к системе ссылок, чтобы найти необходимый раздел книги.

Как организована данная книга

Эта книга разделена на несколько глав, организованных по темам:

• глава 1 «Подготовка». Все этапы создания цифрового видео важны, но са&
мый первый этап, подготовка, способен сэкономить больше времени и
средств, чем любой другой. Если вы выполнили подготовку, вы сможете спра&
виться практически с любой проблемой. Во время работы вам необходимо
заранее готовиться к следующему этапу. В этой главе вы научитесь подготав&
ливать свой проект к обработке и редактированию;

• глава 2 «Освещение». Освещение имеет очень большое значение для видео,
особенно в случае, если вы пытаетесь создать профессиональный проект. Ра&
зумеется, вы можете использовать естественное освещение для сцены. Одна&
ко с помощью специальных методик вы научитесь выделять определенные
детали (или скрывать недостатки) композиции. Здесь мы расскажем о неко&
торых решениях, связанных с освещением;

• глава 3 «Запись материала». Цифровое видео непосредственно связано с ис&
ходным материалом, поэтому его запись – это самый важный этап в вашей
работе. Если у вас не будет материала, вы не сможете редактировать или рас&
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пространять видео. Выбор материала зависит от того, что именно вы хотите
получить, и как вы можете это сделать. Советы в данной главе помогут вам
получить материал из различных источников, снять материал необычным
способом, а также добавить различные исходные данные в один проект;

• глава 4 «Редактирование». Редактирование  – это один из самых сложных
этапов в процессе создания цифрового видео. Кроме того, редактирование
очень сильно зависит от технических возможностей системы и пользователя,
поэтому на данном этапе вам придется чаще всего сталкиваться с различны&
ми ошибками. Используя приведенные здесь советы, вы научитесь редакти&
ровать материал, полученный из различных источников;

• глава 5 «Звук». Очень часто значимость звука для цифрового видео недооце&
нивается, даже несмотря на то, что он является неотъемлемой частью процес&
са. Звук очень специфическим образом воздействует на человека. Музыка,
звуковые эффекты и даже оформление диалогов в сцене будут непосред&
ственным образом влиять на аудиторию проекта. Здесь мы поговорим о том,
как записать и отредактировать звук;

• глава 6 «Эффекты». Эффекты делают процесс редактирования увлекатель&
ным занятием. После записи материала вы можете им управлять, изменять
его внешний вид, а также стилизацию. Спецэффекты могут быть еле замет&
ными, как в фильме «Forrest Gump», или очень яркими, как в «Матрице».
Используя эффекты, вы можете устранить неполадки, которые возникли во
время съемки. Применяя советы из данной главы, вы можете изменить вне&
шний вид снятого материала;

• глава 7 «Распространение». Распространение вашего проекта – это один из
самых приятных и одновременно самых нервозных этапов в процессе созда&
ния цифрового видео. Если вы распространяете видео, это значит, что ваш
проект завершен. Это само по себе большое достижение. В этой главе вы узна&
ете, как можно ознакомить других пользователей с вашим проектом;

• глава 8 «Прочее». Советы из данной главы можно использовать для обыч&
ных проектов, но в первую очередь они предназначены для развлечения. Вам
нужно отдохнуть? Откройте эту главу и посмотрите, что произойдет.

Обозначения, использующиеся в книге

Далее мы приведем список различных обозначений, которые содержатся в книге:

• курсив. Используется для обозначения URL&адресов, имен файлов, расшире&
ний файлов, а также имен папок. Например, путь к папке будет указан как
«/Developer/Applications»;

•øðèôò CourtierC. Используется для выделения кодировки, содержимого
файлов, текста на консоли, а также переменных, команд и других кодов;

•øðèôò CourtierC ïîëóæèðíûé. Выделяет часть кодировки, особенно из&
менения в исходном коде;

•øðèôò CourtierC ñ êóðñèâîì. Используется в кодировке и таблицах,
чтобы показать, что образец текста был заменен.

Вы должны обратить особое внимание на примечания, выделенные в книге
иконками:

Совет, предложение или общее примечание. Содержит дополнительную
информацию о теме.

Предупреждение, которое сообщает вам о возможной опасности.

Иконки в виде термометра обозначают сложность темы:

начинающий; средний уровень; эксперт.

Использование кодировки

Эта книга предназначена для того, чтобы упростить вашу работу. Вы можете исполь&
зовать приведенную здесь кодировку в ваших программах и документации. Вам не
нужно обращаться к нам за разрешением, если только вы не будете полностью копи&
ровать всю кодировку. Например, если вы написали программу, которая содержит
нашу кодировку, разрешение вам не понадобится. Однако если вы продаете или рас&
пространяете CD&диски с информацией, взятой из книг издательства O’Reilly, вам
необходимо получить разрешение. Если вы отвечаете на какой&либо вопрос и приме&
няете нашу кодировку, разрешение вам не нужно. Если вы добавляете нашу кодиров&
ку в документацию вашего продукта, вам понадобится разрешение.

Мы очень ценим ссылки на данную книгу (хотя это и необязательно). Ссылка
обычно включает заголовок, имя автора, имя издателя и ISBN&номер. Например,
ссылка может выглядеть так: «Хакерство для цифрового видео Джошуа Пола.
2005 год, издательство O’Reilly Media Inc., 0596009461».

Если вы полагаете, что вы используете кодировку не так, как описано здесь,
свяжитесь с нами по электронной почте: permissions@oreilly.com.

Как с нами связаться
Мы сделали все возможное, чтобы тщательно проверить все разделы этой книги.
Тем не менее, вы можете обнаружить, что какие&то функции обновились (даже мы
можем делать ошибки!). Как читатель данной книги, вы можете помочь нам улуч&
шить следующие издания. Отправьте нам свои комментарии или предложения.
Сообщите нам о любых ошибках, несоответствиях, неточных выражениях и опе&
чатках, которые вы найдете здесь.
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Напишите нам о том, как мы можем сделать эту книгу более интересной для
вас. Мы постараемся рассмотреть все предложения и внести правки в последую&
щие издания. Вы можете написать нам по адресу:

O’Reilly Media Inc.
1005 Gravenstein Highway North
Sebastopol, CA 95472
(800) 998&9938 (в США или Канаде)
(707) 829&0515 (международный/локальный)
(707) 829&0104 (факс).
Если вы хотите задать вопрос или поделиться своими впечатлениями по пово&

ду книги, напишите нам по электронной почте: bookquestions@oreilly.com.
На Web&сайте Digital Video Hacks вы найдете примеры и планы для будущих

изданий книги. Обратитесь на Web&страницу по адресу: http://www.oreilly.com/
catalog/digitalvideohks/.

За дополнительной информацией об этой и других книгах зайдите на Web&сайт
O’Reilly: http://www.oreilly.com.

Safari® Enabled
Если вы видите на обложке книги иконку Safari® Enabled, это значит, что данную
книгу можно купить в сети Интернет через магазин O’Reilly Network Safari Bookshelf.

У вас есть совет?
Чтобы познакомиться с книгами из серии Hacks в сети Интернет или чтобы дать
нам совет для будущих изданий, обратитесь по адресу: http://hacks.oreilly.com.
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Все этапы создания цифрового видео важны, но самый первый этап, подготовка,
способен сэкономить больше времени и средств, чем любой другой. Если вы вы&
полнили подготовку, вы сможете справиться практически с любой проблемой. Во
время работы вам необходимо заранее готовиться к следующему этапу.

Всегда воспринимайте проект как нечто целостное, а не как группу отдельных
файлов, которые должны быть объединены только перед завершением работы.
Любое выполненное вами действие повлияет на весь проект. Поэтому, если вы
совершите ошибку на одном этапе, она будет доставлять вам неудобство на всем
протяжении работы.

Совет 1 Успешное завершение проекта

Выполнив определенные действия, вы сможете завершить свой проект быстрее
и потратить на это меньшую сумму денег.

У многих пользователей возникают трудности с завершением проекта. Пра&
вильно выполнить редактирование проекта непросто. Проблемы могут быть свя&
заны с недостатком опыта и (или) знаний, с плохими навыками работы с оборудо&
ванием или просто с усталостью дизайнера проекта. К счастью, существует про&
стой процесс, который позволит вам избежать подобных осложнений.

Этот раздел представляет собой краткий список действий, которые
вы должны выполнить. При желании вы можете воспользоваться
и другими разделами книги. Мне приходилось видеть пользователей
(и даже профессионалов), которые тратили тысячи долларов просто
потому, что они не выполнили нужные действия в определенном
порядке.

Маркируйте свои данные
Маркировать диски очень просто. Но сам процесс создания маркировки (см. совет
3) может существенно упростить или, наоборот, осложнить вашу работу. Если вы
совершите ошибку, скорее всего, вам придется заново перенумеровывать все дис&
ки, потому что вы забыли о том, что они удаляются при создании списка EDL.

Следуйте простым рекомендациям:

• не повторяйте нумерацию;
• используйте простую маркировку.

Вы можете задействовать свою фантазию, но не стоит переусердствовать. Если
вы создали систему, пользователи которой постоянно задают вам вопросы, это
значит, что вы попусту потратили свое время и силы. Скажу проще: старайтесь
все сделать правильно с самого начала и не стремитесь к лишним усложнениям.

Следите за своими дисками
Организуйте процесс отслеживания данных. Вы должны знать, какую маркиров&
ку имеют ваши диски и что на них содержится. Для этого вы можете использовать
базу данных, электронную таблицу или даже свой ноутбук.

Если вы не знаете, сколько у вас кассет и что на них записано, вы никогда не
поймете, хватает вам материала или нет. Если вы промаркировали свои диски до
записи, нанесите на них дополнительную информацию после записи. Одних кас&
сет с нумерацией явно недостаточно.

Проверяйте свои данные
Если вы не знаете, что записано на ваших кассетах, как вы сможете найти нужный
материал? Вы можете проверять материал различными способами, начиная от за&
писей на бумаге и заканчивая электронными таблицами (см. совет 5), отдельными
приложениями и даже вашим видеоредактором.

Однако при проверке материала вам необходимо помнить о таком явлении, как
регенерация временной кодировки. Этот феномен проявляется в случае, если вре&
менная кодировка переходит назад во времени; он создает дополнительные слож&
ности при редактировании. Если у вас возникла проблема с регенерацией времен&
ной кодировки, вам необходимо создать цифровую копию кассеты (см. совет 48)
с новой, постоянной временной кодировкой.

Создайте копию на бумаге
Копия на бумаге – это план вашего проекта на бумаге. Перед тем как приступить
к редактированию, вы должны иметь четкое представление о том, какой материал
вы будете использовать и где именно он находится. Для создания плана проекта
вы можете использовать сценарий из двух столбцов (см. совет 7); это значительно
упростит вашу задачу.

Если вы работаете в проекте со сценариями, например в фильме&триллере, вам
необходимо выбрать линейный сценарий (см. совет 11). Если у вас нет такого сце&
нария, вы можете просмотреть материал и сделать записи в нем. Ваши записи долж&
ны содержать такие сведения, как номер кассеты и временная кодировка для каж&
дой сцены.

Создание точки редактирования
Точка редактирования (offline cut) – это начальная точка для редактирования.
В режиме offline вы собираете все элементы и составляете готовую композицию.
Сейчас вы должны определить, какие данные, звуковые эффекты, графические
элементы и другие объекты отсутствуют, а также понять, с какими проблемами вы
можете столкнуться. Пока вам не нужно микшировать звук, если только в этом не
возникнет необходимости.

Для создания шкалы времени воспользуйтесь копией проекта на бумаге или
линейным сценарием. Чтобы устранить недостатки, вы должны изучить материал
(и проверить его!). Помните о том, что проект на бумаге, скорее всего, не будет
полностью соответствовать результату при редактировании.

Успешное завершение проекта
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Как можно чаще выполняйте резервное копирование вашего проекта (см. совет 2);
в противном случае вы можете потерять результаты своей работы. После созда&
ния точки редактирования вам необходимо сформировать копию проекта (см. со&
вет 75), чтобы вы смогли удаленно вносить в нее комментарии.

Зафиксируйте точку редактирования
После создания точки редактирования остановитесь, выполните резервное копи&
рование и создайте копию проекта. Копия проекта не предназначена для измене&
ний! Сейчас у вас не должно остаться дополнительных элементов проекта. Далее
вам не следует больше редактировать вашу композицию.

Изменение параметров точки редактирования
Если вы выполняете редактирование с низким разрешением, например в режиме
OfflineRT для Final Cut или 10:1 для Avid, вам необходимо изменить настройки
материала. При этом следите за тем, чтобы у вас было не менее 15 манипуляторов
кадра, что позволит вам свободно управлять материалом. После передачи всего
материала вы должны оцифровать зафиксированную точку редактирования.

Поместите точку редактирования в верхний слой видео на шкале времени. Затем
вам необходимо убедиться в том, что ваш проект в режиме оnline соответствует про&
екту в режиме оffline. Для этого вы можете использовать различные методики:

• обрезка. Вы можете обрезать исходный материал на 50% по горизонтали или
вертикали, что позволит вам одновременно видеть обе копии проекта. Во вре&
мя работы со шкалой времени вы сразу заметите любые несоответствия. Если
несоответствия отсутствуют, полное изображение на экране будет разделено;

• переключение. Если вы хотите всего лишь проверить материал, вы можете
перейти в любую точку на шкале времени и изменить видимость исходной
точки. Это позволит вам просмотреть полноэкранное изображение выбран&
ной и исходной точек. Данная методика не всегда позволяет находить неболь&
шие недостатки (допустим, отличие в одном кадре), но серьезные проблемы
вы заметите сразу.

После корректировки исходной точки редактирования я советую вам записать
ее на новую кассету. Эта кассета содержит композицию&мастер. Храните ее и гор&
дитесь собой: вы уже добились того, о чем многим людям приходится только меч&
тать.

Корректировка цвета и микширование
Вы можете выполнить два последних шага на той же системе или использовать
другой компьютер (если вы можете себе позволить нанять художника&колориста
или специалиста по микшированию). Если вы собираетесь работать на другой си&
стеме, вы должны знать, какие типы файлов будут использоваться (особенно это
важно для звука). Также вам необходимо знать, как именно будет выполняться
резервное копирование двух сигналов (видео и аудио) на пленку. Другими слова&

ми, какое приложение будет использоваться и какие требования предъявляются
к программному обеспечению.

Корректировка цвета для комопзиции)мастер
Можете верить мне или нет, но вам не нужно выполнять корректировку цвета до
завершения работы над основной композицией. Причина проста: если вы совер&
шите ошибку, то сможете ее отменить. Кроме того, у вас постоянно будет под ру&
кой резервная копия проекта.

Если вы выполняете корректировку цвета на системе, в которой вы отредакти&
ровали свой материал, вы можете воспользоваться оригинальной шкалой време&
ни. До корректировки цвета обязательно скопируйте проект и шкалу времени!

Если вы будете корректировать цвет на другой системе, экспортируйте список
EDL или скопируйте шкалу времени (в зависимости от компьютера). Это позво&
лит вам сохранить ссылки на начальные точки редактирования в вашей компози&
ции. В результате ваша задача значительно упростится.

После завершения корректировки цвета вам необходимо выполнить копирова&
ние на другую кассету. Эта кассета будет содержать скорректированную компози&
цию. Ваш проект успешно продвигается!

Микширование звука
Последний этап состоит из обработки звука. Каждый раз, когда я работаю со зву&
ком, я поражаюсь тому, как небольшое изменение трека, например устранение
помех (см. совет 56), может улучшить общее впечатление от сцены. Если вы соби&
раетесь микшировать звук, обязательно установите качественные динамики; это
позволит вам получить четкую картину о треке.

Если вы выполнили корректировку цвета и микширование звука в одном при&
ложении, то можете идти дальше. Если вы использовали различные приложения,
вы можете применить одну из двух методик (выбор зависит от возможностей ва&
шего аудиомикшера).

Если ваша система может записывать на пленку только звук, вы сможете до&
бавить аудиотрек в скорректированную композицию. Это значит, что вы можете
использовать одну и ту же кассету и сохранить на нее смикшированный звук.
Следовательно, вы точно знаете, какая именно кассета содержит финальную
композицию.

Если система не может записывать только звук, вам необходимо сохранить
аудиотрек в отдельный файл с максимально высоким качеством. После этого им&
портируйте аудиофайл в ваш видеоредактор. Затем поместите аудиофайл на шка&
лу времени и синхронизируйте его с видео. И наконец, завершите создание компо&
зиции.

Вот и все! Ваша работа завершена.

Что делать дальше?
Для завершения проекта вам придется приложить много усилий. Если вы сможе&
те избежать ошибок вначале, вы сможете не повторять их впоследствии. Когда
у вас появится некоторый опыт, вы заметите, что чем позднее вы обнаружите про&

Успешное завершение проекта
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блему, тем труднее и дороже будет ее решить. Если вы будете следовать рекомен&
дациям, приведенным в этом разделе, это позволит вам сэкономить много сил,
времени, нервов и средств.

Совет 2 Организуйте свой проект

В процессе редактирования проекта шкала времени начинает заполняться раз&
личными элементами. Выполните несколько простых действий – и вы сможете
избежать лишних проблем.

Редактирование – это настоящее искусство. Ключевое понятие, связанное с ре&
дактированием, – процесс. К сожалению, многие люди, включая профессиональ&
ных редакторов, не уделяют процессу должного внимания. В результате им при&
ходится обвинять в своих неудачах редакторы, а не самих себя.

Организуем треки
Если вы будете регулярно «чистить» шкалу времени, это позволит вам работать
более эффективно и, как следствие, быстро. Для этого вам необходимо поместить
видео& и аудиоданные в отдельные треки. Например, вы должны поместить все
заголовки (допустим, кредиты) в видео трек 5 (V5). На рис. 1.1 показана сложная,
но хорошо организованная шкала времени Avid.

А аудиотреки так:

• диалоги и авторский текст: A1 и A2;
• естественный звук и окружающий шум: A3 и A4;
• звуковые эффекты: A5 и A6;
• музыка: A7 и A8.

Если для управления звуком вы используете внешний микшер, убедитесь
в том, что вы прослушиваете именно те треки, которые отображены на шкале вре&
мени. Например, если вы поместили звуковой эффект, вызванный работой кухон&
ного блендера, в трек, который воспроизводится только через правый динамик, но
при этом вы слышите звук из обоих динамиков, это значит, что ваш микшер скон&
фигурирован неверно. Как правило, вы будете настраивать микшер таким обра&
зом, чтобы правый и левый каналы звука направлялись на правый и левый дина&
мики соответственно. Вряд ли вам понадобится изменять эту настройку.

Если у вас есть ограничение по числу каналов для работы, я советую
вам изменить настройки баланса звука. К примеру, если вы поместите
авторскую речь в трек A1, вам необходимо изменить его конфигура&
цию. Не забудьте проверить настройки баланса во время микширова&
ния звука.

Организация иконок и папок
Организация иконок, как и организация шкалы времени, даст вам возможность
работать с повышенной эффективностью. Существует огромное количество спо&
собов организации вашего компьютера, а также очень большое количество мето&
дик, предназначенных для организации папок. Впрочем, некоторые методики бо&
лее эффективны, чем другие.

По номеру кассеты
Это самая распространенная методика. Вы даете каждой иконке название, кото&
рое соответствует номеру кассеты, и помещаете в соответствующую папку только
материал, записанный на данной кассете. Например, если у вас есть кассета с но&
мером DV1031, в папке будет сохранен только материал с этой кассеты.

Данная методика очень эффективна, потому что большинство пользователей
выполняют поиск материала по номеру кассеты и по временной кодировке. При&
менение этой методики наряду с сохранением записей о кассетах (см. совет 5) сде&
лает процесс редактирования проекта простым и увлекательным.

По сцене
Если вы редактируете проект со сценариями, например фильм&триллер, возмож&
но, вам будет удобнее организовать иконки по сценам. Для этого создайте нужные
иконки и введите их названия. Затем поместите в каждую папку материал, кото&
рый относится к соответствующей сцене.

Рис. 1.1. Организуем треки в Avid

Не существует единого правила для всех проектов, потому что каждый проект
по&своему уникален. Если вы научитесь правильно организовывать треки, то смо&
жете быстро находить нужные данные по слою, в котором они располагаются.

Для начала я советую вам организовать видеотреки следующим образом:

• материал: V1 и V2;
• альфа&каналы и эффекты: V3 и V4;
• заголовки: V5 и V6.

Организуйте свой проект
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Если вы применяете данную методику, вы можете вводить названия иконок, кото&
рые соответствуют номерам сцен (допустим, «Сцена 3»), либо по событию в сцене
(например, «Заседание суда присяжных»). Разумеется, вы можете комбинировать
обе методики и получить такое название, как «Сцена 3: заседание суда присяжных».

Использование данной методики позволяет вам выполнять поиск только того
материала, который имеет отношение в редактируемой сцене. Особенно это по&
лезно при работе с продюсерами или режиссерами, которые имеют привычку
спрашивать: «А какой еще материал для суда присяжных у нас есть?» Вместо того
чтобы просматривать всю шкалу времени в поисках номеров кассет и названий
папок, вы можете очень быстро найти весь нужный материал.

По дате снимка
Если вы работаете с документальным фильмом или с проектом в режиме реально&
го времени, скорее всего, вам будет проще организовать материал по дате снимка.
При использовании данной методики я советую вам создавать вложенные папки,
что позволяет вводить названия по дате, а также по номеру кассеты. Например, вы
создадите папку 04Jan2000, а затем вложите в нее другие папки для отдельных
кассет (JVa039, JVb039 и JVa040; см. рис. 1.2).

Дополнительные папки
Ваш проект должен содержать следующие дополнительные папки:

• B
Roll. В папку B&Roll вы будете помещать материал B&Roll, например сним&
ки, которые вы собираетесь использовать в основных сценах или в переходах;

• Music. Папка Music, как вы догадались, содержит музыку. Здесь находятся
все аудиофайлы для вашего проекта;

• SFX. Папка SFX содержит все звуковые эффекты вашего проекта;
• EFX. В папку EFX вы помещаете различные эффекты, такие как материал

для композиций и заголовков;
• Project. В папку Project вы должны сохранять последовательности со шкалы

времени. Некоторые пользователи предпочитают создавать в папке Project
несколько вложенных папок, например Archives (для резервных копий),
Promos (для рекламного материала), Scenes (для работы с небольшими фраг&
ментами проекта) и т. д.

Самое важное в процессе организации папок – это определить, как именно вы и
ваши коллеги ищут материал и элементы, с которыми они собираются работать.
Если у вас есть немного свободного времени, вы даже можете скомбинировать
вышеописанные методики.

Следите за свободным пространством
Многие неопытные редакторы не следят за свободным пространством на диске. Это
значит, что они не знают, сколько пространства занято, а сколько – свободно. Вы
можете подумать, что это не имеет большого значения (у вас в системе установлен
жесткий диск объемом 240 Гб, о чем вам беспокоиться?), однако вы будете удивле&
ны, когда узнаете, как быстро видеофайлы способны переполнить жесткий диск.

Следить за пространством на диске важно по двум причинам. Во&первых, вы
всегда будете знать, хватит ли вам пространства для импорта нового материала.
Во&вторых, вы избавите себя от возможных проблем, связанных со сбоем диска
вследствие недостатка свободного места. Некоторые опытные редакторы попада&
ли во вторую ситуацию и мечтают о том, чтобы никогда не попасть в нее повторно.

С местом на диске связано такое понятие, как счетчик объектов в папке. Мно&
гие системы редактирования формируют отдельные файлы для всех видео&
и аудиоэффектов, которые вы создаете или визуализируете. С течением времени
такие файлы вырастают в объеме и могут стать причиной неполадки.

Как заметил один мой знакомый, счетчики объектов могут вызвать
серьезные проблемы. Он работал на телевизионном шоу. Однажды
системы редактирования вышли из строя. После изучения папок он
обнаружил в одной директории около 500 000 файлов. Эти файлы
вызывали неполадки и привели к потере нескольких тысяч долларов,
связанной с простоем оборудования.

Рис. 1.2. Организуем материал по дате снимка

Эта методика очень эффективна при работе с документальными фильмами,
потому что люди должны вспоминать события, которые произошли в определен&
ный день, а не были записаны на отдельной кассете. Например, продюсер с боль&
шой вероятностью спросит вас: «Вы видели снимок с поцелуем Джона (John)
и Ванессы (Vanessa)? По&моему, это произошло во вторник, четвертого числа».
Вряд ли он скажет: «Это было записано на кассете JVa039».

Организуйте свой проект
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Я советую вам время от времени удалять файлы счетчика и выполнять повтор&
ную визуализацию проекта.

Резервное копирование
Последняя методика организации проекта является универсальным решением
для любой проблемы. Я рекомендую вам как можно чаще копировать вашу шкалу
времени и сохранять ее под другим названием. Вы можете называть копии по дате
(14Jun2004), по исходной точке (Offline&pass&5) или по кодировке (DVv5dc:
DV&проект, версия 5, копия для режиссера).

Джексон Андерер (Jackson Anderer), редактор, номинировавшийся
на премию Эмми, использует для названий последовательностей
систему Project&Act или Scene&Cut&Initials. Поэтому заголовок
последовательности выглядит так:
EMHE&212&Act1&Cut10&Feb9&JA
Что можно перевести как: фильм «Extreme Makeover», Home Edition,
Season 2, эпизод 12, акт 1, точка 10, завершено 9 февраля, автор –
Джексон Андерер.
Эта система очень удобна для организации крупных проектов с боль&
шим количеством участников.

Как бы вы ни называли исходные точки, используйте одну систему. Рано или
поздно вам придется вернуться к предыдущей точке, и, если вы постоянно работа&
ли с одной шкалой времени, вы не сможете этого сделать. Мне приходилось ви&
деть, как один режиссер сломал руку (ударив кулаком по столу), когда ему сказа&
ли, что в проекте нет резервной копии предыдущей шкалы времени; ему при&
шлось восстанавливать результаты целого дня работы.

Вам необходимо выполнять резервное копирование проекта (не отдельных
данных) на внешний диск, лучше всего переносной. Для этого лучше всего подхо&
дят небольшие USB&диски, потому что они имеют достаточный объем для хране&
ния крупных проектов, а также очень удобны, и вы можете носить их с собой.

Совет 3 Нумеруйте свои кассеты

Нумерация кассет может повлиять на эффективность вашей работы.
Каждая кассета должна иметь не только уникальную временную кодировку

(см. совет 4), но и уникальный номер. Несмотря на то что пронумеровать кассеты
очень просто, мне очень часто приходилось слышать о пользователях, которым
пришлось иметь дело с ошибками в кодировке или с ее отсутствием.

Используйте свою систему
Вам следует выбрать систему нумерации, которая была бы понятна как для вас,
так и для ваших коллег. Эта система должна быть проста; необходимо сделать так,

чтобы при одном взгляде на кассету вы смогли бы определить, что на ней записа&
но. Для отслеживания материала вы должны использовать отдельную электрон&
ную таблицу или базу данных, которая содержит дату снимка и краткое описание
каждого файла.

Представьте себе, что вы просматриваете 100 кассет MiniDV
и пытаетесь разобрать, что именно вы написали на небольших ярлы&
ках. Я могу вас заверить в том, что вся нужная информация на эти&
кетке не поместится. Электронная таблица или база данных может
стать незаменимым ресурсом для поиска данных.

Я советую вам выбрать систему, которая поддерживает функции поиска и
сортировки. Крупные проекты часто содержат нескольких сотен часов материа&
ла. Некоторые профессиональные проекты могут включать десятки тысяч ча&
сов! Потратьте немного времени и введите всю информацию в один справочный
файл.

Если вы работаете над проектом вместе с небольшой группой коллег,
я рекомендую вам выбрать централизованную систему.
Не имеет значения, что именно вы создаете: методику проверки
электронной таблицы, способ использования WebDAV для блокировки/
разблокировки группы файлов или даже новую базу данных для серве&
ра, – вам все равно понадобится центральная система отслеживания
информации. Это связано с тем, что вам необходимо принять меры
предосторожности и добиться того, чтобы одни пользователи случай&
но не удалили данные, внесенные другими пользователями. Если вы
этого не сделаете, у вас могут возникнуть трудности с вашим соб&
ственным проектом.

Правильная нумерация
Выбор методики нумерации зависит от ваших предпочтений. Лично мне очень не
нравится использовать номера кассет, которые состоят более чем из шести симво&
лов. Нелинейные системы редактирования стремительно становятся популярны&
ми, однако такие форматы, как Advanced Authoring Format (AAF), Media Exchange
Format (MXF) и Edit Decision List (EDL), по&прежнему остаются единым стан&
дартом для перемещения проекта с одного компьютера на другой.

Если вы желаете избежать трудностей при работе с форматом EDL, номер
кассеты не должен содержать более шести символов (или восьми, если вы хоти&
те немного рискнуть). Кроме того, номер кассеты не должен содержать специ&
альных символов, таких как подчеркивание (_) или (&)Б, а также не должен за&
канчиваться на букву «B». Проще всего ограничиться алфавитом (A&Z) и циф&
рами (0–9).

Нумеруйте свои кассеты
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Если вы хотите понять, чем вызваны эти правила, зайдите на сайт
http://users.rcn.com/brooks/maxguide.html#reeln% и помните о том, что
многие системы поддерживают импорт и экспорт GVG EDL.
Если вы уверены в том, что вы не будете работать с форматом EDL,
то можете выбрать и другую систему нумерации. Впрочем,
я по&прежнему рекомендую вам стремиться к простоте.

Перейдем к нумерации. Далее я дам вам ряд простых советов, связанных с опы&
том работы над сложными профессиональными проектами.

Нумерация по проекту
Одна из методик заключается в том, чтобы нумеровать кассеты по проекту, по

номеру камеры и по порядку. В результате номер кассеты будет выглядеть как
PWA032, то есть «свадьба Петера (PW), камера A, кассета номер 32». Обратите
внимание: мы специально выбрали номер 032, а не просто 32. Применение цифры
0 позволяет работать с диапазоном из 1000 кассет (000&999). Если вы планируете
использовать больше тысячи кассет, вы можете ввести два нуля и удалить одну
букву (то есть PA0032).

Нумерация по дате
Если вы хотите нумеровать кассеты по дате и сохранить ограничение из шести
символов, то должны указать только номер, камеру и дату. Например, материал
с четвертой кассеты, снятой 15 марта на камеру A, будет записан как 4A0315. Если
вы будете использовать эту методику, вам понадобится добавить дополнитель&
ную информацию на этикетку кассеты или в вашей системе отслеживания.

Если вы решили использовать восемь символов, я советую вам приме&
нить нумерацию по дате.

Если вы не хотите нарушить нумерацию кассет, то можете просто записать до&
полнительные данные (допустим, название проекта) на ярлыке вручную. Эти све&
дения будут дополнять номер кассеты. Очень легко понять, что кассета с этикет&
кой «Going Home 4A0315» не имеет ничего общего с проектом «Sunset 3B0322».
Это очень эффективное решение, особенно при работе с несколькими проектами.

Если вы выполняете проверку или оцифровываете материал, в качестве номера
кассеты следует вводить только номер отслеживания. Не нужно добавлять в но&
мер кассеты название проекта. В противном случае у вас возникнут проблемы
с созданием списка EDL.

Использование штрих)кодов
Также вы можете купить ярлыки со штрих&кодами и обычной нумерацией. Это
решение особенно эффективно в случае, если вы планируете использовать боль&
шое количество материала. Дополнительное преимущество данной методики за&

ключается в том, что вы можете отслеживать перемещение кассет с помощью
сканера.

Покупка штрих)кода
Если вы хотите купить этикетки со штрих&кодами, я советую вам обратиться
в компанию Barcode Discounters (http://www.barcodediscounters.com). У меня
есть опыт работы с продукцией этой компании; обычно я покупал ярлыки 2’ × 1’
Poly/Permanent. Кроме того, я печатал над штрих&кодом название проекта, а под
ним – обычный номер (см. рис. 1.3).

Рис. 1.3. Этикетка для кассеты со штрих�кодом

Если вы закажете ярлыки со штрих&кодом, вы узнаете о том, что на кассету
MiniDV помещается этикетка 2’ × 1’. В зависимости от своих предпочтений вы
можете купить два набора ярлыков, чтобы поместить их на саму кассету и на пла&
стиковую коробку.

Создание новых этикеток
Если вы хотите напечатать ярлыки самостоятельно, а на вашем компьютере уста&
новлен пакет программ Microsoft Office, то можете связать электронную таблицу
Excel с документом Word и выполнить следующие действия.

1. Создать новый документ Excel.
2. Введите в ячейку A1 текст Barcode.
3. Введите в ячейку A3 формулу =sum(A2+1).
4. Выделите и скопируйте ячейку A3.
5. Скопируйте формулу в нужное количество ячеек под столбцом A:
• каждый комплект Avery 5267 состоит из 2000 ярлыков;

Нумеруйте свои кассеты
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• вы можете вставить формулу в ячейку A1002, если вы хотите промаркиро&
вать кассету и коробку.

6. Введите в ячейку A2 число 10 000 (или любое другое).
7. Сохраните документ.

Обычно я начинаю серию номеров с числа 10 000, потому что некото&
рые системы автоматически конвертируют числа 00001 в 1.
Я предпочитаю постоянство.

Одно из преимуществ данной методики состоит в том, что вы можете настроить
электронную таблицу на отслеживание дополнительной информации, например
даты снимка и содержания. Для этого добавьте нужные критерии в первую строку
таблицы. В результате справа от штрих&кода вы можете напечатать название про&
екта, дату снимка, описание, формат и т. д.

Теперь вы должны отправить информацию в программу Word и распечатать
полученные этикетки. Для этого воспользуйтесь шаблоном Avery 5267. Вы печа&
таете этикетки Return Address, которые имеют размеры 0.5 × 1.75 дюйма и удобно
помещаются на кассеты MiniDV. Если вы используете другой формат пленки, вы&
берите соответствующий шаблон.

Если вы решили добавить название проекта, вы должны ввести его
до печати этикеток. В противном случае вы напечатаете только
номер кассеты.

Выполните следующие действия.

1. Создайте новый документ Word.
2. Выберите пункты меню Tools ⇒ Labels (Инструменты ⇒ Ярлыки).
3. Измените тип ярлыка на Avery 5267.
4. Нажмите кнопку Data Merge (Совмещение данных).
5. Используя приложение Data Merge Manager, выберите пункты меню Data

Source ⇒ Get Data ⇒ Open Data Source (Источник данных ⇒ Получить
данные ⇒ Открыть источник данных).

6. Найдите сохраненный документ Excel.
7. Выберите методику импорта по умолчанию.
8. Добавьте в ярлык штрих&код. Если вы вставили столбец с названием проек&

та, добавьте его.
9. Выберите пункты меню Edit ⇒ Select All (Правка ⇒ Выбрать все).

10. Выберите пункты меню Format ⇒ Paragraph (Формат ⇒ Абзац).
11. Выберите пункты меню Alignment ⇒ Center (Выравнивание ⇒ По центру).
12. Сохраните документ.

Теперь вы можете печатать этикетки напрямую из документа Word. Так как
существует только одна группа данных в строке таблицы, вы можете распечатать

лишь один ярлык для кассеты. Если вы хотите наклеить этикетки на кассету и
коробку, распечатайте две копии ярлыка.

Обновляйте данные
С течением времени ваша система отслеживания должна стать единым докумен&
том, который содержит обзорную информацию по вашим проектам. Убедитесь
в том, что вы вводите в документ данные для каждой кассеты. Чем более внима&
тельно вы будете следить за обновлением информации, тем меньше проблем
в процессе редактирования у вас возникнет.

Совет 4 Кодируйте запись на пленке

Вы можете избежать лишних трудностей с оцифровкой материала, если запишите
временную кодировку на кассеты, перед тем как сохранить на них данные.

Благодаря временной кодировке цифровое видео позволяет вам добиться высо&
кой точности при редактировании. Фильм представляет собой всего лишь серию
неподвижных изображений (или кадров), отображенных на высокой скорости и
в определенной последовательности. Временная кодировка дает вам возможность
отслеживать эти кадры. Частота смены кадров видео показывает, сколько кадров
отображается на экране в секунду.

Временная кодировка измеряется в часах, минутах, секундах
и кадрах. Используется формат HH:MM:SS:FF. Следовательно, если
у вас есть временная кодировка 42:21:33:04, вы знаете, что изображе&
ние имеет продолжительность воспроизведения 42 ч, 21 мин, 33 с
и 4 кадра.
Существует два типа временной кодировки: с пропущенным кадром
(DF) и без пропущенного кадра (NDF). Пропущенный кадр обозначает&
ся точкой с запятой (;), а отсутствие пропущенного кадра – двоето&
чием (:). Некоторые пользователи также обозначают пропущенный
кадр точкой (.). Приведу ряд примеров:
01,00,00,00 – пропущенный кадр
01:00:00;00 – пропущенный кадр
01:00:00.00 – пропущенный кадр
01:00:00:00 – нет пропущенного кадра
Тип временной кодировки имеет значение для любой системы. Большин&
ство редакторов по умолчанию используют пропущенный кадр.

Временная кодировка применяется как ссылка для редактирования. Если одна
и та же кодировка повторяется на кассете несколько раз, вам будет очень трудно
определить, какое именно изображение следует использовать. Следовательно,
каждый кадр видео должен быть связан с уникальной временной кодировкой.

Кодируйте запись на пленке
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Просмотр временной кодировки
Многие камеры генерируют временную кодировку (начиная с 00:00:00;00) в мо&
мент включения и выключения. Это может вызвать проблемы, потому что время
от времени вы будете постоянно включать и выключать камеру, чтобы сохранить
питание батарей. В результате на одной кассете будет записано несколько иден&
тичных временных кодировок.

Чтобы определить, имеете ли вы дело с регенерацией временной кодировки,
посмотрите на текущую кодировку кассеты в видоискателе камеры. Например,
если вы записали 10 мин материала, а затем выключили и включили камеру, но
при этом счетчик кодировки показывает 00:00:00;00, это значит, что вы имеете
дело с регенерацией временной кодировки. На рис. 1.4 показано, как выглядит
временная кодировка на LCD&мониторе до (слева) и после (справа) выключения
камеры.

Некоторые видеокамеры сами кодируют видеоизображение, поэтому
игнорируют любую кодировку на вашей пленке. Эта особенность
упоминается иногда как Regenerate Timecode. Эта особенность не
является аналогом восстановленной кодировки, приведенной выше.

смены кадров, но здесь я не буду рассказывать об этом (подсказка: телевидение не
всегда было цветным).

Приведу список временных кодировок для самых распространенных стандар&
тов цифрового видео:

• NTSC (29,97 кадров/с). Как правило, используется только в Америке. Не&
смотря на то что считается форматом пропущенного кадра, в действительно&
сти кадры не пропускаются. Пропускаются номера кадров. Расчет произво&
дится следующим образом: пропускается один кадр каждую минуту, за ис&
ключением минут, которые делятся на 10. При пропуске кадра счетчик
перемещается с ;29 на ;02;

• PAL (25 кадров/с). Как правило, используется в Европе. Кодировка PAL не
нуждается в дополнительных объяснениях: все достаточно просто и очевид&
но;

• 24p (23,976 кадров/с). Происходит от понятия «видео с высоким разрешени&
ем». Сейчас некоторые DV&камеры могут вести запись в формате 24p, кото&
рый является предпочтительным для многих пользователей, потому что тра&
диционно все фильмы снимаются с частотой 24 кадра/с. Современные систе&
мы редактирования значительно упрощают работу с данным форматом.

Камеры Panasonic имеют формат 24p Advanced, который записывает
видео в режиме 24p и применяют специальный процесс, чтобы доба&
вить поддержку формата 29.97 fps. Некоторые системы редактирова&
ния могут распознавать формат 24p Advanced и работать с ним. Если
вы собираетесь использовать этот формат, убедитесь в том, что
ваша система редактирования может его обрабатывать.

Создание закодированной записи
Вы можете закодировать записи несколькими способами. Независимо от того, ка&
кую опцию вы выберете, вам необходимо закодировать кассеты, перед тем как за&
писывать на них материал. Некоторые пользователи пытаются сделать это в об&
ратном порядке… и не преуспевают.

Использование системы редактирования
Если ваша система редактирования поддерживает кодировку данных, вы должны
ее использовать. Программы Apple Final Cut Pro, Avid Xpress и Adobe Premiere
включают эту функцию. Если ваша система редактирования не может кодировать
данные, вы можете создать новую шкалу времени с черным изображением. Про&
должительность этого изображения должна соответствовать продолжительности
воспроизведения записи на кассете. Следовательно, если вы хотите записать кас&
сету 60 мин, вам необходимо выбрать изображение продолжительностью 60 мин.

После создания шкалы времени просто запишите ее на кассету. Преимуще&
ство данной методики определяется возможностями вашей системы редактиро&

Рис. 1.4. Следите за временной кодировкой:
она может неожиданно обнулиться

Чтобы избежать проблем с регенерацией временной кодировки, кодируйте за&
пись на пленке. В ходе этого процесса на пленку записывается черное изображе&
ние, а камера сохраняет постоянную временную кодировку для каждого кадра
видео. После завершения процесса вы можете спокойно выключать камеру, так
как существующая временная кодировка не будет переписана. Однако черное
изображение будет заменено записанным вами материалом.

Определяем частоту смены кадров
Большую часть времени вы будете работать с видео в формате 29.97 кадров в се&
кунду (стандарт NTSC) или 25 кадров в секунду (стандарт PAL). Существуют оп&
ределенные причины того, что в стандарте NTSC используется другая частота

Кодируйте запись на пленке
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вания и состоит в том, что вы можете создать начальную точку для временной
кодировки. Например, вы можете создать начальную точку для первой кассеты
в точке первого часа (01:00:00;00), для второй кассеты – в точке второго часа
(02:00:00;00) и т. д.

Если ваша система редактирования не может передавать созданную вами вре&
менную кодировку, вы можете использовать ее для отправки черного изображе&
ния. Впрочем, это значит, что вы можете работать и с самой камерой, потому что
она способна кодировать данные самостоятельно.

Использование камеры
Чтобы записать черное изображение на камере, не снимайте крышку объектива во
время съемки. Так как объектив закрыт, ваша камера будет записывать на кассету
черное изображение и постоянную временную кодировку. В результате ваши дан&
ные будут закодированы.

Микрофон вашей камеры может записывать звук и сохранять
его на пленку. Поэтому вы должны отключить микрофон или отсоеди&
нить его от камеры на время записи. Не забудьте затем подключить
микрофон.

Использование видеодеки
Вы можете закодировать ваши кассеты на видеодеке. Если вы собираетесь рабо&
тать с объемным материалом, вам необходимо приобрести видеодеку. Если для
кодировки данных вы используете деку, то можете активировать встроенную
функцию системы редактирования (см. раздел «Использование системы редакти&
рования» ранее) или отправить сигнал черного изображения на аналоговый ви&
деовход вашей деки.

Покупка закодированных кассет
Многие профессиональные видеокомпании продают закодированные кассеты.
Как правило, такие кассеты стоят чуть дороже обычных. Обычно подобные кассе&
ты применяются для записи материала исключительно внутри соответствующей
компании. Впрочем, с высокой вероятностью вы сможете купить их и для личного
пользования.

Совет 5 Загрузка кассеты из электронной таблицы

Если вы загрузите материал, вам будет доступна дополнительная ссылка на со&
держимое кассеты.

Независимо от объема вашего проекта вы должны знать, что именно он содер&
жит. Существует большое количество приложений, которые могут применяться
для просмотра материала; впрочем, для этого вы можете использовать и обычную
электронную таблицу.

Если у вас нет программы для работы с электронными таблицами,
вы можете создать текстовый документ с табуляцией, который
предназначается для решения такой же задачи. Табуляция позволяет
разделить данные по столбцам. В таком файле каждая группа данных
представляет собой столбец, а каждая линия текста – строку.

Внимательно проверьте ваши кассеты
Перед тем как начать, убедитесь в том, что ваши кассеты имеют уникальную мар&
кировку и нумерацию (см. совет 3). Кроме того, проверьте, не содержат ли ваши
записи регенерирующую временную кодировку (см. совет 4). Вы можете испра&
вить эти неполадки в момент загрузки материала (см. совет 48), однако намного
проще это сделать до начала редактирования.

Загрузка материала занимает много времени, но результат этого стоит. В про&
цессе вы сможете ознакомиться с материалом. Во время редактирования вы обна&
ружите, что где&то видели один кадр, но забыли, на какой кассете он был записан.
В такой ситуации вы сможете найти нужную информацию в журнале загрузки.

Настройка электронной таблицы
Чтобы настроить электронную таблицу, введите названия для следующих столбцов:

• Avid (Название клипа, Кассета, Начало, Конец, Треки);
• Final Cut (Точка, Название клипа, Начало данных, Конец данных, Описа&

ние);
• Premiere (Кассета, Вход, Выход, Название клипа, Примечания, Описание,

Сцена, Снимок).

Чтобы загрузить материал, вам необходимо ввести точку входа, описание,
а также точку выхода для материала в строке таблицы. Вы должны ввести уни&
кальное название клипа для любой записи в журнале загрузки материала. Кроме
того, вам нужно ввести дополнительные сведения в соответствии с требованиями,
которые предъявляет ваша система редактирования.

Настройка просмотра вашего материала
Как именно вы хотите просматривать материал при загрузке, полностью зависит
от вас. Некоторые пользователи предпочитают отправлять данные на VHS&кассе&
ты и записывать временную кодировку поверх изображения. Этот процесс под&
робно описан в совете 75. Другие пользователи выполняют оцифровку материала
и просматривают его на компьютере.

Я очень советую вам не использовать кассеты&мастер. Простая механическая
поломка устройства может уничтожить ваш исходный материал, который вы не
сможете восстановить. Вы должны бережно обращаться с исходными данными,
потому что они уникальны (конечно, вы можете переснять материал; но что де&
лать, если вы снимали свадьбу?).

Загрузка кассета из электронной таблицы
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Загрузка материала
Загрузка материала требует много времени, однако результат оправдывает ожи&
дания. Вы должны проверять три основных параметра: номер кассеты, временную
кодировку точки входа и описание содержимого. Кроме того, точка выхода позво&
ляет определить продолжительность записи в журнале, а ее наличие является
обязательным требованием для многих (если не для всех) систем редактиро&
вания.

Если вы правильно настроили электронную таблицу загрузки, вы можете ис&
пользовать ее для создания списка оцифровки, который упрощает процесс обра&
ботки данных в вашей системе редактирования. Благодаря списку оцифровки вы
сможете получить разбивку материала, которая полностью соответствует журна&
лам загрузки. Следовательно, данные в электронной таблице и системе редакти&
рования будут совпадать.

Вводите один журнал загрузки в строке
Создавайте новую строку для каждой записи в журнале. Выполняйте эти дей&
ствия до тех пор, пока содержимое кассеты не будет полностью зафиксировано
в таблице. Продолжительность одной записи в журнале составляет от 1 до 60 мин
и зависит от вашего внимания к деталям.

Большинство пользователей, с которыми мне приходилось работать,
предпочитают использовать записи продолжительностью
от 5 до 10 мин. Если ваш материал содержит интервью, вы должны
записать диалог, а не события, которые происходят на экране.

Проверьте формат временной кодировки
При загрузке вы должны убедиться в том, что вы вводите временную кодировку
в нужном формате. Если вы работаете в формате PAL, вы можете пропустить этот
абзац. Для формата NTSC необходимо выбрать формат часы:минуты:секунды;
кадры (HH:MM:SS;FF). Чаще всего вам придется работать с пропущенным кад&
ром, поэтому перед номером кадра следует ввести точку с запятой (;FF). Если вы
работаете в режиме без пропущенного кадра, введите двоеточие (:FF). Если вы не
знаете, в каком режиме работаете, по умолчанию следует предположить, что это
режим пропущенного кадра.

Разделитель в видео двоеточия/точки с запятой очень важен, потому
что он указывает на тип временной кодировки, которая использова&
лась при записи видео. Неправильный выбор индикатора может
привести к затруднениям, особенно если вы собираетесь оцифровать
материал.

Если вы точно не уверены в том, в каком режиме была записана ваша кассета, то
можете определить это по временной кодировке. Если перед индикатором кадра

присутствует символ в виде точки с запятой или точки, значит, временная коди&
ровка содержит пропущенный кадр. Вы можете воспринимать это следующим
образом: при использовании пропущенного кадра одна из точек в символе про&
пускается.

Создавайте новый файл для каждой кассеты
Вы должны создавать новую таблицу для каждой кассеты, которую вы загружае&
те, а также сохранять ее под названием кассеты. Например, если вы загружаете
кассету P001A, сохраните таблицу как P001A. В результате вы значительно упро&
стите свою дальнейшую работу.

Экспорт списка оцифровки
После завершения загрузки материала вы можете импортировать информацию из
электронной таблицы в вашу систему редактирования. Так как каждая система
имеет свои особенности, вы должны следовать определенным правилам. Для на&
чала вам необходимо сохранить таблицу как файл с табуляцией в формате Avid
или Final Cut, либо в формате Premiere. После добавления записей журнала заг&
рузки в файл вам придется отредактировать его в текстовом редакторе.

П. В следующем листинге мы будем использовать клавиши Tab и
Return. Так как на печати воспроизвести их достаточно трудно,
я буду отображать эти команды полужирным шрифтом, прописными
буквами и в квадратных скобках.

• Avid. Удалите верхнюю строку заголовков, а затем введите в ней следующий
текст:
Heading

FIELD_DELIM[TAB]TABS
VIDEO_FORMAT[TAB]NTSC
AUDIO_FORMAT[TAB]44kHz
TAPE[TAB]TapeNumber
FPS[TAB]29.97
Column

Name[TAB]Tracks[TAB]End[TAB]Tape[TAB]Descript[TAB]DateShot
[TAB]Barcode
[RETURN]
Data;

• Final Cut. Измените название клипа на название;
• Premiere. Удалите верхнюю строку заголовков.

Импорт списка оцифровки
После внесения всех изменений сохраните файл. Затем вам понадобится импор&
тировать список оцифровки в вашу систему редактирования:

Загрузка кассета из электронной таблицы
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• Avid. File ⇒ Import;
• Final Cut. File ⇒ Import ⇒ Batch List при частоте смены кадров 29,97 кадра/с;
• Premiere. Project ⇒ Import Batch List (Импортировать список).

Вы должны выполнить эти действия для каждой кассеты, которую собираетесь
включить в свой проект. Впрочем, результат стоит затраченных сил. После им&
порта списка оцифровки вы сможете находить нужные снимки по ссылке в табли&
це или с помощью функции поиска по проекту.

Поиск по проекту
Если вы нашли снимок в таблице и хотите просмотреть соответствующий матери&
ал в вашей системе редактирования, вы можете без труда его найти (см. совет 2),
потому что таблица автоматически выполняет совмещение данных. Если у вас нет
доступа к таблице, вы можете выполнить поиск в проекте и получить аналогич&
ный результат. На рис. 1.5 показано диалоговое окно Find (Найти) для приложе&
ния Final Cut Pro, а на рис. 1.6 – результат.

Чтобы найти материал, вы должны убедиться в том, что поиск производится из
проекта, а не со шкалы времени. Это связано с тем, что большинство систем редак&
тирования воспринимают контекст. Следовательно, если вы работаете на шкале
времени и выполняете поиск, в нем будут задействованы только те объекты, кото&
рые находятся на шкале времени.

Выполните следующие действия, чтобы активировать функцию поиска:

• Avid. Fast Menu ⇒ Custom Shift (Быстрое меню ⇒ Переключение);
• Final Cut. Edit ⇒ Find (Правка ⇒ Найти);
• Premiere. Edit ⇒ Find.

После того как вы найдете материал, откройте его в исходном режиме просмотра
приложения или просто поместите на шкалу времени. Если вы сохраните простую
ссылку на материал в таблице и системе редактирования, это сэкономит много вре&
мени, которое вам пришлось бы потратить на поиск нужной информации.

Совет 6 Создание цифровой раскадровки

Используя бесплатное программное обеспечение, цифровую камеру, лист бумаги
и карандаш, вы можете создать цифровую раскадровку.

Раскадровка имеет большое значение для процесса создания фильма. Во время
работы над раскадровкой вы определяете, какие изображения будут включены
в ваш проект, и записываете их последовательность на бумаге. Несмотря на оче&
видные сложности, данный процесс имеет и существенные преимущества: он по&
зволяет вам поделиться своими соображениями со своими коллегами, а также с
самим собой.

Рисуем раскадровку
Вы можете создать раскадровку даже в том случае, если не умеете рисовать. Для
начала вам понадобятся карандаш и бумага. Если у вас есть соответствующий сце&
нарий, забудьте о нем: скорее всего, вы не будете его использовать.

Для создания изображений вы можете применять графический редак&
тор или даже профессиональную программу для рисования раскадров&
ки. Приложение StoryBoard Quick! (http://www.storyboardartist.com)
стоимостью 279,99 долл. США предлагает для раскадровки библиоте&
ку, которая содержит свыше 300 персонажей и объектов.

Решаем, что именно мы будем рисовать
В процессе создания раскадровки вам необходимо нарисовать каждую сцену ком&
позиции. Например, если вы используете сцену, в которой два человека разгова&
ривают в автомобиле, вероятнее всего, вы начнете композицию с изображения ав&

Рис. 1.5. Поиск данных в программе Final Cut Pro

Рис. 1.6. Результаты поиска в программе Final Cut Pro

Создание цифровой раскадровки
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томобиля, движущегося по дороге. Этот снимок станет установочным. Затем вы
нарисуете изображение двух разговаривающих людей (снимок будет сформиро&
ван таким образом, как если бы смотрели на людей из&за плеча). Затем вы дадите
снимок одного персонажа крупным планом (будет видно только его лицо).
На рис. 1.7 показан пример простой раскадровки, которая была нарисована
вручную.

После оцифровки изображений вам необходимо импортировать их в вашу фо&
токоллекцию. Скорее всего, пользователи Macintosh будут работать с приложени&
ем iPhoto, пользователи Windows – с приложением Photo Story, а пользователи
Unix – с gPhoto. Впрочем, выбор очень велик. Важно помнить о том, что вы може&
те импортировать свои рисунки и упорядочивать их.

Организация изображений
После импорта изображений вам понадобится их организовать. Некоторые про&
граммы позволяют вам добавлять аннотации к рисункам, следовательно, вы мо&
жете сохранять любые сделанные вами ранее примечания. Внимательно просмот&
рите раскадровку и подумайте, не пропустили ли вы чего&нибудь. Также вы може&
те попробовать поменять сцены местами и изучить результат.

К этому моменту у вас уже должно сложиться определенное представление
о том, как именно будет выглядеть ваш фильм. Учтите, что вы еще не сняли ни
одного кадра!

Добавление авторской речи
После создания раскадровки вы можете воспроизвести ее как слайд&шоу. При
просмотре слайд&шоу попробуйте проследить за сюжетом вашего фильма. Пока
время критики ваших художественных способностей еще не пришло.

Рис. 1.7. Рисуем раскадровку вручную

В зависимости от ваших предпочтений вы можете использовать для каждого
изображения отдельный лист бумаги, разделить его на две или четыре части либо
применить карточки. Лично я предпочитаю работать с карточками и карандашом.
Кроме того, мне кажется очень удобным то, что на оборотной стороне карточки
я могу писать примечания.

Как обозначить движение камеры
Совершенно очевидно, что рисунки не перемещаются. Если вы хотите продемон&
стрировать движение камеры, вы должны нарисовать стрелки, которые показыва&
ют анимацию, вращение или масштабирование камеры. Если вы желаете пока&
зать, что камера масштабируется, вы также можете нарисовать область масштаби&
рования квадратной формы (см. рис. 1.8).

Так как раскадровка в первую очередь предназначена для передачи информа&
ции другим пользователям, не стесняйтесь и добавляйте примечания к вашим ри&
сункам. Это позволит вам избежать проблем с непониманием между коллегами,
которые могут возникнуть во время редактирования сцены.

Импорт рисунков
Если вы нарисовали раскадровку, это значит, что половина вашей работы уже за&
вершена. Ваша раскадровка полностью функциональна; однако оцифровка ин&
формации может предоставить вам определенные преимущества.

Конвертирование из аналогового в видеоформат
Ваши изображения существуют в физическом, но не в цифровом мире. Для оциф&
ровки кадров вы можете воспользоваться сканером или цифровой камерой. Док&
тор Майкл Джонсон из компании Pixar Animation Studios утверждает, что в его
компании используется вторая методика.

Рис. 1.8. Мы используем области квадратной формы,
чтобы показать масштабирование камеры

Создание цифровой раскадровки
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Если ваше программное обеспечение поддерживает соответствующие
функции, вам следует добавить в проект авторскую речь с применени&
ем сценария.

Если вы работаете в одной команде с другими пользователями, попробуйте
прочитать сценарий одновременно с просмотром слайд&шоу. В результате у вас
должно появиться впечатление о том, в чем именно заключаются слабые места
вашего проекта. При необходимости перепишите сценарий и измените раскад&
ровку.

Вам может показаться, что я заставляю вас выполнять ненужную работу. Одна&
ко стоит задуматься о том, что подготовка позволяет вам избежать многих про&
блем, которые часто возникают в процессе съемки или (что намного хуже) редак&
тирования.

Совет 7 Создание сценария из двух столбцов

Сценарии из двух столбцов четко разделяют звук и видео в сцене. Использование
такого сценария дает вам дополнительные возможности при подготовке и редак&
тировании.

Большинству людей приходилось когда&либо видеть сценарии (пьесы, телеви&
зионного шоу или фильма). Это традиционные сценарии, основу которых со&
ставляют диалоги. Они содержат очень мало описаний действий, которые долж&
ны выполнять актеры.

Сценарий из двух столбцов описывает как диалоги в сцене, так и отдельные
снимки. Табличный формат включает инструкции, благодаря которым всем чле&
ны команды точно знают, что именно должно появиться на экране. Вы можете
создавать такие сценарии до съемки или после нее. Они особенно эффективны
при работе над документальным фильмом или реалити&шоу.

Концепция сценария из двух столбцов
В обычном сценарии диалог выглядит примерно так:

Лафу (Lafeu). «Ему нечего больше желать. Они позаботятся о его любимой».
Графиня. «Да благословит его Бог! Прощай, Бертрам (Bertram)».
(Графиня уходит).

Теоретически вы можете представить себе данную сцену, однако мы не можем
быть уверены в том, что разные люди будут представлять себе одно и то же. Один
из способов представления визуальной информации – это раскадровка (см. со&
вет 6). Другой способ связан с использованием сценария из двух столбцов. В та&
ком сценарии диалог из предыдущего примера будет выглядеть так, как показано
в табл. 1.1.

Таблица 1.1. Диалог в сценарии из двух столбцов

Видео Аудио

Два снимка. Лафо (Lafeu) сидит Лафо: «Ему нечего более и желать.
на синем диване, а графиня стоит Его чувство будет удовлетворено»
слева от него
Отслеживающий снимок. Графиня Графиня: «Да благословит его Бог! Прощай,
идет к двери и выходит Бертрам (Bertram)»

Как видите, данный пример содержит больше информации о сцене. Впрочем,
здесь использование сценария из двух столбцов не дает вам особых преиму&
ществ.

Так когда же необходимо применять данный тип сценария? Единого и обяза&
тельного правила не существует; если у вас нет сценария, но есть записанный
материал, то, как правило, сценарий из двух столбцов может избавить вас от
трудностей.

Настройка сценария из двух столбцов
Если у вас в системе установлена программа Microsoft Word, настроить сценарий
из двух столбцов вам будет нетрудно.

1. Создайте новый документ.
2. Выполните команду Table ⇒ Insert ⇒ Table (Таблица ⇒ Вставка ⇒ Таб


лица).
3. Выберите 2 столбца.
4. Выберите 10 строк.
5. Нажмите кнопку OK.

После вставки таблицы в документ введите в заголовке первого столбца слово
Video, а в заголовке второго – слово Audio.

Запись в сценарии с двумя столбцами
Если вы записываете сценарий до съемок сцены, вам понадобится добавить в него
описание всех действий. Кроме этого, вам будет необходимо включить данные по
перемещению камеры. Запись такого сценария может потребовать много време&
ни, но благодаря его наличию любой пользователь сможет получить полную ин&
формацию о проекте.

Если вы работаете с документальным фильмом или с другим проектом, в кото&
ром сценарий следует записать после создания материала, сценарий с двумя столб&
цами может стать единственным решением всех проблем. В таком проекте вы дол&
жны записывать как номер кассеты (см. совет 3), так и временную кодировку (см.
совет 48) выбранного материала. Данные из журнала загрузки кассеты (см. со&
вет 5) могут оказать неоценимую помощь в процессе. В табл. 1.2 показан пример
сценария с двумя столбцами (включает сведения о номере кассеты и временной
кодировке).

Создание сценария из двух столбцов
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Таблица 1.2. Пример сценария с двумя столбцами

Видео Аудио

DVH001 – 02:04:14 (наложение голоса – должно быть записано)
Дэвид (David) сидит перед компью/ «Для того чтобы стать спасателем, требуют/
тером и играет в солитер ся годы тренировок…
DVH032 – 00:25:15 DVH011 – 01:13:50
Зуммер на переговорном устройстве «Эр Файв, это Альфа/920. Прием».
DVH032 – 00:49:29 «10/4. Прием»
Дэвид бежит к своему вертолету,
разговаривая через переговорное
устройство
(нет) (наложение голоса – должно быть записано)

…и способность работать под давлением»

При составлении сценария с двумя столбцами не стоит стараться
соблюдать точность до кадра. Такая точность важна только во время
редактирования. Предыдущий сценарий использует формат временной
кодировки HH:MM:SS.

Данный сценарий имеет ряд интересных особенностей. В первой строке содер&
жится видео из отснятого материала, а также звук, который еще предстоит запи&
сать. Мы знаем, что наложение голоса еще не было записано, так как таблица не
включает номера кассеты и временной кодировки.

Во второй строке видео представляет собой снимок крупным планом, а звук –
это материал, импортированный с другой кассеты. Так как не существует изобра&
жения, которое можно ассоциировать со звуком в данной сцене, я выбрал для ком&
позиции подходящий звук. Звуковой трек с кассеты DVH011 – это посторонний
фон, который был записан совершенно случайно.

В строках четыре и пять содержится изображение человека, Дэвида (David), ко&
торый бежит к вертолету и одновременно говорит. Звук (голос) еще не был записан.

Редактирование в сценарии с двумя столбцами
Если вы редактируете проект, содержащий сценарий с двумя столбцами, ваша за&
дача будет довольно несложной. У вас есть номер кассеты и временная кодировка
как для видео, так и для звука, следовательно, часть вашей работы уже выполнена.
Большую часть времени вы будете выбирать нужную точку для редактирования и
вносить изменения (см. совет 46). Как правило, это позволит вам сконцентриро&
вать внимание на раскадровке проекта.

После оцифровки материала вам понадобится найти звук или видео и добавить
его на шкалу времени. При перемещении по сценарию вы будете смещаться впра&
во по шкале времени и совмещать видео и звук. Если у вас уже есть опыт работы
с материалом, который не содержит сценария, вы оцените преимущества, связан&
ные с использованием двух столбцов… не говоря уже о том, сколько времени вы
при этом сэкономите.

Совет 8 Сделайте свой ящик Apple

Ящики Apple (обычные деревянные ящики, которые очень часто применяются на
телевидении или в кино) могут использоваться практически в любом снимке.
Сделать такой ящик очень легко.

Некоторые предметы, которые просто лежат у вас дома, могут оказаться неза&
менимыми во время съемок видео. Например, прищепки для белья (см. совет 25)
не только дешевы, но и очень удобны. То же самое можно сказать и о деревянных
ящиках.

Ящики Apple (Apple boxes) – это деревянные ящики, которые могут использо&
ваться, к примеру, для маскировки камер или в качестве подставки. Вы можете сами
сделать такой ящик из фанеры либо купить его у компании FilmTools (http://
www.filmtools.com; по цене 31 долл. США) или B&H (http://www.bhphotovideo.com;
по цене 34,95 долл. США).

Найдите компоненты
Для изготовления ящика вам понадобится совсем немного компонентов. Если
у вас есть листы фанеры, вы можете их использовать. Также вы можете купить
фанеру в любом хозяйственном магазине. Цена различается в зависимости от
типа фанеры. Для сборки ящика вы должны купить шесть листов фанеры следую&
щего размера:

• 1/2” × 7” × 11” (2 шт.);
• 1/2” × 7” × 20” (2 шт.);
• 1/2” × 12” × 20” (2 шт.).

В результате ящик будет иметь размеры: 8 дюймов в высоту, 12 в ширину и 20 –
в длину. Также вы можете использовать ящики меньшего размера: 4, 2 или 1 дюй&
ма в высоту. На рис. 1.9 показаны листы фанеры, которые были вырезаны и совме&
щены в форме будущего ящика (для проверки размеров).

Помимо фанеры, вам понадобится купить гвозди (шурупы), а также молоток
или отвертку. При желании вы можете воспользоваться и другими инструмен&
тами.

Дрель поможет вам высверлить отверстия для ручки в ящике. Для этого про&
сверлите два отверстия в центре листов фанеры (7 на 11 дюймов); расстояние
между отверстиями должно составлять 3 дюйма. Затем пропилите фанеру между
отверстиями и извлеките ручку. На рис. 1.10 показано отверстие для ручки.

Если вы собираетесь часто работать с ящиком, я советую вам купить фанеру
высокого качества.

Собираем ящик
После покупки всех компонентов вам необходимо собрать ящик. При желании вы
можете воспользоваться клеем для дерева. Клей поможет скрепить листы фанеры
между собой до того, как вы соедините их гвоздями или шурупами.

Сделайте свой ящик Apple
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Чтобы собрать ящик, поместите на стол лист фанеры (12 на 20 дюймов). Затем
установите стенки (листы 7 на 20 дюймов), выровняйте их и установите листы
(7 на 11 дюймов). Наконец, поместите сверху второй лист фанеры (12 на 20 дюймов)
и скрепите листы гвоздями или шурупами. Собранный ящик показан на рис. 1.11.

После этого выровняйте грани ящика с помощью наждачной бумаги и удалите
остатки клея.

Используем ящик Apple
Вы можете использовать ящик так, как сочтете нужным. Вы можете применять
ящики в качестве подставки, прятать в них камеры, использовать их как столы и
даже крепить к ним другие предметы. Мне приходилось видеть, как некоторые
пользователи пропускали сквозь ящики кабели и даже закрывали их зеленой ма&
терией, чтобы создать эффект зеленого фона (см. совет 22).

В целом ящик является многофункциональным устройством.

Рис. 1.9. Совмещаем листы фанеры,
чтобы проверить их размеры

Рис. 1.10. Сверлим отверстия

Рис. 1.11. Так выглядит ящик после завершения сборки

Совет 9 Сделайте свою информационную доску

Используя небольшую информационную доску, вы сможете упростить процесс
отслеживания материала.

Информационная доска (slate) содержит данные, которые будут записаны в ви&
део. Обычно она представляет собой небольшой лист из пластика или дерева
с выделенной областью для записей. При съемках фильма, как правило, использу&
ется доска с выдвижной планкой, которой ассистент оператора щелкает в начале
дубля.

Причина, по которой во время съемок следует использовать информационную
доску, проста. При просмотре видео вы будете точно знать, что именно вы смотрите.

Сделайте свою информационную доску
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Например, если вы берете кассету, вставляете ее в магнитофон и нажимаете кнопку
Play, вам очень поможет, если на экране появится информационная запись. Поэто&
му в фильмах и телевизионных шоу имеются отдельные кадры с заголовками,
а в вашем материале вам необходимо использовать информационную доску.

Собираем материалы
Вы можете сделать информационную доску несколькими способами.

Из домашнего материала
Если вы хотите сэкономить свои деньги (и выплатить зарплату членам своей ко&
манды), вы можете использовать следующие материалы:

• небольшой лист фанеры (8 на 11 дюймов);
• черный маркер;
• рулон вощеной бумаги;
• рулон пленки.

С помощью маркера разметьте лист фанеры в виде сетки. Разделы нужно будет
промаркировать (об этом мы поговорим позднее). После этого наложите на фане&
ру вощеную бумагу и прикрепите ее пленкой. Бумага должна быть закреплена на
фанере таким образом, чтобы вы могли видеть сквозь нее разметку.

При работе с вощеной бумагой вы можете использовать (и стирать) надписи,
сделанные как обычным, так и постоянным маркером. Чем дольше находится над&
пись на бумаге, тем труднее ее удалить.

Из покупного материала
Если вы хотите потратить немного денег на покупку компонентов, вам понадо&
бится приобрести:

• небольшую белую доску (продается в любом магазине канцпринадлежностей
и стоит примерно 5–10 долл. США);

• один рулон черной изоляционной ленты (продается в хозяйственном магази&
не и стоит 1–3 долл. США);

• ножницы.

Вам нужно разрезать изоляционную ленту на несколько полос, длина и ширина
которых соответствуют длине и ширине доски. Например, если вы купили доску

размером 8 на 11 дюймов, вам нужно вырезать полосы такого же размера. С помо&
щью полос вы разделите поверхность доски на части. На рис. 1.12 показаны ком&
поненты, которые понадобятся вам для изготовления информационной доски.

Вы можете синхронизировать применение информационных досок
для звука и изображения. Пленка записывает только видео, значит,
звук сохраняется отдельно. При просмотре изображения вы видите
момент щелчка планки. Следовательно, в эту секунду вы должны
слышать звук щелчка. Путем совмещения звука и изображения щелчка
вы выполняете синхронизацию видео.

Рис. 1.12. Так выглядит небольшая панель,
которую мы переделаем в информационную доску

Использование информационной доски
Количество разделов на доске определяется тем, какую информацию вы собирае&
тесь на нее нанести. Как минимум, вы понадобится указать заголовок проекта,
дату и номер сцены. Вы можете добавить номер камеры (если их несколько), имя
режиссера, а также сведения о конфигурации звука (например, микрофон Боба
для канала 1, а микрофон Салли – для канала 2). На рис. 1.13 показано, как выгля&
дит заполненная информационная доска для снимка.

Чтобы воспользоваться доской, запишите на ней нужную информацию и задержи&
те ее перед камерой до начала съемки. Это необходимо делать для каждого дубля.
Одно из преимуществ информационной доски состоит в том, что при желании вы
можете стереть с нее записи. Если вы работаете с большим количеством сцен, то мо&
жете без труда удалять ненужные данные и записывать новую информацию. Поэтому
у вас не должно возникнуть проблем с постоянным обновлением данных на доске,
что, в свою очередь, упростит вашу задачу при загрузке материала (см. совет 5).

Если вам очень нужна информационная доска, но у вас ее нет (допус&
тим, вы ее забыли или потеряли), возьмите ручку и листок бумаги.
Лучше иметь хоть какую&то информацию, чем вообще ничего.

Сделайте свою информационную доску
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Если вы забыли воспользоваться доской до съемки, то можете сделать это по&
том. Задержите доску перед камерой после съемки, и нужная информация будет
зафиксирована. Даже тот факт, что данные появляются поздно, не делает их менее
ценными. Если вы хотите определить, что доска относится к предыдущему дублю,
вы можете держать ее вверх ногами.

Совет 10 Удаленное управление камерой

Очень просто управлять камерой удаленно. Вы можете снять видео, даже не при&
трагиваясь к камере.

Время от времени вам понадобится размещать камеру в каком&либо месте. На&
пример, вы можете снимать животное, которое не терпит присутствия людей,
либо вы хотите снять участников вечеринки и остаться при этом в кадре. В любом
случае удаленное управление камерой предоставляет вам новые возможности.

Замена устройства дистанционного управления
Многие камеры поставляются в комплекте с устройствами дистанционного
управления. Однако эти устройства не слишком эффективны; мне приходилось
с ними работать, и я знаю, что они действуют лишь на расстоянии в несколько
метров. К счастью, вы можете обойти это ограничение с помощью программируе&
мого устройства удаленного управления или инфракрасного порта (IR).

Программируемое устройство удаленного управления
Как ясно из названия, это устройство обладает более мощными функциями по
сравнению с обычным пультом дистанционного управления. Они могут сохра&
нять коды, которые воспринимаются камерой, что дает вам возможность управ&
лять ею без пульта дистанционного управления. Сложные модели, например

Philips Pronto (http://www.pronto.philips.com/), могут быть запрограммированы
на компьютере и настроены на управление несколькими устройствами. Кроме
того, они поддерживают макросы, что позволяет вам, к примеру, одним нажатием
клавиши переключить камеру в режим слабого освещения и начать запись.

Программируемые устройства удаленного управления – это решение всех про&
блем в случае потери стандартного устройства, так как на многих Web&сайтах вы
сможете найти конфигурационные файлы для различных устройств. Зайдите на
сайт Remote Central (http://www.remotecentral.com). Инфракрасные порты в та&
ких устройствах намного мощнее, чем в стандартных пультах дистанционного
управления, поэтому вы сможете управлять камерой с большего расстояния.

Инфракрасные пульты управления
Инфракрасные пульты управления работают только в зоне прямой видимости;
они не помогут вам в случае, если вы находитесь в одной комнате, а камера –
в другой. К счастью, существует простое решение: купите инфракрасный удлини&
тель, такой как SmartHome 8220A (http://www.smarthome.com/8220A.html; стоит
50 долл. США).

Такой удлинитель имеет две части: трансмиттер, который получает сигнал от
пульта управления и конвертирует его в радиосигнал, а также ресивер, который
конвертирует радиосигнал в инфракрасный сигнал и направляет его на камеру.
Благодаря использованию радиосигналов, подобное устройство может работать
через стены и другие препятствия.

Если вы умеете работать с паяльником, то можете собрать удлинитель самосто&
ятельно. Схемы нескольких инфракрасных удлинителей можно найти в сети Ин&
тернет по адресу: http://www.mitedu.freeserve.co.uk/Circuits/Interface/candi.htm.

Комбинируем обе методики
Если вы скомбинируете использование программируемого устройства и инфра&
красного удлинителя, то сможете поместить полученный блок в любое место и
управлять видеокамерой. Кроме того, вы сможете изменять масштабирование ка&
меры, а также останавливать и возобновлять запись.

Удаленное панорамирование на камере
Если вы можете настроить удаленное управление камерой, почему бы не сконфи&
гурировать панорамирование? Для этого вы можете воспользоваться головкой па&
норамирования: устройством, которое крепится на камере и позволяет вам накло&
нять ее влево или вправо.

Лично я применяю устройство Memorex Pan&O&Matic от сайта eBay. Эта голов&
ка может панорамироваться на 120° влево или вправо и на 20° вверх и вниз; кроме
того, она поддерживает удаленное управление. Скомбинировав ее с программи&
руемым устройством удаленного управления и инфракрасным удлинителем,
я получаю камеру, которая может свободно панорамироваться и наклоняться.
Кроме того, я смогу установить свою камеру на штативе, как показано на рис. 1.14.

Несмотря на то что данная модель камеры больше не производится, на рынке
существуют и другие головки панорамирования, например X10 Ninja Pan Tilt

Рис. 1.13. Информационная доска используется для передачи сведений

Удаленное управление камерой
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(http://www.x10.com/products/x10_vk74a.htm;
по цене 99 долл. США). Это устройство использу&
ет удаленное управление радиосигналом, поэтому
вам не понадобится устанавливать инфракрасный
удлинитель.

Головки панорамирования не обладают
достаточной мощностью, чтобы
переместить крупную камеру (напри&
мер, Canon XL1). Вы должны использо&
вать их только с небольшими камерами.
Если вы работаете с более крупной
камерой, вам придется купить профес&
сиональную головку панорамирования.

На сайте eBay вам также доступны б/у головки панорамирования. Вы можете
купить такое устройство всего за 40 долл. США. Впрочем, обратите внимание на
то, что многие устаревшие головки панорамирования используют проводку, а это
значит, что вам придется провести кабель между головкой и контроллером. Если
вы собрались покупать такую головку, убедитесь в том, что она поставляется
в комплекте с камерой, а вы точно знаете, как его подключить.

Совет 11 Следите за тем, какой материал
вы снимаете на камеру

Если вы будете точно знать, что именно вы снимаете на камеру, это позволит вам
сэкономить много времени и денег в процессе редактирования.

Практически каждая видеокамера имеет аудио& и видеовходы, однако боль&
шинство пользователей применяют их исключительно для передачи видеомате&
риала после съемки. С помощью данных портов вы можете определить, что снима&
ете на камеру. Это позволит вам не только устранять проблемы в режиме реально&
го времени (например, неправильное подключение звукового порта), но и делать
записи, которые понадобятся вам при редактировании.

Определите, какие кабели вам нужны
Существует большое количество разъемов для аудио& и (или) видео сигналов.
Если вы собираетесь следить за материалом во время записи, вам необходимо
приобрести в магазине соответствующие кабели и переходники. Не забудьте ку&

пить запасные кабели, потому что есть вероятность их выхода из строя в самый
неподходящий момент.

Видео
Для отслеживания материала вы должны отправить сигнал с камеры на монитор.
Некоторые камеры имеют разъемы RCA для аудио и видео, а другие оснащены
разъемом A/V/Phones или его аналогом. В любом случае вам понадобится под&
ключить камеру к монитору.

Изображение материала очень важно;
кроме того, вам придется включить экран ка&
меры, чтобы текущая временная кодировка
появилась в кадре. Это позволит вам зафик&
сировать временную кодировку в ваших за&
писях. Если у вас нет временной кодировки,
информация не будет такой полезной. На
рис. 1.15 показаны камера Canon XL&1 и под&
ключенный к ней LCD&монитор JVC 3 дюй&
ма. Эти устройства были соединены с помо&
щью кабеля RCA.

Если только вы не собираетесь вести долго&
срочную съемку из одного положения, мобильность является ключевым требовани&
ем. Небольшой монитор (13–15 дюймов) – это практически универсальное решение.
Но если вы планируете перемещать камеру (например, при съемках документального
фильма), вы должны установить небольшой LCD&монитор (3–7 дюймов).

Звук
Для работы со звуком вам понадобится использовать наушники. Это связано
с тем, что микрофон записывает не только то, что вам необходимо, но также эхо и
посторонние шумы.

Кроме того, наушники позволяют вам слышать то, что записывается, а не то,
что слышится. Это далеко не одно и то же; ваш микрофон может записать те зву&
ки, которые вы не слышите.

С большой вероятностью ваша камера оснащена
разъемом для подключения наушников. Чаще всего ис&
пользуются разъемы 1/4 дюйма и 3,5 мм; вы можете
купить переходник для переключения между ними.
Следовательно, вы никак не ограничены в выборе типа
разъема. На рис. 1.16 показан разъем «папа» переход&
ника микрофона 1/4 дюйма, а также мини&переходник
3,5 мм соответственно.

Если вы не работаете с камерой самостоятельно (на&
пример, вы наняли оператора), вам необходимо под&

Рис. 1.14. Камера Sony Camcorder
на штативе Memorex Pan�O�Matic

Рис. 1.15. Подключаем камеру
к переносному монитору

Рис. 1.16. Адаптеры микрофона
(1/4 дюйма и 3,5 мм)

Следите за тем, какой материал вы снимаете на камеру
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ключать звук в точке, где вы находитесь. Если вы используете несколько камер, то
должны следить за камерой, к которой подключено устройство записи звука (ос&
новной микрофон).

Настройка
Найти оборудование – это только часть задачи. Вы должны его настроить. Для
этого вам нужно точно знать, где вы будете вести съемку. Это позволит вам опре&
делиться с питанием для камер, настроить сигнал, идущий от камер, а также вы&
полнить другие действия.

Я советую вам подготовить тележку и поместить на нее свое оборудование.
Если тележка имеет три полки, вы сможете установить монитор на верхнюю пол&
ку, чашку кофе и другие аксессуары – на вторую полку, а кабели и разрядники
напряжения – на третью полку. Наличие такой тележки позволит вам быстро пе&
ремещаться от одного места съемки к другому. Также вы можете добавить видео&
магнитофон, чтобы микшировать и записывать материал во время работы.

Проводка
Проще всего подавать питание и аудио/видеосигналы посредством кабелей. Если
рядом есть розетка, вы можете просто подключиться к ней. Возможно, вам пона&
добится использовать дополнительный кабель или удлинитель (если розетка рас&
положена далеко).

Беспроводное соединение
Если вы не можете подключить камеру к монитору с помощью кабеля, то можете
применить для отправки сигнала беспроводной трансмиттер, а для отображения
материала – телевизор или видеоресивер. На рынке имеется большое количество
беспроводных трансмиттеров. Приведу ряд рекомендаций:

• X10. Пакет VideoSENDER (http://www.x10.com; стоит 79,99 долл. США);
• Studio 1 Productions. Видео трансмиттер ShotWatcher (http://www.studio1

productions.com/shotwatcher.htm; стоит 495 долл. США);
• The Spy Store. Различные видеотрансмиттеры доступны по адресу: http://

www.thespystore.com/videotransmitter.com.

Компания NuTex Communications предлагает простое и удобное
беспроводное решение. Эта компания находится на Тайване; если вы
решите купить ее продукцию, вам придется найти локального дилера.
За дополнительной информацией обратитесь по адресу:
http://www.nutex.com.tw/mini.htm.

Беспроводные системы имеют как свои преимущества, так и свои недостатки.
Самый очевидный недостаток связан с тем, что некоторые беспроводные частоты
конфликтуют с аудио/видеосигналом. Мне приходилось видеть, как некоторые
мобильные телефоны (в частности, Nextel) нарушают видеосигнал. Компания

Studio 1 Productions сообщает о том, что использование устройства Shot&Watcher
с камерой Canon XL&1 может сопровождаться проблемами. В любом случае я со&
ветую вам провести тесты, перед тем как приступить к работе.

Записи
Если вы сможете видеть и слышать то, что записывается на пленку, это позволит
вам устранить многие проблемы до начала редактирования. Кроме того, вы смо&
жете делать записи, которые помогут вам освежить память, а также предоставить
необходимую информацию редактору.

Кроме текущей временной кодировки, вам нужно знать, какая именно кассета
установлена в камере. Если вы нанесли на кассеты маркировку (см. совет 3), то
должны увидеть номера кассеты вместе с временной кодировкой на экране мо&
нитора. Если вы этого не сделали, вы должны как можно скорее указать на кас&
сете хотя бы дату съемки (например, в момент, когда вы извлекаете кассету из
камеры).

Вы можете делать записи в любое удобное время. Но при наличии сценария вы
можете использовать методику, которую применяет любой профессиональный
сценарист: выбрать линейный сценарий. Если вы снимаете документальный
фильм или видеофильм без сценария, то можете записать дату и время события
в отдельном документе. При использовании любой из этих методик у вас будет
возможность зафиксировать любое важное событие в вашем проекте.

Создание линейного сценария
Для создания линейного сценария вам понадобится копия основного сценария
проекта. Кроме того, вам также необходимо использовать карандаш, точилку, за&
жим (для сценария) и линейку.

Во время съемки сцены пометьте временную кодировку над первой строкой
диалога. На протяжении сцены рисуйте линию. Когда сцена закончится, запиши&
те конечную временную кодировку. Также вы можете делать записи на полях или
на оборотной стороне страницы. Это могут быть примечания (например, сколько
воды должно быть налито в стакан) или информация о неожиданных событиях
(к примеру, об импровизационных репликах актеров). На рис. 1.17 показано, как
выглядит линейный сценарий после нескольких снимков.

Продолжайте фиксировать временную кодировку для всех дублей в сценарии.
Если вы решили, что определенный дубль вас устраивает, повторите временную
кодировку (см. рис. 1.17). Это явление известно как повторный дубль (circle take);
как правило, оно является свидетельством предпочтений режиссера. Во время ре&
дактирования проекта вы можете обратиться к линейному сценарию и опреде&
лить, где именно на кассете записаны дубли.

Примечания
Даже если у вас нет сценария, вы можете (и должны) делать записи во время
съемки. Вы не можете запомнить все, что происходит. Особенно важно сохра&
нять записи, если вы ведете съемку на протяжении нескольких дней, недель или
месяцев.

Следите за тем, какой материал вы снимаете на камеру
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Например, вы можете запомнить, что Боб (Bob) и Сара (Sarah) впервые поце&
ловались в 3 ч 15 мин во вторник. Но когда вы начнете редактирование, вам пона&
добится помнить время этого поцелуя наряду с десятками других событий. Чем
чаще вы будете делать записи, тем проще вам будет сконцентрировать внимание
на других особенностях проекта.

Использование записей
Если у вас есть ограничение по времени, возможно, вы не успеете выполнить заг&
рузку материала (см. совет 5). В этом случае ваши записи окажутся бесценными.
Чем больше у вас материала, тем важнее иметь записи.

При использовании линейного сценария вы можете загрузить материал доста&
точно быстро, потому что у вас есть точки входа и выхода для каждого дубля. Бо&
лее того, вы можете указать в журнале, какие дубли были успешными во время
записи. Вы даже можете отредактировать сцену с помощью повторных дублей и
внести в них изменения.

Использовать примечания сложнее, чем линейный сценарий, однако их цен&
ность намного выше. Проекты без сценариев часто содержат больше материала,
чем проекты со сценариями. Некоторые реалити&шоу на телевидении состоят из
тысяч часов. Представьте себе, что вам необходимо найти один кадр в материале
с примечаниями и без них. Какой проект вы выберете? Теперь задумайтесь о
том, что проект содержит десятки тысяч часов, и вы оцените эффективность
примечаний.

Независимо от размеров проекта я рекомендую вам настроить его параметры и
следить за тем, что именно вы записываете.

Совет 12 Защитите камеры, которые находятся
вне помещения

Сделайте корпус, чтобы защитить камеру от непогоды и случайных повреждений.
Несколько лет тому назад мой дом сгорел в то время, пока я был за городом. Как

энтузиаст автоматизации, я воспользовался случаем и перестроил мой дом с ис&
пользованием соответствующего оборудования. Например, я установил камеры
как в доме, так и снаружи. Кроме того, я протянул более двух миль кабелей RG&6
и Category 5 таким образом, чтобы новую камеру можно было установить в любом
приглянувшемся месте.

Сейчас моя система состоит из восьми камер, подключенных к видеоконтрол&
леру, видеомагнитофона с возможностью записи до 960 ч, а также модулятора ви&
део&ТВ для каждой камеры. Благодаря этой системе я могу просматривать изоб&
ражение с видео на любом телевизоре (см. рис. 1.18).

Рис. 1.17. В этом линейном сценарии видно,
что удачный дубль данной сцены был отснят в 01:29:03

Рис. 1.18. Центр управления системой камер

Каждая камера подсоединена ко входу видеоконтроллера, а выходы контрол&
лера подсоединены к модулятору ТВ&канала. Модулятор восстанавливает кар&
тинку с камеры на ТВ&канале, поэтому для просмотра с камеры мне достаточно
включить и отрегулировать телевизор. Модуляторы являются программируемы&
ми: они поддерживают все каналы в диапазоне от 14 до 64, следовательно, их мож&
но использовать для свободных каналов в моей кабельной системе.

Компания ChannelPlus (http://www.channelplus.com) производит различ&
ные ТВ&модуляторы и контроллеры для видеокамер.

Мои камеры не оснащены микрофонами, но провод Category 5, который подсо&
единяется к каждой камере, может при необходимости передавать звук к модуля&

Защитите камеры, которые находятся вне помещения
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тору. Сейчас для питания камер я использую две пары из четырех, которые име&
ются в кабеле Category 5. Запасные части для питания камер находятся в помеще&
нии для технического обслуживания, как говорилось ранее.

Пока что я описал систему стандартного оборудования для видеомониторинга.
Самое сложное в данной системе – это защита для внешних камер. Вместо того что&
бы потратить от 50 до 100 долл. США на покупку защитного экрана для каждой
камеры, я решил изготовить их самостоятельно. Такие экраны обошлись мне всего
в 5 долл. США за штуку, а с поставленной задачей они справляются неплохо.

Для создания экрана вам понадобятся следующие компоненты:

• один фрагмент трубы Schedule 40 PVC, обрезанный в длину на расстояние,
которое на 4 дюйма больше, чем длина камеры с объективом;

• две заглушки для трубы PVC;
• обычное оконное стекло, вырезанное в форме зажима для трубы.

Я использовал трубу диаметром 4 дюйма;
этого должно хватить для любой камеры. Од&
нако я советую вам самостоятельно это прове&
рить (см. рис. 1.19). Вы можете резать трубу
PVC практически любой пилой, однако вам мо&
гут понадобиться два выреза. Будьте осторож&
ны и добейтесь того, чтобы вырезанные края
были ровными. Пилите медленно и следите за
тем, чтобы труба не изогнулась и не треснула.

Измерьте положение установочного отвер&
стия для камеры и просверлите в трубе дополни&
тельное отверстие. В результате после установки

объектив камеры будет располагаться на 1 дюйм внутри трубы. Мы будем использо&
вать отверстие (вместе с крепежным винтом) для установки камеры в трубе.

Просверлите еще одно отверстие, размеры которого чуть больше, чем диаметр
коаксиального кабеля. Это отверстие должно располагаться на расстоянии
1 дюйм от задней части трубы. Сделайте дополнительное отверстие для провода
Category 1, который подает питание на камеру.

Установите камеру в трубе и подсоедините все провода, прежде чем закрыть ее
заглушкой. Для передней заглушки: с помощью кольцевой пилы пропилите в заг&
лушке отверстие диаметром 2 дюйма. Нанесите на заглушку немного уплотняю&
щего состава, поместите внутрь кусок стекла и нажмите на нее. Наличие уплотня&
ющего состава позволит добиться водонепроницаемости. Удалите элементы со&
става, которые попали на стекло.

Дождитесь, пока состав не затвердеет (на это должно уйти около часа). Затем
подключите камеру и настройте ее диафрагму и фокусировку. Небольшой кусок
изоляционной ленты поможет зафиксировать детали камеры. После того как со&
став высохнет, поместите заглушку в трубу. Я советую вам смазать заглушку мас&
лом, чтобы она лучше скользила.

Установите камеру на зажим в форме
буквы L, и ваша работа будет завершена (см.
рис. 1.20).

Совет 13 Научитесь быстро оцифровывать
большой объем материала

Если вам нужно записать 100 ч материала всего за два дня, используйте отдель&
ный компьютер для передачи данных. Это позволит вам сэкономить много вре&
мени.

Несмотря на то что цифровое видео предлагает возможность быстрой передачи
данных с кассеты на диск, не существует системы редактирования, которая под&
держивает соответствующую функцию. Чтобы обойти временное ограничение,
многие пользователи применяют несколько систем редактирования. Проблема
состоит в том, что, если у вас нет диска с общим доступом и необходимого про&
граммного обеспечения, ваш компьютер не «увидит» материал, который был
оцифрован в другой системе. К счастью, вы можете выполнить определенные дей&
ствия и решить эту проблему.

Настройка систем
Для того чтобы воспользоваться советами, приведенными в данном разделе, вы
должны установить несколько компьютеров, а также видеокамер или дек. Поэто&
му вам придется потратить силы и время на их настройку. Вы можете конфигури&
ровать систему двумя различными способами (выбор методики зависит от того,
как вы собираетесь редактировать проект). В любом случае вам нужно обратить
внимание на названия дисков, на которые вы будете выполнять запись оцифро&
ванного материала:

• если вы собираетесь использовать для редактирования внешние жесткие дис&
ки, убедитесь в том, что каждый диск имеет уникальное название. Все эти
диски будут добавлены в систему редактирования, следовательно, их назва&
ния не должны конфликтовать друг с другом;

• если у вас нет внешних жестких дисков (либо вы планируете сохранить весь
материал на одном диске), используйте одинаковые названия для всех дис&
ков. Это позволит вам отправить весь материал на новый диск, в то время как

Рис. 1.19. Труба PVC
нужного размера

Рис. 1.20. Так выглядит защитный корпус
на камере

Научитесь быстро оцифровывать большой объем материала
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система редактирования будет ошибочно «полагать», что данные удаляются
с существующего диска.

Оцифровка материала
В целом время, которое требуется для оцифровки материала, в 1,25–1,5 раза боль&
ше, чем общая продолжительность его воспроизведения. Например, один час ма&
териала оцифровывается 1,5 часа. В это время также включены: загрузка кассеты,
ее перемотка, организация папок, устранение разрывов во временной кодировке
и т. д.

Определяем количество компьютеров, которые требуются для
оцифровки
Если у вас есть 100 часов материала, вы можете предположить, что его оцифровка
займет от 125 до 150 ч. Значит, если на оцифровку у вас выделено два дня време&
ни, вам нужно установить три системы. Формула выглядит так:

3 (компьютера) × 48 (ч) = 144 ч на оцифровку.

Разумеется, для круглосуточной работы вам потребуется пить много кофе или
нанять дополнительного сотрудника.

Определяем требуемое место на жестком диске
Во время оцифровки материала вы должны убедиться в том, что у вас достаточно
свободного места на диске. Если у вас есть 100 ч материала и три компьютера, вам
понадобится не меньше 34 ч для каждой системы. Если учесть тот факт, что один
час цифрового видео занимает примерно 13 Гб, каждый компьютер должен иметь
450 Гб свободного места на диске. Формула выглядит так:

100 (ч) / 3 (компьютера) = 33,33 ч на компьютер.
33,33 (ч) × 13 (Гб) = 433,29 Гб на компьютер.

Подготовьтесь к тому, чтобы установить на компьютере дополнительные жест&
кие диски, или обновите жесткий диск в вашей системе редактирования.

Если у вас недостаточно свободного места, вы можете записать
материал с помощью функции сжатия данных, например OfflineRT
в Final Cut Pro или 10:1 в Avid.

Финальное тестирование
После того как вы сконфигурируете системы и убедитесь в том, что у вас есть сво&
бодное место на диске, выполните финальное тестирование, чтобы проверить,
правильно ли будет осуществлена оцифровка материала. Убедитесь в том, что все
системы имеют идентичные настройки. Например, все компьютеры должны быть
сконфигурированы на оцифровку материала NTSC DV с частотой 29,97 кадра/с и
двумя каналами аудио 48 КГц. Если настройки компьютеров различаются, ваши
данные, скорее всего, будут несовместимы.

После завершения тестирования перейдите к оцифровке.

Консолидация материала
Завершив запись материала, консолидируйте его в системе редактирования. Для
этого потребуется выполнить ряд действий, которые зависят от настройки ваших
дисков. В целом вам необходимо переместить материал из системы оцифровки
в систему редактирования, а также импортировать в проект ссылки на оцифро&
ванный материал.

Перемещаем материал
В зависимости от параметров оцифровки для перемещения материала вам пона&
добится выполнить различные действия. Если вы решили оцифровать материал
на диски с различными названиями, вам нужно отключить эти диски от систем и
подключить их в систему редактирования. Если вы выбрали диски с одинаковы&
ми названиями, процесс несколько усложнится.

Во&первых, вам нужно скопировать материал из систем оцифровки в систему
редактирования. Для этого вы можете создать сетевое соединение между компью&
терами и скопировать данные, либо воспользоваться переносным жестким дис&
ком. В любом случае вам необходимо указать для конечного диска название, кото&
рое отличается от названия исходного диска. Переименовать диск можно только
после того, как все данные будут скопированы. Например, если ваши диски оциф&
ровки называются AVD, а конечный диск – XFER, то переименовать данный диск
в AVD вы сможете только после завершения копирования.

Создание ссылок на материал
Когда вы скопируете весь материал из систем оцифровки в систему редактирова&
ния, вам нужно настроить доступ к ней. Так как материал был записан в системах
оцифровки, вы должны вернуться к ним, чтобы получить необходимую информа&
цию. У вас есть две опции:

• скопировать проекты из систем оцифровки в систему редактирования;
• экспортировать список оцифровки из каждой системы и импортировать его

в систему редактирования.

Проще всего скопировать проекты. Вам нужно открыть проекты оцифровки
в системе редактирования и скопировать папки. После этого вы должны закрыть
проекты оцифровки и оставить систему редактирования открытой. Ссылка на
материал будет добавлена автоматически.

Если вы решили экспортировать списки оцифровки, вы должны импортиро&
вать их в проект для редактирования и изменить ссылки.

Выполните следующие действия, чтобы экспортировать список оцифровки:

• Avid. File ⇒ Export ⇒ Avid Log Exchange;
• Final Cut. File ⇒ Export ⇒ Batch List;
• Premiere. Project ⇒ Export Batch List.

Выполните следующие действия, чтобы импортировать список оцифровки:

Научитесь быстро оцифровывать большой объем материала
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• Avid. File ⇒ Import;
• Final Cut. File ⇒ Import Batch List at 29.97 fps;
• Premiere. Project ⇒ Import Batch List.

Измените ссылки (возможно, вам понадобится выделить клипы в режиме
Offline):

• Avid. Avid ⇒ Bin ⇒ Relink;
• Final Cut. File ⇒ Reconnect Media;
• Premiere. Project ⇒ Link Media.

После того как вы переместите и импортируете материал, а также восстановите
ссылки, вы сможете приступить к редактированию проекта. Это произойдет быс&
трее, чем в случае с оцифровкой на одной системе. Если вы работаете в жестких
временных рамках, время для редактирования особенно ценно. Чем раньше вы
перейдете к редактированию, тем лучше.

Специально для хакеров
Если у вас есть данные журналов (см. совет 5), вы можете импортировать их
в системы оцифровки. Проще всего разделить журналы путем импорта в каждую
систему данных с нескольких кассет. Это позволяет вам организовать свой проект
и сэкономить много времени.

Если ваша локальная сеть содержит диск с общим доступом, вы можете приме&
нить данную методику для передачи данных между компьютерами. Так как дан&
ные оцифровки не передаются автоматически, вам придется открывать один про&
ект в другом или копировать папки между ними.

Совет 14 Сделайте синий экран для фона

Всего за 30 долл. США вы сможете сделать большой (24 на 8 фута) переносной
экран синего цвета.

Когда я был еще маленьким (в конце 1970&х гг.), мне пришлось впервые позна&
комиться с принципом синего фона во время просмотра фильма «The Making of
Star Wars». Методика проведения съемки на синем фоне, который впоследствии
можно заменить любым изображением, открывает безграничные возможности
перед режиссером. В наше время существует разнообразное программное обеспе&
чение, которое позволяет применять данную методику в любительских проектах.

Определитесь со своими потребностями
Профессиональный синий экран стоит очень дорого; впрочем, для создания сине&
го экрана подойдет практически любой материал. Очень часто применяется реше&
ние, в котором сцены крупным планом снимаются на фоне небольшого постера
синего цвета. Но что делать, если вам нужно снять более масштабную сцену?

Сделать экран синего цвета просто, и на это вам потребуется всего лишь не&
сколько часов. Экран, который мы собрали во время написания этого раздела,
имеет 24 фута в ширину (включая кайму) и 8 футов в высоту. Используется лег&
кий материал, что позволяет при желании переносить экран. Я записал DVD&диск
с руководством по восточным единоборствам, в котором в качестве фона исполь&
зовался такой же экран, только зеленого цвета.

Я очень советую вам предварительно сделать несколько снимков на фоне вы&
бранного материала и проверить, подходит он вам или нет. Используйте освеще&
ние (совет 22), камеру и программное обеспечение (совет 70), которые будут за&
действованы в вашем проекте. После этого обратитесь к вашим родителям или
арендодателям и получите разрешение на установку экрана. Старайтесь получить
удовольствие от процесса!

Собираем материалы
Разумеется, вам потребуются определенные материалы для сборки экрана. Посе&
тите местный магазин и купите следующие компоненты:

• один рулон синей ткани размером 100 футов на 40 дюймов (стоит примерно
13 долл. США);

• девять деревянных планок размером 1 на 3 фута (10 долл. США);
• один мощный степлер и набор скрепок (20 долл. США);
• пилу (20 долл. США);
• отвес (3–10 долл. США);
• опционально (для установки на каменные стены) – один комплект жидких

гвоздей (4 долл. США).

Выберите свободное помещение для установки экрана. Лично я использовал
кладовую в подвале здания. Мне повезло еще и потому, что это оказалась самая
большая комната в доме! На рис. 1.21 показано, как я подхожу к стене помещения.

Рис. 1.21. Я стою возле стены комнаты

Сделайте синий экран для фона
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Для установки синего экрана использовались планки, которые можно снять.
Однако жидкие гвозди оставят след на поверхности стены. Если вы привинтите
планки к стене, в поверхности сохранятся отверстия. Поэтому вы должны внима&
тельно выбирать крепеж для экрана.

Установка деревянных планок
Синяя ткань достаточно тонкая и почти прозрачная, следовательно, вам понадо&
бится использовать планки для ее крепления на стене. Мне не удалось установить
экран на кирпичной стене; к тому же поверхность стены просвечивала бы сквозь
ткань. Планки оставляют пустое пространство между экраном и стеной; к тому же
вы можете прикрепить к ним экран с помощью степлера.

Перед тем как установить планки на стене (см. рис. 1.22), убедитесь в том, что
вы правильно их измерили. С помощью отвеса пометьте горизонтальную линию
для каждой планки. Оставьте пустое пространство в центре; если ткань имеет
40 дюймов в ширину, отступ должен составлять 36 дюймов.

Установка синего экрана
Теперь мы можем установить сам синий экран, как показано на рис. 1.23. Развер&
ните рулон материала и начинайте работать степлером. Продвигайтесь от одного
края к другому. Используйте три&четыре скрепки на фут, чтобы избежать разрыва
ткани при натяжении. Сместившись на фут к верхнему краю, возвращайтесь об&
ратно.

Рис. 1.22. Осторожно устанавливаем
планки на стене

Установите планки в соответствии с разметкой. Если вы крепите экран на
обычную стену, то можете использовать шурупы. Помните о том, что они оставля&
ют отверстия. Если стена имеет сплошной цвет, вы сможете прикрепить к ней эк&
ран посредством степлера. Скрепки степлера оставляют почти незаметные следы,
но их будет очень много.

Я использовал жидкие гвозди. Жидкие гвозди затвердевают и становятся
очень крепкими. Они очень хорошо крепятся на кирпич, цемент и дерево. Перед
установкой планок я нанес на них и на стену клей, что привело к отличным ре&
зультатам. Для затвердевания клея требуется от 10 до 30 мин, поэтому я реко&
мендую вам подставить другие планки, чтобы удержать экран в течение этого
времени.

Рис. 1.23. Установка синего экрана

Скрепки должны располагаться горизонтально. Это вызвано двумя
причинами. Во&первых, таким образом вы создаете единый горизон&
тальный шов. Он выглядит намного элегантнее, чем несколько верти&
кальных швов. Во&вторых, проще работать слева направо с двумя
планками материала, чем вниз&вверх, а затем снова вверх&вниз по
нескольким швам.

Обязательно натяните материал так сильно, как только допустимо. Сначала я
неверно установил деревянные планки, и они оказались слишком далеко друг от
друга. Чтобы заполнить пустое пространство, я воспользовался скотчем синего
цвета. На рис. 1.24 показан синий экран с нанесенным на него скотчем.

Я надеюсь, что вы сможете научиться на моих ошибках и правильно выполните
все измерения.

Последние штрихи
После установки экрана я добавил немного материала на его края, а также на сте&
ну. Экран скрывает дверь, ведущую из подвала, а планки прикреплены к дверно&
му косяку, а не к стене.

Но работает ли такой экран? Конечно, да! На рис. 1.25 и 1.26 показаны два при&
мера композиций, которые были сняты в моей комнате с синим экраном.

Сделайте синий экран для фона
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Если вы хотите просмотреть видеоклипы, созданные на синем фоне, зайдите на
следующие сайты:

• Windows Media. http://www.hiddenphantom.com/Scene3/03Share.wmv;
• QuickTime. http://www.hiddenphantom.com/Scene3/03Share.mov.

Все, что от вас требуется, – это любовь к цифровой видеотехнологии!

Совет 15 Стабилизируйте свои снимки

Вы можете создать свою систему стабилизации, которая состоит из штатива, ва&
шей видеокамеры и груза весом 5–10 фунтов.

Если вы когда&либо пробовали снимать видео на ходу, то знаете, что при этом
изображение искажается. Многие компании продают специальные устройства,
которые позволяют избежать этого нежелательного эффекта. Самое известное из
этих устройств, SteadiCam, представляет собой профессиональное решение, кото&
рое дает оператору возможность выполнять съемку во время движения. Проблема
состоит в том, что такое устройство стоит довольно дорого, а научиться работать
с ним не так просто.

К счастью, вы можете использовать штатив и груз (используется в тренажер&
ном зале), чтобы стабилизировать свои снимки. Подсоедините груз к нижней час&
ти штатива, и вы сделаете противовес вашей камере. На рынке имеется большое
количество штативов, но лично я предпочитаю использовать устройства произ&
водства компании Bogen&Manfrotto (http://www.bogenimaging.us/), потому что
они очень надежны, а также имеют съемные заглушки.

Сборка системы стабилизации
После того как вы выберете и купите штатив, вам понадобится прикрепить к нему
груз. Если ваш штатив имеет съемную заглушку, вы можете ее снять, вложить груз
внутрь, а затем снова установить заглушку на место. Результат показан на рис. 1.27.

Рис. 1.24. Так выглядит синий экран
после завершения установки

Рис. 1.26. Так выглядит завершенная композиция

Рис. 1.25. Снимок на синем фоне

Рис. 1.27. Штатив с небольшим грузом

Если ваш штатив не имеет съемной заглушки, вы можете просверлить отвер&
стие в корпусе штатива, прикрепить к нему груз, а затем зафиксировать его с по&
мощью болта.

Важно помнить о том, что, если вы не прикрепите груз к нижней части
штатива, вы не создадите противовес камере.

Стабилизируйте свои снимки
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После сборки штатива с грузом поместите камеру на верхнюю
часть штатива и зафиксируйте ее так, как показано на рис. 1.28.

Используем систему стабилизации
Чтобы применить систему стабилизации, поднимите штатив и
удерживайте его на высоте. При ходьбе ваша рука и ваше плечо бу&
дут абсорбировать колебания, что позволит сохранить стабиль&
ность изображения. Вы даже можете обойти объект или персонаж
кругом и избежать при этом искажений.

Поэкспериментируйте, чтобы привыкнуть к тому, как влияет ис&
пользование системы стабилизации на ваше видео. К примеру, попро&
буйте пройтись по лестнице со штативом и отдельно – только с каме&
рой. Вы заметите, насколько сильно различаются два снимка, причем
в определенной ситуации любой из них может оказаться полезным.

У этой методики есть дополнительные преимущества:

• вы можете использовать штатив традиционным способом, то есть установить
его на пол. Это позволит вам сохранить естественность изображения и одно&
временно стабилизировать кадр;

• добавив удлинитель штатива, вы можете изменить влияние противовеса для
камеры. В результате вы сможете отрегулировать параметры стабилизации;

• если вы проработаете со штативом в течение длительного времени, скорее
всего, вы почувствуете себя усталым. В этом случае поменяйте руку и про&
должайте съемку.

Совет 16 Сделайте тележку для камеры

Если вы сделаете тележку для камеры с двумя колесиками, это намного упростит
вашу задачу.

Если вы хотите снять сцену, в которой персонажи отделены от фона, камера
должна перемещаться. Если вы когда&либо пробовали вести съемку во время
ходьбы, скорее всего, вы знаете, что при этом изображение искажается. На экране
видно, что оператор делает шаг, затем останавливается, делает еще шаг, снова ос&
танавливается и т. д.

Многие цифровые видеокамеры имеют функцию стабилизации. Эта функция
особенно эффективна в случае, если вы стоите на месте и держите камеру в руках.
Однако при ходьбе вы не сможете добиться нужного результата даже с примене&
нием стабилизации.

Многие операторы&профессионалы используют специальную тележку для ка&
меры, чтобы вести съемку в движении. Обычно это небольшая тележка с колеси&
ками, на которой оператор может сидеть и снимать, в то время пока ее толкает

другой человек. Вы можете работать с любой обычной тележкой, даже с креслом
на колесах.

Воспользуйтесь роликовыми коньками
У многих людей нет тележки, впрочем, вы можете использовать пару роликовых
коньков и обратиться за помощью к своему другу. Вам кажется, что это очень про&
сто: достаточно встать на коньки и нажать кнопку Record (Запись) на видеокаме&
ре. Однако все немного сложнее.

Питер Смоклер (Peter Smokler), оператор и лауреат премии Эмми,
снимал многие свои кадры с использованием роликовых коньков,
а не тележки.

Ваши друзья вам помогут
Если вы собираетесь ехать на коньках и снимать видео, подумайте, что именно
для вас важнее. Если вы будете смотреть только через видоискатель камеры, ваша
область зрения значительно сузится. Даже если вы воспользуетесь LCD&монито&
ром камеры, изображение на экране будет отвлекать вас от дороги. На рис. 1.29
показано, как оператор с камерой едет на коньках с помощью своего друга.

Для снимков с небольшим углом отклонения удобно применять скейт&
борд. Вы можете установить камеру на скейтборд, чтобы создать
нужный эффект.

Рис. 1.28. Штатив с противовесом и камерой

Рис. 1.29. В качестве тележки
можно использовать пару роликовых коньков

Сделайте тележку для камеры
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Найдите надежного друга и попросите его тянуть и толкать вас, в то время как
вы будете вести съемку. Это позволит вам избежать проблем с ушибами, разбиты&
ми коленями и сломанными руками. Независимо от того, помогает вам кто&ни&
будь или нет, возьмите веник и подметите дорожку, по которой вы будете ехать.
Небольшой камень может стать причиной серьезной травмы.

Движение назад
Если ваши персонажи идут вам навстречу, вам понадобится удаляться от них, что&
бы сохранить их изображение в кадре и в фокусе. Так как при этом вы должны запи&
сать их лица, скорее всего, вам придется двигаться в обратном направлении (то есть
назад). Конечно, ваш друг может толкать вас назад (см. предыдущий раздел), одна&
ко при этом у вас должен быть опыт катания на роликах в обратном направлении.

Берем напрокат кресло с колесиками
Кресло с колесиками может с успехом заменить тележку, потому что оно удобное и
не требует сборки. Особые комментарии тут не требуются: садитесь в кресло, выби&
раете объект, начинаете съемку и едете в нужном направлении. Как и при использо&
вании роликовых коньков, я советую вам обратиться за помощью к своим друзьям.

Не следует применять для съемок тележку на ходу, потому что шум
моторчика может помешать записи звука в сцене.

Обратите внимание: кресло очень удобно использовать на неровной поверхно&
сти, например на ковре, траве или земле.

Как украсть игрушку у ребенка
Если у вас есть ребенок, с большой вероятностью у вас есть и детская коляска.
В зависимости от типа коляски вы можете отрегулировать ее и поместить на нее каме&
ру. Так как все коляски очень сильно различаются по
типу и модели, вам придется самостоятельно выбрать
оптимальную методику установки камеры. Лично
мне проще всего работать с легкой детской коляской.
На рис. 1.30 показана камера Canon XL1, закреплен&
ная на такой коляске.

Вы можете сделать тележку и другими способа&
ми. Некоторые люди даже вырезают из трубы на&
правляющие и устанавливают на них тележку.
Независимо от того, какое именно решение вы выб&
рали, ваша аудитория по достоинству оценит полу&
ченный результат.

Рис. 1.30. Используем легкую детскую коляску
в качестве тележки для камеры
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Освещение имеет очень большое значение для видео, особенно в случае, если вы
пытаетесь создать профессиональный проект. Разумеется, вы можете использо&
вать естественное освещение для сцены. Однако с помощью специальных мето&
дик вы научитесь выделять определенные детали (или скрывать недостатки) ком&
позиции. Кроме того, вы узнаете, как можно осветить сцену и потратить на это
совсем немного денег.

Совет 17 Сделайте простой осветительный комплект

Соберите дешевый комплект осветительного оборудования для съемок цифрово&
го видео.

Многие знают, что качество изображения в сцене очень часто определяется ее
освещением. Когда я решил заняться съемками видеофильма в Таиланде и Кам&
бодже, я обратил внимание на тот факт, что мне придется самостоятельно перено&
сить свое осветительное оборудование из одного места в другое. Я решил при воз&
можности использовать естественное освещение. Кроме того, мне был необходим
легкий и функциональный комплект осветительного оборудования.

Собираем комплект
В Таиланде и Камбодже применяется стандарт напряжения 220 В, поэтому я ре&
шил купить оборудование в Бангкоке. Перед тем как уехать из Лос&Анджелеса, я
посетил свой любимый магазин, The Expendables Recycler, и приобрел некоторые
дополнительные компоненты:

• три четверти рулона черной фольги 12 дюймов (используется для блокиров&
ки и изменения формы света);

• CTO (оранжевый гель для изменения цветовой температуры);
• CTB (синий гель для изменения цветовой температуры);
• ND (нейтральный гель 0.6 и 0.8);
• Full Blue (синий гель);
• рассеивающий экран (216);
• черно&белая лента;
• набор прищепок для белья (используются для крепления гелей, рассеиваю&

щего экрана и черно&белой ленты на источниках освещения).

Далее я приведу список дополнительных аксессуаров, которые были мне необ&
ходимы. Я не привез их с собой исключительно по причине того, что стандарты
напряжения различались:

• два гибких светильника с зажимами (такие светильники вы можете устано&
вить на своей кровати и читать при их свете);

• два диммера (для управления интенсивностью освещения);
• защитный браслет;

• примерно 100 футов проводки;
• дополнительные диммеры.

Вы сможете купить все вышеперечисленные устройства в любом хозяйствен&
ном магазине, например Home Depot. К сожалению, в Бангкоке сеть магазинов
Home Depot не представлена, впрочем, я сумел найти все необходимое в неболь&
шом магазине по продаже осветительных приборов. На рис. 2.1 показан полный
комплект осветительного оборудования. Слева вы видите четыре синих контей&
нера для проводов (по 25 футов в каждом).

Рис. 2.1. Комплект осветительного оборудования

Я заметил, что некоторые кабели, а именно те, которые можно свернуть в коль&
цо диаметром не более 7 дюймов, являются удобными в хранении и транспорти&
ровке. Все компоненты моего комплекта без труда помещаются в рюкзаке средних
размеров.

Использование комплекта
Разумеется, для того чтобы правильно использовать комплект осветительного
оборудования, вы должны соответствующим образом расположить источники ос&
вещения. Далее я приведу пример, который показывает, насколько универсален
мой комплект.

Сделайте простой осветительный комплект
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Во время съемок в Камбодже мне понадобилось осветить помещение душевой
комнаты, которое располагалось на втором этаже здания. Я решил сделать это
с помощью двух светильников с зажимами, которые крепились бы на стеклянной
стене на высоте чуть ниже человеческого роста. Проблема состояла в том, что све&
тильники невозможно было зафиксировать на стене.

При освещении сцены гели могут оказаться весьма эффективными.
Помните о том, что гели CTO (Color Temperature Orange) формируют
искусственное освещение, а гели CTB (Color Temperature Blue) – есте&
ственное.

Размещение источников освещения
Когда я изучил помещение, я обратил внимание на то, что на полу комнаты лежа&
ло большое количество стеблей бамбука. Я решил построить стойку из бамбука
(для установки светильников) и закрепить источники освещения на ней. Я нашел
стебель бамбука длиной около 10 футов. На высоте примерно в 9 футов я сделал
поперечину длиной три фута и закрепил на ней светильники. Затем я установил
данное устройство на заборе; в результате освещение проникало сквозь стекло.
Конечно, вы не сможете использовать данную методику с «профессиональными»
источниками освещения (см. рис. 2.2).

Применение диммеров
Я приступил в работе днем и планировал вести съемку после захода солнца. Мне
потребовалось найти способ регулировки яркости освещения и не использовать
для этого диммеры, подключенные к лампам. Дополнительные диммеры помогли
мне решить проблему; они особенно полезны в случае, если вам необходимо пери&
одически настраивать источники освещения, доступ к которым затруднен.

Функциональность комплекта
Данный комплект осветительного оборудования отличается универсальностью,
высокой функциональностью и приемлемой ценой. Профессиональные комплек&
ты осветительных приборов обычно стоят от 500 долл. США и выше. Если я поте&
ряю светильник из своего комплекта, я смогу без труда его заменить.

Тот факт, что вы легко можете переносить комплект, только усиливает его при&
влекательность. Если вы снимаете фильм с низким бюджетом (или вообще без
бюджета!), вам придется быстро завершать снимки и переключаться на другие
сцены. Как правило, вы будете следовать правилу «Снимай и беги», поэтому вы
оцените по достоинству возможность переноски осветительного оборудования
в рюкзаке.

Совет 18 Пользуйтесь «рабочим освещением»

«Рабочее освещение» – это очень яркое освещение (от 500 до 1000 Вт). Такое ос&
вещение очень удобно для видео.

Если вы не собираетесь посвятить свою жизнь освещению или снять професси&
ональный фильм, покупка дорогого комплекта осветительного оборудования
вряд ли себя оправдает. Если вы можете взять нужное оборудование напрокат,
считайте, что вам повезло. Если вам приходится выбирать между тем, чтобы часто
брать оборудование напрокат (дорого) или купить его (тоже дорого), скорее все&
го, вас заинтересует описание методики, которая позволит вам сократить расходы
на освещение.

 Закупаем «рабочее освещение»
Практически в любом хозяйственном магазине вы можете купить переносные
светильники, которые часто называют «рабочим освещением». Светильники раз&
личаются по мощности, от небольших (50 Вт) до мощных (1000 Вт). Широкий
диапазон по мощности дает определенные возможности для режиссера, потому
что он может выбрать нужный тип светильников. Еще одно преимущество – это
цена: такой прибор стоит не более 25 долл. США. На рис. 2.3 показан «рабочий»
светильник мощностью 500 Вт.

Использование «рабочего освещения»
Если вы будете использовать один мощный светильник, а также комплект освети&
тельного оборудования (см. совет 17), скорее всего, это позволит вам решить все

Рис. 2.2. Профессиональные источники освещения
оснащаются прочными корпусами

Пользуйтесь «рабочим освещением»
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имеющиеся задачи. Для освещения сцены вам достаточно настроить мощный све&
тильник как основной источник освещения (то есть источник, сфокусированный
на персонаже сцены), а другие светильники – как источники заливающего и об&
ратного света (света, предназначенного для обрезки теней и балансирования ос&
новного источника освещения). На рис. 2.4 показан снимок, освещенный только
основным источником света, а также снимок, освещенный основным источником
света и источником заливающего света. Основной источник света формирует
тени; источник заливающего света может их уменьшить.

Методика использования основного источника освещения наряду с заливаю&
щим светом и обратной подсветкой называется трехточечным освещением. Ис&
точник основного освещения должен быть более ярким, чем другие источники
света, причем не менее чем в два раза.

Источники основного и заливающего света должны быть направлены к зрителю
под тем же углом, что и камера. При этом вам необходимо их расположить напротив
друг друга и чуть выше персонажа. Источник обратной подсветки (как ясно из на&
звания) следует расположить позади и чуть выше персонажа. На рис. 2.5 показана
диаграмма сцены с трехточечным освещением.

Рис. 2.3. «Рабочий» светильник

Рис. 2.4. Снимок, освещенный только основным источником света
(слева), а также основным источником света и источником

заливающего света (справа)

Рис. 2.5. Трехточечное освещение

Управление «рабочим освещением»
Источники «рабочего» освещения стоят недорого, обладают мощными функция&
ми и весьма эффективны для съемок видео. Однако проблема состоит в том, что
они отличаются слишком высокой яркостью. Одно из возможных решений состо&
ит в том, чтобы подключить диммер к источнику освещения и уменьшить интен&
сивность света. Также вы можете использовать рассеивание. Кроме того, суще&
ствует возможность комбинирования этих решений.

Использование диммеров
Вы можете купить диммеры в хозяйственном магазине, в магазине осветительно&
го оборудования и даже в некоторых супермаркетах. Если вы хотите максимально
эффективно управлять освещением сцены, используйте один диммер на один ис&

Пользуйтесь «рабочим освещением»

Обратная
подсветка

Основное
освещение Камера

Заливка
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точник света. При покупке диммера обратите внимание на максимальную мощ&
ность, которую он может поддерживать.

Использование рассеивающих фильтров
Многие фотомагазины продают рассеивающие фильтры. Обычно такой фильтр
представляет собой прозрачный лист пластика, отличающийся высокой теплоус&
тойчивостью. Если вы поместите рассеивающий фильтр на источник освещения,
свет будет смягчен.

Вместо фильтра вы можете использовать пергаментную бумагу (продается
в супермаркетах по цене 3–5 долл. США за рулон), которая применяется в кулина&
рии. Подобная бумага является полупрозрачной и идеально подходит для рассеива&
ния света. Кроме того, пергаментная бумага обладает теплоустойчивостью, поэтому
вы можете использовать ее с мощными источниками освещения. На рис. 2.6 пока&
зан источник рабочего освещения мощностью 500 Вт с листом пергаментной бу&
маги, который применяется для рассеивания света.

Совет 19 Используем для освещения лампы
с бумажными абажурами

Вы можете применять для освещения сцены дешевые лампы с бумажными абажу&
рами.

Освещение сцены может серьезным образом изменить общее впечатление от
нее. Проблема заключается в том, что профессиональные комплекты осветитель&
ного оборудования стоят дорого, а также сложны в эксплуатации и транспорти&
ровке. К счастью, вы можете применить дешевые лампы с бумажными абажурами,
для того чтобы нужным образом сконфигурировать освещение сцены. Набор та&
ких ламп является удачным дополнением к недорогому комплекту осветительно&
го оборудования (см. совет 17).

Китайские лампы с бумажными абажурами бывают разной формы и разного
размера (до 30 дюймов в диаметре). Вы можете купить такие лампы в хозяйствен&
ном магазине или магазине электроприборов. Лампы с бумажными абажурами
стоят от 3 до 30 долл. США в зависимости от их размера и качества. Такие лампы
дают мягкий, рассеянный свет. На рис. 2.7 показан кадр видеофильма без освеще&
ния и с одной лампой с бумажным абажуром (мощностью 100 Вт).

Рис. 2.6. Пергаментная бумага
пригодна не только для кулинарии

Как вы можете предположить, источники рабочего освещения позволяют вам
создавать более профессиональные снимки. Но это еще не все: они предназначены
для работы в трудных условиях. Так как такие источники освещения стоят недо&
рого (по сравнению с профессиональными светильниками) и отличаются высо&
кой надежностью, я советую вам внимательно к ним присмотреться во время по&
иска компонентов для комплекта осветительного оборудования.

Рис. 2.7. Освещение без (слева)
и с лампой с бумажным абажуром (справа)

Многие светильники продаются без провода и патрона для лампы. Вы можете
купить эти аксессуары отдельно (стоят около 5 долл. США). Как правило, они
покупаются вместе со светильником, и продавцы об этом знают. Одно из преиму&
ществ системы патрон – провод (см. рис. 2.8) состоит в том, что вы можете исполь&
зовать ее отдельно.

Если вам необходимо управлять освещением, вы можете
подключить диммер. Также вы можете использовать более
мощные лампы (или установить цветную лампу). Если вы

Рис. 2.8. Система патрон – провод

Используем для освещения лампы с бумажными абажурами
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хотите осветить человека, который перемещается по сцене, вы можете прикре&
пить светильник к длинному шесту и подвесить над персонажем (как микрофон;
см. совет 53). Отметим, что лампы с бумажным абажуром являются функцио&
нальными, удобными в транспортировке и дешевыми.

Совет 20 Установите рассеивающий фильтр
на накамерный светильник

Освещение играет важную роль в процессе съемок видео. Однако вам нужно пра&
вильно им управлять.

Если вы ведете съемку без подготовки (например, на свадьбе, в ночном клубе или
для документального фильма), переносной светильник может оказаться весьма по&
лезным. Многие компании продают накамерные светильники с питанием от бата&
реи камеры. Однако такие светильники не имеют функций регулировки света.

Как правило, накамерный светильник представляет собой небольшой, но яр&
кий фонарь, который устанавливается на камере. Только очень немногие нака&
мерные светильники позволяют вам управлять светом с помощью шторок. Боль&
шинство светильников шторок не имеют. Вы можете только включить или вык&
лючить их.

Обычно шторки состоят из четырех металлических пластин, прикреп&
ленных к источнику освещения; они очень часто устанавливаются на
профессиональных светильниках. Закрыв шторку (полностью или
частично), вы изменяете количество света. Заметим, что применение
шторок не позволяет решить проблему слишком жесткого освещения.

Герберт Везерфорд (Herbert Wetherford), независимый продюсер из Лос&Анд&
желеса, рассказал мне об одной методике, которую он использует при съемках
фильмов. Если вы заклеите светильник скотчем, свет станет менее ярким, а также
смягчится. Вы можете рассеять свет с помощью обычного скотча. Результат этого
эффекта показан на рис. 2.9.

П. Скотч не является несгораемым материалом. Не следует распола&
гать его вплотную к источнику освещения. Если вы можете использо&
вать защитный слой, сделайте это. Скотч может плавиться под
воздействием высокой температуры.
При необходимости вы можете воспользоваться прищепками
(см. совет 25) и поместить скотч на удалении от светильника.

Если вы установите на светильник рассеивающий фильтр, свет станет мягче:
жесткие тени уменьшатся, а освещение ровно распределится по области. В опре&
деленных условиях использование ламп с бумажным абажуром (см. совет 19) или
рабочего освещения с рассеивающими фильтрами (см. совет 18) позволяет до&
биться оптимального результата. Однако если вы снимаете на ходу, лучше всего
применять накамерный светильник.

Совет 21 Снимайте видео в полной темноте

В темноте происходит много интересных вещей, но как же снять их на камеру?
Здесь мы поговорим о методиках, которые позволяют вести съемку даже в полной
темноте.

Возможно, ночью ваш сад посещает таинственное животное, либо вы просто
хотите узнать, кто же ворует в темноте печенье из вашей кухни. Вам нужны дока&
зательства, например видеофильм. Но как сделать снимок, не включая при этом
свет? Если свет будет гореть, а камера – работать, скорее всего, ни животное, ни
кухонный вор так и не появятся.

Существуют методики, которые позволяют вам вести съемку в местах с плохим
освещением. Для этого вы можете использовать существующий свет с максималь&
ной эффективностью либо добавить новые источники освещения, которые вос&
принимаются только вашей камерой.

Уменьшаем скорость затвора камеры
Если вы уменьшите скорость закрытия затвора камеры, она сможет восприни&
мать большее количество света. Во многих случаях (например, на улице) эта ме&
тодика позволяет записать видеофильм приемлемого качества; некоторые каме&
ры поддерживают режим Slow Shutter Speed (Низкая скорость затвора каме

ры). Впрочем, изображение может при этом искажаться; если вы уменьшите
скорость затвора камеры, ее колебания, а также колебания при перемещении
объектов в кадре будут усилены. На рис. 2.10 показан кадр из видеофильма, ко&
торый был снят в режиме Color Slow Shutter Speed на камере Sony при плохом
освещении.

Вы не можете устранить размытость движущихся объектов. Впрочем, вы може&
те минимизировать колебания камеры: установите ее на штатив либо держите
обеими руками и обопритесь о стену.

Рис. 2.9. Мы заклеиваем светильник скотчем,
чтобы создать эффект рассеянного света

Снимайте видео в полной темноте
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Добавляем скрытые источники освещения
Другая методика заключается в изменении освещения. Как это ни странно, но су&
ществуют определенные типы освещения, которые воспринимаются камерой, но
не человеческими глазами. В частности, камера может фиксировать инфракрас&
ное излучение, которое человек не видит. Большинство животных тоже не реаги&
руют на инфракрасное излучение.

Чтобы понять, что я имею в виду, выполните следующие действия: возьмите
пульт дистанционного управления, направьте его себе в глаз и нажмите кнопку.
Вы ничего не увидите, потому что ваши глаза не воспринимают инфракрасное
излучение от пульта. Теперь направьте пульт дистанционного управления на
объектив вашей камеры. На экране камеры вы увидите вспышку света (камера
реагирует на инфракрасное излучение). Данную методику вы можете использо&
вать в случае, если сцена недостаточно хорошо освещена: добавьте источник инф&
ракрасного излучения, который не будет замечен аудиторией.

Этот совет применяется даже производителями камер. Многие камеры (напри&
мер, модели Sony) имеют режим Night Vision (Ночное видение), который исполь&
зует встроенный светодиод (компания Sony называет этот режим Super Night

Shot, а компания Panasonic – 0Lux MagicPix). Однако встроенный светодиод не
обладает значительной мощностью и может освещать только объекты, находящи&
еся на небольшом удалении от камеры. Это может быть удобно при съемках круп&
ным планом, и не более того.

Если вы собираетесь записать сложную композицию, вам понадобится более
мощный прибор, такой как инфракрасный светильник. Некоторые производите&
ли камер предлагают свои светильники: компания Sony поставляет устройство
HLV&IRH2, которое работает с любой камерой NightShot, а также может исполь&
зоваться в качестве дополнительного источника освещения. Однако такой све&
тильник может работать только от питания камеры; кроме того, он расходует за&
ряд батареи. Если вы установите отдельный светильник, это позволит вам переме&

стить камеру в другое место. На рис. 2.11 показан инфра&
красный светильник, купленный на сайте eBay.

Недостаток инфракрасного освещения состоит в том,
что ваше видео становится черно&белым. Это связано
с тем, что камера фиксирует исключительно инфракрас&
ное, а не цветное освещение. В результате видео напоминает изображение, полу&
ченное сквозь прибор ночного видения, который применяется в военных целях.
На рис. 2.12 показана сцена, освещенная инфракрасным светильником; обратите
внимание на отсутствие цвета.

Рис. 2.10. Так размывается изображение,
снятое в режиме Color Slow Shutter Speed

Рис. 2.11. Инфракрасный светильник 39 LED

Рис. 2.12. Так выглядит освещение
от инфракрасного светильника

на цифровой камере

Снимайте видео в полной темноте
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Как получить оптимальный результат
Если вы ведете съемку из окна или находитесь рядом с предметом, отражающим
свет, я советую вам отключить встроенную инфракрасную лампу камеры. Если
после включения инфракрасного светильника вы не увидите его свет, не смущай&
тесь: вспомните о том, что ваши глаза не воспринимают инфракрасное излучение.
Максимум, что вы можете увидеть, – это очень тусклый красный свет.

Данная методика позволит вам разглядеть предметы при плохом освещении
или в темноте. Рассмотрим пример: моя жена и я снимаем диких кошек, которые
не любят присутствия человека. Поэтому для наблюдения за ними мы используем
инфракрасный светильник и камеру в режиме Night Vision. На рис. 2.13 показан
кадр из видеофильма, снятого на камеру Sony при плохом освещении. Здесь мы
применили режим Super NightShot Plus и инфракрасный светильник.

что вы сможете создать хорошую композицию. Из плохого материала ее составить
невозможно.

В данном разделе под термином «зеленый экран» имеется в виду любой
фон, который состоит из одного сплошного цвета (например, зеленого
или синего). Вы можете заменить здесь слово «зеленый» любым другим
цветом.

Где взять зеленый фон?
Если вам повезет, вы сможете найти и снять студию с так называемой циклорамой
зеленого цвета. При поисках студии я советую вам выбирать помещение, в кото&
ром имеется циклорама. Однако в большинстве случаев вы просто не можете най&
ти такую студию, или у вас не хватает средств на нее.

К счастью, существуют и другие методики, которые позволяют вам создать зеле&
ный фон. Если у вас есть свободное помещение, вы можете сконструировать зеле&
ный экран с помощью набора компонентов (см. совет 14). Также вы можете покра&
сить стену в зеленый цвет (следите за тем, чтобы краска распределялась равномер&
но). Наконец, вы можете взять отрез зеленой ткани и подвесить его на шесте.

Многие любители и профессионалы покупают материалы для зеленого
фона в компании Film Tools (http://shop.store.yahoo.com/cinemasupplies/),
которая находится в городе Бурбанк (Burbank), штат Калифорния.
Эта компания предлагает большое количество аксессуаров для кино и
видео, от режиссерских кресел до тележек.

Освещаем зеленый экран
При съемках с использованием зеленого экрана освещение играет важнейшую
роль. Если вы неправильно осветите фон, вам придется тратить много времени на
корректировку при редактировании. Сэкономьте свое время и силы и постарай&
тесь избежать таких ошибок.

Персонажи не должны носить зеленые одежды. Когда вы будете
удалять зеленый фон из изображения, вы можете случайно удалить
актеров вместе с ним! Такой же принцип действует и в отношении
реквизита.

Освещение фона
Сначала следует осветить зеленый экран. Это значит, что на зеленом фоне не должны
располагаться актеры или реквизит. Вам необходимо создать ровное фоновое осве&
щение, то есть удалить все тени, точки и отблески. Для создания оттенка фона вы
можете использовать вместе со светильниками гели зеленого цвета. На рис. 2.14
показаны два зеленых экрана (плохо и хорошо освещенный). Ваша задача заключа&
ется в том, чтобы добиться ровного распределения освещения по фону.

Рис. 2.13. Используя инфракрасное излучение,
вы сможете видеть в темноте

Если вы пытаетесь снять на камеру диких животных, вам может помочь лун&
ный свет. Попробуйте выполнить съемку в полнолуние, потому что света будет
достаточно для записи видео в режиме Night Vision. За информацией обратитесь
по адресу: http://aa.usno.navy.mil/idltemp/current_moon.html.

Совет 22 Создание снимков на зеленом фоне

Если вы хотите вести съемку на зеленом (или синем) фоне, вам необходимо уде&
лить внимание деталям.

Для создания реалистичного изображения на экране вам следует выполнить
съемку на зеленом фоне. Многие приложения имеют функции для обработки не&
качественного материала, однако я не советую вам полагаться на них. Проще го&
воря: если во время съемок вы допустили ошибку, не стоит рассчитывать на то,

Создание снимков на зеленом фоне
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Если вы правильно осветите фон и персонажей, то дальнейший процесс съемок
значительно упростится. Для создания композиции вам почти не придется прила&
гать усилий. Чем меньше времени вам понадобится на оформление композиции,
тем дольше вы должны вносить в нее предварительные изменения: добавлять
тени (см. совет 71) и редактировать настройки.

Совет 23 Ведем съемку через окно

Если вы выполняете съемку через окно, изображение может стать размытым или
переэкспонированным. Вы можете устранить эту проблему.

Солнечный свет – это идеальное естественное освещение. Но если вы ведете
съемку через окно, вы заметите, что изображение становится размытым и даже
тусклым. Если вы нанесете на поверхность стекла гель ND, то сможете сохранить
изображение в фокусе.

Гель представляет собой небольшой лист цветного пластика, который
стоит не так уж и дешево. Небольшие листы (21 на 24 дюйма), кото&
рые применяются для изменения освещения, продаются в таких фото&
магазинах, как Film Tools (http://www.filmtools.com) и B&H Photo
(http://www.bhphotovideo.com), и стоят от 5 до 10 долл. США за штуку.
Большие листы (4 на 25 фута) стоят 100–200 долл. США за штуку.
К счастью, гели отличаются долговечностью.

Вам необходимо поместить гель внутрь окна. Это позволит вам не только избежать
попадания грязи на поверхность листа, но и упростит дальнейшие корректировки. На
рис. 2.15 показан гель нейтральной плотности в виде листа 21 на 24 дюйма.

В зависимости от того, с каким окном вы работаете, вы можете закрепить лист
геля имеющимися зажимами (см. совет 25). Если этого сделать нельзя, зафикси&
руйте гель с помощью скотча. Для этого можно использовать специальный скотч
производства Permacel. Такой скотч не оставляет на поверхности следов после уда&
ления. Разумеется, особенно полезно при&
менять скотч Permacel при съемках в арен&
дуемом помещении, потому что вам ни к
чему повреждать чужую собственность.

После установки листа вы можете при&
ступить к съемкам. На рис. 2.16 показано
окно, половина которого была закрыта ге&

Рис. 2.14. Плохо (слева) и хорошо (справа)
освещенный зеленый экран

Освещение персонажа
Только после освещения фона вы должны добавить в сцену актеров и реквизит.
Осветите актеров обычным способом и помните о том, какой фон вы собирае&
тесь использовать в данной композиции. Убедитесь в том, что на зеленый фон не
падают тени от актеров; при необходимости удалите их (путем корректировки
освещения).

Учтите: при совмещении фона и персонажа формируется эффект заливки
(spill). Под заливкой здесь имеется в виду отражение зеленого цвета от персона&
жа. Изменив освещение, вы можете удалить заливку. Если вы заметите, что от
персонажа отражается зеленый свет, попробуйте уменьшить заднюю подсветку.
Кроме того, вам могут помочь гели, потому что они снижают отражение света.

Ведем съемку на зеленом фоне
Вам может показаться, что выполнить съемку на зеленом фоне довольно просто.
Однако я очень советую вам сначала попрактиковаться, а только потом присту&
пать к настоящим съемкам. Попробуйте поместить перед зеленым экраном какой&
либо предмет, а затем снять его. Кроме того, вы можете записать на видео неболь&
шой фрагмент сцены, чтобы убедиться в том, что результат соответствует вашим
ожиданиям.

Во время съемок камера должна находиться в неподвижном положении. Если
вы собираетесь работать с движущимся фоном, совместить его перемещение с пе&
ремещением камеры будет очень трудно, практически невозможно. Даже если вы
сможете просматривать композицию в режиме реального времени, у вас уйдет
очень много времени на совмещение анимации фона и перемещения камеры.

У меня был опыт работы с режиссером, который настаивал на исполь&
зовании движущегося фона в снимке. Даже несмотря на то, что мы
смогли создать композицию в режиме реального времени, для формиро&
вания удачного снимка нам понадобилось 43 дубля. При любой возмож&
ности старайтесь использовать статичный фон, и вы сэкономите как
свои силы, так и свое время.

Рис. 2.15. Стандартный лист геля
нейтральной плотности

Ведем съемку через окно
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Рис. 2.16. Ведем съемку через окно
с использованием геля нейтральной плотности

лем нейтральной плотности. Здесь вы можете сравнить обычное изображение и
изображение, полученное с помощью геля.

Несмотря на то что ваша аудитория не заметит разницы при использовании геля
(визуально никакой разницы не будет), благодаря его применению вы сможете из&
бежать таких ненужных эффектов, как размытость и неяркость изображения.

Совет 24 Отражение света от тени

Применяя систему ветрозащиты, вы можете улучшить освещение сцены.
При освещении композиции вам часто требуется отразить свет, чтобы удалить

небольшие тени. Профессионалы применяют отражающие панели, которые пред&
ставляют собой тяжелые листы белого картона либо диски, покрытые отражаю&
щим материалом. К счастью, эти аксессуары созданы из материалов, которые при&
меняются в системах ветрозащиты.

Листы картона стоят довольно дешево (5 долл. США и меньше). Белый картон
может успешно заменить отражающую панель. Одно из преимуществ состоит
в том, что вы можете складывать картон. Это позволяет вам изменить форму лис&
та и соответственно повлиять на параметры отраженного света.

Отрезки ткани (применяются в ветрозащитных системах) могут заменить от&
ражающие диски. Благодаря своим размерам они довольно удобны. На рис. 2.17
показан ветрозащитный экран в автомобиле.

Для использования экрана согните его таким образом, чтобы он был направлен
на персонажа, которого вы собираетесь осветить. Если на лице актера есть тени,
попробуйте отразить свет и заполнить их. Для этого тень должна направляться
к персонажу под углом. На рис. 2.18 показано, как следует использовать тень
в качестве отражателя.

Рис. 2.17. Ветрозащитный экран,
изготовленный из отражающей ткани

Если у вас уже есть ветрозащитный экран, я советую его применить. В против&
ном случае вам придется отправиться в магазин автозапчастей или купить экран
в сети Интернет (также он может продаваться в бакалейном магазине). Как бы то
ни было, ветрозащитный экран способен исполнять сразу две функции: способ&
ствовать правильному освещению сцены, а также использоваться по своему пря&
мому назначению.

Рис. 2.18. Отражаем свет слева, чтобы уменьшить тени

Отражение света от тени
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Совет 25 Научитесь использовать прищепки
как настоящий профессионал

Прищепки постоянно применяются в телевидении и кино.
Прищепки настолько часто используются в телевидении и кино, что вы легко

можете забыть о том, что изначально они предназначались для развешивания
одежды. В кино их часто называют просто «C47». На рис. 2.19 вы видите ведро,
заполненное прищепками.

Существует несколько различных версий, объясняющих, почему при&
щепки стали называть «C47». Некоторые люди утверждают, что
C47 – это номер прищепки, который использовался в армии, другие
говорят, что в корзине с таким номером прищепки хранились в магази&
не. Есть люди, которые считают, что C47 – это устаревший инвен&
тарный номер. Точного ответа на вопрос нет ни у кого, поэтому вы
вполне можете придумать свое собственное объяснение.

Обычно операторы применяют прищепки, чтобы закрепить гели на источниках
освещения. Если деревянная прищепка будет находиться вблизи от светильника
на протяжении длительного времени, она не нагреется до такой степени, как ме&
таллический зажим. Кроме того, прищепка не подвержена возгоранию.

Чтобы использовать C47, поместите гель или рассеивающий фильтр на све&
тильник. Затем зафиксируйте его с помощью прищепок, как показано на рис. 2.20.

Не нужно размещать гели слишком близко от светильника, потому что
лист пластика может расплавиться.

Ассистенты режиссера применяют прищепки для хранения бумаг, гардеробщи&
ки – для развешивания одежды, а продюсеры за них платят.

Рис. 2.19. Прищепки
или C47

Рис. 2.20. Используя
прищепки, мы поместили
синий гель на светильник
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Цифровое видео непосредственно связано с исходным материалом, поэтому его
запись – это самый важный этап в вашей работе. Если у вас не будет материала, вы
не сможете редактировать или распространять видео. Выбор материала зависит
от того, что именно вы хотите получить и как вы можете это сделать. Советы
в данной главе помогут вам получить материал из различных источников, снять
материал необычным способом, а также добавить различные исходные данные
в один проект.

Совет 26 Создание сжатого видеоклипа
с заходом солнца

Вы можете сжать продолжительное событие и преобразовать его в короткий, но
эффектный переход.

Скорее всего, вам уже приходилось видеть сжатые видеофильмы в образова&
тельных программах: например, вы видели, как роза превращается из ростка в бу&
тон. Такие фильмы выглядят впечатляюще. В отличие от кинокамер большинство
цифровых камер не позволяют вам изменять частоту смены кадров при записи
материала.

Описанная здесь методика дает вам возможность (пусть и с некоторыми огра&
ничениями) добиться подобного эффекта на цифровой камере.

Если ваша камера поддерживает функцию съемки в режиме сжатого
времени, считайте, что вам повезло. Впрочем, я советую вам все равно
прочитать данный раздел и поэкспериментировать.

Изучаем снимок
Если вы собираетесь снять заход солнца или любое другое продолжительное со&
бытие, вам необходимо выбрать идеальное местоположение для съемок. Далее
я приведу список рекомендаций, которые многим из вас могут казаться очевид&
ными:

• постарайтесь минимизировать вероятность появления перед камерой слу&
чайного человека;

• найдите место, расположенное вдали от оживленных дорог;
• убедитесь в том, что в этом месте разрешена съемка;
• внимательно изучите прогноз погоды на день съемок.

Многие цифровые камеры могут вести запись только с одной скоростью, поэто&
му в вашем распоряжении будет всего лишь 60 мин. Поэтому вы должны знать,
в какое время начнется заход солнца, а также начать запись за 30–40 мин до этого.
Если ваша камера имеет функцию LP, вы сможете записать 120 мин материала.

В любом случае вам необходимо расположиться в месте съемок не позднее, чем за
час до их начала.

Настройка снимка
Чтобы записать заход солнца, вы должны поместить камеру на ровную поверх&
ность; я советую использовать штатив. Если вы хотите ограничить перемещение
людей перед камерой, ограничьте доступ в зону съемок (протяните веревки). Ра&
зумеется, вы не стремитесь к тому, чтобы в кадр попали посторонние люди или
предметы. После настройки камеры постарайтесь больше ее не перемещать.

Начните запись. Затем садитесь и ждите.
Если все пройдет удачно, вы запишите долгий и скучный клип с заходом солн&

ца. Вы можете преобразовать полученную композицию в сжатый переход и пока&
зывать его своим друзьям.

Как ускорить время?
Выполните оцифровку материала и перенесите его в систему редактирования. Вы
собираетесь сжать время, поэтому вам понадобится добавить в материал спецэф&
фект. Поэкспериментируйте с настройками скорости записи и добейтесь нужного
результата.

Если вы работаете с материалом в формате NTSC, вы должны скор&
ректировать чередование кадров, перед тем как изменять настройки
скорости. Некоторые системы редактирования автоматически выпол&
няют корректировку при изменении скорости воспроизведения мате&
риала. Если этого не сделать, изображение будет размытым.

Выполните следующие действия, чтобы изменить скорость воспроизведения
материала в популярных системах редактирования:

• Avid. Нажмите кнопку Motion Effect и выберите опцию Variable Speed (Ре

гулируемая скорость);

• Final Cut. Выполните команду Modify ⇒ Speed;
• Movie Maker. Выполните команду Add Video ⇒ Speed Up X2;
• Premiere. Выполните команду Clip ⇒ Speed/Duration;
• iMovie. Выберите режим просмотра шкалы времени и измените скорость

с помощью ползунка Faster/Slower.

В некоторых системах вам необходимо применить эффект скорости к
материалу несколько раз, чтобы добиться нужного результата.
В других вы можете сразу ввести значение (в процентах).

После изменения настроек выполните визуализацию последовательности. Го&
тово! Вы создали эффект быстрого воспроизведения, как показано на рис. 3.1.

Создание сжатого видеоклипа с заходом солнца
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Использование программного обеспечения
с остановкой воспроизведения
Фильмы с остановкой воспроизведения дают вам возможность сгруппировать
изображения, сделанные с интервалом, который превышает 1/24 с. Обычно дан&
ная методика применяется для съемок фильмов с мультипликацией (см. со&
вет 91). Впрочем, с ее помощью вы также можете создавать последовательности
с сжатым временем воспроизведения.

Преимущество программного решения заключается в том, что вы можете запи&
сывать изображения в течение длительного времени (так как единственное ваше
ограничение – это пространство на жестком диске компьютера). Следовательно,
вы можете создавать последовательности, которые показывают рост растений и
даже смену времен года.

Существуют компании, которые занимаются разработкой программного обес&
печения для создания фильмов со сжатым временем воспроизведения:

• Boinx. Эта компания выпустила программу iStop Motion для операционной
системы Mac OS X (http://www.istopmotion.com; стоит 39,95 долл. США);

• Stop Motion Pro. Эта компания выпустила программу Stop Motion Pro
для операционных систем Windows 98 SE (ME), XP и 2000 (http://www.
stopmotionpro.com; стоит 249 долл. США).

Оба приложения имеют демоверсии, которые поддерживают создание филь&
мов со сжатым временем воспроизведения. Чтобы начать работу с программой,
подключите видеокамеру к компьютеру с помощью кабеля IEEE&1394 (FireWire
или i.LINK). После этого запустите приложение, настройте его и займитесь созда&
нием фильмов.

Совет 27 Установка камеры в автомобиле

Существует ряд сложностей, которые затрудняют установку камеры в автомоби&
ле. Здесь мы расскажем о решении, которое позволит вам справиться с этой про&
блемой.

Некоторые типы снимков, в частности снимок из движущегося автомобиля, сде&
лать очень трудно. Вместо того чтобы долго думать над системой установки камеры
в автомобиль, вы можете купить очень простое устройство, которое называется The
Cleat. Оно производится компанией PowrGrip (http://www.powrgrip.com) и прода&
ется в сети Интернет (http://shop.store.yahoo.com/cinemasupplies/cleatsuccamm.html)
за 75 долл. США. Используя устройство The Cleat с камерой, которая весит не
более 10 фунтов, вы сможете делать качественные снимки из автомобиля.

Установка устройства The Cleat
Устройство The Cleat представляет собой специальную присоску. Для его уста&
новки необходимо, чтобы поверхность была гладкой и непористой. Кроме того,
я советую вам тщательно протереть и очистить поверхность от грязи и пыли.

После подготовки поверхности поместите на нее устройство The Cleat и на&
жмите на серый плунжер. Нажимайте до тех пор, пока красный индикатор не пе&
рестанет гореть. Плунжер содержит пружину, поэтому вы будете чувствовать не&
большое сопротивление.

Вероятно, самая удобная функция The Cleat – это наличие красного индикато&
ра на плунжере. Если индикатор горит, это значит, что присоска закреплена не&
плотно. Чтобы зафиксировать присоску, нажмите на плунжер еще несколько раз.
На рис. 3.2 показано незакрепленное, а на рис. 3.3 – закрепленное на поверхности
устройство The Cleat. Если вы видите красный индикатор, не устанавливайте ка&
меру.

Если вы знаете о том, что присоска плотно закреплена на поверхности, вы мо&
жете быть уверены, что ваша дорогая камера не упадет и не разобьется.

Установка камеры
После установки устройства The Cleat зафиксируйте на нем камеру с помощью
болта. В целях безопасности затяните регулятор, расположенный под камерой.
Затем вы можете отрегулировать зажим присоски, чтобы поймать в кадр нужное
изображение. На рис. 3.4 показана камера, которая была установлена на автомо&
биле с применением устройства The Cleat.

Запись видео
Как именно вы начнете запись на камере, зависит от ее модели и производителя.
Если у вас есть дистанционное управление, ваша задача упрощается. Если нет,
вам придется включить камеру вручную. В результате вы, скорее всего, запишите
больше материала, чем нужно, однако больших проблем возникнуть не должно.
На рис. 3.5 показан кадр видео, который был записан камерой, установленной на
автомобиле, а затем повернут (см. совет 42).

Рис. 3.1. Кадры из видеофильма с заходом солнца

Установка камеры в автомобиле
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Если вы не участвуете в сцене и не управляете ав&
томобилем, я советую вам просмотреть записанный
материал (совет 11). Если вы снимаете интерьер ав&
томобиля, расположитесь на заднем сиденье. Также
вы можете вести съемку из другого автомобиля и ис&
пользовать беспроводное соединение.

Снимаем камеру
После завершения съемки снимите камеру с крепле&
ния. Это позволит избежать ее падения при удалении
присоски. Чтобы отделить устройство The Cleat от
поверхности, вам достаточно сильно потянуть за плунжер. Процесс снятия уст&
ройства показан на рис. 3.6.

Дополнительные рекомендации для хакеров
Благодаря своим небольшим размерам устройство The Cleat может применяться
в качестве штатива. Кроме того, вы можете устанавливать его в местах, доступ

Рис. 3.2. Плохое соединение

Рис. 3.3. Хорошее соединение

Рис. 3.4. Камера, установленная на автомобиле

Рис. 3.5. Это видео был снято
на скорости 35 км/ч

Установка камеры в автомобиле



112 Запись материала 113

к которым затруднен. Например, вы можете закрепить камеру на внешней сторо&
не окна и снимать интерьер комнаты.

Вы можете установить несколько камер и снимать сцену с различных точек.
Представьте себе, что вы решили снять интерьер автомобиля с трех камер без уст&
ройства The Cleat; это будет непросто. Купите The Cleat, и вы сможете полностью
раскрыть свой творческий потенциал.

Совет 28 Отслеживайте кадры видео

Вы можете отслеживать каждую версию своего видеофильма.
Любая система редактирования позволяет вам создавать текст и размещать его

на экране. С помощью данной функции вы можете вставить в снимки систему ви&
зуального отслеживания. Как и при работе с исходным материалом (см. совет 9),
вы можете использовать нумерацию и добавлять заголовки.

Создание заголовка занимает всего несколько минут. Тем не менее многие
пользователи забывают об этом и в результате через некоторое время не могут
разобраться, к какой кассете относится данный эпизод. Для формирования заго&
ловка вы должны поместить его текст на экране:

• Avid. Выполните команду Clip ⇒ New Title;
• Final Cut. Выполните команду Effects ⇒ Video Generations ⇒ Text ⇒ Text;

• iMovie. Выполните команду Titles ⇒ Centered ⇒ Centered Multiple;
• Movie Maker. Выполните команду Edit Movie ⇒ Make Titles or Credits ⇒

Title;
• Premiere. Выполните команду File ⇒ New ⇒ Title.

После создания заголовка введите текст и сохраните его. Как минимум, вы долж&
ны указать заголовок проекта и дату создания снимка. Также вы можете ввести
версию снимка (например, 4), общее время воспроизведения, настройки звука
(Каналы 1 и 2 – стерео), а также имя редактора.

Некоторые редакторы и продюсеры предпочитают использовать оригинальные
заголовки. Экспериментируйте. Только не забывайте добавлять необходимую
информацию. На рис. 3.7 показан базовый заголовок на черном фоне, а также его
более оригинальная версия.

Рис. 3.6. Чтобы освободить присоску, сильно потяните за плунжер

Рис. 3.7. Здесь вы видите, сколько времени для записи у вас осталось

После завершения работы над заголовком поместите его на шкалу времени. Не&
смотря на то что некоторые системы редактирования позволяют вам добавлять за&
головки автоматически, я рекомендую делать это вручную, потому что вы сможете
указать версию снимка. На рис. 3.8 показана шкала времени Avid с заголовком.

Если вы привыкнете создавать заголовки для всех фрагментов видео в вашей
системе редактирования, а также копировать шкалу времени, вы сможете в любое
время возвращаться к нужному эпизоду.

Рис. 3.8. Заголовок в левой части шкалы времени

Отслеживайте кадры видео
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Совет 29 Выполняйте конвертирование видео
в другой формат

Тот факт, что вы используете один формат цифрового видео, еще не значит, что
вы не можете работать с другими форматами. Выполнив конвертирование дан&
ных в другой формат, вы сможете передать их другим пользователям.

Допустим, что изначально вы решили распространять информацию на DVD, но
затем передумали и собрались воспользоваться ресурсами сети Интернет. Кон&
вертировать цифровое видео из одного формата в другой легко, если вы знаете,
какие инструменты следует применить. Существует большое количество прило&
жений (как бесплатных, так и коммерческих), которые предназначены для кон&
вертирования данных из одного кодека в другой.

Я рекомендую вам использовать две программы: Discreet Cleaner (http://
www.discreet.com/products/cleaner/; стоит 549 долл. США) или FFmpeg (http://
ffmpeg.sourceforge.net/index.php; распространяется бесплатно). Эти программы
поддерживают операционные системы Macintosh и Windows. Кроме того, прило&
жение FFmpeg также работает с операционной системой Linux.

Используем приложение Cleaner
Программа Cleaner может не только конвертировать файлы из одного формата
в другой, например она позволяет вам открывать URL&ссылки из фильма (см. со&
вет 84), но и данное приложение имеет репутацию одной из самых мощных про&
грамм для конвертирования данных. Здесь вы найдете встроенные предваритель&
ные установки, которые упрощают работу с программой для новичков, а также
позволяют опытным пользователям настроить параметры по своему усмотрению.

Выполните следующие действия, чтобы создать видео в формате MPEG&4 с
поддержкой соединения до 1 Мбит/с.

1. Запустите приложение Cleaner.
2. Переместите ваш файл в окно Batch.
3. Выполните команду Batch ⇒ Specify Setting.
4. Выберите пункты меню MPEG ⇒ MPEG
4 ⇒ IMSA Profile 1 (1 Мбит/с).
5. Нажмите кнопку Apply (Применить).
6. Выберите пункты меню Batch ⇒ Encode.

Перед кодировкой программа Cleaner попросит вас указать название файла и его
местоположение на жестком диске. Когда начнется кодировка, на экране отобра&
зится окно Progress (Прогресс). Содержимое этого окна обновляется с течением
времени; здесь вы видите не только индикатор прогресса, но и вкладки Status (Со

стояние), Data Rate (Скорость передачи данных) и Statistics (Статистика). На
рис. 3.9 показано, как выглядит окно Progress после завершения кодировки.

Когда процесс завершится, программа издаст звуковой сигнал. Вы сможете
свободно распространять свой фильм в новом формате.

Используем приложение FFmpeg
FFmpeg – это бесплатное приложение, которое предназначено для записи, кон&
вертирования и воспроизведения мультимедиа&файлов. Изначально эта програм&
ма была разработана для операционной системы Linux, но вы можете работать
с ней в среде Macintosh или Windows. Инструкции по загрузке последней версии
программы вы найдете на сайте http://ffmpeg.sourceforge.net/download.php. Прило&
жение FFmpeg использует интерфейс командной строки и не поддерживает мышь.

После установки программы FFmpeg найдите ее на вашем жестком диске (из
командной строки). Введите аргумент –i и укажите исходные и конечные видео&
файлы для конвертирования. Формат команды выглядит так:

ffmpeg –i mymovie.dv mymovie.mpg

Рис. 3.9. Отображаем статистику
для фильма после кодировки

Выполняйте конвертирование видео в другой формат
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Введите вместо «mymovie.dv» название исходного файла, а вместо
«mymovie.mpg» – название конечного файла. Приложение FFmpeg поддержива&
ет кодировку в различных форматах, включая ASF, MPEG&1, MPEG&2, MPEG&4,
DV, MJPEG и т. д. Подробная документация доступна на Web&сайте FFmpeg
(http://ffmpeg.sourceforge.net).

На рис. 3.10 показан процесс конвертирования фильма в формате MPEG
(Promo.mov) в формат ASF (Promo.asf) в программе FFmpeg. Для этого использу&
ется команда ffmpeg –i /tmp/Promo.mov /tmp/Promo.asf.

Смотри также
• программа QuickTime Pro (http://www.apple.com/quicktime) может конвертиро&

вать файлы в различные форматы. За дополнительной информацией обратитесь
по адресу: http://www.apple.com/quicktime/products/qt/specifications.html;

• приложение Windows Media Encoder (http://www.microsoft.com/windows/
windowsmeadi/9series/encoder/default.aspx) предназначено дл конвертирова&
ния файлов в форматах, совместимых с Windows Media (.wav, .wma, .wmv, .asf,
.avi, .mpg, .mp3, .bmp и .jpg), в формат Windows Media Video.

Совет 30 Рассеивающий фильтр
для портретной съемки

Объективы с резкой фокусировкой очень эффективны. Однако такой объектив
скорее помешает вам, чем поможет, если вы собираетесь сфотографировать свою
любимую женщину. Воспользуйтесь рассеивающим фильтром.

Портретные снимки очень часто хвалят за их мягкое освещение, точный угол
съемки и естественное выражение. Вряд ли кому&то понравится, если на фотогра&
фии будут видны его веснушки и недостатки кожи. Иногда объективы современ&
ных камер могут быть слишком резкими!

Для решения этой проблемы профессиональные операторы применяют смягча&
ющие или рассеивающие фильтры. Такой фильтр размещается перед объективом
камеры и значительно смягчает текстуру на лице актера. Веснушки не пропадают
совсем, но становятся менее заметными.

Подобные фильтры продаются по цене от 20 до 200 долл. США. Если вы часто
выполняете портретную съемку, скорее всего, вам придется купить несколько
фильтров для различных диаметров камеры. Все очень просто, если вы зарабаты&
ваете себе на жизнь портретной съемкой. Но что делать, если вы всего лишь хоти&
те сделать снимок своей любимой женщины?

Попросите у нее колготки.
Вы не ослышались: возьмите белые колготки, растяните их перед объективом

камеры и закрепите с помощью скотча. В результате изображение будет смягчено
нужным вам образом. Чем сильнее вы натяните материал, тем мягче будет эффект.

Применяя нужную методику, вы можете создавать хорошие портретные сним&
ки даже без использования фильтров (см. рис. 3.11). Впрочем, в некоторых случа&
ях вам понадобится сформировать дополнительный эффект с помощью колготок
(см. рис. 3.12). На этот случай всегда храните в своей сумке набор колготок, а так&
же пару рулонов прочного скотча.

Лично я предпочитаю чулки колготкам, потому что мне не приходится резать
материал. Пара чулок очень удобно помещается в моей сумке. Кроме того, она
практически не снашивается, так как я ее не растягиваю.

Если вы хотите использовать чулки во время съемки, я рекомендую выполнить
следующие действия:

Рис. 3.10. Приложение FFmpeg в действии

Запуск программы FFmpeg из командной строки. Чтобы запустить
программу из командной строки в среде Mac OS X, откройте приложе&
ние Terminal в папке Utilities. Чтобы запустить программу из команд&
ной строки в среде Windows, выполните команду Run в меню Start и
введите «command».
Если вы не умеете работать с командной строкой или у вас нет опыта
компилирования, я советую вам найти версию FFmpeg с пользователь&
ским интерфейсом, разработанную для вашей операционной системы:
FFmpegX для Mac OS X (http://homepage.mac.com/major4; стоит
15 долл. США) или MeWIG для Windows (http://mewig.sourceforge.net;
бесплатная версия).

Распространение вашего фильма
Для любого формата предпочтительно применять определенный кодек (или ко&
деки). Вы можете распространять свой фильм самыми различными способами: на
видеокассете, на DVD (совет 79), на VCD (совет 78), в сети Интернет (совет 83),
в локальной сети (совет 86) или даже через мобильный телефон (совет 89).

Убедитесь в том, что выбранный вами формат является приемлемым для пред&
почтительного способа распространения (совет 77). Не совсем понятно, что имен&
но (кодировка или распространение) является приоритетным. Определитесь
с выбором (например, вы собираетесь распространять данные на DVD), и вы сра&
зу поймете, что следует сделать (использовать кодек MPEG&2).

Рассеивающий фильтр для портретной съемки
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• поставьте актера на расстоянии не менее 10 футов от фона. Фон должен со&
держать небольшое количество отвлекающих элементов, например зеленые
кусты, деревянный забор или даже стену дома;

• используйте рассеянное освещение (например, снимайте сцену в сумерках).
Если солнце светит очень ярко, вы можете поставить актера в тень от дерева и
применить отражающую панель (см. совет 24). Как правило, лучшее время
для съемок – до 10 ч утра или после 4 ч вечера;

• выполняйте различные снимки и по&разному растягивайте чулки перед
объективом камеры. Вы не сможете выбрать оптимальный снимок с помощью
LCD&монитора камеры. Следовательно, чем больше кадров вы сделаете и заг&
рузите на свой компьютер, тем выше вероятность успеха.

Если вы не можете сделать нужный снимок с помощью одной пары чулок, по&
пробуйте использовать другую пару. Результат вас приятно удивит.

Совет 31 Конвертирование из формата PAL в NTSC

Вы можете выполнить снимок в формате PAL и конвертировать его в формат
NTSC, чтобы использовать более широкий диапазон цветов.

Цифровое видео бывает двух форматов: PAL (используется в Европе, Азии и
Австралии) и NTSC (используется в Северной Америке). Формат PAL отличает&
ся более высоким разрешением и богатыми цветами. Вы можете выполнить съем&
ку в формате PAL, а затем конвертировать файл в формат NTSC.

Формат PAL
PAL – это более сложный формат, использующий более естественные цвета, более
высокое разрешение и частоту смены кадров, которая ближе к частоте смены кад&
ров в кино (25 кадров/с и 24 кадра/с). Кроме того, формат PAL отличается боль&
шим размером кадра (720 на 576 пикселей; в формате NTSC размер кадра состав&
ляет 720 на 480 пикселей), поэтому полученное изображение выглядит крупнее.

Большинство цифровых камер поддерживают формат PAL, а не формат NTSC.
Видеофильм в формате PAL выглядит лучше, чем в NTSC. Однако такой фильм
не будет воспроизводиться на DVD и VHS&плеерах NTSC. Вы даже не сможете
просмотреть видеофильм PAL на телевизоре, произведенном в США. Впрочем,
при необходимости вы можете произвести съемку в формате PAL, а затем конвер&
тировать файл в формат NTSC.

Конвертирование из формата PAL в формат NTSC
Коммерческие студии очень часто берут деньги за эту услугу (до 300 долл. США
за одну кассету). При этом результат не всегда оказывается оптимальным. Впро&
чем, вы можете выполнить конвертирование и в домашних условиях. Для этого
воспользуйтесь утилитой DVFilm Atlantis 2 (http://www.dvfilm.com; стоит
195 долл. США), которая поддерживает операционные системы Windows и Mac.

Для функционирования программы Atlantis вам необходимо установить
приложение QuickTime 6 (поставляется на CD&диске Atlantis) или
QuickTime 6.5.1. Вы не должны использовать версию QuickTime 6.5.

Программа Atlantis поможет вам и в случае, если вы работаете над проектом
в формате NTSC вместе с коллегами, которые ведут съемки в формате PAL. Я по&
ступаю именно так во время работы над своим новым фильмом, «Хуберт Селби
(Hubert Selby): Завтра будет лучше, чем вчера». Многие интервью были сняты
моими друзьями в Европе, что позволило мне сэкономить время и деньги на поез&
дках туда.

Подготовка к конвертированию
Для начала вы должны записать материал на жесткий диск в файл с данными.
Необходимо выполнить экспорт файла в формате без сжатия. Программа Atlantis
может работать с файлами QuickTime или AVI. Экспорт поддерживается практи&
чески всеми видеоредакторами. Как правило, соответствующая функция нахо&
дится в меню File ⇒ Export Timeline/Movie. На рис. 3.13 показаны первые дей&
ствия, которые следует выполнить для экспорта фильма в приложении Adobe
Premiere.

Рис. 3.11. Портретный снимок
без фильтра

Рис. 3.12. Портрет, сделанный
с помощью колготок

Конвертирование из формата PAL и NTSC
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Рис. 3.13. Экспортируем шкалу времени
из программы Adobe Premiere

Лично я предпочитаю использовать формат Microsoft AVI. Мне он
больше нравится, чем формат QuickTime (хотя теоретически никакого
различия между ними быть не должно). Кроме того, в этом формате
экспорт выполняется быстрее, чем во многих других.

Вам понадобится настроить формат, кодек, частоту смены кадров и скорость
воспроизведения звука для вашего фильма. На рис. 3.14 показано диалоговое
окно Export Movie (Экспортировать фильм) для приложения Adobe Premiere.
Обратите внимание на кнопку Settings (Настройки), а также на текущие на&
стройки экспорта в нижней части окна.

Вам понадобится просмотреть настройки в редакторе, чтобы убедиться в том,
что вы выполняете экспорт материала в формате PAL. По умолчанию для экспор&
та выбирается формат NTSC. Если вы измените настройки, после конвертирова&
ния не забудьте их восстановить. На рис. 3.15 показаны параметры экспорта для
приложения Adobe Premiere. Обратите внимание: опция Pixel Aspect Ratio
(Размер пикселя) сконфигурирована как D1/DV NTSC; эту настройку следует
изменить.

Процесс визуализации займет некоторое время (примерно 10 мин на одну ми&
нуту видео; зависит от скорости вашего компьютера). После завершения визуали&
зации переместите файл в программу Atlantis.

Рис. 3.14. Окно Export Movie

Рис. 3.15. Экспортируем файл DV AVI в формате PAL

Конвертирование из формата PAL и NTSC
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Используем приложение Atlantis для конвертирования
Программа Atlantis – это небольшая утилита (350 Кб для Windows и 219 Кб для
Mac), которая является образцом простоты. В отличие от многих других про&
грамм, которые содержат множество ненужных функций, приложение Atlantis
предназначено для решения всего одной задачи. Оно конвертирует материал из
формата PAL в формат NTSC (или наоборот).

Если вы дважды щелкните по файлу программы, на экране откроется окно
с приветствием, как показано на рис. 3.16.

услышите звуковой сигнал, а на экране появится сообщение «Processing comp

leted OK» («Процесс успешно завершен»).

Затем вы сможете импортировать видео в проект NTSC, записать его на кассету
или  DVD.

Дополнительная информация для хакеров
При необходимости вы можете использовать приложение Atlantis для конверти&
рования из формата NTSC в формат PAL. Это очень удобно в случае, если вы со&
здаете проект в формате NTSC, но вам нужно сделать копию для распространения
его в Европе или отправить его на фестиваль.

Рис. 3.16. Ниспадающий экран
с приветствием в программе Atlantis

Чтобы воспользоваться приложением, переместите на экран ваш видеофайл.
Откроется ниспадающее меню со списком опций. Помимо конвертирования из
формата PAL в формат NTSC, вы можете поэкспериментировать с заголовками,
добавить сетку или изменить цвета (см. рис. 3.17).

Я рекомендую вам поэкспериментировать с заголовками, сеткой и другими оп&
циями, после того как вы научитесь выполнять простое конвертирование. Чтобы
начать конвертирование, нажмите кнопку Start. После этого на экране появится
строка состояния, которая показывает, сколько времени осталось до завершения
процесса (см. рис. 3.18).

Все остальное будет выполнено автоматически. Программа сама проведет
конвертирование в новый файл под названием New movie. После завершения вы

Рис. 3.17. Опции конвертирования в программе Atlantis

Рис. 3.18. Строка статуса для конвертирования

Конвертирование из формата PAL и NTSC
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Программа Atlantis сообщит вам, с каким типом файла вы работаете. Если вы
переместили файл в формате NTSC, будет выполнено конвертирование в формат
PAL, и наоборот.

Помните о том, что если в папке уже есть файл New movie, он будет
переписан. Чтобы этого избежать, воспользуйтесь функцией пакетной
обработки.

Вы можете активировать команду Batch (Пакет) в интерфейсе, чтобы выпол&
нить пакетную обработку группы файлов. Я часто так делаю, перед тем как пойти
спать; к утру процесс обычно завершается.

Не стоит беспокоиться о звуке; он тоже будет конвертирован.
Мне остается только восхититься возможностями программы Atlantis. Вряд ли

существует более элегантное решение данной проблемы.

Совет 32 Записываем изображение
с телевизионного экрана без мерцания

Если вы снимаете сцену, в которой виден экран телевизора или компьютерного
монитора, вы можете заметить, что он мерцает. Используя простые регулировки,
вы можете устранить этот эффект или свести его к минимуму.

Очень часто во время просмотра видео вам приходится обращать внимание на
то, что экран телевизора или монитора на фоне изображения мигает. Это связано
с тем, что частота обновления кадров на телевизоре отличается от частоты, с кото&
рой ведется запись. Вы можете полностью устранить мерцание или минимизиро&
вать его (зависит от ситуации).

Запись изображения на экране телевизора
Снимать экран телевизора проще, чем компьютерный монитор. Так как частота
смены кадров на телевизоре почти совпадает с частотой смены кадров на камере, вы
можете заметить лишь незначительное мерцание изображения. Появление мерца&
ния вызвано тем, что существует небольшое различие между моментом отображе&
ния кадра на экране телевизора и моментом, когда оно записывается на камеру.

В США телевизоры имеют питание 60 Гц, а в Европе – 50 Гц. Если вы
выполните простой расчет, вы определите, что формат NTSC имеет
частоту смены кадров 30 кадров/с, а формат PAL – 25 кадров/с.
Случайность? Вовсе нет. Частота смены кадров непосредственно
связана с параметрами электрического тока. За дополнительной
информацией обратитесь по адресу: http://en.wikipedia.org/wiki/
Interlace.

Проще говоря, когда вы включаете камеру, она начинает запись на своей часто&
те смены кадров. Первый кадр записи имеет настройки времени, которые отлича&
ются от настроек времени телевизора. В результате на экране появляется эффект
мерцания. На рис. 3.19 показано мерцание на телевизоре, записанное на камеру
PV GS&120 MiniDV. Обратите внимание на серую полосу в верхней части экрана;
именно благодаря этому эффекту возникает мерцание.

Рис. 3.19. Мерцающий экран телевизора

Чтобы устранить мерцание экрана, отключите функцию стабилизации изобра&
жения на вашей камере. К примеру, камера Panasonic PV GS&120 имеет функцию
Electronic Image Stabilization (EIS). Если вы ее отключите, камера будет записы&
вать изображение без мерцания. На рис. 3.20 показано, как выглядит экран теле&
визора на камере Panasonic PV GS&120 с отключенной функцией EIS.

Рис. 3.20. Отключаем стабилизацию изображения,
чтобы устранить эффект мерцания

Конвертирование из формата PAL и NTSC
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П. Если вы используете камеру, которая поддерживает частоту смены
кадров 24 кадра/с (например, Panasonic AG&DVX100), для удаления
мерцания вам необходимо изменить настройку (допустим, выбрать
значение 29,97 кадра/с для формата NTSC). Не забудьте при этом
отключить стабилизацию изображения.

Запись изображения с компьютерного монитора
Записать изображение с компьютерного монитора несколько труднее, чем с теле&
визора. Это связано с тем, что частота обновления экрана телевизора является
фиксированной и не зависит от модели. Частота обновления экрана монитора оп&
ределяется настройками пользователя, а также его возможностями.

Частота обновления монитора воздействует на скорость мерцания. Чем больше
частота обновления, тем быстрее мерцает экран монитора. На рис. 3.21 показан
кадр видео, записанный при использовании частоты обновления монитора, кото&
рая составляет 85 Гц.

ния на камере. Однако вы не можете точно выбрать нужное значение частоты
обновления экрана для монитора, поэтому небольшое мерцание все же сохра&
нится. На рис. 3.23 показано, как выглядит изображение на экране монитора
(60 Гц) после отключения функции стабилизации камеры. Незначительное мер&
цание сохранилось. Обратите внимание на светло&синюю линию в нижней части
экрана.

Рис. 3.21. При частоте обновления 85 Гц
монитор мерцает достаточно быстро

Чтобы уменьшить скорость мерцания, вы должны выбрать частоту обновления
монитора, которая может делиться на значение для камеры. Например, если вы
ведете запись с частотой смены кадров, равной 29,97 кадра/с, следует выбрать для
монитора настройку 60, 90 или 120 Гц (я выполняю округление, потому что мони&
торы не поддерживают такие значения, как, например, 59,94 Гц). На рис. 3.22 вы
видите кадр видео, записанный при использовании частоты обновления монито&
ра, которая составляет 60 Гц.

Как и при корректировке мерцания на экране телевизора, вы можете значи&
тельно снизить мерцание путем отключения функции стабилизации изображе&

Рис. 3.22. Частота обновления экрана монитора составляет 60 Гц.
Экран немного мерцает

Рис. 3.23. Так выглядит экран монитора
после отключения функции стабилизации камеры

Как правило, вы не можете полностью устранить мерцание на экране компью&
терного монитора. Однако вы можете уменьшить эффект мерцания, что, в свою
очередь, привлечет внимание аудитории.

Конвертирование из формата PAL и NTSC
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Совет 33 Импорт материала с DVD

Вы когда&нибудь мечтали о том, чтобы взять интервью у Харрисона Форда (Har&
rison Ford)? Импортируйте материал с DVD, и вы сможете снять в своем следую&
щем фильме настоящую звезду.

Вы хотите попросить Джулию Робертс (Julia Roberts) поаплодировать успехам
вашей маленькой дочки в футболе и заснять эту сцену на видео?

– Добрый день. Я могу поговорить с Джулией Робертс?
– А кто ее спрашивает?
– Это маленькая девочка из штата Огайо.
Короткие гудки отбоя.
Цитата из фильма Фрэнсиса Форда Копполы (Francis Ford Coppola) «Сердца тьмы».

Так все и будет, если ваша дочь попробует сама уговорить Джулию Робертс
принять участие в съемках. Конечно, я немного преувеличиваю, но идею вы поня&
ли – вам вряд ли удастся снять звезд в своем видео, если только вы не научитесь
использовать кадры из их фильмов. К счастью, вы можете импортировать матери&
ал с DVD и добавлять его в свой проект.

Определитесь с вашим потребностями
Вы можете без труда подключить DVD&плеер к компьютеру. Все, что вам нужно, –
это конвертировать аналоговый сигнал в цифровой; с такой задачей справится лю&
бой адаптер (см. совет 37). Но если во время оцифровки вы заметите, что изображе&
ние становится более темным, скорее всего, это значит, что ваш DVD&диск защищен
от копирования с помощью функции Macrovision. В данном случае для оцифровки
материала вам придется выполнить некоторые дополнительные действия.

За дополнительной информацией о DVD и функции Macrovision обрати&
тесь по адресу: http://www.dvddemystified.com/dvdfaq.html.

Чтобы импортировать материал с DVD&диска, защищенного функцией Macro&
vision, вам необходимо передать стабильный сигнал с плеера на компьютер. Для
этого вам понадобится корректор времени (TBC), адаптер или видеокарта PCI.
Следовательно, вы не сможете использовать вход IEEE&1394 (FireWire или
i.LINK), который применяется в обычных обстоятельствах.

Подавляющее большинство фильмов защищены законом об авторских
правах. Если вы собираетесь использовать материал из фильма, убеди&
тесь в том, что вы имеете на это право. Университет Стэнфорда
имеет свой сайт, который посвящен авторским правам
(http://fairuse.stanford.edu/).

Использование корректора времени
Существуют определенные типы оборудования (кроме адаптеров, о которых мы
поговорим в следующем разделе), позволяющие вам импортировать материал
с DVD. Корректоры времени (time base correctors) помогают вам стабилизировать
видеосигналы в процессе их передачи между различными системами. Следова&
тельно, такие устройства могут конвертировать сигнал, защищенный функцией
Macrovision.

Корректоры времени относятся к профессиональным устройствам, поэтому
они стоят достаточно дорого. Самые дешевые модели, такие как DataVision TBC&
1000 или AVToolbox AVT&8710, продаются по цене около 300 долл. США. Компа&
ния Sima Products Corporation (http://www.simacorp.com) производит линию
устройств Video Enhancement и Duplication. Несмотря на то что технически дан&
ные устройства не являются корректорами времени, они могут удалять функцию
Macrovision из видеосигнала. Вы можете найти некоторые модели корректоров
времени в сети Интернет на сайте eBay.

Если вы записали материал в устаревшем формате VHS, а качество
изображения затем ухудшилось, вы сможете использовать некоторые
корректоры времени для устранения этой проблемы. Вам доступны
такие опции, как регулировка контраста, яркости и резкости.

Если вы решили работать с корректором времени, вам понадобится оцифро&
вать выходной сигнал устройства. Следовательно, вы должны использовать адап&
тер или карту PCI. К счастью, вам не придется тратить много времени на выбор:
вы можете просто выбрать устройство, которое работает с вашей системой.

Использование адаптера
Если вас беспокоит вопрос аппаратной совместимости вашего оборудования, вам
может помочь адаптер. Многие адаптеры поддерживают функцию Plug&and&Play,
поэтому вы можете просто подключить их к компьютеру и приступить к конвер&
тированию материала. Адаптер имеет несколько разъемов, которые могут воспри&
нимать видео& и аудиосигналы, а затем конвертировать их в указанный вами тип
сигнала.

Некоторые адаптеры, например Miglia Director Cut (http://www.miglia.com; сто&
ит 269 долл. США), игнорируют сигнал Macrovision, а другие, такие как Canopus
ADVC&100 (http://www.canopus.com; стоит 249 долл. США), необходимо соответ&
ствующим образом настроить. Выполните следующие действия, чтобы сконфигу&
рировать адаптер Canopus ADVC&100 на конвертирование видеосигнала.

1. Отключите все переключатели в нижней части адаптера.
2. Подсоедините DVD&плеер к адаптеру посредством кабеля S&Video или RCA.
3. Подсоедините адаптер к компьютеру через порт IEEE&1394.
4. Включите питание DVD&плеера, компьютера и адаптера.

Импорт материала с DVD
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5. Запустите программу, которую вы будете использовать для записи видео.
6. При возможности настройте эту программу на запись вручную.
7. Начните воспроизведение DVD.
8. Если запись на DVD защищена функцией Macrovision, красный индикатор

загорится.
9. Нажмите и удерживайте кнопку Input Select (Выбор входного сигнала) до

тех пор, пока индикатор не погаснет.
10. Отпустите кнопку Input Select и убедитесь в том, что индикатор Analog In

(Аналоговый входной сигнал) горит.
11. Если индикатор Analog In не горит, нажмите кнопку Input Select, чтобы пе&

реключить режим из Digital In в Analog In.
12. Начните оцифровку.

В новых версиях устройства Canopus ADVC&100, которые продаются
на рынке США, эта опция отсутствует.

Использование карты PCI
Как и адаптеры, некоторые компьютерные видеокарты игнорируют сигнал Mac&
rovision. Карта Happauge WinTV&GO относится к таким устройствам и стоит все&
го 50 долл. США.

Кроме функции записи DVD&материала, видеокарта WinTV&GO поддерживает
ТВ&тюнер (125 каналов); следовательно, вы можете подключить кабель и выпол&
нить оцифровку своих любимых телевизионных программ. Другие видеокарты
Happauge тоже позволяют импортировать материал с DVD; при желании вы мо&
жете купить карту с FM&тюнером или функцией Dolby Surround.

Использование программного обеспечения
Существует большое количество программ, которые могут копировать материал
с DVD. Попробуйте найти текст «dvd copy» или «dvd rip» в системе Google (http://
www.google.com). К сожалению, многие приложения способны копировать только
весь диск целиком, а не отдельные кадры. Кроме того, обычно данные кодируются
кодеком MPEG&2.

Если вы собираетесь использовать такую программу для импорта материала
с DVD в свой проект, скорее всего, вам придется скопировать весь диск, а затем
декодировать данные (см. совет 29) с помощью оригинального кодека (с большой
вероятностью DV). Процесс может занимать много времени, особенно если вам
нужен всего лишь один кадр!

Информацию и поддержку (через пользовательские форумы) вы сможете най&
ти на следующих сайтах:

• http://www.afterdawn.com;
• http://www.doom9.net;
• http://www.videohelp.com.

Эти ресурсы содержат много полезных сведений. Когда у вас появится свобод&
ное время, посетите их и изучите различные темы на форумах.

Вы должны знать, что именно вы используете
Не имеет значения, какое именно решение вы выбрали, – вам необходимо убедить&
ся в том, что для импорта материала вы выбрали формат, который будет использо&
ваться при редактировании. При применении любого устройства вам необходимо
конвертировать аналоговый сигнал в цифровой, поэтому вы должны оцифровать
DVD&материал с настройками, соответствующим параметрам вашего проекта. Если
проект относится к формату DV, во время оцифровки выбирайте опцию DV.

Совет 34 Применение формата HDV для улучшения
качества цифрового DV/видео

Даже если вы не собираетесь создавать проект с высоким разрешением, примене&
ние формата HDV может привести к интересным результатам.

Видео с высоким разрешением (HD) часто ассоциируется с форматом HDTV
(High Definition Television). Следует помнить о том, что, в отличие от HDTV,
HD – это не формат данных.

Вы можете использовать HD&камеру для записи материала HDTV, как, впро&
чем, и для записи материала для цифрового кинотеатра, обычного телевидения
или даже сети Интернет.

Что такое «высокое разрешение»?
Для начала мы дадим определение понятию «высокое разрешение». HD&видео –
это видео, качество которого выше, чем качество сигнала D&1 NTSC с разрешени&
ем 720 × 486. Следовательно, HD представляет собой не стандарт, а категорию.

В форматах DV и DVCPro видео записывается с разрешением 720 × 480
(NTSC).

Некоторые HD&камеры (например, Thomson Viper и Sony HDW&950), а также
редакторы (например, Final Cut Pro HD и Adobe Premiere Pro) поддерживают раз&
личные HD&форматы. Это такие популярные форматы, как 720p и 1080i. Некото&
рые форматы работают с более широкими диапазонами цветов. Некоторые форма&
ты имеют более высокое разрешение. Некоторые просто отличаются друг от друга.
В целом можно заметить, что термин «HD» является достаточно нечетким.

Что представляет собой формат «HDV»?
HDV – это версия формата DV с высоким разрешением. Формат HDV использует
кодировку MPEG&2, чтобы конвертировать изображение (1920 × 1080) в формат
MiniDV. HDV представляет собой новый стандарт; однако с появлением на рынке

Применение формата HDV для улучшения качества цифрового DV/видео



132 Запись материала 133

модели камеры Sony HDR&FX1 (http://www.sonystyle.com; стоит 3699 долл. США)
он с большой вероятностью станет популярным среди продюсеров видео& и кино&
фильмов, а также в сфере кабельного телевидения.

Формат HDV бывает двух видов: 1080i и 720p. Стандарт 1080i представляет
собой изображение из 1080 строк с 1920 пикселями в строке. Формат 720p содер&
жит 720 строк с 1280 пикселями в строке (см. рис. 3.24). Так как стандарт HDV
отличается высокой степенью сжатия данных, скорость передачи информации
является сопоставимой с форматом DV. Вы можете записывать видео с HDV&ка&
мер через порт FireWire (интерфейс FireWire способен работать и с другими
сложными форматами, например Panasonic DVCPRO HD).

Компания Sony выпустила новый формат пленки, предназначенный
для HDV&камер. Этот формат позиционируется как высококачествен&
ный (низкий процент пропущенных кадров) и оптимизированный
для камеры Sony HDV. Тем не менее вы можете без проблем использо&
вать пленки в формате MiniDV.

Скорее всего, вы сейчас думаете: «Но формат DV имеет свои особенности. Если
я выполню конвертирование, я потеряю все преимущества в качестве, которые
предоставляет формат HDV». Разумеется, качество ухудшится, но результат бу&
дет лучше, чем при использовании обычного DV&формата.

Представьте себе ваше любимое телевизионное шоу. Обычно вы смотрите про&
грамму, которая была записана на кинопленку (35 мм), а затем конвертирована
в формат с менее высоким разрешением. Вы без труда сможете определить разли&
чие в качестве между телевизионным шоу и коммерческими рекламными ролика&
ми, которые были сняты в формате DV, а затем конвертированы в формат телеви&
дения. Цвета являются более богатыми, а изображение имеет большую глубину.
В обоих случаях вы просматриваете один и тот же материал (в телевизионной
программе или на кабельном телевидении), но вы сможете без усилий отличить
кино от видеозаписи.

Теперь мы поговорим о чем&нибудь более знакомом. Возьмите напрокат и по&
смотрите свой любимый голливудский блокбастер на DVD. Затем посмотрите
свой видеофильм о семейном отдыхе, который вы сняли на камеру, а потом пере&
писали на DVD с помощью компьютера своего брата. Если только вы не путеше&
ствовали вместе со съемочной группой, различие между двумя фильмами будет
очевидным.

Мы не будем обсуждать качество содержимого. Мы очень трогательно
относимся к своему домашнему видео и часто даже готовы поверить
тому, что оно не уступает блокбастерам.

Это правило распространяется на все DV&проекты. Если вы начинаете работу
с высококачественного материала, это позволит вам улучшить общее качество
проекта, причем независимо от конечного формата. Если вы уже готовы к допол&
нительным расходам, я советую вам купить HDV&оборудование или взять напро&
кат HDV&камеру. Это не повредит вашим текущим проектам; кроме того, вы буде&
те готовы к появлению новых DVD&форматов.

Совет 35 Снимаем фильм без камеры

Даже если у вас нет видеокамеры, вы все равно сможете создать фильм, загрузив
нужный материал из сети Интернет. Web&сайт Интернет Archive содержит бес&
платный видеоматериал, который вы можете использовать в своих проектах.

Рис. 3.24. Сравнительное разрешение
для форматов DV (с прямоугольными пикселями), HDV 720p

(с квадратными пикселями) и HDV 1080i (с квадратными пикселями)

Конвертирование HDV в форматы более низкого разрешения
Так в чем же состоит хакерство? Вы можете использовать HDV&камеру для за&
писи высококачественного материала, который предназначен для конвертиро&
вания данных в формат DV для редактирования, записи на DVD (см. Совет 79)
или распространения в сети Интернет (см. совет 82). В процессе конвертирова&
ния разрешение преобразуется из высокого (HDV) в более низкое (DVD). HDV&
камеры стоят примерно столько же, сколько и DV&камеры, например Canon XL2
(http://www.canon.com; стоит 4999 долл. США). Цена одинаковая, так почему бы
не попробовать?

Вам не нужно выполнять какие&то особые действия для конвертирования. Дос&
таточно записать данные в формате HDV, а затем преобразовать их в другой фор&
мат, например VCD (см. совет 78). В результате вы сможете получить информа&
цию самого высокого качества.

Снимаем фильм без камеры
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Представьте себе, что вам понадобилось отредактировать новый проект, но
у вас нет видеокамеры. Вам поможет некоммерческий сайт Интернет Archive
(http://www.archive.org),  который была создан в качестве специальной «Интер&
нет&библиотеки». На сайте вам доступно большое количество данных, в том числе
аудио& и видеофайлов.

Также вы можете применять данные с сайта Интернет Archive
для создания снимков и переходов в ваших фильмах.

Использование архивов
Сайт Интернет Archive содержит объемную коллекцию бесплатных архивов. Пер&
вый архив, Open Source (http://www.archive.org/movies/opensource_movies.php),
содержит фильмы, которые были загружены пользователями сайта. Второй архив,
Prelinger Archive (http://www.archive.org/movies/prelinger.php) был создан в 1983 г.
Риком Прелинджером (Rick Prelinger). Этот архив включает около 2000 фильмов.

Поиск по сайту
Архивы Open Source и Prelinger относятся к коллекции Moving Images. Эта кол&
лекция состоит из большого количества разделов, в том числе Independent News,
Computer Chronicles и Future Films. Особенно интересен раздел Feature Films, ко&
торый содержит множество фильмов, начиная от боевиков и заканчивая вестер&
нами. Вы хотите снять триллер? Перейдите в раздел Mystery, соберите материал,
а затем отредактируйте его.

Все разделы архива имеют одинаковую структуру. Домашняя страница включа&
ет ссылки на самые популярные фильмы, а также те фильмы, которые пользователи
загружают чаще всего. Если вы щелкните по нужной ссылке, вы сможете прочитать
информацию о фильме, а также загрузить его. На рис. 3.25 показан список после&
дних обзоров и ссылок на соответствующие фильмы в разделе Open Source.

Во время поиска по сайту меня заинтересовал фильм «Как выжить среди зом&
би» (см. рис. 3.25). Я щелкнул по ссылке и открыл страницу с информацией. За&
тем я обнаружил, что этот проект был создан из двух других фильмов, «Ночь жи&
вых мертвецов» («Night of the Living Dead») и «Амид, мертвец» («Amid the Dead»),
которые тоже доступны на сайте.

На информационной странице вы найдете сведения о продолжительности
фильма, поддерживаемых форматах, а также об участниках проекта. Также вы
можете щелкать по имеющимся ссылкам, чтобы открыть другие фильмы, относя&
щиеся к одному ключевому слову.

Наконец, под разделом Keyword (Ключевое слово) указаны требования, связан&
ные с лицензией на фильм (то есть здесь имеется список действий, которые вы може&
те выполнять с этим материалом). Обязательно внимательно прочитайте лицензию и
определитесь с тем, как вы собираетесь использовать данный материал. На рис. 3.26
показана информационная страница для фильма «Как выжить среди зомби».

Рис. 3.25. Нас заинтересовал фильм «Как выжить среди зомби»
(«How to Survive a Zombie Epidemic»)

В левом верхнем углу данной страницы вы увидите кадры из фильма, которые
воспроизводятся в определенной последовательности. Эти снимки дают вам неко&
торое представление о фильме: черно&белый он или цветной, обычный или мульти&
пликационный и т. д. Если вы щелкнете по ссылке View Movie Scenes (Просмот

реть ссылки из фильма), вы сможете просмотреть фрагменты из фильма.

Загрузка фильма
Если после изучения информационной страницы вы решили загрузить фильм,
щелкните по соответствующей ссылке в разделе Download (Загрузить) справа.
Проще всего щелкнуть по ссылке правой кнопкой мыши (или выполнить
Ctrl+щелчок в среде Mac) и загрузить ссылку как файл. На рис. 3.27 показано нис&
падающее меню, в котором мы выбрали пункт для загрузки фильма.

Если вы загрузите ссылку как файл, это позволит вам сохранить фильм на жест&
ком диске вашего компьютера. После завершения загрузки вы сможете импорти&
ровать видео в вашу систему редактирования и приступить к его редактированию.

Рис. 3.26. Отсюда мы можем сделать вывод,
что Габриэль Кениг (Gabriel Koenig) – очень занятой человек

Снимаем фильм без камеры
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Некоторые видеофильмы, загруженные с сайта Интернет Archive,
могут относиться к формату, который отличается от формата
вашего проекта. В этом случае вам придется сначала конвертировать
фильм в нужный формат (см. совет 29).

При желании вы можете микшировать и совмещать материал из различных
фильмов, повторно отредактировать фильм или воспользоваться отдельным ви&
деоредактором. Кроме того, вы можете загрузить новый материал (см. совет 5) и
записать соответствующий скрипт (см. совет 7) перед началом редактирования.

Совет 36 Остановка времени

Вы можете произвольным образом изменить настройки времени, например со&
здать «эффект Матрицы».

Недавно я узнал, что могу самостоятельно создать так называемый «эффект
остановки времени», известный по фильму «Матрица». Под «остановкой време&
ни» я имею в виду визуальный эффект (описанный далее в этом разделе), при ис&
пользовании которого какое&то действие останавливается, а камера начинает пе&
ремещаться в пространстве. Данный эффект известен уже на протяжении 20 лет,
однако особую популярность он приобрел совсем недавно, после выхода фильма
«Матрица».

Обращаемся к прошлому
Лично меня очень удивил тот факт, что методика применения эффекта останов&
ки времени сейчас подается как нечто революционное. Почему? Впервые эф&
фект «движущегося изображения» был снят почти 100 лет назад; для этого ис&
пользовалась группа камер, которые располагались вдоль скаковой дорожки.

Камеры были подсоединены к проводам и делали снимки в момент, когда ло&
шадь скакала мимо.

Поговаривают, что к этому трюку решили прибегнуть для того, чтобы решить
давний спор: отрывает ли лошадь на скаку все четыре ноги от земли или нет (как
выяснилось, да). Однако в результате возник побочный эффект: движущееся
изображение лошади. Очень похожая методика применяется сейчас, почти
100 лет спустя, и позволяет остановить время!

Первое решение
В статье «Magic Morphing» Скотта Андерсона (Scott Anderson), опубликованной
в журнале «Videomaker» в июне 2001 года, говорилось, что впервые эффект «оста&
новки времени» удалось снять в 1980 г. студенту по имени Тим Макмиллан (Tim
Macmillian). Он составлял коллаж из фотографий, сделанных под разными угла&
ми. По мере того как Тим добавлял в коллекцию все больше и больше камер, он
дошел до точки, когда имеющегося количества камер стало недостаточно. Чтобы
решить данную проблему, он создал новую камеру.

Эта камера представляла собой большой деревянный ящик с отверстием, ок&
ном и дверцей, в которых Тим просверлил несколько круглых отверстий. Если
закрыть дверцу, съемка выполняется через отверстия. В результате при быстром
перемещении по изображениям действие «останавливалось», а в кадре формиро&
вался эффект движущейся камеры.

Использование аппаратных средств и программного обеспечения
Во время работы над созданием фильма «Матрица» дизайнер по спецэффектам
Джон Гаета (John Gaeta) значительно усовершенствовал эту методику и поднял
ее на новый уровень. В этом проекте Джон впервые выдвинул следующую идею:
неподвижные камеры (управляемые компьютером) делают снимки поочередно,
с интервалом в одну секунду, что позволяет сформировать эффект перемещения
камеры и не остановки, а замедления времени. Кроме того, Джон использовал оп&
ределенное программного обеспечение, чтобы смягчить переход между снимка&
ми. Съемка эффекта была выполнена в помещении с зеленым экраном.

В США авторство эффекта приписывают Дэйтону Тэйлору
(Dayton Taylor). Его компания, DigitalAir (http://www.digitalair.com),
обладает патентами не только на использование камер, но и на сам
спецэффект.

Так как же называется этот эффект? Тим Макмиллан называл его «фрагмент
времени», сотрудники компании Manes Studios (то есть создатели фильма «Мат&
рица») – «плавное движение», а Джон Гаета – «остановка времени» («bullet time»).
Также данный эффект известен как «temps mort» («мертвое время»), «трек време&
ни», «виртуальная камера», «мультикамера» и (для зрителей финала Кубка Аме&
рики по футболу) как «EyeVision». Лично я полагаю, что это очень интересный
спецэффект, и его название большого значения не имеет.

Рис. 3.27. Загружаем фильм «Как выжить среди зомби»

Остановка времени
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Формируем эффект
Далее мы поговорим о том, как вы можете смоделировать данный эффект с помо&
щью своих друзей и шести видеокамер.

Подготовка к снимку
Для съемок вы должны подготовить шесть видеокамер и расположить две из них
под углом в 90°. Если вам даже не удастся добиться нужного результата, с этих
камер вы сможете сделать интересные снимки. Между двумя «угловыми» камера&
ми расположите четыре остальные камеры по дуге.

В фокусную точку дуги следует поместить подставку для светильника. Она бу&
дет играть роль конечной точки. Затем измерьте расстояние между всеми объек&
тивами камер и высоту их положения. Добейтесь того, чтобы все камеры находи&
лись на одном расстоянии (и на одинаковой высоте) относительно конечной точ&
ки. Правильное расположение камер показано на рис. 3.28 и 3.29.

кассетах. Благодаря маркировке вы сможете без труда идентифицировать началь&
ный кадр на всех камерах. Затем вы сможете перейти к нужному событию во время
редактирования и мгновенно выбрать соответствующее событие на любой камере.

Завершаем работу над сценой
Вы можете завершить создание композиции практически в любом видеоредакторе.
Для записи синхронизированного кадра на камере следует применить инструмент
Paint или другой кадр. Затем вы сможете воспользоваться шкалой времени, которая
позволяет нужным образом совместить все шесть камер. Впоследствии с помощью
данного шаблона вы сможете выполнить столько снимков, сколько требуется.

Просмотреть полученный эффект вы можете на сайте http://www.hiddenphantom.
com/NBBF/PalmHeel.wmv (необходимо установить приложение Windows Media
Player 9 или VLC).

Совет 37 Конвертируем аналоговое видео
в цифровой формат

Специальное приложение поможет вам конвертировать устаревший материал
Hi8, VHS или Beta в цифровой формат.

Если у вас есть профессиональные видеодеки, например Sony UVW&1800
(Beta) и Sony DSR&80 (DV), вы можете соединить их друг с другом
с помощью компонентного видеоразъема и порта RS&422, чтобы выпол&
нить конвертирование в цифровой формат.

На протяжении последних нескольких лет вы записали множество часов до&
машнего видео. Вы записали дни рождения своих детей, школьные праздники и
даже целые фильмы. Теперь благодаря цифровому формату ваш материал может

Чтобы настроить панорамирование, отклонение и фокусное расстояние, вам
необходимо подключить первую камеру к видеомонитору (см. совет 11) и напра&
вить ее на подставку для светильника. Затем пометьте положение конечной точки
на экране (воспользуйтесь стираемым маркером).

Последовательно подключите все оставшиеся камеры к одному монитору и на&
стройте их на конечную точку (ориентируйтесь по меткам маркера на мониторе).
На рис. 3.30 показано, как оператор конфигурирует положение камеры с помо&
щью внешнего монитора.

Внимательно изучите полученную сцену и учтите, что в ходе финального ре&
дактирования вы сможете внести необходимые изменения.

Запись сцены
Включите все камеры; пользуйтесь раскрашенной табличкой (см. совет 9) или
вспышкой камеры, чтобы выделить каждое событие и промаркировать его на всех

Рис. 3.28. Устанавливаем
основные камеры по дуге

Рис. 3.29. Измеряем расстояние
между всеми камерами.

Это очень важно!

Рис. 3.30. Настраиваем камеру
с применением внешнего монитора

Конвертируем аналоговое видео в цифровой формат
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получить новую жизнь. Используя два видеомагнитофона, вы сможете конверти&
ровать аналоговые записи в цифровой формат.

Определитесь с вашими потребностями
Вы должны решить, будете ли вы записывать конвертированный материал на цифро&
вую видеопленку или на жесткий диск компьютера. Для редактирования вам необхо&
димо выполнить запись на пленку, потому что вам понадобится работать с временной
кодировкой (см. совет 4). Кроме того, для длительного хранения надежнее использо&
вать видеопленку. Если вы конвертируете аналоговое видео и запишите полученные
данные на жесткий диск, сохранить временную кодировку будет невозможно.

Если вы собираетесь использовать конвертированный материал
в проекте, убедитесь в том, что вы правильно выбрали кодек. Напри&
мер, если вы редактируете проект в формате DV, вы должны выпол&
нить конвертирование с применением DV&кодека.

Сохранение временной кодировки
Существует большое количество устройств для конвертирования. Такие устрой&
ства могут стоить от 100 до 3000 долл. США, поэтому я советую вам в первую
очередь определиться с вашими потребностями. Если у вас нет библиотеки анало&
гового материала (к примеру, BetaSP), как правило, вам не придется тратить мно&
го денег на закупку аппаратных средств.

Большинство устройств конвертирования обеспечивают двусторонний про&
цесс, то есть конвертирование из аналогового формата в цифровой и наоборот.
Следовательно, вы можете преобразовать аналоговые записи в цифровые, конвер&
тировать цифровой материал в формат VHS и даже отобразить цифровой сигнал
на экране телевизора.

Некоторые видеокамеры могут конвертировать аналоговые данные на
входе в цифровой сигнал на выходе; за подробной информацией обрати&
тесь к руководству пользователя. Процесс конвертирования аналого&
вых данных на входе в цифровой формат на выходе часто называют
«проходным сигналом».

Если вы собираетесь конвертировать аналоговые данные, которые содержат
временную кодировку (например, BetaSP или 3/4"), проверьте, может ли ваше
устройство ее обрабатывать. Некоторые устройства, такие как ProMax ProMedia
Converter (http://www.promax.com/Products/Detail/27187; стоит 1495 долл. США),
могут преобразовать аналоговую временную кодировку в цифровую; другие,
к примеру Canopus ADVC&500 (http://www.canopus.us/US/products/ADVC500/
pm_ADVC500.asp; стоит 1649 долл. США), – нет.

Если вы планируете конвертировать устаревший материал в формате VHS или
Hi&8, вы можете купить простое устройство, допустим, Canopus ADVC&55 (http://

www.canopus.us/US/products/ADVC110/pm_advc55.asp; стоит 229 долл. США)
и сэкономить более 1000 долл. США.

Терминология
При покупке высокотехнологичного устройства очень сложно не запутаться
в терминологии. Приведу список различных терминов, в которых вам необходимо
ориентироваться:

• композитный видеосигнал (Composite Video). Соединение, в котором комби&
нируются такие функции, как освещенность и цветность; обычно для переда&
чи данного сигнала используется разъем RCA;

• сигнал S&Video. Соединение, в котором функции освещенности и цветности
разделяются;

• компонентный видеосигнал (Component Video). Соединение, в котором фун&
кции освещенности и цветности разделяются; часто используется для обозна&
чения более сложного сигнала, например S&Video;

• SDI. Последовательное цифровое соединение, которое применяется для пе&
редачи видеосигнала; используется только профессионалами;

• AES/EBU. Цифровой аудиостандарт, который применяется в США и Евро&
пе; используется только профессионалами.

Если только у вас нет серьезной необходимости в том, чтобы работать с сигна&
лами Component Video, SDI или AES/EBU, для передачи материала вам должно
хватить возможностей сигналов S&Video или Composite (RCA) Video. Если вам
раньше не приходилось слышать об этих терминах, вы вполне можете без них
обойтись. Другими словами, если вы собираетесь конвертировать устаревшие за&
писи в формате VHS, не нужно покупать устройство с разъемами SDI. Вы не буде&
те его использовать; зачем же платить лишние деньги?

Запись на видеопленку
Перед тем как приступить к записи данных на цифровую видеопленку, выясните,
какие функции записи видеосигнала поддерживает ваша камера или дека. Боль&
шинство цифровых видеопленок имеют продолжительность воспроизведения 60
мин. Однако некоторые системы позволяют вам записывать данные как в стан&
дартном (SP; 60 мин), так и в расширенном формате (LP; 90 мин).

Компания Sony предлагает методику записи цифрового видео, которая
называется DVCAM. Этот формат осуществляет запись на стандар&
тную пленку MiniDV, однако скорость выше обычной примерно на 33%.
Поэтому на кассету продолжительностью 60 мин вы сможете запи&
сать всего 40 мин видео. Если у вас есть камера или дека производства
Sony, убедитесь в том, какую именно методику вы используете. Это
позволит вам понять, сколько времени вам действительно доступно.

Конвертируем аналоговое видео в цифровой формат
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При записи цифровой кассеты в режиме LP качество звука ухудшится. Некото&
рые системы редактирования не позволяют вам микшировать материал SP и LP,
а другие требуют выполнять визуализацию звука в случае, если форматы разли&
чаются. Чтобы избежать проблем, постоянно следите за тем, в каком режиме вы
ведете запись. Старайтесь не менять режим при переходе к другой кассете.

Обратите внимание на продолжительность воспроизведения конвертируемого
материала. Это поможет вам определить, можно использовать вашу камеру (деку)
в процессе конвертирования или нет. Разумеется, если у вас есть кассета VHS
(с продолжительностью воспроизведения 120 мин) с материалом, вы не сможете
уместить всю информацию на кассету MiniDV (с продолжительностью воспроиз&
ведения 60 мин) даже в режиме LP. В этом случае вам придется разделить инфор&
мацию с кассеты VHS между двумя кассетами MiniDV.

Запись на жесткий диск
Если вы собираетесь записывать конвертированный материал на жесткий диск,
вам понадобится использовать несколько различных дисков. В среднем один час
цифрового видео требует около 13 Гб на жестком диске. К счастью, жесткие диски
дешевеют с каждым днем (по крайней мере, существует такое впечатление), и на
рынке вы уже можете найти даже диски емкостью 1 Тб (1000 Гб).

Для записи материала на жесткий диск вам понадобится использовать про&
граммное обеспечение, позволяющее сохранить видео в файле. С большой вероят&
ностью ваша система редактирования сможет выполнить оцифровку материала;
возможно, ваше устройство конвертирования поставляется в комплекте с такой
программой. Если вы осуществляете оцифровку кассеты, которая не содержит
временной кодировки (например, VHS), ваша система предупредит вас об этом.
Вы не сможете работать с кодировкой.

После завершения конвертирования вы сможете использовать материал в про&
екте, заархивировать его на DVD (см. совет 79), разместить в сети Интернет (см.
совет 82) или сохранить на жестком диске компьютера.

Совет 38 Создание трехмерного видео

Для создания трехмерного видео вам необязательно покупать дорогое оборудование.
В 1950&е гг. все кинорежиссеры активно увлекались трехмерным видео. Посе&

тители кинотеатров тратили деньги на покупку дешевых бумажных очков с раз&
ноцветными линзами. Сейчас мода уже прошла; впрочем, вы можете без труда
снять такое трехмерное видео.

Для этого вам понадобится выбрать определенную методику и изучить ее пре&
имущества и недостатки. Всего существует четыре методики, но только две из них
можно отнести к сравнительно недорогим: анаглиф и Pulfrich. Другие методики,
поляризация и альтернативное поле, являются весьма сложными и дорогостоя&
щими.

При применении такой трехмерной методики, как ChromaDepth®, вам
не понадобится применять к материалу дополнительные спецэффекты.
Впрочем, для создания видео вам придется следовать определенным
правилам. Подробную информацию вы найдете на Web&сайте ChromaTek
(http://www.chromatek.com/ChromaDepth_Primer/chromadepth_primer.html).
Для просмотра фильма в трехмерном режиме зрителям понадобятся
специальные очки (их тоже продает компания ChromaTek).

Создание трехмерного фильма с помощью методики анаглифов
Традиционные трехмерные фильмы, такие как «Челюсти» и «Дети шпионов», со&
здаются с применением анаглифов. Анаглифы состоят из двух изображений, ко&
торые были выполнены в одно и то же время, но под разными углами. Как прави&
ло, эти изображения сделаны в режиме «глазами пользователя» (одна камера рас&
полагается слева, а другая – справа).

К сожалению, анаглифы удобнее всего применять в черно&белом видео,
потому что для просмотра изображения используются очки
с синими и красными линзами. Поэтому, если вы собираетесь снять
трехмерный фильм, вам придется работать с черно&белым материа&
лом или смириться с тем фактом, что все прочие цвета будут удалены
после завершения работы над композицией.

После корректировки цвета и при
просмотре сквозь очки с красными и
синими линзами анаглифы кажутся
трехмерными, что связано с чув&
ством глубины. На рис. 3.31 показа&
на пара очков, которая используется
для просмотра изображений с анаг&
лифами.

Запись видео для трехмерных эффектов
Для создания анаглифа вы должны записать видеоклип на двух камерах. Если вы
собираетесь использовать несколько камер, вам придется установить в два раза боль&
ше камер, чем вы планировали. Например, если вы хотите работать с тремя камерами,
для записи изображения с анаглифами необходимо установить шесть камер.

Ваши результаты улучшатся в случае, если вы будете использовать
камеры одного производителя и одной модели. Это связано с тем, что
объективы, устройства CCD (или чипы) и другие функции различают&
ся в зависимости от производителя. Эти изменения могут повлиять
на цвет и качество полученного изображения.

Рис. 3.31. Трехмерные очки
для просмотра анаглифов

Создание трехмерного видео
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Если у вас нет двух видеокамер, для формиро&
вания эффекта трехмерности вы можете восполь&
зоваться двумя Web&камерами. В зависимости от
скорости вашего компьютера и того, каким про&
граммным обеспечением вы собираетесь пользо&
ваться, вам может потребоваться дополнитель&
ный компьютер. На рис. 3.32 показана система,
в которой применяются две камеры iSight.

При настройке камер попробуйте поместить их
на расстоянии не менее трех дюймов друг от дру&
га. Это позволит вам сымитировать расстояние
между глазами зрителя. Вы можете установить
рядом два штатива, купить специальное устрой&
ство, например у компании Jasper Engineering
(http://www.stereoscopy.com/jasper/heavyduty&
bar.html; стоит 199–289 долл. США), либо изгото&
вить его самостоятельно. Если вы собираетесь ве&
сти съемку крупным планом, возможно, вам при&
дется направить камеру вперед.

Чтобы упростить процесс редактирования,
синхронизируйте свои камеры. Для этого вы мо&
жете настроить камеры на запись временной ко&

дировки, которая соответствует текущему времени дня, либо воспользоваться
цветной доской (см. совет 9). Обязательно промаркируйте свои кассеты, чтобы
разделить материал, снятый различными камерами.

Создание эффекта
После записи материала вам нужно импортировать его в систему редактирования
и добавить на шкалу времени. Поместите оба видеофайла в одно пространство и
сгруппируйте их на шкале времени. Убедитесь в том, что вы точно знаете, какой
материал был записан на левую камеру, а какой – на правую.

Если вы собираетесь создать черно&белое видео, устраните насыщенность из обоих
видеослоев (или просто конвертируйте их в черно&белые слои, если ваша система это
позволяет). Добавьте все эффекты сцены, перед тем как создавать анаглифы. В про&
тивном случае полученный результат может не соответствовать вашим ожиданиям.

Вам необходимо совместить изображения с правой и левой камер, поэтому вер&
хний слой следует сделать немного прозрачным; 50% прозрачности должно хва&
тить. Если вы этого не сделаете, вы не сможете увидеть материал в нижнем слое.
Выполните следующие действия, чтобы изменить непрозрачность материала:

• Avid. Выберите пункты меню Effects ⇒ Blend ⇒ Superimpose;
• Final Cut. Выберите пункты меню Motion Tab ⇒ Opacity;
• Premiere. Выберите пункты меню Effects Controls Tab ⇒ Opacity.

После настройки непрозрачности вам нужно изменить значения параметров
RGB (Red, Green и Blue). Чтобы создать трехмерный эффект, вы должны уда&

лить красный цвет из правой камеры, а также зеленый/синий цвет из левой каме&
ры. При этом зрители в очках будут видеть изображение с иллюзией глубины.
Выполните следующие действия, чтобы изменить значения параметров RGB:

• Avid. Выберите пункты меню Effects ⇒ Image ⇒ Color Effect;
• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Color Correction
⇒ RGB Balance;

• Premiere. Выберите пункты меню Effects ⇒ Video Effects ⇒ Image Control
⇒ Color Balance (RGB).

После настройки значений RGB изображение будет выглядеть довольно нео&
бычно. Это связано с тем, что мы удалили из композиции цвета. Чтобы завершить
создание трехмерной композиции, попробуйте поместить изображения таким об&
разом, чтобы они практически совпадали друг с другом. На рис. 3.33 показана
композиция до и после совмещения.

Рис. 3.32. Система
с двумя Web�камерами

Рис. 3.33. Выравниваем два изображения, чтобы активировать эффект

Просмотр видео
Чтобы увидеть трехмерный эффект, вам понадобится использовать пару очков
с красными и синими линзами. Если у вас нет таких очков, вы можете зайти
в книжный магазин и купить трехмерную детскую книгу (очки входят в комп&
лект). При желании вы можете заказать бесплатную пару очков в сети Интернет
по адресу: http://www.rainbowsymphony.com/freestuff.html. Также вы можете ку&
пить очки на сайте: http://www.3dglassesonline.com.

После этого для просмотра трехмерного видео вам понадобится всего лишь на&
деть очки и нажать кнопку Play.

Создание трехмерного фильма в режиме Pulfrich
Благодаря эффекту Pulfrich вы можете снимать трехмерное видео на одну камеру.
При этом вам не придется редактировать изображения; достаточно просто пере&
местить камеру или соответствующие объекты. Кроме того, вы сможете просмат&
ривать оригинальный материал в трехмерном пространстве! Даже без специаль&
ных очков вы можете смотреть такое видео в полностью трехмерном режиме!

Создание трехмерного видео
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С. Эффект Pulfrich был описан немецким физиком Кардом Пулфричем
(Carl Pulfrich) в 1922 г. Возникновение этого эффекта связано с тем
фактом, что человеческому мозгу требуется больше времени на обра&
ботку плохо освещенного изображения. Поэтому если вы закроете один
глаз серым фильтром, время обработки изображений от левого и
правого глаза будет различным. Такой эффект уже использовался в
кино: в качестве примера можно привести эпизод из фильма «3rd Rock
from the Sun» («Камень с солнца»), снятого в 1997 г.

Запись видео
Снимать видео с применением эффекта Pulfrich достаточно просто. Вам нужно
всего лишь переместить камеру по горизонтали слева направо или справа налево.
При этом движение камеры должно быть очень плавным. На рис. 3.34 показано,
как именно следует перемещать камеру, чтобы добиться нужного результата.

Рис. 3.34. Эффект Pulfrich проявляется вследствие
горизонтального перемещения камеры

Основной компонент данного эффекта – это движение объекта относительно
камеры. Чтобы проверить воздействие эффекта Pulfrich, попробуйте сесть на пас&
сажирское сиденье в автомобиле и снять пейзаж за окном на камеру. При измене&
нии скорости автомобиля изображение на камере тоже будет изменяться. Если вы
собираетесь воспользоваться данной методикой, я советую вам сначала поэкспе&
риментировать.

Просмотр эффекта
Чтобы просмотреть видео с эффектом Pulfrich, вам понадобится использовать
пару очков с серыми и прозрачными линзами. Вы можете изготовить такие очки и
самостоятельно: извлеките одно стекло из солнечных очков. Если вы наденете та&
кие очки во время просмотра спортивных состязаний (например, футбола), вы га&
рантированно увидите некоторое количество трехмерных эффектов.
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Редактирование  – это один из самых сложных этапов в процессе создания цифро&
вого видео. Кроме того, редактирование очень сильно зависит от технических воз&
можностей системы и пользователя, поэтому на данном этапе вам придется чаще
всего сталкиваться с различными ошибками.

Совет 39 Редактировать цифровое видео
стало проще

Почти все цифровые фотоаппараты могут записывать не только фотографии, но и
видеоматериал. Но как вы можете преобразовать полученный материал в видео&
фильм?

Если бы мне пришлось делать выбор между камерой и цифровым фотоаппара&
том, я бы выбрал второе. Мне нравится снимать видео, но фотографировать я
люблю еще больше. Кроме того, цифровые камеры меньше по размеру, а управ&
лять фотографиями проще, чем видео.

Но время от времени мне приходится снимать видеоматериал. Некоторые со&
бытия (например, речь на свадьбе, пожелания от старого друга или первые шаги
ребенка) воспринимаются намного лучше при наличии анимации и звука. К счас&
тью, большинство цифровых камер поддерживают режим съемки Movie
(Фильм).

Допустим, что вы записали видео на камеру. Но что с ним делать дальше? Пе&
ред тем как ответить на этот вопрос (я отвечу, можете не сомневаться), я хотел бы
объяснить, в чем заключается различие между видеоматериалом, записанным ва&
шим фотоаппаратом, и видео, снятым камерой.

Сейчас многие люди снимают видео на цифровые видеокамеры (DV). Формат
DV становится все более и более популярным. После записи видеоклипа вы може&
те подключить камеру к своему персональному компьютеру и открыть приложе&
ние, которое предназначено для загрузки и редактирования материала. В среде
Windows вы можете использовать программу Microsoft Movie Maker, а в среде
Mac – программу Apple iMovie или Final Cut Express.

Однако если вы подключите к компьютеру цифровой фотоаппарат, такие при&
ложения его не распознают. Одна из причин заключается в том, что вы, скорее
всего, подсоединяете камеру к USB&порту, в то время как ваша видеокамера ис&
пользует порт FireWire. Большинство видеоредакторов настроены на поиск уст&
ройств, подключенных к порту FireWire. Но это не единственная особенность.

Цифровые видеокамеры, как правило, выполняют запись в формате DV. Циф&
ровой фотоаппарат использует совершенно другой формат, например Motion
JPEG OpenDML (расширенная версия файлового формата AVI). Вы можете вос&
произвести эти файлы на своем компьютере в программе QuickTime Player; дан&
ный формат является составной частью рабочей среды QuickTime. В комплект
поставки практически любой современной видеокамеры входит отдельный CD&
диск с программой установки QuickTime.

Воспроизведение воспроизведением, но вам понадобится также объединить
файлы в одну композицию и отредактировать их. Если вы не можете использо&
вать оригинальную систему редактирования, что же вам делать?

Здесь мы расскажем о том, как следует работать с программой QuickTime в вер&
сии Pro (http://www.apple.com/quicktime/buy; стоит 29,99 долл. США). Бесплат&
ная версия приложения QuickTime, которую вы можете загрузить на сайте компа&
нии Apple, позволяет вам только смотреть фильмы. А версия Pro (коммерческая)
дает вам возможность редактировать фильмы, а также предлагает многие другие
функции. Приложение QuickTime Pro отличается исключительно мощными оп&
циями. Впрочем, здесь мы ограничимся описанием процесса редактирования, рас&
тягивания и обрезки видео.

Прежде всего вам необходимо отправить мультимедиа&файлы с камеры на ком&
пьютер. Если вы не знаете, как это сделать, обратитесь к руководству пользовате&
ля. Любая комбинация камеры/компьютера требует своего, уникального подхо&
да. Если вам повезло, ваша камера поддерживает функцию подключения Mass
Storage Device (Устройства хранения информации). Это значит, что она отобра&
жается на вашем компьютере как отдельный жесткий диск. Обычно данная функ&
ция поддерживается камерами производства Nikon, Olympus и Kyocera. Вам дос&
таточно открыть «новый жесткий диск», переместить из него мультимедиа&фай&
лы и сохранить их на своем компьютере. Если вы не уверены в том, какие именно
файлы вам нужны, обратите внимание на их расширение (мультимедиа&файлы
обычно имеют расширение .avi).

Теперь вам нужно купить версию Pro программы QuickTime. Зайдите на сайт
http://www.apple.com/quicktime/ и нажмите кнопку Upgrade to QuickTime Pro
(Установить QuickTime Pro). Вы получите ключ, который позволяет разблокиро&
вать функции Pro в версии Player программы QuickTime.

Итак, вы установили нужное программное обеспечение. Для редактирования
фильмов вам необходимо изучить всего три команды:

• Trim (Обрезать). Эта команда позволяет вам быстро обрезать ненужные кад&
ры в фильме. Переместите маркеры в виде треугольников в строке и выберите
область композиции, которую вы хотите сохранить (см. рис. 4.1).
Если вы зайдете в ниспадающее меню Edit (Правка) и выберите пункт Trim,
серая область композиции сохранится, а белая область будет обрезана. В ре&
зультате ненужный материал будет удален из композиции;

• Add (Добавить). Многие цифровые камеры позволяют вам записать всего
несколько минут видео в последовательности. Поэтому для формирования
клипа вам придется объединить все записанные фрагменты. Для этого следу&
ет использовать команду Add.
Процедура аналогична копированию/вставке в текстовом документе. Снача&
ла переместите символы в виде треугольников внизу и выберите область ком&
позиции для копирования (см. рис. 4.1). Затем зайдите в ниспадающее меню
Edit и выберите пункт Copy (Копировать). Выделенная область будет добав&
лена на панель Clipboard.

Редактировать цифровое видео стало проще
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Откройте документ, в который вы хотите вставить скопированный материал.
Переместите верхний треугольник на шкале в конец клипа; затем зайдите
в меню Edit и выберите пункт Add. Скопированное вами видео будет добав&
лено во второй файл (включая записанный звук);

• Make Movie Self
Contained (Удалить все слои из фильма). После создания
фильма из фрагментов, записанных на камеру, выберите в ниспадающем
меню File (Файл) пункт Save As (Сохранить как). Введите название фильма
и нажмите кнопку Make Movie Self
Contained. При этом все добавленные
вами в фильм слои будут удалены.

Поздравляю! Вы только что создали первый фильм, который состоит из запи&
санных на цифровую камеру фрагментов. Независимо от того, в какой именно
операционной системе вы редактировали фильм, вы сможете просмотреть его как
в среде Mac, так и в среде Windows. При желании вы даже сможете записать фильм
на CD&диск и поделиться им со своими друзьями.

Далее я приведу ряд рекомендаций по процессу съемки:

• при возможности снимайте все фрагменты фильма с одной частотой смены
кадров, лучше всего 15 кадров/с;

• ровно держите камеру и не выполняйте панорамирование. На большинстве
цифровых камер вы не можете заблокировать экспозицию во время съемки
видео, поэтому изменение освещения является нежелательным эффектом.
Камера будет реагировать на любые изменения, что приведет к искажению
изображения. Сфокусируйте камеру на персонаже, снимите 15–60 с видео и
сделайте паузу. Подготовьтесь к следующему снимку и продолжайте;

• не пользуйтесь функцией Automatic White Balance (Автоматический баланс
белого цвета). Это может привести к искажениям цвета в середине клипа.
Лучше выберите одну из предварительных установок, например Cloudy. В ре&
зультате настройки баланса белого цвета будут заблокированы;

• четко берите персонажа в кадр, как показано на рис. 4.1. Обычно фильмы на
цифровой камере имеют расширение 320 × 240 пикселей, поэтому вы не мо&
жете стоять слишком далеко. Если ваш кадр окажется очень широким, ваши
зрители не смогут четко разглядеть персонажа;

• помните о том, что порт микрофона, как правило, находится очень близко от
ваших рук. Следите за тем, чтобы случайно не закрыть его во время записи.

Теперь мы приступим к съемкам и созданию фильма. Завидуйте нам, Мартин
Скорцезе (Martin Scorsese)!

Совет 40 Создание видео в программе
Windows Movie Maker

Используя встроенное приложение операционной системы Windows XP, Windows
Movie Maker, вы сможете создавать видеоклипы и фильмы.

Windows XP – это операционная система, ориентированная на работу с муль&
тимедиа&программами и файлами. Среда Windows XP поставляется со встроен&
ным программным обеспечением, которое предназначено для создания и редакти&
рования видео и клипов: Windows Movie Maker (для запуска приложения выбери&
те пункты меню Start ⇒ Programs ⇒ Windows Movie Maker). Однако процесс
создания фильма сопряжен со многими трудностями, поэтому я советую вам вни&
мательно ознакомиться с нашими рекомендациями в текущем разделе.

В книге «Windows XP Hacks» Престона Гралла (Preston Gralla) изда&
тельства O’Reilly вы найдете большое количество советов, связанных
с операционной системой Windows XP. Данный раздел был взят
из этой книги.

Как правильно записать видео
Приложение Windows Movie Maker позволяет вам редактировать фильмы и до&
бавлять в заголовки спецэффекты. Процесс записи материала имеет очень боль&

Рис. 4.1. Редактирование в программе QuickTime Pro

Создание видео в программе Windows Movie Maker
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шое значение. Прежде всего вам необходимо убедиться в том, что вы правильно
записываете исходный материал.

Запись аналогового видео
Если у вас есть аналоговая видеокамера или видеопленка, вам понадобится вы&
полнить конвертирование данных в цифровой сигнал (см. совет 37). Для этого вы
можете использовать видеодеку или другое устройство, которое подключается
к порту FireWire или USB. Если вы выбрали видеодеку, убедитесь в том, что ее
драйверы поддерживаются средой Windows XP; если вы этого не сделаете, у вас
могут возникнуть проблемы. За подробной информацией обратитесь к списку
Windows Compatibility List на сайте www.microsoft.com/windows/catalog.

Если ваше устройство имеет USB&порт, вы сможете импортировать аналоговое
видео из приложения DVD Express, Instant DVD 2.0 или Instant DVD+DV; эти
приложения доступны по адресу: http://www.adstech.com. Существуют различ&
ные комбинации аппаратных средств/программного обеспечения; чтобы отпра&
вить видео на компьютер, подключите аналоговое видеоустройство к устройству
USB Instant Video или USB InstantDVD, а затем подсоедините USB&кабель от ус&
тройства к USB&порту компьютера. Также для решения данной задачи вы можете
использовать приложение Dazzle Digital Video Creator; за дополнительной ин&
формацией обратитесь по адресу: http://www.dazzle.com.

Обратитесь к руководству пользователя и определите, какой USB&порт уста&
новлен на вашем устройстве. Если у вас имеется порт USB 1.1, вы не сможете им&
портировать видео высокого качества. В этом случае я бы посоветовал вам устано&
вить видеокарту с возможностью записи. Порт USB 2.0 позволит вам решить все
проблемы.

Если на вашем компьютере установлен порт FireWire, вы сможете без труда
импортировать видео. Однако вам понадобится купить дополнительное устрой&
ство SCM Microsystems Dazzle Hollywood DV&Bridge. Подсоедините RCA&кабель
или кабель S&Video к устройству Hollywood DV&Bridge,. Затем подсоедините ка&
бель FireWire от устройства Hollywood DV&Bridge к порту FireWire, и вы сможете
записывать видео на компьютер. Устройство продается на различных Интернет&
сайтах, например на http://www.buy.com.

После того как вы настроите аппаратные средства и камеру, записать видео бу&
дет просто. Откройте приложение Windows Movie Maker, включите камеру или
устройство конвертирования и выберите пункты меню File ⇒ Capture Video
(Файл ⇒ Записать видео).

Запись цифрового видео
Если у вас есть цифровая видеокамера или Web&камера, а ваш компьютер обору&
дован портом FireWire, вам не понадобится использовать дополнительное уст&
ройство для записи видео. Как правило, такие устройства включают встроенные
порты FireWire (возможно, ваше устройство поддерживает порт IEEE&1394 или
i.LINK). Если ваш компьютер не имеет порта FireWire, вы можете установить кар&
ту FireWire. Как правило, такая карта стоит не более 100 долл. США. Убедитесь
в том, что карта поддерживает интерфейс Open Host Controller Interface (OHCI).

Когда вы подсоедините цифровую  камеру к порту FireWire и включите ее, опе&
рационная система Windows запросит вас о том, какие действия вы намерены вы&
полнить. Выберите опцию Record in Movie Maker (Выполнить запись в Movie
Maker). Система вызовет приложение Movie Maker и откроет диалоговое окно
Record.

Оптимальные настройки для записи видео
Перед тем как начать запись, вам необходимо ввести название видеофайла, а так&
же выбрать папку для его сохранения. По умолчанию операционная система
Windows выполняет сохранение в папке Videos; это очень удобно. После ввода
названия файла и папки на диске укажите настройки для записи видео.

Далее вы выбираете параметры оцифровки материала в приложении Movie
Maker (см. рис. 4.2). Сейчас вы можете изменить настройки видео. Правильный
выбор параметров оказывает существенное воздействие на конечный результат.

Рис. 4.2. Опции записи видео в программе Windows Movie Maker

Посмотрите на ниспадающее меню Other Settings (Другие настройки), кото&
рое показано на рис. 4.2. Если вы нажмете переключатель, ниспадающее меню ак&
тивируется, и вы сможете выбрать качество видео (очень важно!). Выбор пара&

Создание видео в программе Windows Movie Maker
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метра зависит от исходного материала; к примеру, цифровые видеокамеры позво&
ляют вам вести запись с более высоким качеством, чем аналоговые видеокамеры,
поэтому выбор опций будет более широким. Приложение Movie Maker содержит
большое количество предварительных установок, включая три базовые: DV&AVI
(NTSC), High Quality Video (NTSC) и Video for broadband (512 Kbps). При выбо&
ре профиля программа Movie Maker сообщит вам, сколько часов и минут вы мо&
жете вести запись (зависит от свободного места на диске, а также от требований
профиля). Например, профиль DV&AVI может предоставить вам 193 ч времени,
а профиль Video for Broadband – 1630 ч.

Впрочем, ваш выбор не ограничивается только этими тремя профилями. Вы
можете выбирать и другие профили (я советую вам поэкспериментировать), при&
чем ваш выбор будет зависеть от требований, которые вы предъявляете к конеч&
ному проекту. Вы собираетесь поместить видео в сети Интернет? Или просто про&
смотреть его дома? Или открыть на своем устройстве PDA? Существуют профи&
ли, предназначенные для решения различных задач.

Выберите нужный профиль в ниспадающем меню Other Settings (см. рис. 4.3).
Каждый профиль имеет свое предназначение. Например, если вы записываете
видео для сети Интернет, выберите один из профилей Video for broadband. Если
вы записываете видео для цветного устройства PDA, выберите один из профилей

Video for Pocket PC. Если вы записываете видео для просмотра на телевизоре,
выберите профиль DV&AVI.

После выбора профиля вы увидите размер кадра в видео и частоту смены кад&
ров. Далее я приведу описание настроек:

• File type (Тип файла). Формат файла, который будет создан. Некоторые фор&
маты могут воспроизводиться только определенными приложениями, к при&
меру Windows Media Player;

• Bit rate (Скорость передачи данных). Частота передачи данных при записи
видео. Чем больше частота, тем выше качество;

• Display Size (Размер экрана). Размер видео в пикселях, например 740 × 480
или 320 × 240;

• Frames per second (Кадров в секунду). Количество записанных кадров в се&
кунду. Если вы хотите записать высококачественное видео, выберите значе&
ние 30 кадров в секунду. Для создания видео среднего качества следует вы&
брать значение 15 кадров в секунду.

В табл. 4.1 приведены настройки для всех профилей Movie Maker.

Таблица 4.1. Настройки для профилей Movie Maker

Название профиля Размеры Частота бита Кадров Требуемое
экрана, в секунду пространство
пиксели на диске (для

одной минуты
видео)

Video for Pocket PC 208 × 160 218.2 килобит 20 1 Мб
(218 Kbps) в секунду (Kbps)
Video for Pocket PC 208 × 160 143.3 Kbps 8 1 Мб
(143 Kbps)
Video for Pocket PC 320 × 240 218 Kbps 15 1 Мб
(Full Screen 218 Kbps)
High quality video 640 × 480 переменная 30 переменное
(large)
High quality video 320 × 240 переменная 30 переменное
(small)
Video for local 640 × 480 2.1 Mbps 30 14 Мб
playback (2.1 Mbps)
Video for local 640 × 480 1.5 Mbps 30 10 Мб
playback (1.5 Mbps)
Video for LAN 640 × 480 1.0 Mbps 30 7 Мб
(1.0 Mbps)
Video for LAN 640 × 480 768 Kbps 30 5 Мб
(768 Kbps)
Video for broadband 320 × 240 512 Kbps 30 3 Мб
(512 Kbps)Рис. 4.3. Выбираем профиль в списке

Создание видео в программе Windows Movie Maker
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Таблица 4.1. Настройки для профилей Movie Maker (окончание)

Название профиля Размеры Частота бита Кадров Требуемое
экрана, в секунду пространство
пиксели на диске (для

одной минуты
видео)

Video for broadband 320 × 240 340 Kbps 30 2 Мб
(340 Kbps)
Video for broadband 320 × 240 150 Kbps 15 1 Мб
(150 Kbps)
Video for ISDN 160 × 120 48 Kbps 15 351 Кб
(48 Kbps)
Video for dial/up 160 × 120 38 Kbps 15 278 Кб
access (38 Kbps)
DV/AVI 720 × 480 25.0 Mbps 30 178 Мб
High quality video 720 × 480 переменная 30 переменное
(NTSC)
Video for local playback 720 × 480 2.1 Mbps 30 14 Мб
(2.1 Mbps NTSC)
Video for local playback 720 × 480 1.5 Mbps 30 10 Мб
(1.5 Mbps NTSC)

Методики записи
После выбора профиля вам необходимо указать, хотите ли вы записать всю кассе&
ту или только ее часть. Если вы решили записать всю кассету, программа Movie
Maker перемотает ее (при выборе формата DV) и выполнит запись материала ав&
томатически. Если вы хотите записать только часть кассеты, вам понадобится ус&
тановить курсор в начальную точку записи. Вручную вы можете записать не&
сколько разделов, и вам не придется повторно вводить название композиции и
выбирать профиль. На рис. 4.4 показано диалоговое окно Capture Wizard (Мас

тер записи), которое настроено на запись всей кассеты с камеры.

Кроме того, вы можете просматривать материал во время записи последователь&
ности в программе Movie Maker. Это очень удобная функция, потому что вы можете
убедиться в том, что вы записываете нужный материал. После выбора нажмите
кнопку Next (Далее), и приложение Movie Maker начнет запись материала.

Запись DVD)дисков
Если вы используете программу Movie Maker для создания или копирования ви&
део, а также для записи DVD&дисков (см. совет 79), обратите внимание на следую&
щие рекомендации:

• стандарт USB 1.1 является недостаточно быстрым для того, чтобы подклю&
чить к компьютеру камеру или другое видеоустройство. Пропускной способ&
ности порта USB 1.1 (11 Мб/с) не хватает для записи высококачественного
видео, которое имеет частоту 30 кадров/с с 24 бит цвета, разрешением

640 × 480 и требует скорости 210 Мб/с. Стандарты USB 2.0 (480 Мб/с) и
FireWire (400 Мб/с) отвечают всем необходимым требованиям;

• если вы собираетесь записывать видео на DVD, убедитесь в том, что доступ&
ного пространства на жестком диске достаточно. Видео будет кэшироваться
на жесткий диск до записи на DVD, поэтому вам понадобится освободить не&
которое количество гигабайт;

• чтобы улучшить производительность, дефрагментируйте жесткий диск перед
созданием и записью DVD. Если у вас есть второй жесткий диск, используйте
для записи DVD его, а не основной диск. Независимо от скорости процессора
на время импорта видео и создания DVD закройте все фоновые приложения;

• если вы записываете на DVD высококачественное видео, учтите, что на один
диск вы сможете поместить около часа видео. При низком качестве (низкой
скорости передачи данных) вы сможете записать на DVD&диск примерно два
часа материала. Помните о том, что, если вы будете вести запись с более низкой
скоростью, данный DVD&диск может не воспроизводиться на отдельном DVD&
плеере (впрочем, вы сможете его просмотреть на DVD&плеере компьютера);

• не существует единого стандарта записи DVD, поэтому не все записанные
вами диски будут воспроизводиться на различных DVD&плеерах. Как прави&

Рис. 4.4. Вы можете выбрать для записи
всю кассету или только ее часть
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ло, многие качественные DVD&плееры способны воспроизводить диски
DVD&R, однако далеко не все плееры могут работать с дисками DVD&RW или
DVD+RW. Не следует полностью доверять информации от производителя.
Последние сведения вы сможете найти на Web&сайте компании;

• после того как вы создадите видео и подготовите его к записи на DVD, можете
расслабиться и отдохнуть. Для записи одного DVD&диска вам может потребо&
ваться до двух часов времени (зависит от процессора и скорости жесткого
диска).

Смотри также
Если вам необходимо использовать функции, которые не поддерживаются прило&
жением Windows Movie Maker, попробуйте установить программное обеспечение
от компании Ulead Software, например Ulead VideoStudio, Ulead DVD Movie Fac&
tory или Ulead DVD Workshop. Эти программы обладают мощными возможностя&
ми и позволяют вам использовать переходы, добавлять спецэффекты и меню.
Кроме того, они содержат фоны, предварительные установки и музыку, которые
вы можете добавлять в свои видеофильмы. Также эти приложения могут записы&
вать DVD, VCD, SVCD и сохранять файлы в различных видеоформатах. Вам дос&
тупны бесплатные демоверсии программ, но придется заплатить, если вы собира&
етесь регулярно с ними работать. За дополнительной информацией обратитесь
к сайту: http://www.ulead.com.

Совет 41 Создание фильма в программе iMovie

Компания Apple устанавливает на свои компьютеры видеоредактор iMovie. Вы
можете использовать это приложение для создания фильмов практически любой
продолжительности.

Если вы купите новый компьютер Macintosh, в папке Applications вы сможете
найти приложение iMovie HD. Если у вас имеется устаревший компьютер Mac
либо устаревшая версия программы iMovie, вы можете купить новую версию в со&
ставе пакета iLife (стоит 79 долл. США). Пакет iLife включает программы iDVD
(для создания DVD), Garage&Band (для создания музыки), iTunes (для организации
музыки) и iPhoto (для организации цифровых фотографий), а также iMovie HD.

Используя приложение iMovie HD, вы можете редактировать цифровое видео,
а затем распространять его на видеопленке, в сети Интернет (см. совет 82), по
электронной почте или даже через мобильный телефон (см. совет 89). Но сначала
вам необходимо передать видеофайлы на компьютер. Вы можете импортировать
видео в программу iMovie через интерфейс USB, IEEE&1394 (FireWire или
i.LINK) либо напрямую с камеры iSight.

Передача видео
Для отправки видео с камеры на компьютер вы должны соединить их посред&
ством кабеля.

Если вы подключили камеру к компьютеру через USB&кабель, вы можете им&
портировать видео путем перемещения файлов из камеры (отображается на рабо&
чем столе как отдельный жесткий диск) в окно iMovie. Также вы можете перемес&
тить файлы на жесткий диск, а затем импортировать их в программу iMovie.

Если вы используете камеру DV, HDV или iSight, то должны импортировать
данные с помощью кабеля FireWire и встроенной функции iMovie. После подклю&
чения камеры запустите приложение iMovie HD, введите название проекта, а за&
тем переключитесь в режим Camera (Камера). Для этого щелкните по переключа&
телю под окном просмотра видео. На рис. 4.5 показан интерфейс программы
iMovie (в окне выделен переключатель режима Camera).

Рис. 4.5. Режим Camera в программе iMovie

Если вы хотите отправить все видео с кассеты на компьютер, убедитесь в том,
что кассета перемотана в начало записи. Вы можете перемотать кассету вручную
либо автоматически (нажмите кнопку Rewind в окне iMovie).

Нажмите кнопку Import (Импортировать), чтобы начать процесс передачи
данных. Система начнет с воспроизведения вашего видео, которое отобразится
в окне просмотра под кнопкой Import. Во время импорта приложение iMovie вы&
полнит автоматическое распознавание сцен и разобьет ваш материал на отдель&
ные сцены. Полученные клипы отобразятся справа в окне iMovie, в режиме Clips
(Клипы), как показано на рис. 4.6.

Создание фильма в программе iMovie
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Автоматическое создание фильма
Программа iMovie HD имеет две функции, которые автоматически помещают
ваши клипы на шкалу времени. Первая функция просто добавляет клипы на шка&
лу времени во время передачи материала. Чтобы ее активировать, выберите пунк&
ты меню iMovie HD ⇒ Preferences ⇒ Import ⇒ Movie Timeline.

Вторая функция, Magic iMovie, не только добавляет клипы на шкалу времени,
но и вставляет переходы (например, Dissolve), а также саунд&трек. При необходи&
мости приложение iMovie может записать для вас DVD&диск; кроме того, вы мо&
жете использовать шкалу времени, которая была создана автоматически.

Любая из вышеперечисленных функций позволяет вам создать основу для бу&
дущего проекта.

Редактирование фильма
Чтобы приступить к редактированию фильма, переключитесь из режима Camera
в режим Cutting (это другой режим, доступный для переключателя Camera). Пос&
ле этого вы сможете внести изменения на шкале времени. Чтобы добавить клип на
шкалу времени, переместите его с помощью мыши. Кроме того, вы можете обре&
зать или разбивать клипы, если вам необходимо изменить продолжительность их
воспроизведения.

Во время редактирования вы можете добавлять переходы, звуковые и даже спе&
цэффекты. Все имеющиеся функции доступны в виде кнопок в режиме просмотра
Clips:

• Clips (Клипы). Предоставляет доступ к видеоклипам, которые вы импорти&
ровали в программу iMovie;

• Photos (Фотографии). Позволяет вам открывать и использовать фотографии из
библиотеки iPhoto. При добавлении фотографий на шкалу времени вы можете
использовать эффект Кена Бернса (Ken Burns). Данный эффект выполняет па&
норамирование или масштабирование изображения, чтобы его анимировать;

• Audio (Звук). Содержит список встроенных саунд&треков, включая звуковые
эффекты, а также музыку и звуковые файлы из библиотеки iTunes;

• Titles (Заголовки). Позволяет вам добавлять в ваш фильм различные заго&
ловки, начиная от простых и заканчивая сложными заголовками с трехмер&
ной анимацией и вращением;

• Trans (Переходы). Содержит список переходов, которые вы можете исполь&
зовать между клипами на шкале времени;

• Effects (Эффекты). Если вы хотите изменить внешний вид вашего фильма,
то можете выбрать здесь различные эффекты, например Aged Film, Fog или
Letterbox;

• iDVD. Программы iMovie и iDVD отличаются высокой интеграцией: вы може&
те добавлять главы для DVD&проекта напрямую из интерфейса iMovie. Также
вы можете нажать всего лишь одну кнопку, чтобы создать проект iDVD.

Режим просмотра Clips изменится в зависимости от того, какую кнопку вы на&
жмете. На рис. 4.7 показано, как выглядит окно Effects, после того как мы приме&
нили эффект Aged Film к клипу на шкале времени.

Рис. 4.6. Отдельные клипы готовы к созданию фильма

Рис. 4.7. Режим просмотра Effects

Создание фильма в программе iMovie
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Создание DVD
Как говорилось ранее, программы iMovie и iDVD отличаются высокой степенью
интеграции. Благодаря таким функциям, как Magic iMovie, создание глав и про&
ектных файлов iDVD, приложение iMovie позволяет вам быстро формировать
сложные DVD&проекты. Чтобы записать DVD из проекта iMovie, нажмите кнопку
iDVD, а затем кнопку Create iDVD Project (Создать проект iDVD). На рис. 4.8
показано приложение iMovie в процессе создания проекта iDVD.

Эти приложения представляют собой упрощенные версии программ, которые
применяются профессионалами в области видео и кино.

Совет 42 Вращение фильма по горизонтали
и вертикали

Кто сказал, что фильмы можно снимать только в горизонтальной проекции? Как
и при работе с фотографиями, время от времени вы можете переворачивать каме&
ру. Но после загрузки снимков на компьютер они выглядят не так, как нужно!
Далее мы поговорим о том, как решить данную проблему.

Во время съемок фильмов на цифровую камеру вы вряд ли захотите ограничи&
вать себя, как вы это делаете при обычном фотографировании. Представьте себе,
что кто&то приказал вам всю оставшуюся жизнь выполнять съемки только в гори&
зонтальной плоскости. Вы бы попросили его не вмешиваться в чужие дела.

Проблема состоит в том, что, даже если вы сняли видео с вертикальной ориен&
тацией, после загрузки файлов на компьютер она будет автоматически изменена
на горизонтальную. В результате при просмотре фильма вам придется постоянно
крутить головой.

К счастью, у этой проблемы есть очень простое решение.

Вращение видео
После загрузки видео на жесткий диск вашего компьютера откройте файл в про&
грамме QuickTime Pro, которая предназначена для просмотра и редактирования.

Если вы еще не установили версию QuickTime Pro
(http://www.apple.com/quicktime/buy; стоит 29,99 долл. США),
я советую вам это сделать как можно быстрее.

Выберите в ниспадающем меню Movie (Фильм) пункт Get Movie Properties
(Получить параметры фильма). Сейчас вы активировали раздел с самыми мощны&
ми опциями программы QuickTime Pro. В верхней части этого диалогового окна вам
доступно два ниспадающих меню. Выберите в левом меню пункт Video Track (Ви

деотрек), а в правом меню – пункт Size (Размер), как показано на рис. 4.9.

Вы увидите, что содержимое и функции в диалоговом окне изменяются в зави&
симости от того, какой пункт вы выберете в ниспадающем меню. В данном случае
необходимые функции находятся в правом нижнем углу. Щелкните по стрелке,
которая выполняет вращение в нужном направлении (см. рис. 4.10). Теперь ваш
фильм будет ориентирован в заданной проекции.

Теперь вы можете редактировать и обрезать клипы. Разумеется, все ваши
фильмы должны быть ориентированы аналогичным образом; иначе у вас могут
возникнуть трудности.

Рис. 4.8. Создаем проект iDVD в программе iMovie

После создания проекта iDVD вам понадобится ввести информацию о нем (см.
совет 79). Затем нажмите кнопку Burn (Записать) в окне программы iDVD,
вставьте DVD&диск и дождитесь завершения процесса.

Отходим от программы iMovie
Программа iMovie обладает весьма мощными функциями редактирования. Од&
нако она имеет и свои ограничения. Если эти ограничения не позволяют вам пол&
ноценно работать с программой, обратитесь к другим приложениям. На рынке
имеются такие редакторы, как Apple Final Cut Express (http://www.apple.com/
finalcutexpress; стоит 299 долл. США) и Avid Xpress DV (http://www.avid.com/
products/xpressdv/; стоит 695 долл. США). Компания Avid также предлагает бес&
платное приложение для редактирования, которое называется Avid FreeDV
(http://www.avid.com/freedv/; бесплатно).

Вращение фильма по горизонтали и вертикали
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Редактирование видео в вертикальной проекции
Ваша система редактирования настроена на видео в горизонтальной плоскости,
поэтому вам придется изменить параметры. К счастью, это сделать несложно; вам
понадобится всего лишь модифицировать такие настройки видео, как высота и
ширина. Достаточно просто заменить два значения.

Настройка шкалы времени
Для редактирования материала с вертикальной ориентацией вам необходимо со&
здать новый проект и соответствующим образом изменить настройки шкалы вре&
мени. Например, если вы выполнили съемку в формате DV, измените высоту и
ширину видео с 720 × 480 (720 × 576 PAL) на 480 × 720 (576 × 720 PAL):

• Final Cut. Выберите пункты меню Sequence ⇒ Settings ⇒ General;
• Premiere. Выберите пункты меню Custom Settings ⇒ General ⇒ Editing

Mode ⇒ Video for Windows.

Если ваша система редактирования не позволяет изменять настройки
шкалы времени (то есть вы ограничены разрешением, например,
720 × 480), то можете отредактировать видео и экспортировать его
в формате фильма QuickTime. Затем вы сможете выполнить вращение
завершенного проекта.

После подготовки проекта к обработке видео в вертикальной проекции вам не&
обходимо соответствующим образом отредактировать материал.

Импорт материала
Даже несмотря на то что вы сняли видео в вертикальной проекции, ваша камера
и система редактирования не будут воспринимать его так, как вам нужно. Сле&
довательно, вы должны повернуть видео на 90°, как описывалось ранее. Так как
вы уже отправили видео на жесткий диск вашего компьютера (и завершили вра&
щение), вам достаточно просто импортировать материал в систему редактиро&
вания.

После импорта видео вы можете отредактировать его обычным способом. Что&
бы определить, правильно ли было осуществлено импортирование данных, поме&
стите видео на шкалу времени. На рис. 4.11 показано, как выглядит видео с верти&
кальной ориентацией после импорта в систему редактирования (без вращения).
На рис. 4.12 вы видите то же самое изображение, которое было повернуто.

Фильм с вертикальной ориентацией выглядит весьма интересно. Я советую
вам при возможности чаще использовать данную опцию.

Смотри также
Simple Rotate (http://www.imovieplugins.com/plugs/simplerot.html) – это простое
обновление для программы iMovie (стоит 1,50 долл. США), которое предназначе&
но для работы со спецэффектами.

Рис. 4.9. Делаем выбор в диалоговом окне Movie Properties
программы QuickTime

Рис. 4.10. Вращаем фильм в диалоговом окне Movie Properties
программы QuickTime

Вращение фильма по горизонтали и вертикали
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Совет 43 Создание шаблона для редактирования

Во время редактирования встречаются ситуации, в которых вам приходится обра&
батывать слишком большое количество материала. Шаблоны позволяют редакто&
рам решать сложные задачи.

Использование шаблонов может быть связано с различными трудно&
стями. Чтобы их избежать, убедитесь в том, что вы правильно прону&
меровали кассеты (см. совет 3), а также организовали их в единую
систему.

Независимо от того, работаете ли вы с крупным или с небольшим проектом,
в процессе редактирования вам приходится вносить в него ряд изменений. Чем
больше изменений вы вносите, тем сложнее вам их отследить. Это особенно за&
метно проявляется в случае, если вы работаете над проектом вместе с коллегой,

например с режиссером или продюсером. Вы можете создать шаблон, чтобы огра&
ничить количество кассет, с которым вам приходится работать.

Если вы работаете с большим количеством материала, я советую вам восполь&
зоваться шаблоном. Вы можете создать шкалу времени и просмотреть материал
в поисках выделенных объектов (то есть тех объектов, которые вы будете исполь&
зовать). Вам следует не изменять материал, а только выбирать его и отправлять на
шкалу времени в завершенном проекте.

Вы можете выполнить оцифровку только того материала, который
войдет в проект. Если вы собираетесь воспользоваться данной методи&
кой, скорее всего, вы будете загружать материал заранее (см. совет 5).

Когда вы сформируете шкалу времени, которая содержит материал для одной кас&
сеты, то можете приступить к созданию шаблона. Затем вы сможете создать новую
шкалу времени и продолжить выделение материала. Я не советую вам удалять шкалу
времени, потому что она может служить ссылкой на оригинальный материал.

Рис. 4.11. Видео с вертикальной ориентацией, без вращения Рис. 4.12. Материал после вращения

Создание шаблона для редактирования
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Создание шаблона
Процесс создания шаблона полностью совпадает с процессом создания кассе&
ты&мастер. После конфигурирования шкалы времени просто сохраните ее на
кассету.

Если вы выполнили оцифровку материала и использовали сжатие
данных, например OfflineRT для Final Cut или 15:1 для Avid, вы не
сможете применить шаблон. Вам придется сначала отменить сжатие
материала.

• Avid. Выберите пункты меню Clip ⇒ Digital Cut;
• Final Cut. Выберите пункты меню File ⇒ Print to Video;
• Movie Maker. Выберите пункты меню File ⇒ Save Movie File;
• Premiere. Выберите пункты меню File ⇒ Export ⇒ Export to Tape;
• iMovie. Выберите пункты меню File ⇒ Share ⇒ Videocamera ⇒ Share.

В результате вы запишите кассету, которая может использоваться для редакти&
рования в дальнейшем. Я рекомендую вам сохранить копию проекта, связанную
с записанной вами кассетой. Другими словами, сразу после записи материала на
пленку следует сохранять копию проекта.

Если после создания шаблона вы хотите продолжить работу с проектом, вам
необходимо внести изменения в копию сохраненного проекта. Если вы этого не
сделаете, то лишитесь всех ссылок, которые могут оказаться полезными в буду&
щем. Об этом очень важно помнить даже в случае, если вы не собираетесь регу&
лярно применять шаблоны.

Использование шаблона
Вы можете использовать шаблон таким же образом, как и кассету&мастер. Шаб&
лон играет роль кассеты&мастер для вашего проекта. Единственное различие со&
стоит в том, что шаблон объединяет материал с различных кассет.

Если вы применяете шаблон, вам необходимо отличать его от других кассет
с материалом. Убедитесь в том, что ваша система нумерации кассет позволяет вам
их различать. Достаточно использовать простую систему нумерации, например
PWCut1 (кадр 1 со свадьбы Петера). На рис. 4.13 показана шкала времени для
проекта, который содержит шаблон.

Если вы сформировали шаблон из проекта после его редактирования, то може&
те создать новую шкалу времени, оцифровать шаблон, а затем добавить его в про&
ект. Это позволит вам работать с более свободной шкалой времени, а также позво&
лит вашей системе функционировать быстрее в случае, если ее производитель&
ность уменьшилась (например, вы обратили внимание на пропуски кадров).
Повышение производительности связано с тем, что вашему жесткому диску не
приходится делать «скачки» в поисках различных файлов.

Совет 44 Пользуйтесь телевизором,
чтобы избежать неприятных сюрпризов

Компьютерный монитор функционирует совершенно не так, как телевизор. Если
при редактировании видео вы будете просматривать изображение только на экра&
не монитора, после отправки проекта на телевизор вас могут ожидать неприятные
сюрпризы.

Телевизоры отображают материал с помощью функции развертки, которая позво&
ляет сформировать изображение на экране. В развертке любой кадр видео состоит из
двух полей: верхнего и нижнего. Эти поля рисуются на экране последовательно,
и в результате вы видите кадр видео. Значит, если частота смены кадров для телеви&
зора составляет 29,97 кадров/с, за секунду на экране отображается 59,94 поля.

В любом материале формата DV сначала формируется нижнее поле.

Компьютерные мониторы отображают картинку с помощью функции прогрес&
сивного сканирования, причем частота смены кадров может различаться. Данная
функция рисует изображение на экране в один проход. Поэтому картинка на ком&
пьютерном мониторе может отличаться от той картинки, которую вы увидите на
экране телевизора. Подключите телевизор к вашей системе редактирования, что&
бы заранее выявить и устранить возможные неполадки. На рис. 4.14 показано
изображение, в котором каждое поле было взято из отдельного кадра.

При подключении камеры к системе редактирования вы можете
обнаружить, что видео отображается на LCD&мониторе камеры (если
таковой имеется). Большинство таких мониторов не используют
развертку. Если вы хотите использовать LCD&монитор камеры, не
подключайте телевизор, а убедитесь в том, что он применяет развер&
тку для изображения.

Рис. 4.13. На шкале времени используется шаблон PWCut1

Пользуйтесь телевизоров, чтобы избежать неприятных сюрпризов
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Для соединения устройств воспользуйтесь кабелем IEEE&1394 (FireWire или
i.LINK). Подключите камеру к телевизору с помощью видеокабеля (так же, как и
при просмотре видео с камеры). Возможно, вам понадобится использовать RCA&
кабель или специальный кабель, который поставляется компанией – производи&
телем вашей модели камеры. Например, камера Panasonic PV&GS120 применяет
для передачи аудио/видеосигнала кабель mini&AV, а камера Canon XL2 поддержи&
вает интерфейсы BNC, S&Video и RCA.

После подключения устройств друг к другу ваш аудио/видеосигнал будет пе&
редаваться следующим образом:

• от вашей системы редактирования на камеру (где выполняется конвертиро&
вание из цифрового в аналоговый формат);

• от вашей камеры на телевизор.

На рис. 4.15 показано, какие кабели и порты вам понадобятся для того, чтобы
установить соединение между видеокамерой и телевизором.

Рис. 4.14. Мы объединили два поля из различных кадров.
Полученное изображение выглядит необычно

Рис. 4.15. Кабельные соединения между компьютером,
камерой и телевизором

Затем вы сможете включить ваш компьютер, камеру и телевизор (в этот момент
ваша компания – поставщик электроэнергии вполне может отправить вам поздра&
вительную открытку с выражением благодарности).

Чтобы послать видеосигнал от компьютера на телевизор, вам нужно соответ&
ствующим образом настроить свою систему:

• Avid. Конфигурируется автоматически;
• Final Cut. Выберите пункты меню View ⇒ External Video ⇒ All Frames;
• Premiere. Выберите пункты меню Project ⇒ Project Settings ⇒ General ⇒

Playback Settings ⇒ Video Playback ⇒ Play Video on DV Hardware;
• iMovie. Выберите пункты меню iMovie HD ⇒ Preferences ⇒ Playback ⇒

Play DV project video through to DV camera (Воспроизвести DV
проект на
DV
камере).

После настройки вы сможете просмотреть на телевизоре видео, с которым вы
работаете в системе редактирования.

Если вы пользуетесь данной методикой, то заметите, что видео и аудио не отли&
чаются синхронизацией. С большой вероятностью вы увидите картинку на теле&
визоре, но будете слышать звук от компьютера. Так как сигналу от компьютера
нужно пройти через ряд кабелей и устройств (например, через камеру) на пути
к телевизору, существует небольшая задержка по времени перед его отображени&
ем. Звук идет от другого источника, поэтому он не синхронизируется с картинкой.

Пользуйтесь телевизоров, чтобы избежать неприятных сюрпризов

1394
(FireWire/LINK)

Кабель
Audio/Video

(RCA , miniAVI)
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Чтобы решить проблему, сконфигурируйте изображение и звук для одного ис&
точника. Если вы смотрите видео на телевизоре, вам необходимо добиться того,
чтобы звук тоже шел от телевизора. Для этого вам может потребоваться настроить
вашу систему на отправку звукового сигнала от внешнего устройства.

Если вы будете пользоваться внешним телевизором, это позволит вам полу&
чить и другие преимущества, помимо устранения неправильной развертки в кад&
рах. Например, ваш телевизор будет отображать только видео, поэтому изображе&
ние должно выглядеть больше, чем на компьютерном мониторе. Кроме того, если
вы работаете вместе с коллегами, им не придется все время заглядывать через
ваше плечо. Наконец, возможность просмотра видео на экране телевизора может
оказаться весьма полезной для вашего проекта.

Совет 45 Конвертирование файла с титрами
в скрипт

Если вы добавили в ваш проект титры, то можете применить кодировку Perl, что&
бы извлечь из файла скрипт для других пользователей.

Если вы продаете кому&то видеопроект, скорее всего, ваш клиент затребует
скрипт с информацией о временной кодировке (так называемый телевизионный
скрипт). Однако в документальном фильме или реалити&шоу такой скрипт вряд
ли будет доступен.

Создание телевизионного скрипта – это длительный и сложный процесс. Вам
необходимо прослушать запись звука и зафиксировать услышанный текст. Часто
бывает так, что для правильной интерпретации вам приходится прослушать за&
пись несколько раз.

Некоторые дизайнеры создают файлы с титрами, чтобы упростить эту задачу.
Здесь мы поговорим о том, как вы можете конвертировать файл с титрами в скрипт.

Мотивация
Даже если у вас нет опыта программирования, однажды вам наверняка захочется
написать несколько строк кодировки на Perl, языке компьютерного программиро&
вания. Если бы мне предложили сделать выбор между несколькими часами про&
слушивания записи и получасом составления и редактирования программы,
я уверенно выбрал бы второе. Стоит только один раз попробовать применить про&
грамму, и вы очень быстро к ней привыкнете.

Следующий скрипт на языке Perl был написан для телевизионной
программы, авторам которой понадобилось составить телевизионный
скрипт для 140 ч видео. По приблизительным подсчетам, человеку
необходимо не менее 5 ч, чтобы зафиксировать текст для 1 ч видео.
Следовательно, для записи данного материала вручную потребовалось
бы около 560 ч.

Рассмотрим файл с титрами
В процессе создания титров вы добавляете кодировку в строку 21 видеосигнала.
Если вы не знаете, что это значит, учтите, что формат NTSC DV имеет разрешение
720 × 480 (то есть 720 строк в ширину и 480 строк в высоту). Данные титров будут
добавлены в строку 21 по высоте.

Формат NTSC для телевидения содержит 525 строк по горизонтали.

Вы можете открывать файл с титрами в любом текстовом редакторе, как и мно&
гие другие документы. Однако результат нельзя назвать впечатляющим. Далее
я приведу выдержку из файла с титрами (имеет разрешение .tds).

u ò01000013

uêFUfl 14,Ufl14)Ufl 13tUfl17”Ufl 11. Coming up:Ufl14tUfl 17”Whoa, wait.

u ò01000112

uêFUfl 14 Ufl 14.Ufl14tUfl17!Ufl 11. That’s got meUfl 14, Ufl 14/

u ò01000209

uêFUfl 14 Ufl 14rUfl17#a little nervous. Ufl 14, Ufl 14/

u ò01000316

uêFUfl 14 Ufl 14RThese guys are not likeUfl14rUfl 17!my friends back home.Ufl 14, Ufl14/

Посмотрите на кодировку. Вы сразу заметите в ней прямую речь. В этом приме&
ре вы видите слова Coming up. Остальной текст достаточно непонятен.

Но если вы вглядитесь внимательнее, вы отметите определенное правило: uò
(номер), предложение, затем uò (номер) и т. д. Номер после буквы u ò состоит из
восьми цифр. Следовательно, он представляет собой временную кодировку.

Сделаем вывод: текст uò01005108 обозначает время 01:&00:51;08.

Кодировка
Язык программирования Perl очень эффективно работает с текстом. Кодировка
Perl может быть сложной для чтения и восприятия, однако она позволяет вам ре&
шать различные задачи и сэкономить много времени. Если вы работаете в среде
Mac OS X или Linux, скорее всего, язык Perl уже установлен на вашем компьюте&
ре. Если вы работаете в среде Windows, то можете загрузить язык программирова&
ния Perl с сайта Active State (http://www.activestate.com/Products/ActivePerl/;
поставляется бесплатно).

Далее я приведу скрипт Perl, который используется для форматирования фай&
лов с титрами (.tds).

#!/usr/bin/perl

# for Caption Center (.tds) files

while (<>) {

# remove everything before and including BeginData

Конвертирование файла с титрами в скрипт
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$_ =~ s/. *BeginData//g;

# remove all of the >>

$_ =~ s/>> //g;

# remove all of the uêF

$_ =~ s/\x9cF//g;

# remove all of the Ufl followed by 3 characters

$_ =~ s/\x9e(…)/ /g;

# reformat the timecodes… i.e. u ò01005108 to 01:00:51;08

$_ =~ s/\x9d([0-9][0-9])([0-9])([0-9])([0-9][0-9])

/\r\1:\2:\3\;\4\t\t/g;

# replace all of the places where there is a tab-tab-return with a single

tab

$_ =~ s/\t\t\r/\t/g;

# print everything back out

print $_;

}

Вот и все. Работа с кодировкой завершена.
Сохраните файл на вашем компьютере и назовите его, к примеру,

CCConverter.pl (или как&нибудь иначе).

Дополнительные возможности
После того как вы запишите кодировку Perl, вам понадобится лишь загрузить
в нее файлы с титрами. Для этого введите следующий текст в командной строке:

perl CCConverter.pl <MyScriptCC.tds >MyScript.txt

Выполните следующие действия, чтобы запустить программу
из командной строки:
• Mac OS X. Откройте приложение Terminal, которое находится

в папке Utilities;
• Windows. Выберите в меню Start пункт Run. Введите текст

command.
Запускать скрипт Perl вам будет проще из папки, в которой он нахо&
дится.

Вам необходимо ввести сначала название файла с титрами, а затем название
конечного файла. Символ «<» сообщает кодировке Perl, какой файл следует про&
читать, а символ «>» – какой файл следует записать.

Результат
Далее я приведу оригинальный файл после конвертирования в программе Perl.

01:00:00;13 Coming up: Whoa, wait.

01:00:01;12 That’s got me

01:00:02;09 a little nervous.

01:00:03;16 These guys are not like my friends back home.

Благодаря использованию скрипта вам удалось сэкономить три часа своего
времени. Поэтому у вас появится дополнительное время, которое вы можете по&
тратить на чтение этой книги, общение со своими родственниками или даже на
прогулку на свежем воздухе.

Совет 46 Как сделать изображение
более привлекательным для аудитории

Не имеет значения, работаете ли вы с одним или с несколькими исходными файла&
ми, – очень часто после редактирования изображение выглядит неестественно. Ис&
пользуя простую методику, вы можете полностью скрыть внесенные изменения.

Любой видеоклип (начиная от 30&секундного рекламного ролика и заканчивая
трехчасовым документальным фильмом) имеет свой сюжет. Для сюжета очень
важен переход от одного раздела проекта к другому. Однако после редактирова&
ния переход может быть нарушен. Чтобы решить проблему, вы можете применить
методику, которая называется «раздельное редактирование» (а также L&редакти&
рование, или J&редактирование).

Раздельное редактирование
Для раздельного редактирования необходимо разделить аудио& и видеоматериал
на шкале времени. Это значит, что в некоторых системах редактирования, напри&
мер Final Cut Pro, вам понадобится удалить ссылки или разблокировать аудио&
и видеотреки. Другие системы (к примеру, Avid Xpress) позволяют вам выпол&
нить раздельное редактирование без предварительной подготовки.

Вы можете продолжить работу с аудиотреком после удаления видеоматериала,
и наоборот. Другими словами, аудио (или видео) трек будет воспроизводиться
даже после того, как видео (или аудио) трек закончится. Для этого вам нужно из&
менить направление соответствующего трека на шкале времени.

L)редактирование
При L&редактировании аудиотрек материала воспроизводится дольше, чем видео&
трек. На шкале времени вы можете направить видеотрек назад либо аудиотрек –
вперед. Вы можете использовать эту методику, чтобы привлечь внимание зрителей
к разговору между персонажами. На рис. 4.16 показано L&редактирование на шкале
времени Avid. Обратите внимание на то, как аудиотрек следует за видеотреком.

J)редактирование
Как вы и подумали, J&редактирование является прямой противоположностью
L&редактированию. На шкале времени вы можете направить видеотрек вперед,
либо аудиотрек  назад. Вы можете использовать эту методику, чтобы устранить
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неполадки, возникшие при редактировании (звук готовит зрителей к перемене
картинки). На рис. 4.17 показано J&редактирование на шкале времени Avid. Обра&
тите внимание на то, как видео трек следует за аудиотреком.

Если вы редактируете диалог, то можете использовать раздельное редактиро&
вание для перехода от одного персонажа к другому. В результате в течение опре&
деленного времени на экране остается изображение человека, который слушает
своего собеседника. Здесь методика раздельного редактирования позволяет вам
создать более интересную с точки зрителя сцену.

Кроме того, вы можете использовать раздельное редактирование для устране&
ния неполадок, связанных с видео или звуком. Например, если ваш материал
содержит ненужную композицию, допустим, речь посторонних людей, вы може&
те применить J&редактирование и изменить угол снимка либо добавить новый
кадр.

Когда вы изучите раздельное редактирование, вы не только начнете регулярно
его использовать, но и начнете замечать, что данная методика активно применяет&
ся в различных фильмах.

Дополнительные возможности
В фильме «Веревка» Альфред Хичкок (Alfred Hitchcock) попытался создать
полноценный проект без редактирования. Несмотря на то что режиссеру при&
шлось иметь дело с ограничениями, связанными с размером киножурналов (то
есть любой исходный файл содержал не более 10 мин видео), ему удалось со&
здать настоящий шедевр. Из девяти фрагментов фильма вы сможете заметить
только четыре.

Чтобы добиться нужного эффекта, Альфред Хичкок заранее снял опреде&
ленную композицию, которая должна была поместиться в кадр с переходом.
Например, в момент, когда пленка заканчивалась, на экране появлялось изоб&
ражение человека, который заслонял собой камеру. Переход осуществлялся
тогда, когда зритель переставал видеть что&либо, кроме одежды или лица пер&
сонажа. В результате новый фрагмент начинался точно там, где закончился
предыдущий.

Комбинируя методику Хичкока и раздельное редактирование, вы сможете со&
здать очень интересную и современную видеокомпозицию.

Совет 47 Создаем интерактивный видеокаталог

Нам всем приходилось слышать о том, что однажды мы сможем щелкнуть по ру&
башке ведущего телевизионного шоу, чтобы получить о ней дополнительные све&
дения или даже ее купить. И этот день настал.

При просмотре цифрового видео на компьютере вам доступны многочислен&
ные функции, которые не поддерживаются на DVD или видеопленке, например
ссылки на URL&адреса (совет 84), а также закладки на различные эпизоды филь&
ма (совет 49). Так называемая точка ссылки (hotspot) позволяет композиции реа&
гировать определенным образом в момент, когда зритель щелкает по экрану. Ком&
бинируя точки ссылки, URL&адреса и закладки, вы можете самостоятельно со&
здать интерактивный видеокаталог.

Рис. 4.16. L�редактирование в программе Avid

Рис. 4.17. J�редактирование в программе Avid

Используем раздельное редактирование
Несмотря на то что звук составляет весьма незначительную часть сигнала, он
играет очень важную роль в процессе создания фильма. Применяя звук, вы смо&
жете смягчить недостатки видео, которые являются уязвимыми местами вашей
композиции. Выбор опции в раздельном редактировании определяется компо&
зицией вашего материала, а также типом перехода, который вы хотите сформи&
ровать.

Создаем интерактивный видеокаталог
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Создаем видео
Создание видео – это достаточно непростой процесс. Интерактивность еще боль&
ше его усложняет. Если вы решили создать интерактивный каталог, во время съе&
мок вам необходимо учесть некоторые особенности.

Во&первых, постарайтесь сделать так, чтобы интерактивный объект не был
скрыт другими объектами или персонажами. Это даст зрителю возможность акти&
вировать объект в любое удобное время. Например, если вы хотите, чтобы зритель
щелкнул по телевизору, не размещайте перед ним посторонние объекты.

Кроме того, вам нужно добиться того, чтобы интерактивный объект был непод&
вижен. Лучше всего использовать штатив (даже при съемке с нескольких камер).
Неподвижное положение объекта в кадре упрощает задачу зрителя, потому что
ему не приходится искать нужный предмет с помощью мыши.

Наконец, учитывайте размер объекта относительно размера изображения.
Если ваши зрители должны купить телевизор, не стоит отправлять его на задний
план или уменьшать в размерах.

Если нужный объект слишком маленький, вы можете выделить его в кадре во
время редактирования. Например, вы можете использовать окружность в начале
композиции либо сделать все прочие объекты черно&белыми (см. совет 74). В лю&
бом случае вам необходимо помнить об этом при работе над сценой.

Создание точки ссылки
Методика создания точек ссылки зависит от того, с каким приложением вы собира&
етесь работать. Вам доступны три редактора: LiveStage Pro (http://www.totallyhip.
com/; 449 долл. США), Cleaner (http://www.discreet.com/cleaner/; 549 долл.
США) и VideoClix (http://www.videoclix.com; 349 долл. США). К сожалению, эти
программы работают только в среде Macintosh.

Предыдущая версия программы Cleaner для операционной системы
Windows (версия 5) включала опцию для создания точек ссылки,
а также других интерактивных элементов (EventStream). Для создания
точек ссылки в среде Windows вам нужно установить программу
Cleaner 5 или загрузить соответствующее обновление.

Так как в сети Интернет имеются интерактивные руководства для LiveStage
Pro и VideoClix, здесь мы расскажем только о приложении Cleaner.

После запуска программы вам необходимо импортировать видео: выберите
пункты меню Batch ⇒ Add Files (Пакет ⇒ Добавить файлы). Выберите видео&
файл, записанный на вашем жестком диске. Для создания точки ссылки вы долж&
ны отредактировать данные EventStream. Вы можете дважды щелкнуть по иконке
видео или выполнить команду Windows ⇒ Project. Откроется окно Project
(Проект).

В окне Project выберите пункты меню EventStream ⇒ Edit (кнопка Edit нахо&
дится справа от вкладки). Откроется окно EventStream. Чтобы добавить точку

ссылки, вам нужно найти соответствующий фрагмент видео и нажать кнопку
Add. Будет создано новое событие.

В ниспадающем меню Event Type (Тип события) выберите пункт Hotspot
(Точка ссылки). Затем вы можете щелкнуть и выделить интерактивную часть
изображения. Кроме того, вы можете выбрать форму точки, а также настроить ее
как ярлык. На рис. 4.18 показана точка ссылки, для которой мы выбрали форму
овала.

Рис. 4.18. Создаем точку ссылки овальной формы

Точка ссылки создана; однако вам необходимо выполнить некоторые дополни&
тельные действия. Во&первых, если вы не хотите, чтобы продолжительность вос&
произведения точки ссылки соответствовала продолжительности всего видео&
фильма, вы должны ее настроить. Сделать это в программе Cleaner очень просто:
щелкните по небольшому ниспадающему меню справа от текстового поля
Duration (Продолжительность воспроизведения). Меню предлагает три опции:
To In Point (К точке входа), To Out Point (К точке выхода) и To Current Time
(К текущему времени). При выборе любой опции соответствующее значение бу&
дет автоматически введено в текстовом поле Duration.

Нажмите кнопку Add Action (Добавить действие), чтобы создать действие для
точки ссылки. Будет создано событие, которое выполняется при щелчке по точке
ссылки. При создании каталога вы можете использовать два действия: Open URL
(Открыть сайт) и Go To Time (Перейти по времени). На рис. 4.19 показан процесс
создания действия Open URL для точки ссылки. Это действие открывает задан&
ный сайт в Web&браузере пользователя.

Выбор действия определяется тем, как именно вы собираетесь использовать
свой каталог. Если вы планируете добавить в свой проект Web&сайт (например,
предназначенный для интерактивных покупок), добавьте действие Open URL и

Создаем интерактивный видеокаталог
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введите URL&адрес данного сайта. Если вы хотите, чтобы видео отображалось на
Web&странице, выберите опцию Target (Цель). Сайт будет открываться в отдель&
ном кадре (вам поможет знание HTML&кодировки).

Если вы желаете обеспечить зрителя дополнительной информацией, восполь&
зуйтесь действием Go To Time. В результате при щелчке по точке ссылки проис&
ходит переход к другому фрагменту видео (например, к изображению объекта
крупным планом), а также открывается диалоговое окно. Поначалу данное дей&
ствие может показаться вам достаточно запутанным, но в то же время инте&
ресным.

При решении сложных задач вы можете использовать в одном и том же проекте
оба действия, Open URL и Go to Time. Вы можете создать несколько точек ссыл&
ки. После завершения изменений не забудьте нажать кнопку Save (Сохранить)
в окне EventStream. В противном случае все сконфигурированные вами события
не будут сохранены.

Смотри также
• LiveStage Pro (http://www.totallyhip.com/; 449,95 долл. США);
• VideoClix (http://www.videoclix.com; 349–499 долл. США).

Дополнительные возможности
Вы можете использовать точки ссылки для создания каталога, но этим их функ&
ции не ограничиваются. Например, вы можете создать фильм, в котором у зрите&
ля будет возможность выбора. Добавьте точку ссылки и действие, осуществляю&
щее переход к другому фрагменту фильма, – и ваши зрители смогут самостоя&
тельно влиять на развитие сюжета.

К примеру, вы можете создать сцену, в которой персонажу нужно выбрать одну
из двух дверей (как в телевизионном шоу). Вы можете сконфигурировать проект

таким образом, чтобы зритель сделал выбор сам. Разумеется, вам понадобится
снять две сцены (для различных дверей).

Не имеет значения, как именно вы будете использовать точки ссылки. Очевид&
но одно: ваш проект вышел за рамки традиционного видео.

Совет 48 Устраняем ошибки во временной
кодировке на записанной кассете

Ошибки во временной кодировке способны доставить вам много проблем. Их сле&
дует устранить так быстро, как только возможно.

Если ваша временная кодировка содержит переход к более раннему фрагменту,
у вас возникнут трудности при оцифровке материала. Например, если ваша кассе&
та имеет кодировку 00:34:23;00, которая обнуляется (00:00:00;00), это значит, что
вы столкнулись с проблемой, которую необходимо устранить в максимально ко&
роткие сроки. Чтобы избежать подобных трудностей, вам следует выполнять
предварительную кодировку всех кассет (см. совет 4).

Некоторые пользователи пытаются устранить проблемы с временной кодиров&
кой путем нумерации кассет. К примеру, кассета TCP001 содержит запись до раз&
рыва, а кассета TCP001.1 – после него. Такой подход не только не позволяет уст&
ранить неполадки, но и создает дополнительные трудности (см. совет 3).

Если вы хотите решить проблему с временной кодировкой на кассете, вам при&
дется переписать данные на другую кассету или на компьютер. В процессе переза&
писи материала его качество может ухудшиться. Вам необходимо исправить вре&
менную кодировку и сохранить оригинальное качество материала.

Как избежать ухудшения качества
В прошлом активно использовались такие видеоформаты, как VHS и Beta. При
копировании с одной кассеты на другую качество видеоматериала снижалось.
Многие пользователи называли этот эффект «потерей качества при перезаписи».
К счастью, при работе с цифровыми форматами вы можете скопировать ваш мате&
риал, и его качество не ухудшится.

Чтобы избежать проблем с потерей качества, вам необходимо создать цифро&
вую копию материала. Для этого следует подключить два устройства друг к другу.
Многие цифровые видеокамеры и деки оборудованы разъемом IEEE&1394, кото&
рый предназначен для создания такого соединения.

Очень часто порт IEEE&1394 называют FireWire® или i.LINK®.

Разъемы IEEE&1394 бывают трех типов:

• 4&контактные;
• 6&контактные;
• 9&контактные.

Рис. 4.19. Создаем действие Open URL

Устраняем ошибки во временной кодировке на записанной кассете
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Как правило, вам не придется работать с 9&контактными разъемами. Не так
просто определить, какой именно кабель вам понадобится для соединения двух
устройств. У вас есть три варианта:

• 4&контактый и 4&контактный;
• 4&контактный и 6&контактный;
• 6&контактный и 6&контактный.

Многие продавцы, с которыми мне приходилось иметь дело, не знают о разли&
чиях между этими кабелями, поэтому вам придется заранее подготовиться к посе&
щению магазина. На рис. 4.20 показано, чем различаются данные типы кабелей.

Существуют различные типы цифрового видео. Вы должны точно
знать, с каким типом вы работаете. Большинство цифровых камер
записывают видео в формате DV, однако встречаются и другие форма&
ты: DVCPRO, DVCAM и HDV.

Кроме того, вам следует убедиться в том, что свободного места на вашем жест&
ком диске достаточно для записи всей кассеты. В формате DV для сохранения од&
ного часа видеоматериала вам понадобится примерно 13 Гб.

Чтобы выполнить оцифровку материала, подключите камеру или деку к ваше&
му компьютеру. После этого вам нужно записать материал с кассеты на компью&
тер. Все системы редактирования различаются, но результат будет одинаковым.
Приведу список действий для различных систем:

• Avid. Выберите пункты меню Tools ⇒ Capture;
• Final Cut. Выберите пункты меню File ⇒ Log and Capture;
• Movie Maker. Выберите пункты меню File ⇒ Capture Video;
• Premiere. Выберите пункты меню File ⇒ Capture;
• iMovie. Переключитесь в режим Camera и нажмите кнопку Record.

Если ваша система редактирования поддерживает функцию Ignore
Timecode Breaks (Игнорировать разрывы во временной кодировке),
активируйте ее.

После завершения оцифровки материала поместите его на шкалу времени,
а затем экспортируйте на новую кассету:

• Avid. Выберите пункты меню Clip ⇒ Digital Cut;
• Final Cut. Выберите пункты меню File ⇒ Print to Video;
• Movie Maker. Выберите пункты меню File ⇒ Save Movie File;
• Premiere. Выберите пункты меню File ⇒ Export ⇒ Export to Tape;
• iMovie. Выберите пункты меню File ⇒ Share ⇒ Videocamera ⇒ Share.

Вы можете выполнить запись на оригинальную кассету, но в случае
сбоя (например, питания) вы можете потерять свой материал.

Как и при использовании двух камер или дек, вы создаете точную цифровую
копию вашей кассеты&мастер и устраняете ошибки во временной кодировке.

Заключение
После завершения процесса промаркируйте вторую кассету как мастер и запиши&
те, на какой кассете содержится какой материал. Правильная маркировка имеет
огромное значение для вашего проекта (см. совет 1).

Два видеоустройства
Если вам повезло и вы используете два видеоустройства (камеры или деки), вы
можете быстро создать цифровую копию своей записи.

Вы не можете использовать RCA&порт для создания цифровой копии,
потому что он поддерживает только аналоговый формат. Если вы
выполните запись через RCA&порт, ее качество ухудшится.

Для копирования соедините два устройства посредством кабеля IEEE&1394.
Поместите кассету&мастер в первое устройство, а пустую кассету – во второе. На&
жмите кнопку Play на первом устройстве и кнопку Record – на втором. На вто&
рую кассету будет записан весь материал (аудио и видео) с первой кассеты. В ре&
зультате вторая кассета будет содержать точную копию вашего материала, но с
новой, неразрывной временной кодировкой. Если у вас есть закодированная кас&
сета (см. совет 4), вы можете использовать ее.

Оцифровка и вывод данных
Если у вас есть только цифровая видеокамера, для вас еще не все потеряно. Вы
можете устранить неполадки с временной кодировкой. Для этого выполните
оцифровку данных. Вам придется использовать для оцифровки тот кодек, с по&
мощью которого видео было записано. Например, если вы используете DVCPRO,
при записи материала применяйте этот же кодек.

Рис. 4.20. Выбираем тип соединения для различных устройств

Устраняем ошибки во временной кодировке на записанной кассете
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Совет 49 Добавление закладок в фильм

Приложения QuickTime и Windows Media позволяют пользователям переходить
к определенным фрагментам видео. Используя данную функцию, вы можете со&
здавать закладки для фильма.

При проведении кастинга для фильма вам необходимо встретиться с большим
количеством людей. Даже после того как вы составите список кандидатов, вам
понадобится время от времени просматривать запись их интервью. Возможно, вы
отправите эти записи своим коллегам и обратитесь к ним за советом. Вы можете
записать одну видеокассету или DVD для каждого кандидата или создать один
цифровой файл, в котором с помощью специальной функции вы сможете перехо&
дить от одного кандидата к другому.

Для осуществления перехода между фрагментами видео вы должны создать
определенные метки. В приложении Quicktime такие метки называются главами,
а в Windows Media – маркерами. Для упрощения терминологии я буду называть
их закладками.

Несмотря на то что и QuickTime, и Windows Media поддерживают закладки,
методики их создания значительно различаются. В QuickTime вы используете
QuickTime Pro (http://www.apple.com/quicktime/upgrade/; 29,99 долл. США) и
текстовый редактор. В Windows Media следует применить редактор Windows
Media File Editor, который входит в комплект инструментов Windows Media
Encoder 9 Series от компании Microsoft (http://www.microsoft.com/windows/
windowsmedia/9series/encoder/default.aspx; бесплатно). Если вы собираетесь рас&
пространять оба типа видео, то можете использовать приложение Discreet Cleaner
(http://www.discreet.com/products/cleaner; 549 долл. США), чтобы создать зак&
ладки.

Если для редактирования вы применяете программу Final Cut Pro или
Premiere, то можете создавать главы в вашей системе редактирования
с помощью маркеров. После добавления маркеров закладки будут
автоматически добавлены в последовательность во время экспорта.
В программе Final Cut вы можете выбрать пункты меню Mark ⇒
Markers ⇒ Edit, чтобы отредактировать маркер. Затем вы можете
ввести команду <CHARTER> в текстовом поле Comment либо нажать
кнопку Add Chapter Marker (Добавить маркер главы).
В программе Premiere вы можете выбрать пункты меню Marker ⇒ Edit
Sequence Marker, чтобы отредактировать маркер. Затем необходимо
переместить заголовок главы в текстовое поле Chapter.

Создание глав в программе QuickTime Pro
Если на вашем компьютере установлены программа QuickTime и текстовый ре&
дактор, вы сможете создать главы видео. Однако предварительно вам понадобит&
ся выполнить обновление до QuickTime Pro, чтобы получить доступ к скрытым

функциям. Кроме того, при обновлении вы получите возможность выполнять ре&
дактирование, добавлять фильтры и эффекты (см. совет 39), экспортировать
фильмы на мобильный телефон и использовать некоторые другие опции.

Создание списка глав
Чтобы создать трек главы, вы должны сформировать список глав, к которым зри&
тели смогут обращаться. Используя текстовый редактор, например Text Edit, со&
здайте список глав, разделенных разрывом строки. Допустим, в списке кандида&
тов вы можете ввести главы, которые соответствуют их именам:

• Оксфорд Уэллс (Oxford Wells);
• Тони Кларк (Tony Clark);
• Рич Гейбл (Rich Gable);
• Джой Харпер (Joey Harper).

После этого сохраните список как текстовый файл.
Затем запустите приложение QuickTime Player, выполните команду File ⇒

Import и выберите текстовый файл со списком глав. В результате программа им&
портирует текстовый файл и создаст фильм QuickTime на его основе. На рис. 4.21
показан текстовый файл после импорта в QuickTime Player.

Рис. 4.21. Импортированный текстовый файл,
который будет использоваться в качестве списка глав

Как это ни странно, но после импорта списка глав вам необходимо его экспор&
тировать. Команда File ⇒ Export открывает окно экспорта с небольшим количе&
ством опций. Настройки этих опций очень важны, потому что они оказывают воз&
действие на список глав.

Чтобы создать текстовый файл, выберите в ниспадающих меню пункты Export
⇒ Text to Text, а затем Use ⇒ Text with Descriptors. Кроме того, вы должны на&
жать кнопку Options и выбрать опции Show Text (Показать текст), Descriptors
(Закладки) и Time (Время). Также выберите в окне Options команды Show time
relative to start of ⇒ Movie (Показать время относительно начала ⇒ Фильма) ⇒
1/30, как показано на рис. 4.22.

Добавление закладок в фильм
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Редактирование текстового файла закладки
После экспорта файла закладок QuickTime вам нужно открыть его в текстовом
редакторе. Кроме того, вам необходимо открыть фильм в программе QuickTime
Player. После этого выполните команду Movie ⇒ Get Movie Properties, а затем
выберите пункт Movie в первом и пункт Time – во втором ниспадающем меню.

Когда вы откроете файл, который был экспортирован из приложения
QuickTime Player, то заметите, что некоторые слова и числа заключе&
ны в скобки и кавычки, а к тексту было применено специальное форма&
тирование. Не следует изменять это форматирование,
за исключением временной кодировки в скобках ([]) и соответствующе&
го заголовка главы. Например, далее я приведу кодировку для главы
00:11:10.08 с заголовком «Тони Кларк»:
[00:11:10.08]
{textbox: 0, 0, 50, 160}Tony Clark

Обратите внимание: временная кодировка имеет формат [HH:MM:SS.FF], а за&
головок главы отображается в строке под ней, после ввода форматирования
QuickTime.

Окно Properties отображает текущее время (ваше положение на шкале време&
ни фильма), продолжительность воспроизведения фильма, а также параметры
Selection Start и Duration Time, которые являются аналогами точек In и Out. При
изменении положения на шкале времени точка Current Time перемещается соот&
ветствующим образом.

Когда вы найдете нужный фрагмент для перехода, например начальную точку
интервью кандидата, введите текущее значение времени в текстовый файл.

Используя данную методику, введите данные для всех глав вашего проекта. На
рис. 4.23 показан фильм, окно Properties и текстовый файл, который мы редакти&
руем как список глав.

Рис. 4.22. Мы настроили опции Text Export Settings
для работы со списком глав

Рис. 4.23. Создаем список глав в текстовом файле

Вы не можете изменять порядок глав в списке. Следовательно, если
начальный список глав не соответствует порядку глав в вашем видео,
вам придется изменить список. Например, если изначально интервью
с Джоем Харпером было первым, но в видео оказалось на четвертом
месте, вам нужно переместить его в списке.

Последняя временная кодировка в вашем текстовом файле должна соответ&
ствовать продолжительности воспроизведения фильма. Если продолжительность
фильма составляет 00:39:35.00, введите временную кодировку [00:39:35.00].
После этого сохраните текстовый файл и импортируйте его в программу

Добавление закладок в фильм
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QuickTime Player: выполните команду File ⇒ Import и выберите файл в диалого&
вом окне.

Создаем список глав из файла с закладками
После импорта файла с закладками в программу QuickTime Player выберите пун&
кты меню Edit ⇒ Select All (Выбрать все) и Edit ⇒ Copy (Копировать). Затем
вставьте скопированный проект в фильм, для которого вы хотите создать список
глав. Выберите фильм и выполните команду Edit ⇒ Add Scaled. Это позволит вам
использовать импортированный текст в качестве списка глав для фильма.

В окне Properties нового проекта выберите пункт Text Track (Текстовый список)
в первом и пункт Make Chapter (Создать главу) – во втором ниспадающем меню.
Затем нажмите кнопку Chapter Owner Track (Содержание главы) и выберите аудио&
или видеотрек. На рис. 4.24 показано окно Properties с новым треком главы.

Вряд ли вам понадобится использовать это поле, поэтому я советую выполнить
команду Edit ⇒ Enable Tracks (Активировать треки) и выбрать пункт меню Text
Track, чтобы его отключить. Затем воспользуйтесь ниспадающим меню трека,
чтобы проверить, выполняется ли переход к другому фрагменту. Если результат
вас не устроил, вам придется повторить вышеописанные действия и внимательно
проверить временную кодировку, а также заголовки глав.

После этого выберите пункты меню File ⇒ Save As и нажмите переключатель
Make movie self
contained. Готово! Это было забавно.

Создание закладок с помощью редактора
Windows Media File Editor
Редактор Windows Media File Editor (как и некоторые другие приложения) уста&
навливается на ваш компьютер при загрузке пакета инструментов Windows Media
Encoder 9 Series. Работать с редактором File Editor достаточно просто, однако вам
понадобится записать видео в нужном формате (WMV или ASF). В программе вы
можете добавить команды, которые позволяют отображать текст, открыть прило&
жения, вызвать URL&сайты или активировать другие скрипты.

Открываем видео
После запуска программы Windows Media File Editor вам необходимо открыть
видеофайл для редактирования. Для этого выберите пункты меню File ⇒ Open и
найдите файл. Приложение открывает исключительно файлы Windows Media
(.wmv и .wma) или ASF. Если ваше видео было записано в другом формате, вам

Рис. 4.24. Новый трек главы
с настройкой Video Track (Видеотрек)

Функция Preloading (Предварительная загрузка) позволяет вам настроить
список глав на предварительную загрузку (до загрузки фильма). Несмотря на то
что приложение QuickTime Player может автоматически активировать предвари&
тельную загрузку для списка глав, я советую вам убедиться в том, что данная функ&
ция действительно была включена. Выберите пункт Preload во втором ниспадаю&
щем меню окна Properties и проверьте, выбрано ли поле флажка Preload.

Завершение создания фильма со списком глав
После формирования списка глав вы заметите небольшое ниспадающее меню
в окне фильма. Как показано на рис. 4.25, это меню содержит заголовки глав и
позволяет пользователю быстро переключаться между фрагментами проекта. Об&
ратите внимание на черное поле рядом с заголовком каждой главы.

Рис. 4.25. Трек главы
содержит неудобное черное поле в углу

Добавление закладок в фильм



190 Редактирование 191

нужно его конвертировать (см. совет 29). Вы можете выполнять конвертирование
между различными форматами Windows Media с помощью инструментов Micro&
soft Windows Media Encoder 9 Series. На рис. 4.26 показан файл WMV, Audition,
который открыт в редакторе Windows Media File Editor.

Сохраняем фильм с маркерами
После ввода информации обо всех маркерах вы должны сохранить свой видео&
файл. Чтобы сохранить маркеры в текущем файле, выберите пункты меню File ⇒
Save and Index (Сохранить и индексировать). Все маркеры будут сохранены.

После сохранения фильма вы сможете переходить от одного маркера к друго&
му. Для этого выполните команду View ⇒ File Markers (Вид ⇒ Маркеры файла)
и выберите нужный маркер. На рис. 4.28 показаны маркеры для интервью актеров
в фильме Audition.

Если вы хотите сохранить видео в другом формате, выберите пункты меню File
⇒ Save As and Index (Сохранить как и индексировать). Функция Save As позво&
ляет вам экспортировать видео как файл Windows Media или ASF. Это полезная
функция, которая может вам помочь при определенных обстоятельствах.

Используем приложение Cleaner для создания закладок
Если у вас есть программа Discreet Cleaner и вы хотите упростить себе жизнь или
использовать для распространения видеоформаты QuickTime и Windows Media,
я рекомендую вам создать закладки в приложении Cleaner. Данная опция носит
название «событие главы» (chapter event).

Рис. 4.26. Открываем видеофайл в редакторе Windows Media File

После этого вы сможете воспроизвести свой файл. Кроме того, вы можете до&
бавлять маркеры, команды скрипта и сведения о различных атрибутах, например
заголовок, автора и информацию об авторских правах.

Добавляем маркеры
Чтобы добавить маркеры, просмотрите видео и выберите нужную точку. Нажми&
те кнопку Markers (Маркеры), чтобы открыть окно Markers. Если вы знаете,
сколько раз вы хотите использовать определенный маркер, это позволит значи&
тельно ускорить весь процесс.

Окно Markers содержит список всех маркеров видеофайла. Если вы нажмете
кнопку Add, откроется диалоговое окно, которое предназначено для ввода пара&
метров маркера (Name – Название и Time – Время). Текущее время (ваше поло&
жение в файле) будет введено в поле Time. Поэтому вам достаточно указать назва&
ние для каждого маркера (например, имя актера). На рис. 4.27 показан маркер
с названием Джой Харпер и временной кодировкой 00:36:26.1.

После ввода названия и временной кодировки нажмите кнопку OK, чтобы зак&
рыть окно Marker Properties. Если вы не знаете временную кодировку для других
маркеров, нажмите кнопку OK, чтобы закрыть окно Markers и найти следующую
точку в фильме. Вам придется повторить эти действия для каждого нового маркера.

Рис. 4.27. Редактируем параметры маркера

Добавление закладок в фильм
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Для начала запустите программу Cleaner и переместите фильм в окно Batch.
Затем выберите пункты меню Windows ⇒ Project или дважды щелкните по икон&
ке фильма, чтобы активировать окно Project.

В окне Project щелкните по вкладке EventStream и нажмите кнопку Edit. От&
кроется окно EventStream, которое позволяет вам вводить информацию для глав
видео. На рис. 4.29 показан процесс добавления глав в фильм с применением
вкладки EventStream.

Чтобы создать новую главу, найдите нужную точку на шкале времени фильма
(в окне Project). Затем в окне EventStream нажмите кнопку Add и выберите
в ниспадающем меню пункт Chapter (QT, WM). Программа Cleaner автомати&
чески укажет начальное время, и вам останется лишь ввести текст для списка
глав фильма.

Повторяя описанные выше действия, введите данные для всех глав. После это&
го нажмите кнопку Save и закройте окно EventStream. Чтобы завершить создание
фильма, выберите пункты меню Batch ⇒ Encode или нажмите кнопку Start
в окне Batch.

Вот и все, что вам нужно знать о программе Cleaner. Все просто и понятно.

Дополнительные возможности
Возможности закладок не ограничиваются подготовкой к кастингу. Вы можете
создать видеокаталог, в котором пользователи будут переключаться между раз&

личными продуктами. Кроме того, вы можете создать видеоруководство, предназ&
наченное для описания какого&либо процесса.

Вы можете даже скомбинировать закладки и функцию, которая позволяет от&
крывать URL&сайты (совет 84). В результате пользователь сможет открывать
Web&страницы, связанные с определенными сценами фильма. Например, если вы
создали видеокаталог, каждая страница которого содержит изображение какого&
либо объекта, пользователь сможет открыть дополнительную Web&страницу с ин&
формацией о цене или о заказе данного продукта. Вы можете пойти еще дальше
и записать интерактивный Web&каталог (см. совет 47).

Совет 50 Быстрая навигация по DVD

Навигация в меню DVD необязательно должна быть медленной и утомительной.
Вы можете применить простые опции, чтобы ускорить переход между страницами.

Нам всем приходилось их видеть: многочисленные страницы меню, которые
приходится просматривать, чтобы найти нужную главу фильма. Многие дополни&
тельные функции, к примеру списки актеров и скрипты, тоже состоят из несколь&
ких страниц информации. Пользователю приходится постоянно пользоваться ин&
терактивными кнопками, чтобы осуществлять навигацию по меню DVD.

Рис. 4.28. Файлы маркеров,
которые доступны в программе Windows Media Player

Рис. 4.29. Добавляем главу в программе Cleaner

Быстрая навигация по DVD
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С помощью клавиш со стрелками вы можете выбрать нужную кнопку, а затем
активировать ее клавишей Select или Enter. Все довольно просто, однако процесс
может занимать много времени, особенно если вам нужно быстро перейти к по&
следним страницам меню.

Изменяем стандарты
А что, если вам не понадобится активировать кнопки?  Многие программы для
записи DVD поддерживают функцию, которая называется автоматическая акти&
вация. Если пользователь выбирает определенную кнопку с помощью дистанци&
онного управления или приложения, эта кнопка активируется автоматически.
В DVD&плеерах по умолчанию данная функция отключена; если вы ее включите и
поместите курсор мыши на какую&либо кнопку, то сразу же переместитесь в соот&
ветствующую главу DVD.

Большой проблемы в этом нет, однако вам вряд ли понравится, если
вам придется постоянно следить за положением курсора мыши в меню
DVD на вашем компьютере.

Посмотрите на рис. 4.30. Когда пользователь открывает это меню, активной
является кнопка Main. Вы можете перейти вверх и выбрать текущую главу, либо

влево или вправо и выбрать предыдущую или следующую страницу соответ&
ственно. Вместо того чтобы заставлять пользователя нажимать кнопку Right на
пульте дистанционного управления и кнопку Select, вы можете автоматически
активировать кнопку Next Page.

На рис. 4.31  вы видите окно парамет&
ров для кнопки Next в приложении
Apple DVD Studio Pro. Мы выделили
опцию Auto Action (Автоматическое
действие). Выберите это поле флажка.
Когда откроется меню, нажмите кнопку
Right на пульте дистанционного управ&
ления, чтобы мгновенно перейти на сле&
дующую страницу меню.

Повторите эти действия для кнопки
Previous. Обратите внимание: не следу&
ет настраивать автоматическую актива&
цию для других кнопок. Например, если
вы выберите опцию Auto Action для
всех кнопок глав, то не сможете найти
нужную главу. При нажатии кнопки Up
на пульте дистанционного управления
вы перейдете к индексу главы K; в ре&
зультате вы мгновенно переместитесь
к фрагменту K видеоклипа. Следова&
тельно, вы не сможете открыть другие
главы.

Дополнительные возможности
Вы можете использовать описанную здесь методику для записи интересных
слайд&шоу на DVD. Посмотрите на слайд на рис. 4.32. Вы можете настроить слайд
как фоновое изображение для вашего меню и добавить в него кнопки Previous,
Main и Next. Кнопка Main конфигурируется по умолчанию; теперь вы можете
перемещаться по слайд&шоу с помощью всего лишь двух кнопок на пульте дис&
танционного управления: Left и Right.

Обратите внимание на размер кнопок. Если вы будете воспроизводить DVD на
своем ноутбуке, вам понадобится увеличить область навигации.

Кроме того, вы можете применить функцию Invisible (Невидимый), чтобы
скрыть кнопки на слайдах. На рис. 4.33 мы выделили эту опцию в программе DVD
Studio Pro.

Даже если ваш редактор не поддерживает функцию Invisible, вы можете вы&
брать для кнопки полностью прозрачное изображение в формате GIF или PNG.

Рис. 4.30. Стандартное меню DVD,
предназначенное для выбора определенной главы

Рис. 4.31. Настраиваем кнопку Next
на автоматическую активацию

Быстрая навигация по DVD
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Рис. 4.32. Пример слайда,
который используется для автоматической навигации

Рис. 4.33. Выбираем опцию Invisible
в программе DVD Studio Pro
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Очень часто значимость звука для цифрового видео недооценивается, даже не&
смотря на то, что он является неотъемлемой частью процесса. Звук очень специ&
фическим образом воздействует на человека. Музыка, звуковые эффекты и даже
оформление диалогов в сцене будут непосредственным образом влиять на ауди&
торию проекта. Независимо от того, что именно вы снимаете, – первый день рож&
дения вашего ребенка или эпический фильм – вам необходимо внимательно сле&
дить за параметрами звука. Вряд ли вам понравится, если во время просмотра ви&
део ваши зрители будут постоянно спрашивать: «Что она сказала?»

Совет 51 Мобильная студия звукозаписи

Я практически уверен в том, что у вас дома уже есть отличная студия звукозаписи.
И вы даже не подозреваете об этом.

Запись диалога может оказаться весьма трудной задачей. При съемках вне по&
мещения вам придется иметь дело с такими посторонними эффектами, как шум
ветра (совет 52), звук пролетающих самолетов, трафик и т. д. При съемках в поме&
щении вам будет мешать эхо, шум кондиционеров, компьютерных вентиляторов и
электроприборов (совет 56). Если учесть тот факт, что обычно вы весьма ограни&
чены в выборе средств для записи звука, создание качественного аудиотрека для
вашего фильма становится почти неразрешимой задачей.

Даже профессионалам приходится решать большое количество проблем. Часто
в качестве универсального средства применяется дополнительная сессия звукоза&
писи (ADR) в студии после съемок. При этом актеры произносят свои диалоги
в помещении, где помехи и посторонние шумы отсутствуют. Еще одно преимуще&
ство ADR&сессии заключается в том, что персонаж может полностью сконцентри&
роваться на своем тексте (который лежит перед ним), и ему совершенно не нужно
беспокоиться о положении своего тела, о своих движениях и т. д. Затем записан&
ный в студии диалог заменяет первичную запись. В результате фильм содержит
четкий и ясный аудиотрек.

Ищем помещение для звукозаписи
Если вы ограничены в средствах, найти настоящую студию для ADR&сессии будет
невозможно. Впрочем, существует альтернативное решение: запишите вашу сес&
сию в припаркованном автомобиле.

Интерьеры многих современных автомобилей оборудованы системами звуко&
изоляции и содержат различные средства, предназначенные для устранения вне&
шних и внутренних шумов. Дорогие машины отличаются очень высокими воз&
можностями по звукоизоляции, но даже автомобили среднего класса обладают
лучшими характеристиками, чем обычные помещения. Еще одно преимущество
автомобиля – это его мобильность. Даже если ваша «студия» находится в месте
с сильным шумовым фоном, вы можете без труда переехать в другое место и при&
ступить к записи.

Подготовка к записи
Даже если вы собираетесь провести APR&сессию, я очень рекомендую вам макси&
мально эффективно подготовиться к записи звука во время съемок. Оригиналь&
ный аудиоматериал может использоваться как ссылка до APR&сессии; кроме того,
вы можете его воспроизводить во время записи, чтобы проверить аудиотрек.

Для финального микширования я советую вам записать несколько минут
обычного окружающего звука, без диалогов и других звуковых эффектов фильма
(совет 55). Да, того самого шума, от которого вы пытаетесь избавиться! Эти звуки
могут оказаться очень полезными для формирования образа персонажа в сцене,
а также для создания эффекта реалистичности.

Поиск местоположения
Как говорилось ранее, лучше всего переместить вашу мобильную APR&студию
в тихое, уединенное место. Кроме того, я советую вам записать аудиотрек (на ка&
мере или любом аудиоплеере), который будет использоваться в качестве исходно&
го материала для диалогов во время APR&сессии.

При записи лучше всего пользоваться цифровым устройством с качественным
микрофоном. В режиме 16 бит все DV&камеры записывают цифровой звук с CD&
качеством. Если вы работаете с DV&камерой, убедитесь в том, что она не настроена
на режим 12 бит, потому что это приведет к снижению качества записи.

При возможности не пользуйтесь встроенным микрофоном камеры, так как он
может случайно записать посторонние шумы от устройства перемотки кассеты.
Лучше всего применять внешний микрофон, который предназначен исключи&
тельно для записи звука от предметов, расположенных перед камерой, а не дина&
мичный микрофон (записывает звук во всех направлениях).

Обязательно поручите еще одному человеку включать устройство и прослуши&
вать запись. Это позволит актеру сконцентрироваться на своей речи, а также обес&
печит высокое качество звука. Кроме того, данный сотрудник должен фиксиро&
вать временную кодировку для каждой записи (совет 11); в результате поиск
фрагментов во время редактирования проекта потребует меньше времени и сил.

Наконец, во время APR&сессии актерам необходимо стремиться к тому, чтобы
продемонстрировать эмоции, которые они проявляли при записи видео.

Редактирование звука
Далее я приведу ряд советов, которые помогут вам синхронизировать ADR&сес&
сию и оригинальные снимки с камеры:

• пользуйтесь аудиодиаграммой вашего редактора, чтобы отобразить график
звука на шкале времени. Процесс синхронизации звука и видео при этом су&
щественно упростится;

• применяйте маркеры, чтобы выделить определенные точки в видео и ADR&
треке;

• выделяйте ADR&треки с помощью небольших переходов. Это позволит уст&
ранить помехи в финальном аудиотреке проекта;

Мобильная студия звукозаписи
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• если ADR&трек слишком сильно отличается от действий персонажа в сцене,
попробуйте изменить угол, чтобы показать, как персонаж слушает диалог.
В результате несоответствие будет удалено;

• не забудьте смикшировать ADR&сессию и окружающий фоновый шум, кото&
рый был записан изначально. Это поможет вам усилить впечатление аудито&
рии от сцены.

Как и любой другой творческий процесс, редактирование APR&сессии требует
не только теоретических познаний, но и практического опыта. Я надеюсь, что опи&
санные здесь методики помогут вам записать естественные диалоги для вашей
сцены.

Совет 52 Уменьшаем шум от ветра в микрофоне

Микрофоны предназначены для записи звука. Однако некоторые звуки, напри&
мер шум ветра, являются посторонними. Ветрозащита позволит вам уменьшить
шум ветра в микрофоне.

Любители спорта, скорее всего, видели операторов, которые окружают камеру
во время съемок соревнований. При этом один из операторов держит в руках
странный шест с необычным предметом на конце. Этот шест играет важную роль
в процессе записи качественного звука. Шест (совет 53) помогает поместить мик&
рофон (с ветрозащитой) таким образом, чтобы обеспечить запись аудиотрека.

Создание ветрозащиты
Первое, что вы должны сделать, – это купить нужный материал. Многие материа&
лы содержат поддельный мех, который обеспечивает хорошую звукоизоляцию.
Чем длиннее мех, тем лучше. Выбирайте самый густой и длинный мех, потому что
его все равно никто не увидит в кадре.

Количество материала, которое вам нужно купить, зависит от типа и размера
микрофона. Если вы купите полметра ткани, материала вам должно вполне хва&
тить. Если у продавца возникнут вопросы, вы всегда сможете ему объяснить, что
именно вы хотите сделать (лично я всегда немного теряюсь в магазине тканей).

После покупки материала положите его на ровную поверхность, мехом вниз,
и поместите на него свой микрофон. Затем нарисуйте контуры микрофона и ос&
тавьте немного свободного пространства для шва. Как правило, это 5/8 дюйма.
Затем вырежьте материал по контуру, как показано на рис. 5.1.

Поместите два куска материала рядом, мехом внутрь. Сшейте их края. После
этого выверните ветрозащиту наизнанку и натяните ее на ваш микрофон. Воз&
можно, вам придется несколько раз перешивать шов, прежде чем вы добьетесь
нужного результата.

Лучше всего использовать ветрозащиту в ветреную погоду. Впрочем, вы може&
те применять данное устройство в различных ситуациях, потому что оно позволя&
ет уменьшить уровень постороннего шума в вашем микрофоне.

Двойная ветрозащита на микрофоне не только не уменьшит помехи,
но даже приведет к снижению качества звука. Я не советую ее исполь&
зовать.

Как сделать ветрозащиту из ничего
При определенных обстоятельствах может оказаться, что у вас нет под рукой вет&
розащиты (вы ее еще не сделали, потеряли или просто забыли). К счастью, для вас
еще не все потеряно. Если вы или ваш коллега носите гольфы, вам очень повезло.

Собрать простую ветрозащиту очень легко. Выверните гольфы наизнанку. За&
тем поместите их на микрофон и приступайте к работе.

Совет 53 Как сделать шест для микрофона

Если вы хотите повысить качество звука, вам понадобятся длинный шест и вне&
шний микрофон.

Шест представляет собой длинную палку, которая применяется для крепления
микрофона. Благодаря шесту вы можете переместить микрофон ближе к персона&
жу (но не в один кадр с ним). Вы можете купить профессиональный шест (попро&
буйте поискать его в сети Интернет по ключевому слову «шест для микрофона»)
либо собрать его самостоятельно.

Как найти шест
Во&первых, шест – это обычная палка, значит, именно ее вы и должны искать.
Длина шеста влияет на то, насколько далеко может располагаться ваш персонаж
от камеры. В принципе, вы можете использовать обычную щетку или телескопи&
ческую антенну. Проще всего работать с телескопическим шестом, потому что он
позволяет вам регулировать длину в зависимости от ситуации.

Покупаем микрофон
Звук имеет очень большое значение для цифрового видео, однако об этом часто
забывают. На рынке доступно большое количество различных моделей микрофо&

Рис. 5.1. Две половинки (слева)
и полностью готовая ветрозащита (справа)

Как сделать шест для микрофона
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нов, причем каждая имеет свои преимущества и недостатки. Для шеста вам необ&
ходимо купить внешний микрофон, который напоминает длинный и тонкий ци&
линдр (см. рис. 5.2). Я рекомендую вам внимательно присмотреться к микрофо&
нам производства компаний Audio&Technica (http://www.audiotechnica.com/) и
Sennheiser (http://www.sennheiserusa.com/).

ной, вам понадобится аудиокабель длиной четыре метра. При покупке кабеля по&
мните, что чем он длиннее, тем лучше.

Сборка
После подготовки всех компонентов вам нужно завершить сборку. Если вы
пользуетесь телескопическим шестом, поместите микрофон на его короткую
часть. Выбор крепления для микрофона зависит от того, с каким шестом (дере&
вянным или металлическим) вы работаете, а также от дизайна самого микрофона.

Во время установки микрофона помните о том, что он предназначен для записи
звука. Однако микрофон способен записывать и посторонние шумы. Поэтому вы
должны плотно закрепить микрофон на шесте и добиться того, чтобы он не уда&
рялся о другие предметы, в частности о сам шест. Вы стремитесь к тому, чтобы
качество звука было оптимальным, не так ли? Микрофон, закрепленный на шес&
те, показан на рис. 5.4.

Рис. 5.2. Внешний микрофон

Возможно, вам удастся даже взять микрофон напрокат. Это зависит
от того, где именно вы проживаете.

Если у вас еще нет микрофона, его покупка – это, наверное, самый важный этап
в процессе сборки шеста. Собрав шест самостоятельно, вы сэкономите некоторую
сумму денег и сможете ее потратить на покупку микрофона. Учтите: если зрители
не услышат, что именно говорят персонажи в кадре, эффект от просмотра вашего
видео значительно ухудшится.

Измеряем кабель
Далее вам придется определить тип разъема для своей камеры и микрофона. Мно&
гие профессиональные камеры имеют разъемы XLR; обычные камеры оснащают&
ся разъемами RCA, 1/4" или Mini. На рис. 5.3 показаны различные типы разъемов:
XLR, RCA, 1/4" и Mini.

После установки микрофона вам необходимо подключить к нему кабель и про&
вести его к нижней части шеста. Для крепления кабеля на шесте вы можете ис&
пользовать зажимы или фиксаторы. Если у вас нет специального покрытия для
микрофона, вы можете применить ветрозащиту (см. совет 52).

Использование шеста позволит вам повысить качество звука, что, в свою оче&
редь, улучшит восприятие вашего видео аудиторией.

Рис. 5.3. Разъемы XLR, RCA, 1/4" и Mini

Вам необходимо купить аудиокабель, который длиннее вашего шеста, а также
разъемы, соответствующие типу вашей камеры. В идеале ваш аудиокабель ока&
жется намного длиннее, чем ваш шест (по крайней мере, на два метра), потому что
вам нужно провести кабель от верхней части шеста (от микрофона) до его нижней
части, а затем к камере. Например, если вы пользуетесь шестом в два метра дли&

Рис. 5.4. Микрофон на шесте

Как сделать шест для микрофона
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Совет 54 Экспорт звука для микширования

Применение специализированного аудиоредактора, такого как Pro Tools, дает вам
возможность значительно улучшить звук в вашем фильме. Но сначала вы должны
экспортировать звук в вашу программу микширования.

В настоящее время видеоредакторы обладают неплохими функциями для ра&
боты со звуком. Однако они в первую очередь предназначены для редактирова&
ния видео, поэтому с их помощью вы не сможете добиться профессионального
звучания. Поэтому на рынке имеются специализированные редакторы звука, на&
пример Audacity (http://audacity.sourceforge.net; бесплатно), Adobe Audition
(http://www.adobe.com; стоит 299 долл. США), Apple Logic (http://www.apple.com;
версия Express стоит 299, а версия Pro – 699 долл. США) и DigiDesign Pro Tools
(http://www.digidesign.com; стоит от 495 до 2895 долл. США).

Итак, вы хотите смикшировать звук и улучшить его качество. Но как же экс&
портировать звуковой файл из редактора в микшер? Это очень просто.

Определите, что именно вам нужно
Вы должны определить, какие аудиоформаты поддерживает ваша программа
микширования, а также какие аудиоформаты может экспортировать ваш видео&
редактор. Каждая звуковая система имеет свои, уникальные возможности, однако
все они предназначены для решения одной задачи: работы со звуком. Поэтому вы
можете быть уверены в том, что они поддерживают функции импорта и экспорта
стандартных аудиоформатов.

Каждый аудиоредактор обязательно должен поддерживать следующие стан&
дартные форматы:

• Audio Interchange File Format (AIFF);
• Audio (AU);
• Musical Instrument Digital Interface (MIDI);
• Waveform Audio (WAV).

Если вы выполняете редактирование в программе Final Cut Pro
или Avid Xpress, а также планируете использовать редактор Pro Tools,
то сможете экспортировать звуковые файлы в формате Open Media
Framework (OMF). Помните о том, что не все системы Pro Tools могут
конвертировать данные в формате OMF.

После выбора формата для импорта и экспорта аудиофайлов вы можете перей&
ти непосредственно к микшированию звука.

Подготовка к микшированию
Перед тем как экспортировать звуковые файлы, вам необходимо создать корот&
кий (как правило, продолжительностью в один кадр) аудиофрагмент в начале ва&

шего фильма. Обычно этот фрагмент включает и видео. Я рекомендую вам доба&
вить еще один фрагмент в конце фильма. Это позволит вам изменять порядок
фрагментов после импорта звука, а также поможет добиться синхронизации меж&
ду видео и звуком.

Постарайтесь максимально упростить процесс микширования звука. Во&пер&
вых, убедитесь в том, что звук в фильме должным образом организован (см. совет
2), и вы можете с легкостью определить, какие данные записаны в каждом треке.
Например, если вам необходимо заменить музыкальный фрагмент, вы будете
знать, что он записан не в треках диалога, и наоборот. Если вы не учитывали этих
требований во время редактирования проекта, я советую потратить немного вре&
мени сейчас и заняться организацией звуковых треков.

Экспорт звука
После подготовки звука к микшированию вам следует его экспортировать. Для
этого выполните следующие действия:

• Avid. Выберите пункты меню File ⇒ Export ⇒ Select;
• Final Cut. Выберите пункты меню File ⇒ Export ⇒ Audio to AIFF(s) (или

Audio to OMF);
• Premiere. Выберите пункты меню File ⇒ Export ⇒ Audio.

После экспорта у вас должно быть не менее одного файла на два аудиотрека.
К примеру, если шкала времени проекта содержит четыре аудиотрека, ваша про&
грамма будет содержать два аудиофайла (первый файл включает треки один и
два, а второй – три и четыре). Впоследствии эти файлы будут импортированы
в вашу программу микширования звука.

Импорт звука после микширования
 После микширования звука у вас должно появиться несколько аудиофайлов (их
количество зависит от того, как именно вы выполнили экспорт данных из про&
граммы микширования). Если вы создали только один файл, значит, он представ&
ляет собой полную версию вашего аудиотрека. Если было создано несколько фай&
лов, это говорит о том, что вы полностью скопировали конфигурацию данных при
экспорте. В любом случае вам понадобится импортировать полученные файлы
в ваш видеоредактор:

• Avid. Выберите пункты меню File ⇒ Import;
• Final Cut. Выберите пункты меню File ⇒ Import ⇒ Files;
• Premiere. Выберите пункты меню File ⇒ Import.

Вы создаете новую версию вашего видео (смикшированную), поэтому вам не&
обходимо сконфигурировать вторую шкалу времени и промаркировать ее соот&
ветствующим образом. Затем поместите микшированный звук на вторую шкалу
времени и переместите маркеры аудиофрагмента. Если вы сделали все правильно,

Экспорт звука для микширования
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аудио и видео будут синхронизированы. После добавления микшированного зву&
ка вы можете спокойно удалить оригинальный аудиотрек.

Совет 55 Скрываем отсутствие звука
с помощью фонового шума

Иногда (например, при съемках в переполненном помещении) вам приходится
полностью удалять окружающий звук. Однако отсутствие окружающего звука
сразу становится очевидным даже для неопытного зрителя. Добавление фонового
шума позволяет устранить эту проблему.

Рано или поздно во время редактирования вам понадобится удалить часть зву&
ка со шкалы времени. Допустим, вы хотите устранить какое&то слово из диалога
или автомобильный гудок. Скорее всего, в этом случае вам придется полностью
удалить окружающий шум из сцены.

Полное отсутствие окружающего звука сразу будет замечено аудиторией и не&
гативно повлияет на общее впечатление от фильма. Чтобы решить проблему, вам
необходимо заполнить пробел фоновым шумом. Такой фон часто называют ком&
натным, потому что он представляет собой всего лишь звуки, записанные в тихой
комнате. Вы можете записать окружающий звук в помещении даже несмотря на
то, что там никого нет.

Эд Голя (Ed Golya), редактор звука, который несколько раз становился
обладателем премии Эмми, любит говорить, что для него фоновый
шум – это «звук пролетающих мимо облаков».

Как правильно выбрать время для записи фонового шума
Чтобы избежать потенциальных проблем при редактировании, я советую вам за&
писывать фоновый шум во время съемок сцены. Обычно после завершения съем&
ки режиссер просит всех актеров молча посидеть в течение 30–60 с. Именно в это
время фоновый шум записывается на пленку.

Для всех актеров и сотрудников должно быть ясно, что вы ведете запись. Для
их оповещения воспользуйтесь табличкой. Если впоследствии выяснится, что по
какой&то причине запись была произведена некачественно, у вас могут возник&
нуть значительные трудности. Чтобы использовать фрагмент фонового шума,
найдите его на кассете и заполните с его помощью пробел в аудиотреке фильма.

Копируем фоновый шум из сцены
Если вы не смогли вовремя записать фоновый шум, то можете скопировать его из
какой&либо сцены вашего фильма. Для этого воспроизведите оригинальный мате&
риал (до редактирования) и попробуйте найти фрагмент, который не содержит
диалогов, перемещения актеров и других звуков (например, музыку).

Допустим, что вы нашли нужный фрагмент. Скопируйте его на шкалу времени.
Это решение является оптимальным в случае, если вам необходимо переписать
совсем небольшой кусок аудиотрека. Однако чем длиннее нужный вам фрагмент,
тем труднее его найти.

Возможно, вам придется несколько раз подряд добавить на шкалу времени
один и тот же кусок аудиотрека. Теоретически это позволит вам заполнить фоно&
вым шумом любой фрагмент видео. Но обратите внимание: вы можете применять
данную методику только до тех пор, пока повтор фонового шума не станет заме&
тен для аудитории. Как это ни странно, но со временем зритель замечает, что фо&
новый шум повторяется, и обращает на это внимание.

Запись фонового шума после съемок
Если вы не записали фоновый шум во время съемок и не можете найти подходя&
щий фрагмент в вашей сцене для его замены, я рекомендую вам выполнить запись
шума отдельно.

Лучше всего вернуться в место, где вы вели съемку, и записать звук именно там.
Существует определенная вероятность того, что вам удастся добиться почти пол&
ного соответствия между новой записью и оригинальным аудиотреком фильма.
Если вы не можете вернуться в место съемок, попробуйте выполнить запись в пу&
стом помещении.

Запись фонового шума поверх аудиотреков
Чтобы скрыть от зрителя тот факт, что вы изменили аудиотрек фильма, добавьте
переходы между оригинальной последовательностью и добавленным вами фоно&
вым шумом. Используйте очень короткие переходы; как правило, вам должно хва&
тить нескольких кадров. Вам может потребоваться немного больше времени на
завершение работы, однако в результате вы сможете привлечь внимание аудито&
рии к сцене, а не к техническим неполадкам, что позволит улучшить общее впе&
чатление от фильма.

Совет 56 Как улучшить звучание аудиотрека

Звук может составлять весьма незначительную часть вашего проекта, однако он
непосредственным образом влияет на вашу аудиторию.

Приходилось ли вам когда&либо смотреть низкобюджетный фильм и негативно
отзываться о качестве аудиотрека? Возможно, вас отвлек какой&либо посторон&
ний шум в кадре, например потрескивание люминесцентных ламп. Если в сцене
присутствуют посторонние звуки (допустим, гул кондиционера), ваши зрители
довольно скоро обратят на него внимание. Поэтому очень важно заранее устра&
нить все лишние звуковые эффекты. Существуют инструменты, которые помога&
ют вам решить эту задачу.

Если в процессе работы над фильмом вы обнаружите, что вам необходимо уда&
лить какие&либо звуки, не паникуйте. У вас есть несколько вариантов решения
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проблемы. Проще всего купить программу Bias SoundSoap (http://www.bias&inc.
com/products/soundsoap; стоит 99 долл. США), которая поставляется для опе&
рационных систем Macintosh и Windows. Также вы можете использовать аудио&
фильтры в вашем редакторе. Наконец, вы можете экспортировать ваш файл
в профессиональную программу микширования, которая выполнит удаление
автоматически. Вероятно, последняя методика является самой эффективной и
одновременно достаточно недешевой.

Независимо от того, какую опцию вы выбрали, обязательно сохраните
резервную копию оригинального файла. Это позволит вам не только
избежать неприятных последствий в случае ошибки – вы всегда сможе&
те прослушать исходный материал и сравнить его с полученным
результатом.

Удаление звука в программе SoundSoap
Если вам нужно удалить посторонние шумы, такие как гудение, треск и др., проще
всего применить приложение SoundSoap. Оно работает как отдельный редактор
либо как обновление для программы DirectX или пакета Virtual Studio Technology
(VST), который включает различные звуковые редакторы, например Bias Peak
(http://www.bias&inc.com/products/peak/; стоит 499 долл. США) и Steinberg
Cubase (http://www.steinberg.com; стоит 129–799 долл. США). В любом случае
программа SoundSoap работает по аналогичной схеме.

Если вы используете редактор SoundSoap в стандартном режиме, вам нужно
открыть соответствующий мультимедиа&файл. Команда File ⇒ Open Media File
позволяет вам выбрать на вашем жестком диске файл, совместимый с QuickTime
(DV, AVI, WAV, MP3 или MP4). Затем приложение SoundSoap импортирует этот
файл.

Вам должно вполне хватить настроек по умолчанию. Однако с помощью функ&
ций Noise Tuner (Регулятор шума), Noise Reduction (Снижение шума), Preserve
Voice (Сохранить голос), Remove Hum (Удалить помехи) и Remove Rumble
(Удалить шумы) вы можете настроить параметры удаления звука. Окно Wash в
центре интерфейса показывает, какую именно часть аудиосигнала вы собираетесь
удалить; синяя шкала соответствует звуковой диаграмме, а красная – шуму.

Функция Noise Reduction позволяет вам выделить звук для удаления. Вы мо&
жете нажать кнопку Play в нижней части интерфейса, чтобы прослушать аудио&
файл. Во время воспроизведения файла вы можете воспользоваться опцией Noise
Reduction и найти нужный звуковой эффект.

Используя регулятор Noise Reduction, вы можете сконфигурировать удаление
звука. Эта опция функционирует так же, как и опция Noise Tuner. Обратите вни&
мание: в первую очередь вы удаляете верхние ноты, поэтому вам необходимо быть
очень внимательными.

Если ваш фильм содержит диалоги между актерами (а скорее всего, это именно
так), я советую вам включить функцию Preserve Voice. В результате из компози&

ции будут удалены звуковые эффекты, которые не входят в диапазон человече&
ского голоса. Данная опция особенно полезна для съемок интервью.

Функции Remove Hum и Remove Rumble удаляют звук из аудиотрека специ&
фическим образом. Опция Remove Hum устраняет посторонние шумы, вызван&
ные различными электрическими помехами, например неполадками в проводке.
Если вы работаете с сетью напряжением 120 В (Северная Америка), вам необхо&
димо устранить помехи частотой 60 Гц; если вы работаете с сетью напряжением
220 В, вам придется иметь дело с помехами частотой 50 Гц. Проще говоря: в стан&
дарте NTSC следует устранить помехи 60 Гц, а в стандарте PAL – 50 Гц.

Кнопка Learn Noise (Изучить шум) оптимально функционирует в небольших
фрагментах, которые содержат только шум. Если вы работаете с сценой, содержа&
щей несколько секунд видео без диалогов, вы можете воспроизвести соответст&
вующий фрагмент и нажать кнопку Learn Noise. Программа SoundSoap проана&
лизирует аудиотрек и попытается удалить аналогичный шум из всей композиции.

На рис. 5.5 показан интерфейс SoundSoap с активными функциями Noise Tuner
и Noise Reduction; опция Preserve Voice была включена.

Вы можете выделить отдельные фрагменты видео с помощью точек In и Out (то
есть так же, как в любом видеоредакторе). Чтобы создать точку In, выберите пун&
кты меню Edit ⇒ Set In Point (или введите «i»); чтобы создать точку Out, выбери&
те пункты меню Edit ⇒ Set Out Point (или введите «o»). Точки In и Out позволя&
ют вам удалить шум только для отдельного фрагмента аудиотрека.

Рис. 5.5. Чистка аудиотрека с помощью программы SoundSoap

Как улучшить звучание аудиотрека
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После завершения изменений нажмите кнопку Apply (Применить), чтобы со&
хранить их в вашем файле. Вы можете использовать программу SoundSoap сле&
дующим образом: выделить точками In и Out фрагмент трека для редактирова&
ния, найти часть трека, которая содержит только фоновый шум, нажать кнопку
Learn Noise, внести нужные изменения (например, устранить помехи) и сохра&
нить изменения в файле.

Устраняем шумы и помехи в системе редактирования
Сейчас многие видеоредакторы включают функции, предназначенные для рабо&
ты со звуком. Очень часто эти функции имеют форму звуковых эффектов или
фильтров. Если вы хотите устранить посторонние шумы или помехи, вам понадо&
бится удалить некоторые диапазоны некоторых частот.

Для удаления ненужного шума вы можете воспользоваться фильтрами высо&
ких или низких частот. Такие фильтры работают с высокими или низкими диапа&
зонами частот соответственно. Вы можете применить несколько фильтров, чтобы
повысить качество звучания. Например, если ваш аудиотрек содержит посторон&
ний шум, вы можете добавить в него фильтр высоких частот и уменьшить частоту
звука. Если ваш аудио трек содержит шипение, вы можете добавить фильтр низ&
ких частот и подавить нежелательные звуки. На рис. 5.6 показан фильтр низких
частот программы Final Cut Pro в действии.

Используем аудиомикшер
Практически в любом крупном городе мира вы без труда сможете найти професси&
ональный аудиомикшер. Кроме того, существуют небольшие компании, которые
производят качественные микшеры. Если вы планируете выполнить микширова&
ние вашего звука на таком устройстве, я не рекомендую вам заниматься предвари&
тельным редактированием. Любой профессионал должен получить исходный ма&
териал, чтобы сотворить из него маленькое чудо.

Перед тем как встречаться с композитором, уточните, какой именно аудиофайл
ему нужен. Спросите, нет ли у него специфических требований, например не сле&
дует ли вам использовать исключительно частоту 48 или 44,1 КГц. В зависимости
от аудиомикшера от вас могут потребовать предоставить файлы в формате OMF,
SDII или AIFF. Убедитесь в том, что ваша система редактирования поддерживает
нужный формат, либо выберите альтернативное решение, например запишите
звук на видеопленку.

Узкополосный фильтр (notch filter) имеет много общего с фильтрами высоких и
низких частот. Отличие заключается в том, что данный фильтр блокирует опреде&
ленные частотные диапазоны, а не пропускает их. Узкополосный фильтр являет&
ся весьма эффективным инструментом для устранения аудиопомех. Также я сове&
тую вам при возможности применить фильтр&эквалайзер (EQ).

Некоторые системы редактирования, например Premiere Pro, включают
фильтр DeNoiser. Другие, такие как Final Cut Pro, содержат фильтр Hum Remover.
Попробуйте установить, какие именно фильтры установлены в вашей системе.
Поэкспериментируйте с ними и выясните их возможности.

Рис. 5.6. Используем фильтр низких частот
в программе Final Cut Pro

Совет 57 Вы можете обмануть вашу аудиторию

Далеко не всегда вы слышите то же, что видите.
Редактирование видеопроекта состоит из двух частей: работы с видеоизобра&

жением и со звуком. Многие пользователи знают о том, что они могут использо&
вать звук для смягчения переходов (совет 46) и устранения других недостатков
(советы 55 и 56). Кроме того, вы можете скомбинировать видео и аудио таким об&
разом, чтобы зрители видели одно, а слышали совершенно другое.

Это утвреждение можно проиллюстрировать на примере так называемого «эф&
фекта МакГурка» (McGurk).

За дополнительной информацией об эффекте МакГурка и других
методиках вы можете обратиться к книге издательства O’Reilly
«Mind Hacks» Тома Стаффорда (Tom Stafforda) и Мэтта Уэбба (Matt
Webb). Также вы можете выполнить поиск в сети Интернет (введите
ключевые слова «эффект МакГурка»). Вы не только найдете научное
объяснение данного эффекта, но и сможете просмотреть несколько
демонстрационных роликов.

Создание эффекта
Эффект МакГурка имеет место в случае, если вы видите что&либо, и это воздей&
ствует на то, что вы слышите, или наоборот. Гарри МакГурк (Harry McGurk)
и Джон Макдональд (John MacDonald) описали этот эффект в 1976 г. в своей ста&
тье «Видим движение губ и слышим голоса» («Nature», 246, 746–748). В клипе вы
видите пример этого эффекта: губами человек говорит слово «га», вы слышите
слово «ба» и думаете, что он сказал «да». Этот клип доступен в сети Интернет по

Вы можете обмануть вашу аудиторию



212 Звук 213

адресу: http://www.media/uio.no/personer/arntm/McGurk_english.html. Чтобы
создать данный эффект, вы должны получить видео и звук из разных источников.

Запись видео
Как говорилось ранее, для создания эффекта вам необходимо записать видео. Для
этого проще всего снять нужную сцену, потому что при редактировании проекта
вы все равно удалите аудиотрек. Чтобы упростить процесс редактирования, по&
просите актера произнести свои слова несколько раз подряд. Это позволит до&
биться желаемого результата.

Запись звука
Речь в кадре может произносить актер или кто&нибудь другой. Скорость воспро&
изведения звука должна соответствовать скорости воспроизведения видео. Если
вам понадобится дополнительная информация, вы можете повторно просмотреть
видеосегмент, отключив при этом звук. Замените оригинальный аудиотрек про&
екта той композицией, которую вы хотите использовать.

Редактирование материала
После записи материала импортируйте его в систему редактирования. Добавьте
видео на шкалу времени. Затем вам понадобится удалить из сигнала его аудио&
часть:

• Avid. С помощью инструмента Lift/Overwrite выберите аудиотрек и удалите
его со шкалы времени;

• Final Cut. Нажмите клавишу F4 (Function 4) и введите номер трека, который
вы желаете заблокировать. Затем выделите аудиотреки и удалите их со шка&
лы времени;

• Movie Maker. Щелкните по аудиотреку правой кнопкой мыши и выберите
в меню команду Mute (Отключить);

• Premiere. Нажмите кнопку с символом замка на шкале времени, чтобы забло&
кировать видеотрек. Затем удалите аудиотрек;

• iMovie. Щелкните по клипу на шкале времени и выберите пункты меню
Advanced ⇒ Extract Audio (Извлечь аудио трек). Щелкните по новому ви&
деоклипу и выберите пункты меню Edit ⇒ Clear (Удалить).

В некоторых системах на шкале времени имеется функция Lock (Заблокиро

вать). Если ваша система поддерживает данную функцию, вы сможете с ее помо&
щью заблокировать видеотрек, а затем удалить из него аудиотрек. На рис. 5.7 по&
казан интерфейс программы Adobe Premiere Pro. Обратите внимание: на шкале
времени доступна функция Lock.

После удаления аудиотрека из оригинального материала вам понадобится за&
менить его новый треком. Для этого выполните следующие действия:

• Avid. С помощью инструмента Lift/Overwrite выберите видеотрек и удалите
его со шкалы времени;

• Final Cut. Нажмите клавишу F5 (Function 5) и введите номер трека, который
вы желаете заблокировать (например, 1). При необходимости повторите эти
действия для второго трека (если вы работаете в режиме стерео). Затем выде&
лите видеотрек и удалите его со шкалы времени;

• Movie Maker. Переместите материал в трек Audio/Music. На шкалу времени
будет добавлен только аудиотрек;

• Premiere. Нажмите кнопку Lock на шкале времени, чтобы заблокировать
аудиотрек. Затем удалите видеотрек;

• iMovie. Щелкните по клипу на шкале времени и выберите пункты меню
Advanced ⇒ Extract Audio (Извлечь аудио трек). Щелкните по видеоклипу
и выберите пункты меню Edit ⇒ Clear (Удалить).

После добавления в проект видео& и аудиоклипов вы должны их объединить.
Переместите аудиотрек таким образом, чтобы он оказался под видеотреком на
шкале времени. Теперь вам необходимо сконфигурировать аудиотрек в соответ&
ствии с видеотреком. Возможно, вам придется разбить аудиоматериал на отдель&
ные фрагменты. После настройки аудио& и видеофрагментов воспроизведите ком&
позицию со шкалы времени.

Эффект должен оказаться очевидным (по крайней мере, для большинства зри&
телей). Даже несмотря на то, что вы точно знаете, что актер говорит слово «ба», вы
будете воспринимать его речь как «да». Вы можете закрыть глаза и воспроизвести
видео клип, чтобы убедиться в том, что с ним ничего не произошло.

Рис. 5.7. Блокируем трек в программе Premiere Pro

Вы можете обмануть вашу аудиторию
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Использование эффекта в настоящих проектах
У вас уже есть небольшой опыт работы с эффектом МакГурка; скорее всего, вы
начинаете задумываться в том, как применить его в настоящем проекте. Ясно, что
данный эффект функционирует при съемках диалогов. Попросите вашу подругу
произнести перед камерой слова «оливковое масло». Затем она должна повторно
произнести эти слова, но только губами. Вы можете определить, что именно сказа&
ла ваша подруга?

Теперь попросите другого человека встать позади вашей подруги и произнести
слова «я тебя люблю» в то время, как ваша подруга, двигая только губами, говорит
«оливковое масло». А теперь подумайте, что еще вы видите и слышите (кроме
того странного факта, что вы видите на камере девушку, которая признается вам
в любви мужским голосом)?

Подобные эффекты очень часто применяются во время показа художествен&
ных фильмов на телевидении. Например, некоторые слова запрещены к употреб&
лению в телевизионном эфире. Поэтому такие слова удаляются цензурой, а вмес&
то них записываются их синонимы. В результате актер говорит в камеру «Про&
клятье!», но вы точно знаете, что в оригинале он сказал нечто иное.

Впрочем, вы необязательно должны добиваться соответствия между движени&
ем губ актеров и произносимыми репликами. Функция редактирования аудио&
трека может оказаться очень полезной, особенно в случае, если вам необходимо
внести изменения в проект после съемок. Приведем пример: допустим, что у вас
есть снимок определенной масштабной сцены, и вы хотите изменить текст диало&
га. Вы можете выбрать аудиотрек из другой сцены и попробовать совместить его с
движениями губ актеров. Если в сцене происходит одновременно несколько со&
бытий, зрителям будет очень трудно читать текст по губам, и им придется в основ&
ном полагаться на то, что они слышат.

Лично мне пришлось наблюдать данный эффект во время съемок
телевизионной программы «The Larry Sanders Show». В сцене один
из персонажей, Арти (Artie), располагался спиной к камере, а другой
персонаж, Ларри (Larry), произносил текст. Нам нужно было пропус&
тить одну из фраз Ларри, но мы не могли ее вырезать. Поэтому
редактор взял реплики Арти из другого дубля и заменил ими текст,
который произносил Ларри. В итоге даже несмотря на то, что губы
Ларри двигались в кадре, внимание зрителей переключалось на Арти,
и они игнорировали тот факт, что говорить должен был все&таки
Ларри.

Не забывайте об аудиотреках. Предназначение звука не ограничивается фор&
мированием видео сигнала. Используя аудиотрек, вы можете переписать сцены,
скрыть ошибки и выгодно выделить свой проект из общей массы.

Совет 58 Бесплатная музыка

Музыка представляет собой один из важнейших компонентов фильма. При опре&
деленных условиях вы сможете использовать музыку бесплатно. Вы даже можете
сделать так, чтобы за вас автору музыки платил кто&то другой!

Вы даже не можете себе представить, насколько сильно влияет музыка (кото&
рую мы часто даже не слышим) на наше общее впечатление от просмотра фильма.
Подсознательно человек следует тому эмоциональному настрою, который созда&
ется у него под воздействием музыки. Благодаря использованию различной музы&
ки один и тот же видеоклип будет восприниматься как очень веселый, грустный,
спокойный или даже драматичный. Многие фильмы ужасов полностью зависят
от музыкального фона. Бывает и так, что пугающая музыка используется слиш&
ком часто; это приводит к тому, что зритель заранее подготавливает себя к сцене
следующего убийства.

Есть одна причина провала проекта «The Blair Witch Project». Да, все говорят
о недостаточном бюджете и высоких накладных расходах, но мало кто упоминает,
что в этом действительно страшном фильме ужасов полностью отсутствует музы&
ка! В этом фильме есть одна песня, но и ее персонажи всего лишь слушают в авто&
мобиле по дороге из леса.

Тот факт, что саунд&трек для этого фильма был продан, доказывает,
какими мощными возможностями обладает современный маркетинг.
Запись носит название «Josh’s Blair Witch Mix», и это именно та кассе&
та, которую полиция нашла в автомобиле Джоша Леонарда (Josh
Leonard) после его мнимой смерти. Джош говорил мне о том, что он
никогда не слушал эту кассету; кроме того, три песни из альбома были
записаны через два года после того, как она была «найдена».

Итак, успех сцены непосредственным образом связан с музыкой.

Использование музыки в фильме
При работе над фильмами продюсерам Голливуда приходится платить крупные
суммы денег за использование классических песен из прошлого. Кроме того, они
платят и за лицензию  на воспроизведение современных хитов. Очень часто схема
работает и в обратную сторону: продюсеры спонсируют музыкантов и в обмен по&
лучают право на использование их музыки. Бывает и так, что киностудия покупает
компанию звукозаписи или становится продюсером известного исполнителя песен.
Все эти механизмы только поддерживают процесс создания новых кинофильмов.

Вряд ли вы можете позволить себе использование известной музыки в своем
видео. А это значит, что вы не можете продать свой проект, если он содержит му&
зыку, правами на применение которой вы не обладаете.

Бесплатная музыка
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На создание автобиографического документального фильма
«Tarnation», который недавно стал сенсацией Каннского кинофестива&
ля, режиссеру Джонатану Кауэтту (Jonathan Caouette) пришлось
потратить всего 218 долл. США. Однако после того как он заплатил
за права на использование музыки и видеоклипов в своем фильме, эта
цифра подскочила до 400 000 долл. США.

Впрочем, вы можете найти очень качественную музыку и использовать ее со&
вершенно бесплатно.

Как найти бесплатную музыку
Вам необходимо найти музыку, которая была записана неизвестными исполните&
лями. Существует огромное количество групп, которые с радостью предоставят
вам свои записи. Ведь это способствует их рекламе. Вы производите равноценный
обмен, только и всего.

Я рекомендую вам искать музыку на таких ресурсах, как craigslist (http://
www.craiglist.org) и MySpace.com (http://www.myspace.com). Также вы можете за&
ходить на другие сайты, например MP3.com (http://www.mp3.com), чтобы про&
слушать музыку или связаться с различными исполнителями.

Обычно я размещаю на ресурсе сообщение, которое вкратце описывает теку&
щий проект, например:

Тема: требуется музыка к фильму, в частности фоновая музыка для интер&
вью. Подойдут все стили, кроме хард&рок. Только оригинальные компози&
ции. Семплы и ремиксы не принимаются.

За дополнительной информацией обратитесь на сайт: http://www.
kittyfeet.com.

Присылайте мне ваш файл в формате MP3 или ссылку на него. Я гаранти&
рую, что Ваша музыка не будет использована без Вашего разрешения. При&
менение музыки в фильме оплачиваться не будет, но сведения о вас как об
исполнителе будут размещены в BMI и ASCAP.

Все авторские права будут сохранены.
С уважением, Майкл В. Дин.

Это практически все, что нужно вам, чтобы полностью заменить музыкального
директора вашего фильма. При съемках голливудских фильмов продюсеры обыч&
но нанимают таких сотрудников и выплачивают им огромные гонорары. Вы тако&
го себе позволить не можете; впрочем, в этом нет и большой необходимости.

Что значит быть музыкальным директором фильма
Хороший музыкальный директор должен уметь быстро и точно обрабатывать
большой объем материала. Как только вы услышите хорошую запись в формате
MP3, сразу же просите исполнителя отправить вам CD&диск. Лично я обычно от&

правляю электронное сообщение, которое содержит примерно такой текст: «Вы
согласны с тем, что мы будем использовать вашу музыку в соответствии с услови&
ями, размещенными на нашем сайте?»

Если исполнитель отвечает согласием, сохраните его сообщение и прослушайте
другие мелодии в его исполнении. Но ни в коем случае не говорите о том, что вы
обязательно будет использовать его музыку, пока вы не будете в этом уверены. Вы
должны сделать так, чтобы люди поняли: если вы не используете их музыку, это
еще не значит, что она вам не нравится. Самая качественная музыка в мире может
не подойти для определенной сцены. Все очень субъективно.

Во время работы над моим последним фильмом мне пришлось прослу&
шать более 70 музыкальных CD&дисков. Это около 70 ч музыки,
из которых мне требовалось выбрать всего 70 мин. Поэтому мне
пришлось научиться слушать звук так же, как это делает музыкаль&
ный директор.

Когда вы получите CD&диск, установите его в свой компьютер и прослушайте
примерно по 20 с в начале, середине и конце мелодии. Намного проще понять, что
вам не подходит, чем сразу же определить, что вам точно подойдет. Сначала вы
должны отсеять все лишнее, а это примерно 6–7 песен на диске, который состоит
из 10 композиций.

После удаления ненужных треков внимательно прослушайте оставшиеся. Лич&
но я делаю пометки фломастером прямо на поверхности диска. Затем скопируйте
два лучших трека с помощью приложения Windows Media Player. Вы сможете ис&
пользовать полученный материал во время редактирования.

Организуйте ваши музыкальные файлы
Используйте описательные названия файлов (например, BobBartosik Quartetslow
jazz_Sax_Gasam.wav), а не безликие (song14.wav). Если вы укажете тип музыки
в названии файла, вам будет намного проще найти его впоследствии. А наличие
имени исполнителя и названия композиции упростит процесс создания титров
для завершенного проекта.

Не следует разделять слова в названии файла точками. Это может
привести к сложностям во время редактирования. Используйте точки
исключительно между названиями и расширениями файлов.

Итак, вы прослушали несколько CD&дисков и выбрали несколько композиций,
которые вас устраивают. Отправьте эти мелодии вашему редактору. Попросите
его принять окончательное решение. Если у вас нет редактора, значит, решение
придется принимать вам!

Вам необходимо сократить количество мелодий с пяти&шести до одной или
двух. Затем полученный материал будет отправлен в вашу систему редактирова&
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ния. При необходимости вы сможете открыть соответствующую папку и скопиро&
вать музыку на шкалу времени проекта. Вам необязательно придется использо&
вать все доступные композиции.

Если вам понравилась какая&то мелодия, вы даже не должны ждать
получения CD&диска по почте. Время от времени я использую на шкале
времени музыку в формате MP3. Однако для финального проекта вам
понадобится получить данные в формате без сжатия (.wav или .aiff).
Замените временную копию музыки, потому что звук в формате .wav
воспроизводится лучше, чем в формате MP3.

Получаем форму подтверждения
Если вы собираетесь использовать какую&либо песню в своем фильме, вы должны
отправить исполнителю форму подтверждения по электронной почте, а также по&
просить ее подписать и отправить вам обратно.

Далее я приведу текст формы, которую я отправляю исполнителям во время
работы над проектом:

Форма утверждения
Я __________ (здесь и далее именуемый «Исполнитель») настоящим

разрешаю использовать мою песню ______________ в фильме __________
режиссера Майкла В. Дина (здесь и далее именуемого «Режиссер»).

Оплата за использование материала производиться не будет.
Авторские права сохраняются за Исполнителем. Исполнителю разрешено

выступать со своей песней, а также записывать ее в любое время.
Режиссер настоящим гарантирует, что песня будет им использована ис&

ключительно с благородными целями.
Дата _________________
Подпись _________________
Расшифровка подписи _________________
Разрешение BMI или ASCAP _________________

Если вам нужна копия этой формы, вы сможете загрузить ее из сети Интернет
по адресу: http://www.kittyfeet.com/30bucks/.

Последняя строка о разрешении BMI или ASCAP является серьезным преиму&
ществом. Если исполнитель зарегистрирован в одной из этих организаций (он
может быть членом только одной организации, но не двух одновременно), то вы
как режиссер сможете отправить им официальный документ со списком всех пе&
сен, которые вы используете. Затем, если фильм выходит на экран, музыкант смо&
жет получить определенный гонорар от телевизионной компании или кабельного
канала. Я не уверен в том, как именно это происходит, но мои друзья уверяют
меня, что они уже получали такие гонорары за свои произведения.

Как стать членом BMI или ASCAP
Вы можете записаться в эти организации на сайтах http://www.ascap.com или
http://www.bmi.com соответственно. Регистрация проводится бесплатно; член&
ские взносы отсутствуют. На сайтах http://www.ascap.com/about/payment/
identifying.html и http://www.bmi.com/library/brochures/cuesheet.asp вы сможете
найти дополнительную информацию.

Когда я играл в составе моей группы, «Bomb», я сам состоял в одной
из таких организаций и даже заработал какие&то деньги. Но это давно
в прошлом. Я мог бы теоретически восстановиться как член организа&
ции (потому что я использую музыку в своих фильмах). Однако вместо
этого я предпочитаю работать с композициями, записанными другими
исполнителями.

Перед вступлением вам понадобится подписать контракт. Я изучил контракт,
предложенный ASCAP, и обнаружил, что, подписав его, я согласился бы поддер&
живать любые антипиратские законы, которые лоббирует эта организация. Мне
данный пункт не понравился по ряду причин. Мне не пришлось пока что прочесть
контракт BMI (он очень длинный), но я уверен в том, что он практически такой
же. Многие мои друзья могут подтвердить тот факт, что эти две организации име&
ют очень много общего.

Будьте честны с теми, кто вам помогает
Обратите внимание: контракт, который я составил, очень честен в отношении ис&
полнителя. Он и должен таким быть, потому что вы ничего ему не платите! Впро&
чем, многие музыканты живут в таких тяжелых условиях, что они готовы отдать
вам и другие права на свои композиции, а не только разрешить вам использовать
их в фильмах. Но я не советую вам так поступать. Лично я очень уважительно
отношусь к музыке и к ее исполнителям и очень надеюсь, что вы будете с ними
честны.

Однажды мне пришлось составить один контракт, который содержал
дополнительные ограничения: это был контракт на использование
песни «Друзья» Аарона Джонса (Aaron Jones). Именно эта песня звучит
после завершения моего последнего фильма, а также применяется
в качестве фоновой музыки для диалогов.

Мне очень не хотелось, чтобы данная композиция использовалась в других
фильмах, поэтому я добавил в контракт соответствующий пункт. Я желаю, чтобы
мой проект выделялся среди других. Благодаря этой композиции мне удалось со&
здать очень интересный, драматичный эффект. Посмотрев мой фильм, вы пойме&
те, что я имею в виду. Я очень тщательно выбрал именно эту песню, прослушав
более 70 ч музыки.

Бесплатная музыка
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И не забудьте поблагодарить всех, кто помог вам во время работы над проек&
том; сделайте это на своем сайте (отправьте им ссылку) и в титрах фильма. И обя&
зательно пошлите им копию DVD&диска (сделайте это сами и не заставляйте себя
просить). Напишите каждому человеку письмо с благодарностями.

Пусть ваш фильм станет успешным!

Совет 59 Управляем библиотекой музыки
и звуковых эффектов

Используя программу Apple iTunes, вы можете создать полноценную цифровую
библиотеку вашей музыки и звуковых эффектов.

Сейчас через систему iTunes Music Store продаются сотни миллионов песен,
а люди работают с бесчисленным количеством устройств iPod. Именно поэтому
программа Apple iTunes пользуется таким успехом. Однако это приложение
(http://www.apple.com/itunes/download/; бесплатно), которое поддерживает опе&
рационные системы Macintosh и Windows, может не только применяться для ре&
дактирования музыки. Вы можете использовать его для организации библиотеки
музыкальных файлов и звуковых эффектов, а также для отслеживания треков
в ваших проектах.

Организация вашей музыки
Чтобы организовать ваши аудиофайлы, загрузите их в программу iTunes. Устано&
вите CD&диск в ваш компьютер и запустите приложение (если оно не загрузится
автоматически). Как правило, вы должны обнаружить, что кто&то уже ввел дан&
ные о CD&диске в программу CDDB (http://www.gracenote.com). Программа
iTunes использует эту информацию для автоматического ввода названий треков.
На рис. 5.8 показано окно с полученными данными для CD&диска, который содер&
жит звуковые эффекты, записанные в домашней обстановке.

Несмотря на то что импорт вашей музыки и звуковых эффектов в данной про&
грамме может занимать много времени, не забывайте о том, что в итоге вы именно
экономите свое время и силы. Это связано с тем, что в окне приложения iTunes вы
можете сортировать файлы по названию песни, исполнителю, продолжительнос&
ти воспроизведения и т. д. Кроме того, вы можете выполнить поиск нужного фай&
ла в библиотеке.

Создание каталога аудиофайлов
Программа iTunes позволяет вам добавлять в аудиофайлы специальную инфор&
мацию, так называемые метаданные. Это дает вам возможность каталогизировать
ваши аудиофайлы. Например, приложение iTunes не содержит категории Sound
Effects (Звуковые эффекты), но вы можете добавить ее в разделе Custom (Про

извольные). На рис. 5.9 показаны метаданные для группы треков.

Рис. 5.8. Просматриваем звуковые эффекты в программе iTunes

Рис. 5.9. Добавляем сведения о CD�диске

Управляем библиотекой музыки и звуковых эффектов
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несколько треков, программа iTunes откроет окно, которое позволяет вам под&
твердить изменения. В этом окне вы сможете добавить новую информацию для
выбранных треков.

Поиск звуковых файлов
Преимущество работы с библиотекой звуковых файлов в программе iTunes свя&
зано с применением функции поиска. Некоторые библиотеки музыки содержат
тысячи треков, поэтому поиск нужного файла может потребовать много време&
ни. Даже если ваша библиотека была правильно организована и у вас есть пол&
ный каталог, вам все равно придется найти нужный CD&диск и прослушать
запись.

Поиск треков
Введите текст для поиска в соответствующем поле в верхнем правом углу окна
программы. Программа выполнит поиск метаданных для всех треков в библиоте&
ке iTunes. Эта функция позволяет вам быстро находить определенные песни или
звуковые эффекты. Кроме того, если вы ввели дополнительные метаданные, на&
пример, стоимость покупки мелодии, вы сможете найти и их. Если вы хотите огра&
ничить поиск категорией Artists (Исполнители), Albums (Альбомы), Composers
(Композиторы) или Songs (Песни), вы можете щелкнуть по символу в виде уве&
личительного стекла в поле поиска (рис. 5.10).

Импорт треков
Если вы нашли песню или эффект и хотите использовать ее в вашем проекте, то
можете выполнить различные действия. Если ваша система редактирования
поддерживает программу iTunes, вы сможете импортировать файлы напрямую.
Если нет, я советую вам найти оригинальный CD&диск или аудиофайл, который
содержит данный трек, а затем импортировать его в вашу систему редактиро&
вания.

Также для импорта аудиотрека вы можете найти папку iTunes: выполните ко&
манду Preferences ⇒ Advanced и просмотрите папку iTunes Music. При импорте
файлов из библиотеки iTunes вам, скорее всего, придется просмотреть несколько
папок, в том числе Artist и Album. Например, если вы пытаетесь импортировать из
библиотеки эффект Jar, Juice Pour Into Glass или Food, вам понадобится просмот&
реть папку Sound Ideas (исполнитель CD&диска), папку 6021 – Household #2 (аль&
бом), а затем выбрать нужный трек. Если вы работаете с этой методикой, я реко&
мендую вам отобразить в окне iTunes столбцы Artist и Album.

Использование списков playlist
Программа iTunes позволяет организовать музыкальные треки таким образом, что
вам, скорее всего, будет достаточно всего одной библиотеки. Впрочем, вы можете
создать списки playlist для упрощения работы с библиотекой. Кроме того, списки
playlist программы iTunes автоматически обновляются в случае, если вы добавля&
ете новые треки, которые отвечают заданным критериям. Более того, вы можете
использовать функцию поиск только для определенного списка.

Как узнать стоимость трека?
Очень многие пользователи задают вопросы, связанные со стоимостью опреде&
ленного трека. Я бы сказал, что стоит удивиться в случае, если вас об этом не
спросят. Если вы введете в поле Comments стоимость лицензии трека, то значи&
тельно упростите работу со своими музыкальными файлами для других пользо&
вателей.

Вы можете создавать списки, содержащие треки с одинаковой, заданной сто&
имостью. Например, вы можете использовать списки с бесплатной и дорогой
(99 долл. США за композицию) музыкой. Чтобы создать список бесплатной му&
зыки, введите в поле Comments текст «бесплатно». Затем создайте список (вы&
полните команду File ⇒ New Smart Playlist) и назовите его Royalty Free. Повто&
рите эти действия, чтобы создать список дорогих треков (по 99 долл. США).

Следите за тем, с какой музыкой вы работаете
Очень часто вас будут спрашивать о том, какую музыку вы используете. Другими
словами, вас могут попросить вспомнить автора и название композиции, которую
вы использовали в проекте годичной давности. Обычно на такой вопрос прихо&
дится отвечать: «Я не знаю».

И здесь вам поможет программа iTunes. Создайте список с названием, которое
соответствует названию вашего проекта. Вы сможете добавить в него оригиналь&Рис. 5.10. Поиск звуковых эффектов в программе iTunes
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Столбец Comments (Примечания) может оказаться полезным,
особенно если вы работаете с треками, использование которых ограни&
чено лицензией. Вы можете отобразить метаданные Comments
в главном окне по умолчанию (для этого воспользуйтесь меню Edit ⇒
View Options).

Чтобы изменить данные для одного трека или группы, выделите файл и выбе&
рите пункты меню File ⇒ Get Info (Получить информацию). Если вы выделите
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ные композиции и звуковые эффекты. Чтобы создать список, выполните команду
File ⇒ New Playlist. Затем укажите название списка и переместите в него аудио
треки из вашей библиотеки.

Если вам понадобится узнать, какую музыку или звуковые эффекты вы ис&
пользовали, щелкните по списку проекта и найдите нужную информацию. Еще
одно преимущество списка состоит в том, что (если вы указали стоимость компо&
зиций) вы можете щелкнуть по одному столбцу и определить, сколько денег вы
потратили!

Дополнительные возможности
Не бойтесь экспериментировать! Если вы захотите выйти из ограничений, постав&
ленных программой iTunes, вы можете это сделать.

Стоимость треков
Вы можете ввести данные о стоимости ваших треков в поле Year (Год). Это позво&
ляет вам создать более сложные списки, которые содержат коллекции треков сто&
имостью, например, от 5000 до 9999 долл. США. Однако вы быстро заметите, что
не можете использовать более четырех цифр. Поэтому стоимость лицензии не мо&
жет превышать 9999 долл. США. Такой суммы должно хватить, если только вы не
собираетесь использовать песню группы Rolling Stones.

Сервер
Если вы работаете с несколькими программами редактирования, то можете со&
здать единую библиотеку музыки и звуковых эффектов. Одна система должна
быть настроена как сервер (то есть она будет содержать библиотеку с общим дос&
тупом к файлам). Так как программа iTunes использует для поиска других прило&
жений iTunes функцию Rendezvous, все ваши системы смогут найти сервер, а, зна&
чит, будут искать и воспроизводить треки.

Если вы хотите, чтобы системы редактирования смогли импор&
тировать музыку в ваш проект, папка с аудиофайлами на сервере
должна поддерживать общий доступ к данным. Общий доступ
к музыкальным файлам в приложении iTunes осуществляется
другим способом.

Использование центральной системы имеет свои преимущества. Во&первых,
программы редактирования будут работать только с авторизованными треками,
потому что им необходимо загружать музыку из списка с общим доступом. В ре&
зультате посторонние пользователи не смогут открыть ваши музыкальные фай&
лы. Если вы создадите ссылки между всеми аудиотреками и диском, на котором
находится библиотека iTunes, вы добьетесь того, чтобы ваш проект не содержал
нелицензионную музыку. Если другие пользователи не смогут вести запись на
диск, все нелицензионные треки будут отключены.

Совет 60 Добейтесь соответствия
музыкальному ритму

Независимо от того, что именно вы редактируете, – музыкальный видеоклип, ви&
део со свадьбы вашего друга или свой следующий фильм, – музыка способна зна&
чительным образом повлиять на общее настроение в любой сцене. Если вы сможе&
те добиться соответствия ритму, ваша композиция от этого только выиграет.

Цифровое видео представляет собой комбинацию видео& и аудиосигналов, од&
нако аудиосигналу традиционно уделяется намного меньше внимания. Если вы
стараетесь улучшить впечатление от сцены с помощью музыки, вам необходимо
очень тщательно подойти к выбору композиции. Даже если вы сделаете правиль&
ный выбор, но не сможете выполнить необходимые изменения в процессе редак&
тирования, ваша сцена будет выглядеть бледно, а аудитория, скорее всего, ока&
жется разочарованной.

Выбор музыки
Выбор музыкальной композиции для проекта имеет большое значение, потому
что любая ошибка может отрицательным образом сказаться на всей сцене. Напри&
мер, ритмичная музыка в стиле техно совершенно не подходит для драматичной
сцены. Если вы собираетесь заняться распространением своего проекта, вам необ&
ходимо убедиться в том, что вы имеете на это право (см. совет 58).

Существует большое количество библиотек с бесплатными аудиофайлами, ко&
торые можно использовать при съемках фильмов. Некоторые коллекции доступ&
ны только за разумную плату, которая зависит от того, как именно вы собираетесь
распространять музыку. Простой поиск слов «бесплатная музыка» в сети Интер&
нет должен принести результат. Многие компании даже разрешают вам прослу&
шать свою музыку в сети Интернет, перед тем как вы решите ее купить или подпи&
сать лицензионное соглашение.

Импорт музыки
После выбора нужной музыки импортируйте ее в свою систему редактирования.
Чтобы добиться оптимального результата, выбирайте аудиофайлы самого вы&
сокого качества. Если у вас есть оригинальный источник музыки, например
CD&диск, импортируйте композицию непосредственно с него.

Лично я не увлекаюсь рассуждениями о качестве звука
и сжатии аудиоданных. Я убежден в том, что вам необходимо
использовать только аудиофайлы с самым высоким качеством
звучания. Если вам кажется, что музыка звучит хорошо, этого
вполне достаточно. Если кто&то начнет сомневаться в вашем
выборе, вы можете очень быстро закончить дискуссию словами:
«Это мое творческое решение».

Добейтесь соответствия музыкальному ритму
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Если вы загружаете песню, постарайтесь выбрать звук CD&качества с частотой
44,1 КГц. Как правило, при загрузке у вас не будет большого выбора, поэтому вы
можете следовать очень простому правилу: используйте самый объемный файл.
Если вы загружаете композицию продолжительностью три минуты и вам предла&
гают выбрать один файл из двух, выберите более объемный файл, потому что он
отличается самым высоким качеством.

Маркируйте ритм музыки
После импорта музыки и видеоматериала вы можете приступить к редактирова&
нию сцены. Вы заметите, что в процессе редактирования вы игнорируете ритм
музыки. Это особенно неприятно при работе со сценой, в которой музыка играет
значительную роль.

Вместо того чтобы бороться с ритмом, вы можете добавить маркеры музыки на
шкалу времени, чтобы упростить решение данной задачи. Сделать это просто: вам
достаточно лишь воспроизвести часть шкалы времени и нажать комбинацию кла&
виш, чтобы добавить маркер. В результате вы создадите систему маркеров, кото&
рая будет очень близко соответствовать ритму музыки.

Я обнаружил, что мне проще концентрироваться на ритме музыки
в том случае, если я не смотрю в монитор.

На рис. 5.11 показан фрагмент музыки с выделенным ритмом.

• Premiere. Выберите пункты меню Marker ⇒ Set Clip Marker ⇒ Unnumbered
(Создать маркер клипа ⇒ Без номера);

• iMovie. Выберите пункты меню Bookmarks ⇒ Add Bookmark (Закладки ⇒
Добавить закладку).

Чтобы упростить процесс, определите, какая комбинация клавиш применяется
в вашей системе редактирования. Вы сможете затем использовать данную комби&
нацию вместо мыши.

Как только вы добавите все маркеры, можете перейти к редактированию. Если
вы обнаружите, что по&прежнему не можете попасть в ритм, то можете попробо&
вать переместить маркеры на один кадр в любом направлении. Через некоторое
время у вас должен выработаться свой собственный стиль работы с маркерами.

Используем аудиодиаграмму
Для маркировки музыкального ритма вы также можете использовать аудиодиаг&
рамму. Как правило, ритм будет отображаться на диаграмме в виде группы пиков.
На рис. 5.12 показана диаграмма с маркерами.

Если вы скомбинируете маркеры и аудиодиаграмму, то сможете добиться прак&
тически полного соответствия музыкальному ритму композиции. При удалении
аудиофрагментов вы можете использовать маркеры как ключевые точки. Удалив
фрагменты с маркерами, вы сумеете избежать появления разрывов в ритме.

Рис. 5.11. Фрагмент музыки с выделенным ритмом

Выполните следующие действия, чтобы добавить маркеры:

• Avid. Привяжите комбинацию клавиш к кнопке Locator (Локатор);
• Final Cut. Выберите пункты меню Mark ⇒ Markers ⇒ Add (Маркеры ⇒ До


бавить);

Рис. 5.12. Аудиодиаграмма с маркерами

Добейтесь соответствия музыкальному ритму
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Эффекты делают процесс редактирования увлекательным занятием. После запи&
си материала вы можете им управлять, изменять его внешний вид, а также стили&
зацию. Спецэффекты могут быть еле заметными, как в фильме «Forrest Gump»,
или очень яркими, как в «Матрице». Используя эффекты, вы можете устранить
неполадки, которые возникли во время съемки.

Совет 61 Как придать вашему видеоклипу
«внешний вид кинофильма»

Даже при работе с цифровым видео вы можете добиться «эффекта кинофильма».
Многие люди предпочитают эффект кино эффекту видео. К сожалению, съемка

на кинопленку стоит очень дорого. Однако если вы готовы к тому, чтобы потра&
тить некоторое время при съемках и редактировании, вы можете добиться «эф&
фекта кинофильма». На рис. 6.1 показан оригинальный кадр видео, а также кадр
с эффектом кино.

Некоторые камеры имеют дополнительные опции, например Frame Mode (кад&
ры видео сканируются в определенной последовательности), а также функцию
изменения скорости открытия объектива. На рынке постоянно появляются новые
технологии и модели камер. Если вы собираетесь купить камеру и снимать видео
с эффектом кинофильма, уточните, какие именно функции вам понадобятся.
Внимательно присмотритесь к камерам HDV (см. совет 34).

Используем обновление Magic Bullet
Программа Magic Bullet for Editors (http://www.redgiantsoftware.com; стоит 299 долл.
США) – это обновление, которое предлагает набор инструментов Look Suite и
Misfire. Данное обновление позволяет вам создать эффект кинофильма и содер&
жит 55 предварительных установок. Magic Bullet поддерживает Avid Xpress, Final
Cut Pro и Premiere Pro. Бесплатно доступна демонстрационная версия программы.

Программа Magic Bullet была разработана Сту Машвитцем, бывшим
дизайнером по спецэффектам компании Industrial Light & Magic (ILM).
Он имеет опыт работы с различными кинофильмами, включая «Кас&
пер», «Twister», «Люди в черном», «Deep Impact» и «Звездные войны:
Эпизод 1».

Начинаем работу
Самый простой способ работы с программой Magic Bullet связан с использовани&
ем предварительных установок. Выберите нужный материал и добавьте в него
предварительную установку. Для этого переместите установку в материал или
выделите ее на палитре Effects (Эффекты). Пример предварительной установки
показан на рис. 6.2.

После добавления установки откройте клип в окне Monitor/Viewer. Затем про&
смотрите настройки этого клипа. Здесь вы сможете понять, каким образом раз&
личные параметры влияют на конечный результат.

Используем инструменты Look Suite
Пакет Look Suite состоит из 26 различных настроек, которые разделяются на че&
тыре категории: Subject (Тема), Lens Filter (Фильтр объектива), Camera (Каме

ра) и Post (Размещение). Чтобы продемонстрировать использование этих инст&
рументов, я выбрал установки Neo и Miami.

Если вы не знакомы с терминами, которые применяются в программе
Magic Bullet, то можете найти видеословарь и внимательно их изу&
чить. Компания Joe Kane Productions предлагает полный словарь видео&
терминов по адресу: http://www.videoessentials.com/glossary.php. Брэд
Хансен (Brad Hansen) поместил словарь видеотерминов на сайте
университета штата Портлэнд по адресу:
http://www.hansenb.pdx.edu/DMKB/dict/index.php.

Рис. 6.1. Оригинальное видео (слева)
и кадр с эффектом кино (справа)

Ведем съемку в режиме кинофильма
Если вы точно знаете, что собираетесь использовать эффект кинофильма, вам
нужно подготовиться к этому еще до начала съемок. Частично эффект кино фор&
мируется во время съемки. Очень простые приемы, например дополнительное ос&
вещение сцены, способны привести к довольно интересным результатам.

Внимательно следите за движением камеры. Например, вы можете использо&
вать кран или тележку вместо функции панорамирования, которая способна ис&
казить полученное изображение. Изучите возможности вашей камеры. Если она
поддерживает функции, которые позволяют вам уменьшить резкость или детали&
зацию, изменять цветность (комбинацию оттенка и насыщенности) или экспози&
цию, активируйте их.

Как придать вашему видеоклипу «внешний вид кинофильма»
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Работаем с настройками в категории Subject
Категория Subject дает вам возможность редактировать уровни Pre
Saturation
(Предварительное насыщение), Pre
Gamma (Предварительная гамма) и Pre

Contrast (Предварительный контраст). Постарайтесь использовать эти настрой&
ки с максимальной эффективностью. На рис. 6.3 показано оригинальное изобра&
жение (уровень в категории Subject был сконфигурирован).

Работаем с настройками в категории Lens Filter
Настройки в категории Lens Filter позволяют вам применять к изображению
фильтры Black Diffusion, White Diffusion и Gradient. Если вы вели съемку без
фильтра объектива (совет 30), то можете симулировать соответствующий эф&
фект. На рис. 6.4 показано изображение, к которому мы применили настройки
Lens Filter:

• Neo. Black Diffusion: Grade: 0. Size: 10. Highlight Bias: 0;
• White Diffusion: Grade: 3. Size: 3. Highlight Bias: 70;
• Gradient. Grade: 0. Size: 85. Color (черный). Highlight Squelch: 15. Fade: 50;
• Miami. Black Diffusion: Grade: 0. Size: 10. Highlight Bias: 0;
• White Diffusion: Grade: 3. Size: 3. Highlight Bias: 70;
• Gradient. Grade: 3. Size: 85. Color (оранжевый). Highlight Squelch: 15. Fade: 50.

Рис. 6.2. Пример одной из 55 предварительных установок

• Neo. Pre Saturation: &30. Pre Gamma: 0. Pre Contrast: &30;
• Miami. Pre Saturation: &10. Pre Gamma: 0. Pre Contrast: &10.

Скорее всего, вы заметите, что три изображения имеют очень много общего.
Предварительная установка Neo Look (с настройками Saturation и Contrast, рав&
ными &30), выглядит более заметно.

Рис. 6.3. Используем настройки категории Subject,
чтобы изменить насыщенность, гамму и контраст

Рис. 6.4. Используем настройки в категории Lens Filter,
чтобы изменить фильтры рассеивания и цвета

После конфигурирования параметров Gradient Color и Diffusion предвари&
тельная установка выглядит уникально. Установка Miami (с настройкой парамет&
ра Color на оранжевый цвет) обладает очень высокой насыщенностью оттенков.

Работаем с настройками в категории Camera
Группа параметров Camera содержит настройки для функции 3
Strip Process,
а также пять опций Tint (Tint, Tint Color, Tint Black, Tint Black Color и Tint Black
Threshold). Нас особенно интересует функция 3
Strip Process, которая симули&
рует цвета Technicolor середины 1930&х гг. На рис. 6.5 показаны следующие эф&
фекты Camera для изображения:

• Neo. 3
Strip Process: 0. Tint: 10. Tint Color: (зеленый). Tint Black: 50. Tint
Black Color (голубой). Tint Black Threshold: 25;

• Miami. 3
Strip Process: 0. Tint: 0. Tint Color: (зеленый). Tint Black: 0. Tint
Black Color (голубой). Tint Black Threshold: 30.

При добавлении фильтра Camera вы можете заметить только незначительные
изменения. Установка Neo Look приобрела зеленый оттенок; это связано с ис&
пользованием параметров Tint.

Как придать вашему видеоклипу «внешний вид кинофильма»

Эффекты
отсутствуют

Magic Bullet:
White Diffusion

Magic Bullet:
Dream Look

Magic Bullet:
Basic

Magic Bullet:
Miami

Magic Bullet:
Neo

Эффекты отсутствуют Magic Bullet: MiamiMagic Bullet: Neo

Эффекты отсутствуют Magic Bullet: MiamiMagic Bullet: Neo
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Работаем с настройками в категории Post
Наконец, настройки в категории Post позволяют вам редактировать тональность
и температуру изображения. Вы можете изменять такие параметры, как Warm/
Cool (Теплый/Холодный), Warm/Cool Hue (Оттенок теплый/холодный), Post
Gamma (Гамма), Post Contrast (Контраст) и Post Saturation (Насыщенность).
Вероятно, вы уже заметили, что категория Subject дает вам возможность выбрать
значения параметров Saturation, Gamma и Contrast. На рис. 6.6 показано, как
выглядит изображение после добавления следующих настроек категории Post.

Используем группу инструментов Misfire
Инструменты Misfire предлагают вам различные артефакты, такие как царапины,
пыль, мерцание и зернистость. Вы можете активировать и отключить любую опцию
Misfire, что позволяет вам комбинировать функции в любом удобном порядке. Так&
же вы можете применить только один эффект, чтобы добиться нужного результата:

• Fading. Освещает изображение;
• Funk. Изменяет тональность изображения;
• Splotches. Удаляет цветность изображения;
• Dust. Добавляет в изображение небольшие частицы черного и белого цвета;
• Flicker. Изменяет яркость изображения от одного кадра к другому;
• Vignette. Затемняет границы изображения;
• Displacement. Немного искажает изображение;
• Micro Scratches. Помещает в изображение черные вертикальные линии;
• Grain. Предлагает 10 переменных, предназначенных для имитации зернисто&

сти изображения (эффект кинофильма);
• Deep Scratches. Добавляет в изображение вертикальную цветную линию;
• Basic Scratches. Добавляет тонкие линии;
• Gate Weave. Немного перемещает изображение из стороны в сторону;
• Post Contrast. Позволяет вам изменить контрастность изображения.

Чтобы понять, для чего можно использовать тот или иной эффект, вам необхо&
димо просмотреть его в действии. Применяя инструменты Misfire в комбинации
с предварительными установками, вы сможете придать своей сцене «эффект ки&
нофильма», который не поддерживается в обычных видеоклипах.

Визуализация вашего проекта
Как это ни грустно, но все эффекты, которые поддерживает программа Magic Bullet,
имеют и свою цену: время. Время визуализация вашего проекта зависит от того,
сколько эффектов вы в него добавили, а также от мощности вашего компьютера.
Многим редакторам приходилось оставлять свои системы на ночь, чтобы завершить
визуализацию, а утром они обнаруживали, что компьютеры продолжали работать.

Помните о том, что программа Magic Bullet for Editors не конвертирует
ваш материал в материал с частотой смены кадров 24 кадра/с. Кино&
пленка воспроизводится именно с такой частотой, поэтому для созда&
ния эффекта кинофильма вам необходимо удалить кадры и применить
коэффициент 3 : 2. Это достаточно сложный процесс, и управление им
выходит за границы возможностей программы Magic Bullet for Editors.
Если вы хотите, чтобы ваше видео выглядело так, как будто оно
воспроизводится с частотой смены кадров 24 кадра/с, вы можете
выполнить съемку на соответствующую камеру или использовать
отдельное обновление. Программа Magic Bullet Suite (http://
www.redgiantsoftware.com; стоит 795 долл. США) позволяет решить
эту задачу, однако она поддерживает только Adobe After Effects.

Рис. 6.5. Изменяем настройки категории Camera,
уделяя особенное внимание параметру Tint

Рис. 6.6. Завершаем процесс с применением настроек Post

• Neo. Warm/Cool: &3. Warm/Cool Hue: &66.11. Post Gamma: 0. Post Contrast:
40. Post Saturation: &20;

• Miami. Warm/Cool: 0. Warm/Cool Hue: 0. Post Gamma: &3. Post Contrast: 30.
Post Saturation: &10.

Параметры в категории Post работают напрямую с настройками
в категории Subject. Если вы настроите параметр Pre�Saturation на
+5, а параметр Post Saturation – на &5, то общий уровень насыщенно&
сти вашего изображения останется неизменным.

Теперь предварительная установка отличается определенной детализацией.
Настройки параметра Warm/Cool в установке Neo сделали изображение более
холодным, а для установки Miami они обнулились.

Как придать вашему видеоклипу «внешний вид кинофильма»

Эффекты отсутствуют Magic Bullet: MiamiMagic Bullet: Neo

Эффекты отсутствуют Magic Bullet: MiamiMagic Bullet: Neo
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Если вы не хотите быть разочарованными, постоянно выполняйте визуализа&
цию небольших фрагментов видео. В результате у вас появится предварительное
представление о проекте, над которым вы работаете. Процесс конфигурирования
видеоизображения в соответствии с параметрами эффекта кинофильма может
оказаться очень длительным и сложным, поэтому я советую приступать к нему
в предпоследнюю очередь, перед редактированием звука.

Совет 62 Как снять программу с прогнозом погоды

Как говорится в одной известной песне: «Мне неважен прогноз погоды. Когда мне
говорят, что пойдет дождь, я этому не верю». А причина состоит в том, что вы
можете снять программу с прогнозом погоды самостоятельно.

Ни один фильм&катастрофа не обходится без прогноза погоды, в котором нам
рассказывают о том, как на нашу планету обрушиваются штормы, ураганы и дож&
ди и как наш мир погружается в полный хаос. А может быть, вы всего лишь хотите
добавить прогноз погоды в ваш собственный выпуск новостей? Снять свою про&
грамму с прогнозом погоды несложно.

Для этого мы воспользуемся картой погоды, загруженной из сети Интернет, ви&
деоклипом, в котором вы (или ваш знакомый актер) рассказывает о погоде на
фоне зеленого экрана (совет 22), а также методиками создания зеленого экрана
(совет 70).

Как найти информацию о погоде
Прежде всего вам понадобится найти сведения о погоде. Вы сможете без труда
загрузить необходимую информацию и изображения из сети Интернет. Такие
правительственные Web&сайты, как National Oceanographic and Atmospheric
(NOAA; http://www.noaa.gov), предлагают доступ к картинкам со спутников,
а также к картам погоды, составленным экспертами в данной области.

Большое количество карт погоды имеется на сайте Weather Underground
(http://www.wunderground.com). Этот сайт предоставляет доступ к картам дождя
и сложным картам погоды для всей территории США и многих других стран. За
небольшую плату (5 долл. США в год) сайт Weather Underground предложит вам
ознакомиться с историческими данными (это может быть очень полезно, напри&
мер в случае, если вы хотите показать перемещение шторма в пространстве и вре&
мени). На рис. 6.7 показана радарная карта залива Сан&Франциско, загруженная
с сайта Weather Underground. Тот, кто говорил вам, что в штате Калифорния ни&
когда не бывает дождей, солгал, и у меня есть доказательства.

Чтобы загрузить любое изображение, щелкните по нему правой кнопкой мыши
(в среде Windows) или выполните Ctrl+щелчок (в среде Mac) и выберите в кон&
текстном меню команду Save Picture As (Сохранить рисунок как). Большинство
изображений представляют собой файлы в формате GIF, которые вы сможете от&
крыть в любом графическом редакторе.

Если файл содержит анимацию (как, например, радарная карта, которая пока&
зывает перемещение шторма), скорее всего, это анимация GIF или Flash. Если вы
имеете дело с анимацией GIF (определяется по расширению .gif файла), вы смо&
жете сохранить файл так, как описано выше (воспользуйтесь редактором, кото&
рый поддерживает файлы GIF с анимацией). Допустим, программа Photoshop не
может открывать такие файлы, а приложение ImageReady (поставляется в комп&
лекте со многими версиями Photoshop) может. Если у вас нет программы, которая
поддерживает файлы GIF с анимацией, попробуйте установить демоверсию при&
ложения Paint Shop Pro 9 от компании JASC (http://www.jasc.com).

Если анимация находится в файле другого формата, например Flash, в операци&
онной системе Windows вам понадобится использовать специальное приложение,
такое как SnagIt (http://www.techsmith.com; стоит 40 долл. США). В операцион&
ной системе Mac воспользуйтесь функцией Grab Timed Screen (выберите пункты
меню Applications ⇒ Utilities ⇒ Grab ⇒ Capture ⇒ Timed Screen).

Редактирование изображений
Далее вам необходимо отредактировать изображения соответствующим образом.
Посмотрите прогноз погоды на телевидении и обратите внимание на следующую
особенность: обычно изображение дается в полноэкранном режиме, а кадр увели&
чивается в зависимости от того, о какой области в данный момент говорит веду&
щий. Вы можете создавать аналогичные эффекты в любом графическом редакто&

Рис. 6.7. Радарная карта с сайта Weather Underground

Как снять программу с прогнозом погоды
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ре. Набор различных иконок можно найти в сети Интернет по адресу: http://
www.awesomeclipartforkids.com/cat.cfm?cat=Weather&sec=General.

Для прогноза погоды вы можете использовать заимствованные изображения
либо создать их самостоятельно. Бюро U.S. Census имеет свой Web&сайт (http://
tiger.census.gov/cgi&bin/mapbrowse&tbl), оно формирует настоящие карты погоды
с общим доступом (это значит, что вы можете выполнять с ними любые действия
совершенно бесплатно). На этом сайте вы можете отредактировать содержимое
карт погоды.

На сайте компании ToolFram находится руководство (http://www.toolfarm.com/
tutorials/weather.html), которое описывает процесс создания карт погоды в про&
грамме After Effects. Вы можете применять данную методику и в других приложе&
ниях. Профессионалы используют очень дорогое программное обеспечение, на&
пример Curious Maps (http://www.curious&software.com; 2500–7500 долл. США),
однако вам достаточно вашего терпения и обычного графического редактора.

Создание отчета
Для начала сделайте несколько снимков актера на фоне зеленого экрана и нало&
жите их на карту погоды. Получилось! Во время съемок первого дубля вы будете
чувствовать себя очень странно: вы стоите перед зеленым экраном и рассказывае&
те о том, чего в действительности там нет.

Для усиления эффекта вы можете использовать в своем прогнозе
погоды материал с изображением различных природных катаклизмов.
Web&сайт FreeStock Footage (http://www.freestockfootage.com) предлага&
ет коллекцию недорогих снимков таких явлений; кроме того, вы може&
те применить функцию поиска в разделе Moving Images Web&сайта
Интернет Archive (http://www.archive.org). Использовать готовые
изображения намного дешевле, чем снимать их самостоятельно.

Вам будет намного проще работать с зеленым экраном, если у вас появится
представление о том, как должно выглядеть конечное изображение. Некоторые
приложения, например Visual Communicator от компании Serious Magic (http://
www.seriousmagic.com; стоит 199–695 долл. США), предлагают вам функцию
предварительного просмотра. На рис. 6.8 показано изображение, которое было
создано в программе Visual Communicator, а затем отредактировано в приложе&
нии Premiere (я добавил бегущую строку в нижней части экрана).

Если у вас не получается добиться нужного результата, сделайте несколько те&
стовых снимков, чтобы привыкнуть к карте погоды и научиться с ней работать.

Вы можете использовать стикеры, чтобы обозначить нужные точки на карте.
Вам понадобится подключить телевизор к компьютеру (см. совет 44), чтобы вы
смогли просмотреть карту на экране. Перед тем как приступить к записи, при&
клейте стикер на экране телевизора. Кроме того, вам необходимо видеть свое

изображение на том самом телевизоре, экран которого вы промаркировали (см.
совет 11). В результате вы сразу увидите, на что именно указываете. Попракти&
куйтесь, и у вас все получится.

Совет 63 Увеличенное изображение со спутника

Вы можете определить местоположение сцены с помощью нескольких изображе&
ний со спутника.

Иногда точное вычисление места для съемок сцены может оказаться очень важ&
ной задачей. Благодаря службе United States Geological Survey (USGS) вы можете
загрузить изображения со спутника практически для любой точки земного шара.
Вы можете использовать эти изображения для масштабирования.

Существует большое количество Web&сайтов, которые позволяют вам просмат&
ривать фотографии со спутника. Лично я предпочитаю работать с сайтом
TerraServer USA (http://www.terraserver&usa.com). В этом разделе приведены ре&
комендации именно для данного сайта; впрочем, вы можете использовать их и при
работе с другими службами.

Рис. 6.8. Этот прогноз погоды был снят с использованием
радарных изображений от компании Weather Underground,

а также программ Visual Communicator и Premiere

Увеличенное изображение со спутника
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Сейчас сайт Google Maps (http://maps.google.com) содержит фотогра&
фии со спутника с функцией поиска по адресу. Как и на сайте
TerraServer, вы можете увеличить масштаб изображения (при помощи
полосы прокрутки и команд интерфейса). Сайт Google Maps позволяет
вам просматривать цветные фотографии; однако уровень детализа&
ции изображений на сайте TerraServer значительно выше.

Как найти изображение нужной вам точки
На домашней странице сайта TerraServer USA щелкните по ссылке Advanced

Find (Расширенный поиск) и выберите пункт меню Address (Адрес). На страни&
це Address Search (Поиск по адресу) введите нужный адрес для поиска. На рис. 6.9
показана фотография парка Fenway Park, полученная с сайта TerraServer.

Вы можете увеличивать масштаб только до определенного
предела. Также вы можете использовать панель Navigate
слева на странице (см. рис. 6.10), чтобы изменить разрешение
изображения. Чтобы увеличить размер текущего снимка, на&
жмите кнопку Map Size (Размер карты).

Вероятно, вы захотите загрузить самое крупное изображение. Исполь&
зуя панель Navigate, вы можете выбрать в ниспадающем меню пункт
Large (Крупный). В идеале фотография должна иметь разрешение
не менее 720 × 480 (NTSC) или 720 × 576 (PAL).

Выполните следующие действия, чтобы выделить группу изображений. Затем
вы сможете с их помощью сформировать эффект масштабирования:

1. Нажмите кнопку Download (Загрузить).
2. Сохраните изображение на вашем компьютере.
3. Щелкните по ссылке Back to TerraServer (Вернуться на сайт TerraServer).
4. Уменьшите масштаб на один уровень.

После загрузки всех изображений вам понадобится импортировать их в вашу
систему редактирования.

Создаем эффект масштабирования
Выполните следующие действия, чтобы импортировать изображения:

• Avid. Выберите пункты меню File ⇒ Import;
• Final Cut. Выберите пункты меню File ⇒ Import ⇒ Files;
• Movie Maker. Выберите пункты меню File ⇒ Import;
• Premiere. Выберите пункты меню File ⇒ Import ⇒ File;
• iMovie. Выберите пункты меню File ⇒ Import.

Многие системы редактирования позволяют вам импортировать файлы путем
их перемещения в отдельные окна.

Чтобы симулировать эффект масштабирования, начните с фотографии, кото&
рая показывает место, расположенное далеко от конечной точки. Для этого по&
местите изображение в последовательность на шкале времени, как показано на
рис. 6.11.

Рис. 6.9. Фотография парка
Fenway Park с сайта TerraServer

Также вы можете выполнять поиск с применением опций Latitude/
Longitude (Широта/долгота) и Place (Место). Функция Place
пытается найти соответствия введенным вами данным, включая
достопримечательности. Например, если вы введете текст «fenway»,
система найдет Fenway, Массачусетс и парк Fenway Park.

Страница Results Page (Результаты) содержит набор ссылок на различные
изображения. Скорее всего, вам понадобится загрузить фотографию из категории
Urban Areas (Городские зоны) или Aerial Photo (Снимок с воздуха).

Загрузка коллекции изображений
После того как вы сделаете выбор, вы сможете просмотреть снимки со спутника.
Обратите внимание: при щелчке по изображению вы увеличиваете его масштаб.

Рис. 6.10. Панель Navigate для сайта TerraServer USA

Увеличенное изображение со спутника
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Дополнительные возможности
Дальнейшие действия во многом определяются вами. Далее я приведу ряд реко&
мендаций:

• чтобы сделать эффект более заметным, немного увеличьте масштаб всех
изображений;

• чтобы симулировать «эффект микроскопа», добавьте переход из трех пустых
кадров между изображениями, а также примените эффект затухания;

• если вы хотите создать иллюзию перемещения сквозь облака, наложите на
изображение эффект Fog.

Тот факт, что вы можете загрузить фотографию места, в котором снимается
ваша сцена, еще не значит, что вы обязаны это делать. Если вы хотите, чтобы ваш
сын играл в бейсбол в парке Fenway Park, вы можете это снять!

Совет 64 Удаляем посторонний объект

Время от времени в кадре появляются ненужные объекты, такие как микрофоны.
Далее мы поговорим о том, как их можно удалить.

Вы не всегда можете снять именно то, что вам нужно. Иногда в кадр могут по&
падать лишние объекты. На рис. 6.12 показан посторонний объект в верхней части
кадра. Особенно часто такие проблемы возникают при работе с внешними микро&
фонами, а также при наличии отблесков света в кадре. Вам достаточно немного

отредактировать шкалу времени и внести незначительные изменения в изображе&
ние, чтобы устранить посторонний объект.

Если у вас есть возможность вырезать объект из кадра, я советую вам попробо&
вать это сделать. Если результат вас устроит, продолжайте работу. Удаление
объекта – это последний шаг перед повторной съемкой сцены.

Процесс удаления объекта полностью различается в зависимости от
сцены. Не существует единой методики, которая была бы применима
при любых обстоятельствах. От вас потребуется максимум терпения
и фантазии.

Быстрое устранение неполадок
Если ваш объект располагается недалеко от внешней границы кадра, вы можете
удалить его путем увеличения масштаба изображения. Отмасштабируйте изоб&
ражение нужным образом. Чем больше масштаб, тем более мягким становится
видео. Следовательно, вам необходимо быть внимательным. На рис. 6.13 пока&
зан кадр видео, который был отмасштабирован таким образом, чтобы удалить
микрофон.

Если вы не хотите выполнять масштабирование (или если объект располагает&
ся очень далеко от границы кадра), для удаления постороннего объекта вам при&
дется отредактировать видео и применить спецэффекты.

Находим замену
Вам необходимо определиться с заменой для постороннего объекта. Следователь&
но, вы должны очень хорошо знать исходный материал, потому что для решения
этой задачи вам придется выбрать отдельный фрагмент видео или применить за&

Рис. 6.11. Пять изображений парка Fenway Park
с эффектом масштабирования

Рис. 6.12. В кадр попало
изображение внешнего микрофона

Удаляем посторонний объект
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ливку. Помните о том, что вы собираетесь удалить один фрагмент композиции и
заменить его другим фрагментом, который должен выглядеть точно так же.

Выбираем другие кадры
Если вы выполняли съемку с помощью штатива или использовали несколько дуб&
лей, скорее всего, вы сможете найти снимок, который содержит нужную вам за&
ливку. Другим словами, если посторонний объект (микрофон) располагается
в верхнем правом углу кадра, но при этом у вас есть материал, в котором микрофон
в кадре отсутствует, вы можете использовать его в качестве заливки. На рис. 6.14
показан проблемный снимок, а также другой кадр, который является исходным
материалом для корректировки.

После выбора материала для замены вы можете приступить к удалению объек&
та. Помните о том, что вы можете поместить заливку под исходное изображение.

Например, если бы микрофон располагался ниже, а за ним была бы стена, вы
смогли бы переместить заливку по горизонтали.

Если вы не можете найти материал для заливки, вам придется создать ее с нуля.

Создаем материал
Создание материала – это творческий процесс, поэтому подход будет различаться
в зависимости от ситуации. Впрочем, существует несколько методик, которыми
вы можете воспользоваться.

Во&первых, вы можете вернуться в место, где вы вели съемку оригинального ма&
териала, и попробовать его переснять. Учтите, что освещение композиции, вероят&
нее всего, уже изменилось, поэтому добиться точного совмещения вам не удастся.

Также вы можете воспользоваться программой, которая предназначена для об&
работки фотографий, например Adobe Photoshop (http://www.adobe.com; стоит
89,99 долл. США за приложение Photoshop Elements и 649 долл. США за прило&
жение Photoshop CS). При помощи данной программы вы можете создать одно
или несколько изображений для заливки. Вам понадобится создать ссылку на ис&
ходное видео. Для этого экспортируйте один кадр из видео:

• Avid. Выберите пункты меню Mark In and Out Points ⇒ File ⇒ Export ⇒
Windows/Macintosh Image;

• Final Cut. Выберите пункты меню Mark In and Out Points ⇒ File ⇒ Export ⇒
QuickTime Movie;

• Premiere. Выберите пункты меню File ⇒ Export ⇒ Frame.

Импортируйте кадр в ваше приложение для работы с фотографиями. Теперь вы
сможете редактировать вашу заливку, используя кадр видео в качестве ссылки.

Настройка шкалы времени
Чтобы подготовиться к удалению объекта, вам придется создать на шкале време&
ни не менее двух видеотреков. Если у вас есть только один видеотрек, выполните
следующие действия:

• Avid. Выберите пункты меню Clip ⇒ Add Video Track (Добавить видеотрек);
• Final Cut. Выберите пункты меню Sequence ⇒ Insert Tracks (Последова


тельность ⇒ Вставить треки);
• Premiere. Выберите пункты меню Sequence ⇒ Add Tracks (Добавить треки).

После того как на шкале времени появятся два видеотрека, поместите сцену
в самый верхний трек. На рис. 6.15 показана шкала времени с двумя треками (сце&
на находится в самом верхнем слое).

Процесс удаления объекта определяется его местоположением.

Удаление объекта
Поместите заливку в трек, который находится под оригинальным материалом.
Если объект расположен возле внешней границы кадра, вы сможете удалить его

Рис. 6.13. Удаляем посторонний объект
путем масштабирования

Рис. 6.14. Находим снимок,
который содержит материал для заливки

Удаляем посторонний объект
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путем обрезки изображения. В противном случае вам придется создать альфа&ка&
нал. Сначала выберите оригинальный клип, а затем приступайте к редактиро&
ванию.

Обрезка сцены
В результате обрезки изображения вы теряете часть материала. Не стоит расстра&
иваться, потому что вместо удаленного изображения вы добавите заливку. Вы&
полните следующие действия, чтобы обрезать материал:

• Avid. Выберите пункты меню Effects Palette ⇒ Image ⇒ Mask (Маска);
• Final Cut. Выберите пункты меню Motion ⇒ Crop (Обрезать);
• Premiere. Выберите пункты меню Effects ⇒ Transform ⇒ Crop.

Открыв настройки, обрежьте границу изображения в направлении объекта.
Например, если в верхнюю часть кадра попало изображение микрофона, увеличь&
те значение параметра обрезки Crop таким образом, чтобы оно исчезло. Если во
время обрезки вы заметите, что вам приходится удалять из кадра нужные компо&
ненты, попробуйте использовать альфа&канал. Помните о том, что на создание
альфа&канала требуется много времени.

Создаем и используем альфа)канал
Существует большое количество различных альфа&каналов; выбор зависит от си&
туации. Как правило, вы будете чаще всего работать с каналами удаления, потому
что они значительно упрощают настройки размера, формы и местоположения.
Для активации соответствующих параметров выполните следующие действия:

• Avid. Выберите пункты меню Effects Palette ⇒ Blend ⇒ Picture
in
Picture;
• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Matte;
• Premiere. Выберите пункты меню Effects ⇒ Video Effects ⇒ Keying.

Когда вы найдете нужный тип альфа&канала, вам придется изменить его форму
в соответствии с настройками эффекта. Задача состоит в том, чтобы удалить по&
сторонний объект и при возможности сохранить оригинальное изображение.
Если только вы не имеете дело с объектом, который появляется мгновенно (на&
пример, с отблеском света), вам понадобится добавить в альфа&канал ключевые
кадры анимации.

Заполняем пробел
После удаления объекта вам необходимо добавить заливку. Если вы вели съемку с
применением штатива или из статичного положения, у вас не должно возникнуть
проблем с заливкой.

Если вы выполняли съемку в движении, вам придется отредактировать исход&
ную композицию. Скорее всего, в процессе редактирования вы будете вынуждены
переместить материал:

• Avid. Выберите пункты меню Effects Palette ⇒ Image ⇒ Resize;
• Final Cut. Выберите пункты меню Motion ⇒ Basic Motion ⇒ Center;
• Premiere. Выберите пункты меню Effect Controls ⇒ Fixed Effects ⇒ Motion
⇒ Anchor.

После конфигурирования заливки ваш снимок будет завершен. На рис. 6.16
показано оригинальное изображение, изображение после обрезки, а также конеч&
ное изображение с заливкой.

Рис. 6.15. Размещаем материал
в самом верхнем видеотреке

Рис. 6.16. Обрезаем и редактируем изображение таким образом,
чтобы посторонний объект был удален

С большой вероятностью рано или поздно вам придется столкнуться с ситуа&
цией, когда в вашем видео появится посторонний объект. Для того чтобы его уда&
лить, вам потребуется немного знаний, ваша фантазия и большое терпение.

Удаляем посторонний объект
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Совет 65 Создаем эффект инвертирования
в программе Movie Maker

Приложение Windows Movie Maker включает эффект инвертирования. Однако
в оригинальном виде вы не сможете использовать данный эффект для своего ви&
део. Далее мы расскажем о том, как обойти это ограничение.

В некоторых случаях вам понадобится инвертировать ваше видео. При инвер&
тировании цвета изображения изменяются (как при использовании негатива).
Инвертирование – это очень полезная функция. Поэтому компания Microsoft до&
бавила в программу Movie Maker специальный эффект Negative, который поддер&
живает инвертирование. Однако вы не можете использовать данный эффект без
предварительной подготовки.

Я хочу поблагодарить Рейана (Rehan) из компании RehanFX
(http://www.rehanfx.com) за то, что он проконсультировал меня
по теме отсутствия эффекта инвертирования в программе
Movie Maker.

Создание эффекта
Приложение Movie Maker позволяет вам создавать новые эффекты. Используя
текстовый редактор, например WordPad, вы можете записывать соответствующие
команды на языке XML. Чтобы сформировать эффект инвертирования, создайте
новый документ и введите следующее:

<TransitionsAndEffects Version=”1.0”>

<Effects>

<EffectDLL guid=”{B4DC8DD9-2CC1-4081-9B2B-20D7030234EF}”>

>Effect nameID=”62864” iconid=”18” comment=”Negative”>

<Param name=”InternalName” value=”Standard” />

<Param name=”Invert” value=”-1.0” />

</Effect>

</EffectDLL>

</Effects>

</TransitionsAndEffects>

При вводе XML&кодировки (и любой другой компьютерной кодировки)
вы должны быть очень внимательны и не допускать ошибок. Кодировка
не будет работать, если вы пропустите какой&либо символ, например
обратный слэш (/) или даже кавычки (“). Если вы обнаружите, что ваш
эффект функционирует неправильно, вернитесь и проверьте, не
ошиблись ли вы при вводе кодировки.

Сохраните файл как invert.xml (в виде текстового документа) в папке
C:\Program Files\Movie Maker\Shared\AddOnTFX, как показано на рис. 6.17.
Если такой папки не существует, создайте ее. При запуске программа Movie
Maker выполнит поиск дополнительных эффектов и переходов в этой папке.

Рис. 6.17. Сохраняем документ invert.xml в папке AddOnTFX

Загрузка и использование эффекта
Сохранив файл, запустите программу Movie Maker. Если она уже была запущена,
перегрузите ее (только программу, а не компьютер). Затем выберите пункты
меню Tools ⇒ Video Effects (Видеоэффекты) либо щелкните по панели Video
Effects, чтобы убедиться в том, что эффект Negative доступен. На рис. 6.18 пока&
зан эффект Negative на панели Video Effects программы Movie Maker.

Если эффект доступен, вы сможете выбрать его и добавить в свой материал.
Для этого переместите его в нужный клип с помощью мыши. Да, вы поняли меня
правильно: этот эффект ничем не отличается от любого другого эффекта на пане&
ли. На рис. 6.19 показано изображение, в которое мы добавили эффект Negative.

Дополнительные возможности
Если вы увлекаетесь написанием кодировки, то сможете создать большое количе&
ство разнообразных эффектов и переходов. Некоторые компании занимаются ис&
ключительно разработкой спецэффектов для программы Movie Maker; многие
люди зарабатывают этим себе на жизнь. Если вас заинтересовала данная тема, об&
ратитесь к библиотеке Microsoft Developers Network Library for Movie Maker

Создаем эффект инвертирования в программе Movie Maker
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Совет 66 Как добавить в видео специальные
символы в стиле фильма «Матрица»

Трилогия «Матрица» стала настоящим феноменом современной культуры. По&
степенно текстовые символы в виде зеленых букв, которые использовались в этом
фильме, стали применяться в различных скрин&сейверах, на Web&сайтах и даже
на футболках. Далее мы расскажем о том, как вы можете создать аналогичный
эффект для своего цифрового видео.

В фильме «Матрица» некоторые персонажи могли различать зеленые буквы на
темных экранах мониторов и интерпретировать их значение. Казалось, что они
воспринимают изображения в виде символов. Мы не живем в Матрице (а может
быть, и живем, кто знает?), но существует возможность создания похожего эф&
фекта для видео. Более того, вы можете указать, какие именно изображения вы
хотите увидеть.

Фильм, в котором изображение было конвертировано в группу симво&
лов, очень часто называют «ASCII&видео».

Загружаем приложение ASCIIMoviePlayer
Если вы работаете в среде Mac OS X, то сможете использовать встроенное прило&
жение QuickTime. Инженеры компании Apple разработали программу ASCIIMo&
viePlayer (http://developer.apple.com/samplecode/ASCIIMoviePlayerSample/
ASCIIMoviePlayerSample.html), которая предназначена для воспроизведения
фильма QuickTime в текстовом окне Terminal. Приложение ASCIIMoviePlayer
берет видеофайл и конвертирует его настройки освещенности в текстовые симво&
лы. Этот процесс осуществляется благодаря встроенному движку QuickTime.

После загрузки программы ASCIIMoviePlayer в вашей системе появится папка,
которая содержит четыре объекта: ASCIIMoviePlayer, ASCIIMoviePlayer.pbproj,
build (папка) и qtplyr.c. Нас больше всего интересует файл ASCIIMoviePlayer (ис&
полняемый файл программы).

Братья Вачовски (Wachowski) воспользовались данной методикой при
съемках фильма «Ghost in the Shell».

Другие файлы содержат информацию, которая необходима вам
для создания приложения с нуля. Исходная кодировка программы
записана в файле qtplyr.c (при желании вы можете ее просмотреть
или отредактировать). Если вы установили пакет Developr’s Tools,
который поставляется вместе с операционной системой Mac OS X,
то можете дважды щелкнуть по файлу ASCIIMoviePlayer.pbproj
и приступить к работе с исходной кодировкой.

Рис. 6.18. Эффект Negative готов к использованию

Рис. 6.19. Настраиваем видео на параметры негатива

Effects and Transitions по адресу: http://msdn.microsoft.com/library/default.asp?url=/
library/en&rus/dnwmt/html/moviemakersfx.asp.

Как добавить в видео специальные символы в стиле фильма «Матрица»
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Запускаем программу ASCIIMoviePlayer
Для активации программы ASCIIMoviePlayer вам необходимо запустить прило&
жение Terminal. Если вы не имеете опыта работы с этим приложением, то сможете
найти его в папке Utilities. По умолчанию в программе Terminal используется чер&
ный текст на белом фоне.

Если вы хотите изменить цвет текста и фона в приложении Terminal, выберите
пункты меню Terminal ⇒ Window Settings ⇒ Color (Цвет). Существует набор за&
данных установок, например Green on Black (Зеленый текст на черном фоне). При
желании вы можете настроить комбинацию цветов любым удобным способом.

Чтобы воспроизвести фильм в программе ASCIIMoviePlayer, переместите
файл приложения в окно Terminal. Затем переместите в окно нужный видеофайл
(при желании вы можете использовать командный интерфейс).

При перемещении файла в окно Terminal вы заметите, что путь
к файлу вводится автоматически. Все так, как и должно быть.

Перед тем как нажать клавишу Return, нажмите кнопку Zoom (небольшая зе&
леная кнопка в верхнем левом углу окна), чтобы развернуть окно Terminal. На
рис. 6.20 показано окно Terminal, которое содержит приложение ASCIIMo&
viePlayer с фильмом mymovie.mov.

Альтернативные методики
Существуют и другие программы, которые могут конвертировать фильмы в фор&
мат ASCII.

Приложение QuickASCII (http://sourceforge.net/projects/quickascii/; постав&
ляется бесплатно) основано на ASCIIMoviePlayer, но имеет дополнительные на&
стройки цвета и отличается более высокой производительностью. Программа
QuickASCII поддерживает операционные системы Linux, Mac OS X и Unix.

Программа MPlayer (http://www.mplayerhq.hu/homapage/; поставляется бес&
платно) – это видеоплеер для операционных систем Windows, Mac OS X и Linux.
Если вы установите обновление AA&lib (http://aa&project.sourceforge.net/aalib/;
поставляется бесплатно), то сможете открывать фильмы в формате ASCII с по&
мощью аргумента -vo aa. Если у вас возникли проблемы с установкой обновле&
ния AA&lib, загрузите установочный пакет с сайта http://sveinbjorn.vefsyn.is/aalib.
Если вы хотите использовать цветную ASCII&кодировку, добавьте библиотеку
libcaca (http://sam.zoy.org/projects/libcaca/).

Дополнительные возможности
Разумеется, просмотр фильма в кодировке может увлечь вас на некоторое время,
но при желании вы сможете добавить данный эффект и в свои проекты. Напри&
мер, вы можете взять отредактированную сцену из фильма и объединить ее
с ASCII&кодировкой. Данную задачу можно решить несколькими способами:

• вы можете вести запись на цифровую видеокамеру с экрана вашего компью&
терного монитора. Вам придется внимательно проверять все кадры видео, но
вы и так это делаете, не так ли? Возможно, вам понадобится изменить на&
стройки камеры и монитора, чтобы записать изображение без мерцания
(см. совет 32);

• вы можете использовать программу записи изображения с экрана, чтобы со&
хранить ASCII&фильм в цифровом формате. Я рекомендую использовать эту
методику только в случае, если вы работаете на очень быстром компьютере и
у вас достаточно много свободного места на жестком диске.

Большое количество пользователей работают с ASCII&кодировкой. Существу&
ют ASCII&веб&камеры, ASCII&рисунки и даже ASCII&мультфильмы. Кто мог себе
такое представить раньше?

Совет 67 Создаем сюрреалистическую сцену

В некоторых ситуациях вы как продюсер видеофильма можете дать полную сво&
боду своему воображению. В качестве примера можно привести сцену, в которой
вы пытаетесь показать события, происходящие во сне. Если во сне вы можете из&
менять реальность, почему бы не сделать это необычным образом? Вы можете по&

Рис. 6.20. Окно Terminal готово к воспроизведению фильма

После завершения подготовки нажмите клавишу Return и просмотрите эф&
фект на экране. Ваш фильм должен конвертироваться в текстовые символы.
На рис. 6.21 показан кадр из фильма, который был воспроизведен в программе
ASCIIMoviePlayer.

Рис. 6.21. Вы выпили красную пилюлю?

Создаем сюрреалистическую сцену
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местить своего персонажа на луг синего цвета, в помещение, стены которого рас&
крашены разными красками, или даже на поверхность другой планеты.

Вы даже можете попасть на Марс! На сайте Spirit and Opportunity
Rovers вы найдете большое количество разнообразных фотографий
(http://marsrovers.jpl.nasa.gov/gallery/all/).

Создаем передний план и фон
Вы создадите полноценную окружающую среду, в которой будут действовать
персонажи фильма. Для этого вам понадобится сформировать передний план и
фон, которые будут размещаться перед персонажами и позади них соответ&
ственно. Изображение переднего плана должно состоять из объектов, например
столов или автомобилей. Эти объекты используются для создания иллюзии
пространства.

При выборе среды для переднего плана постарайтесь использовать цвет, кото&
рый не входит в дизайн переднего плана. Это связано с тем, что дизайн будет до&
бавлен в вашу сцену. Если вы этого не сделаете, изображение станет прозрачным.
Например, если вы решили создать передний план на зеленом фоне, не следует
добавлять зеленый цвет в дизайн.

Некоторые системы редактирования способны удалять фон
исключительно синего или зеленого цвета. Перед тем как приступить
к работе, определите возможности вашей системы.

Фоновое изображение должно покрывать всю поверхность композиции (или
нет, если это соответствует вашим ожиданиям). Кроме того, вам необходимо до&
бавить в фон композиции перспективу (включая линию горизонта).

Используем художественные средства,
чтобы сформировать изображения
Если вы умеете рисовать, придайте изображению черты, которыми отличают&
ся сновидения. Помните о том, что после завершения работы вам необходимо
импортировать изображение в вашу программу редактирования. Следователь&
но, ваш материал должен быть в формате, который поддерживается компью&
тером.

Если у вас есть сканер, отсканируйте изображение с высоким разрешением.
Даже несмотря на то, что вы не сможете использовать разрешение выше 720 × 480
(720 × 576 для PAL), я советую вам работать с высокой детализацией, которая мо&
жет понадобиться впоследствии. Если у вас нет сканера, вы можете записать мате&
риал на видеокамеру. При использовании камеры следите за тем, чтобы изобра&
жение было правильно освещено и расположено в кадре. Я рекомендую вам вести
съемку с применением штатива, чтобы стабилизировать изображение.

Формируем изображения на компьютере
Если у вас есть проблемы с рисованием (как у меня), вы можете создать фоновое
изображение на компьютере. Для этого очень удобно использовать программу
DAZЅStudio (http://www.daz3d.com/studio/; поставляется бесплатно). Это при&
ложение предназначено для создания трехмерных пейзажей; оно содержит встро&
енные установки и изображения. Программа DAZЅStudio поддерживает операци&
онные системы Windows и Macintosh. На рис. 6.22 показан снимок из DAZЅStudio
с предварительной установкой Fairy Forest (Сказочный лес).

Рис. 6.22. Установка Fairy Forest: встроенная сцена

Если вы заметите, что не можете создать нужное изображение самостоятельно,
просмотрите встроенные установки DAZЅStudio. Многие установки предлагают&
ся отдельно, по разумным ценам. Лично я считаю, что эти установки заслуживают
внимания.

Здесь я хочу рассказать еще об одной программе, Painter
(http://www.corel.com; стоит 399–429 долл. США). Painter –
это своеобразное промежуточное звено между рисованием
от руки и компьютерной графикой.

Съемка сцены
Чтобы поместить персонажей в созданную вами среду, вы должны выполнить
съемку на фоне зеленого экрана (см. совет 70). Убедитесь в том, что зеленый экран
и персонажи хорошо освещены. Если у вас есть время и возможность, запишите
материал на фоне зеленого экрана и попробуйте наложить его на фоновое изобра&
жение. Это позволит вам устранить все неполадки заранее.

Создаем сюрреалистическую сцену
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Редактирование сцены
После того как вы сформируете и импортируете изображения для переднего пла&
на и фона, а также выполните оцифровку материала, вы сможете перейти к редак&
тированию слоев и созданию конечной сцены.

Поместите фоновое изображение в нижний слой на шкале времени. В следую&
щий по порядку слой добавьте материал, который был снят на фоне зеленого эк&
рана. Поместите в третий слой материал для переднего плана.

Сначала вам необходимо добавить в передний план эффект Chroma Key. Про&
цесс аналогичен процедуре создания эффекта Chroma Key для изображения с зе&
леным экраном; различие связано с последовательностью действий:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Key ⇒ RGB Key ⇒
(выберите цвет);

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Key ⇒ Color Key
⇒ (выберите цвет);

• Premiere. Выберите пункты меню Effects ⇒ Video Filters ⇒ Keying ⇒
Chroma Key ⇒ (выберите цвет).

После добавления эффекта Chroma Key для переднего плана вставьте эффект
в материал с зеленым фоном (см. совет 70). Затем вы должны переместить цент&
ральные точки слоев так, как это необходимо для конечной композиции.

Когда вы настроите эффекты Chroma Key для зеленого фона и переднего пла&
на, сцена будет выглядеть так, как будто ее сняли за один дубль. Скорее всего, вам
понадобится внести некоторые изменения в композицию перед визуализацией.
Завершенная сцена показана на рис. 6.23.

Выполните визуализацию и наслаждайтесь сценами из своего сна.

Дополнительные возможности
При создании сцены с применением данной методики вы можете дать полную
свободу своей фантазии. Для фона используйте изображение, вытянутое по гори&
зонтали. При съемках попросите актеров перемещаться от одной стороны фона
к другой. Когда вы будете редактировать композицию, добавьте анимацию фона,
изменив его положение относительно персонажей.

Создайте несколько слоев для переднего плана. Если в сцене участвуют не&
сколько актеров, вы можете поместить их в различные слои и добавить между
ними объекты. Настройте тени объектов, чтобы создать иллюзию перспективы
(см. совет 71).

Кроме того, вы можете добавлять различные видеоэффекты в отдельные слои
или в сцену. Сконфигурируйте насыщенность, яркость и оттенок, чтобы выделить
важные компоненты видео. Также вы можете изменить размеры объектов пере&
днего плана и даже самих персонажей!

Не забывайте о том, что этот мир вы создаете сами; зрители – это всего лишь
ваши гости.

Совет 68 Изменяем текущее время суток для сцены

Используя инструменты корректировки цвета, вы можете создать иллюзию того,
что дневная сцена была снята ночью.

Далеко не все могут позволить себе роскошь вести съемки ночью. Если вам не&
обходимо выполнить съемку в ночное время, но вы не можете этого сделать, вос&
пользуйтесь инструментами корректировки цвета.

Инструменты корректировки способны решить проблему, однако
оптимального результата вы можете добиться, только если будете
вести съемку ночью. Настоящая сцена всегда лучше, чем ее имитация.

Работаем с инструментами корректировки цвета
Основное различие между снимками днем и ночью связано с отображением цве&
тов. Вы можете заметить, что ночью любой объект принимает темно&синий отте&
нок. Именно этот эффект мы и будем симулировать.

Функция корректировки цвета работает непосредственно с цветами.
Если вы собираетесь воспроизвести свой фильм на телевидении, вам
необходимо использовать соответствующие настройки (см. совет 44).
Помните о том, что в формате NTSC цвета отличаются непостоян&
ством. Это значит, что цвета в одном и том же фильме могут выгля&
деть неодинаково на двух разных телевизорах.Рис. 6.23. Завершенная сцена, которая состоит из трех слоев

Изменяем текущее время суток для сцены
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Найдите нужную сцену в вашей программе редактирования и выделите ее. За&
тем откройте инструмент корректировки цвета:

• Avid. Выберите пункты меню Toolset ⇒ Color Correction (Инструменты ⇒
Корректировка цвета);

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Color Correction
3
way (Трехсторонняя корректировка цвета);

• Movie Maker. Воспользуйтесь обновлением Pixelan SpiceFX Pakc E1: Correc&
tion Effects (http://www.pixelan.com; стоит 14 долл. США);

• Premiere. Выберите пункты меню Window ⇒ Workspace ⇒ Color Correction;
• iMovie. Воспользуйтесь обновлением GeeThree Slick Effects: Volume 6 (http:/

/www.geethree.com; стоит 69,95 долл. США).

При корректировке цвета используются некоторые специальные термины:

• информация о цветности изображения (chrominance). Часть видеосигнала,
которая включает оттенок и насыщенность;

• гамма. Часть видеосигнала, которая включает интенсивность и воздействует
на детализацию;

• освещенность. Часть видеосигнала, которая включает яркость.

Чтобы создать иллюзию ночной съемки, вам необходимо изменить настройки
параметров Chroma, Gamma и Luminance, а также отредактировать черные цвета,
белые цвета и полутона. В зависимости от функций вашей системы редактирова&
ния или выбранного обновления результаты могут различаться. Кроме того, не
существует двух одинаковых снимков; это связано с освещением, различными на&
стройками объективов и цветовыми композициями сцены. На рис. 6.24 показано
оригинальное изображение, а также изображение после применения эффекта
«ночной съемки».

Уменьшаем освещенность и цветность изображения
Прежде всего вам необходимо уменьшить освещенность и цветность вашей сце&
ны. Очевидно, что при уменьшении освещенности четкость изображения ухудша&
ется. Но ночью вы не можете видеть объекты так же ясно, как днем, не правда ли?

Кроме того, вы должны уменьшить цветность изображения. Это приведет
к тому, что некоторые объекты сцены перестанут выделяться. Я советую вам сна&
чала поэкспериментировать. На рис. 6.25 показано изображение, для которого мы
изменили настройки освещенности и цветности.

Рис. 6.24. Так выглядит одна и та же сцена днем и ночью

Рис. 6.25. Изображение с измененными настройками
освещенности и цветности

Уменьшаем гамму
Если вы можете уменьшить гамму для сцены, сделайте это. Помните о том, что
при работе с таким параметром, как гамма, небольшое изменение может привести
к непредсказуемым результатам. На рис. 6.26 показано изображение, для которо&
го мы немного снизили уровень гаммы, от 1,0 до 0,95.

Изменение настроек черного цвета
Для добавления в сцену оттенка темно&синего цвета вы можете отрегулировать
настройки черного цвета таким образом, чтобы они приблизились к диапазону
синего цвета. Будьте внимательны и не переусердствуйте. На рис. 6.27 показано
изображение с измененными настройками черного цвета.

Редактирование полутонов
Чтобы еще больше усилить эффект, измените полутона изображения в сторону
синего цвета. Скорее всего, вам придется сделать несколько попыток, прежде чем
вы добьетесь успеха. На рис. 6.28 показано изображение с измененными настрой&
ками полутонов.

Изменяем текущее время суток для сцены
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Изменение настроек белого цвета
Вы можете поиграть с цветами и в другой части спектра.
Настройки белого цвета следует приблизить к желтому
диапазону. Мой совет может показаться вам странным,
однако при таком изменении белые цвета будут выделе&

ны. На рис. 6.29 показано изображение, в котором настройки белого цвета были
приближены к желтому диапазону спектра.

Уменьшение насыщенности
Наконец, вы можете уменьшить насыщенность изображения. Это позволит
уменьшить интенсивность всех цветов изображения. Кроме того, при снижении
насыщенности общий вид сцены изменится. На рис. 6.30 показано, как выглядит
изображение после того, как мы уменьшили его насыщенность на 50%.

Рис. 6.26. Уменьшаем уровень гаммы

Рис. 6.27. Редактируем настройки черного цвета,
чтобы создать иллюзию ночной съемки

Рис. 6.28. У вас появилось чувство,
что приближается вечер

Рис. 6.29. Редактируем настройки
белого цвета и приближаем их
к желтому диапазону спектра

Рис. 6.30. Изменяем
насыщенность цвета

Корректировка цвета – это очень мощная функция, предназначенная для из&
менения внешнего вида композиции. Инструменты  корректировки цвета позво&
ляют вам решать самые разнообразные задачи, начиная от изменения времени
суток в кадре и заканчивая формированием уникального изображения для ком&
позиции.

Совет 69 Создаем титры

Многие видеоредакторы позволяют вам создавать текст на экране. Некоторые
приложения даже поддерживают редактирование заголовков. Впрочем, даже ис&
пользование более простой методики позволяет добиться впечатляющего резуль&
тата.

Как правило, любой фильм начинается с вступительной сцены, которая содер&
жит титры на экране. Это явление называется «последовательность заголовков».
Если вы воспользуетесь самой простой методикой создания титров (я называю ее
«флаги титров»), ваша аудитория будет приятно удивлена.

Подготовка флагов
Во&первых, вам потребуется найти некоторые компоненты: большой кусок легкой
белой ткани, черный маркер, деревянный или металлический шест и вентилятор.
Кроме того, вам понадобятся ножницы, а также крепление для шеста, например
степлер, набор булавок или скотч. На рис. 6.31 показан набор компонентов.

Создаем титры
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Разрежьте кусок ткани на несколько квад&
ратных частей, достаточно больших для того,
чтобы вы могли писать на них маркером. На&
пример, при создании флага титров вам пона&
добится кусок ткани, на котором можно напи&
сать большими буквами: «Автор сценария и ре&

жиссер – я!» Расположение и размер букв зависят от ваших предпочтений. Вам
необходимо создать отдельный флаг для каждой записи в титрах.

Запись флагов
После создания флагов вы можете приступить к записи видео. Чтобы создать
флаг, прикрепите кусок ткани к шесту. Затем установите шест в вертикальное по&
ложение и направьте на него вентилятор.

Вы должны настроить камеру и сфокусировать ее на флаге. Убедитесь в том,
что флаг полностью закрывает экран, причем даже в тот момент, когда он развева&
ется. Если вы заметите, что на флаге появляются темные тени, вам придется уста&
новить дополнительный источник освещения и устранить их.

Вы можете записать материал на белом фоне, чтобы получить право
на ошибку. Если у вас нет вентилятора, вы можете развевать флаг
вручную. Для этого возьмите шест в руки и раскачивайте его.

После настройки камеры начните запись. Вам достаточно записать 30 с видео
для одного флага. Повторяйте эти действия до тех пор, пока вы не запишите фла&
ги для всех титров. Затем вам понадобится импортировать видео в систему редак&
тирования. На рис. 6.32 показан флаг титров, который мы импортировали в при&
ложение Adobe Premiere Pro.

Настройка флагов
Когда вы завершите оцифровку материала, откройте файл в вашем редакторе и
примените эффект Inverse. В результате буквы станут белыми, а фон – черным
(см. рис. 6.33).

Выполните следующие действия, чтобы оцифровать материал в различных си&
стемах редактирования:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Image ⇒ Color Effect
(Chroma Adjust ⇒ Invert);

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Channel ⇒
Invert (Инвертировать);

• Movie Maker. Добавьте новый эффект инвертирования (см. совет 65);
• Premiere. Выберите пункты меню Window ⇒ Effects ⇒ Video Effects ⇒

Channel ⇒ Invert;
• iMovie. Воспользуйтесь обновлением Negate B/W от CF/X (http://www.

imovieplugins.com/; поставляется бесплатно).

Рис. 6.31. Эти инструменты помогут вам
создать титры

Рис. 6.32. Этот флаг скоро будет преобразован в титры

Рис. 6.33. Это не школьная доска,
а флаг после применения функции инвертирования

Создаем титры
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С. Если вы заметите, что ваш флаг выглядит не так, как следует,
проверьте настройки освещения.

После добавления эффекта инвертирования поместите материал в начальную
сцену композиции и примените эффект Matte или Key:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Key ⇒ Luma Key;
• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Matte ⇒ Image

Mask (Маска изображения);
• Premiere. Выберите пункты меню Effects ⇒ Keying ⇒ Luma Key (измените

настройки параметров Threshold и Cutoff соответствующим образом);
• iMovie. Воспользуйтесь обновлением Chroma Key от CF/X (http://www.

imovieplugins.com/; стоит 3,50 долл. США).

Эффект Matte удалит черную часть флага титров. В результате вы сможете уви&
деть нижний слой материала, а буквы титров сохранятся на экране (см. рис. 6.34).

мацию титров и музыкальный ритм композиции, вы сможете создать очень инте&
ресную композицию.

Данная методика поддерживает большое количество опций. Поэксперименти&
руйте и получите удовольствие.

Совет 70 Создание композиции с зеленым фоном

Композиции с зеленым фоном позволяют вам создавать эффекты, которые при&
меняются в голливудских фильмах.

Вам когда&нибудь хотелось полетать на космическом корабле? Или отправить&
ся в путешествие по России? А может быть, вы мечтали стать ведущим прогноза
погоды (см. совет 62)?

С помощью зеленого экрана вы можете воплотить свои мечты в реальность (со&
вет 14). В фильме «Forrest Gump» зеленый экран успешно применялся для имита&
ции встреч между героем Тома Хэнкса (Tom Hanks) и такими историческими лич&
ностями, как Джон Ф. Кеннеди, Ричард Никсон и Элвис Пресли. Записав сцену
на фоне зеленого экрана (совет 22), вы можете создать иллюзию практически лю&
бого явления или события (совет 67).

Помимо записи на фоне зеленого экрана, вам также необходимо записать ос&
новной материал для композиции. Например, если вы собираетесь записать сцену
встречи с историческим персонажем, вам понадобится найти материал, в котором
он участвует. Перед тем как приступить к записи на фоне зеленого экрана, убеди&
тесь в том, что вы знаете, какой дополнительный материал будет использоваться
в вашей композиции. На рис. 6.35 вы видите кадр из снимка с зеленым фоном,
а также фоновое изображение для композиции.

Рис. 6.34. Так выглядят начальные титры фильма

После добавления титров на шкалу времени выполните визуализацию и вос&
произведение. Теперь титры будут показываться на фоне изображения.

Дополнительные возможности
Вы можете настроить дополнительную анимацию титров на экране. Например,
титры могут «подпрыгивать», отражаться от границ кадра и т. д. Совместив ани&

Рис. 6.35. Очень скоро мы объединим эти два снимка в одну сцену

Приступаем к созданию композиции
Для композиции вам понадобится использовать эффект Key, который позволяет
вам удалять из конечного изображения определенные цвета или фрагменты ви&
деосигнала, например освещенность. Если вы работаете с эффектом Key в компо&
зиции с несколькими слоями, слой, расположенный под слоем Key, будет виден.

Создание композиции с зеленым фоном
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На рис. 6.36 показаны два изображения с зеленым фоном. Одно изображение со&
держит эффект Key, а другое – нет.

В большинстве случаев вам понадобится изменить положение персонажей
в кадре.

Смещаем снимок
Далее вам необходимо переместить снимок в нужное положение. Чтобы изменить
положение персонажей относительно различных объектов в сцене, переместите
центральную точку. В результате вы сможете расположить актеров реалистич&
ным образом.

Выполните следующие действия:

• Avid. Выберите пункты меню Tools ⇒ Image ⇒ Resize Position (Изменить
положение);

• Final Cut. Выберите пункты меню Viewer Window ⇒ вкладка Motion ⇒
Basic Motion ⇒ Center (Центр);

• Premiere. Выберите пункты меню Effect Controls ⇒ Motion ⇒ Position (По

ложение).

Изменять положение фрагмента видео вам придется исключительно методом
проб и ошибок. Для достижения результата вам придется потратить некоторое
время. После перемещения фрагмента выполните воспроизведение (если ваша
система поддерживает функцию воспроизведения видео в режиме реального вре&
мени) или щелкните по нескольким точкам на шкале времени. Если изображение
с зеленым фоном содержит анимацию, вероятно, вам понадобится переместить
отдельные фрагменты. На рис. 6.38 показано, как выглядит композиция после пе&
ремещения изображения с зеленым фоном.

Рис. 6.36. Изображение с зеленым фоном
(с эффектом Key и без него)

Выполните следующие действия, чтобы применить данный эффект:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Key ⇒ Chroma Key;
• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Blue and Green

Screen (Синий и зеленый фон);
• Premiere. Выберите пункты меню Effects ⇒ Video Filters ⇒ Keying ⇒ Green

Screen Key (Эффект Key для зеленого экрана).

Если вы обнаружите, что применение эффекта Key не позволяет добиться нуж&
ного результата, вы можете выбрать другой эффект, например Color Key, Chroma
Key или RGB Key. Начальная композиция показана на рис. 6.37.

Рис. 6.37. Объединяем два изображения
в исходной композиции

Рис. 6.38. Перемещаем центральную точку
изображения

Создание композиции с зеленым фоном
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Вероятно, вам придется внести дополнительные изменения в вашу компози&
цию, чтобы сделать ее более реалистичной для аудитории.

Последние штрихи
В зависимости от освещения зеленого экрана, цветов и теней фона, а также от об&
щего совмещения материала вам с определенной вероятностью понадобится до&
бавить в композицию дополнительные эффекты. Это эффекты, которые связаны
с изменением насыщенности, яркости, контраста и цвета.

Если вы умеете работать с инструментами корректировки цвета, то будете их
применять особенно часто. Если фоновое изображение содержит тени, вы можете
добавить тени для зеленого экрана (см. совет 71), чтобы добиться совмещения. На
рис. 6.39 показано, как выглядит изображение после того, как мы незначительно
уменьшили насыщенность, а также изменили яркость и контраст.

фоне любого другого цвета. Помните о том, что ваше изображение располагается
перед фоном одного цвета, а цвета вашего персонажа и его фона различаются.
Я рекомендую вам учитывать эти особенности во время освещения и редактиро&
вания сцены (см. совет 22).

Если вы создаете сцену с использованием зеленого экрана, то можете обнару&
жить, что ваш персонаж не отбрасывает тени. Эту проблему легко решить. Более
того, решение проблемы заключается в ней самой.

Данная методика очень удобна при работе со снимками, которые
содержат один движущийся персонаж (например, актера, идущего
через пляж). Вы можете использовать ее и в композициях с нескольки&
ми персонажами. Однако чем больше движутся актеры в кадре, тем
труднее вам будет добиться нужного результата, потому что тень
от одного персонажа не будет падать на другого.

Создаем копию изображения
Для формирования эффекта тени вам необходимо сначала скопировать видео&
изображение. Добавьте на шкалу времени еще один видеослой и поместите на
него копию композиции с зеленым экраном. Вам понадобится использовать тот
же эффект, который применялся при создании исходной сцены (см. совет 70).
После завершения редактирования ваша композиция должна содержать два ви&
деослоя с одинаковыми эффектами.

Самая простая методика – это копирование и вставка изображе&
ния на шкалу времени. Добавьте в оригинальное изображение эффект
Key, чтобы скрыть зеленый экран. Скопируйте весь клип (включая
эффекты) и поместите его в другой слой на шкале времени. Возмож&
но, вам придется переместить ваш материал в новые слои на шкале
времени.

Добавляем видео в соответствующий слой, чтоб подготовить его к формирова&
нию эффекта тени

Для правильного воспроизведения эффекта необходимо, чтобы оригинальное
изображение находилось в слое над слоем тени. Если вы расположите слои дру&
гим образом, тень появится перед вашим персонажем. На рис. 6.40 показано раз&
личие между композициями, в которых слой тени располагается над оригиналь&
ным слоем и под ним.

Создаем оболочку для тени
После подготовки слоев изображения вы должны удалить из композиции цвет.
В результате оригинальное изображение станет черно&белым. Для этого выпол&
ните следующие действия:

Рис. 6.39. Редактируем насыщенность,
яркость и контраст

Создание реалистичного изображения на зеленом фоне может потребовать
много времени и сил. При работе с материалом я советую вам делать короткий
перерыв каждый час. В противном случае вы можете «потеряться».

Совет 71 Создаем тень для изображения
с зеленым фоном

Создание композиции для сцены само по себе является достижением. Однако вы
должны добавить тень, чтобы сделать композицию реалистичной.

Изображение с зеленым экраном имеет фон, который содержит только один
цвет, зеленый. При желании вы можете сделать снимок на синем фоне или на

Создаем тень для изображения с зеленым фоном
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• Avid. Откройте редактор Effect Editor для клипа и выберите пункт меню
Show Alpha (Показать альфа
канал);

Если вы активируете опцию Show Alpha в программе Avid, все дополни&
тельные эффекты будут использоваться независимо от других слоев.
После создания альфа&канала примените к клипу эффект Paint:
Выберите пункты меню Tools ⇒ Effects Palette ⇒ Image ⇒ Paint Effect.
Затем переместите альфа&канал на эффект Paint, чтобы сформиро&
вать тень:
Выберите пункты меню Tools ⇒ Effects Palette ⇒ Key ⇒ Matte Key.

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Image Control ⇒
Brightness and Contrast (Яркость и контраст);

• Premiere. Выберите пункты меню Effects ⇒ Video Filters ⇒ Adjust ⇒
Brightness and Contrast.

Смещение тени от персонажа
После создания базовой тени вы должны переместить ее от персонажа. Если вы
этого не сделаете, ваши зрители никогда не увидят тень, потому что она постоян&
но будет располагаться за оригинальным изображением. Для смещения тени вам
необходимо ее исказить:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Blend ⇒ 3D Warp
(Трехмерное искажение);

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Perspective ⇒
Basic 3D (или воспользуйтесь инструментом Distort);

• Premiere. Выберите пункты меню Effects ⇒ Video Filters ⇒ Distort ⇒
Corner Pin.

Настройка тени в соответствии с параметрами сцены требует
времени и терпения.

Я не могу привести здесь конкретные рекомендации по настройке конфигура&
ции тени, так как они будут изменяться в зависимости от снимка. Если фон изоб&
ражения содержит другие тени, используйте их для выбора настроек сцены.

Изменение параметров тени
Возможно, вам понадобится несколько изменить параметры новой тени. Это за&
висит от ваших предпочтений, а также от особенностей композиции. Вам доста&
точно изменить непрозрачность тени. Также вы можете добавить эффект Blur для
тени, что позволяет ее смягчить.

Если вы хотите отредактировать параметры эффекта, измените соответству&
ющие настройки. Если ваша композиция уже содержит другие тени, постарай&
тесь совместить их с новым эффектом. На рис. 6.41 показана группа изображе&
ний из завершенной сцены. Некоторые изображения содержат тень, а некото&
рые – нет.

Рис. 6.40. Небольшое различие между слоями

Рис. 6.41. Завершенная сцена с тенью (вверху) и без нее (внизу)

Дополнительные возможности
Вам необходимо уделить внимание мелким деталям. Скорее всего, вам понадо&
бится внести в изображение некоторые изменения, например отредактировать
яркость и контраст в соответствии с параметрами фона. Чтобы добиться правиль&
ного смешивания цветов в оригинальном изображении, вам необходимо выпол&
нить корректировку цвета.

После завершения работы попробуйте активировать и выключить эффект не&
сколько раз подряд. Итак, все готово: вы создали эффект тени, который следует за
вашим персонажем в кадре.

Создаем тень для изображения с зеленым фоном

С тенью

Без тени
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Совет 72 Альтернативные концовки фильма,
связанные со временем

Альтернативная концовка – это завершение фильма, которое отличается от его
оригинальной концовки. Используя скрытые функции приложения QuickTime
(доступны только после установления обновления Totally Hip LiveStage Pro), вы
можете создать альтернативную концовку для своего фильма. Параметры кон&
цовки будут определяться временем просмотра фильма аудиторией.

Возможно, вы еще помните серию книг «Choose Your Own Adventure», в кото&
рой в конце каждой главы вы могли выбрать одну из доступных опций. После вы&
бора вы переходили к определенной странице книги, и история продолжалась.
Сюжет определялся вашими действиями, поэтому вы могли прочесть книгу не&
сколько раз, переживая все новые и новые события.

Книги очень легко сделать интерактивными. А видео – нет. Как правило, зри&
тели ничего не делают во время просмотра фильма; если им хочется что&то сде&
лать, они начинают играть в компьютерные игры. Как же нам адаптировать пас&
сивную среду видео к интерактивности? Это можно сделать с помощью такого
понятия, как время; в зависимости от времени просмотра фильма вы увидите
разные сцены.

Используя приложение Totally Hip LiveStage Pro (http://www.totallyhip.com;
стоит 449,95 долл. США), вы можете создавать интерактивные фильмы, которые
меняются в соответствии с заданными настройками времени.

Подготовка к созданию интерактивного фильма
Прежде всего вам необходимо все планировать заранее. Как и при написании кни&
ги из серии «Choose Your Own Adventure», вы должны подготовить все доступные
опции и снять соответствующие сцены. Я советую вам начать с самого простого
варианта, в котором вам следует снять всего две альтернативные концовки филь&
ма. Затем вы сможете перейти к работе с более сложными проектами.

Не следует добавлять элементы интерактивности до тех пор, пока вы не заверши&
те редактирование фильма. К этому моменту вы должны создать три композиции:

• весь фильм без концовки;
• оригинальную концовку;
• альтернативную концовку.

Далее мы объединим три композиции в финальный проект.

Создание проекта
Создайте новый проект в программе LiveStage Pro и выберите пункты меню Edit
⇒ Document Settings (Настройки документа), чтобы изменить некоторые пара&
метры фильма. На вкладке Playback (Воспроизведение) измените настройку
Transport ⇒ Controller: выберите значение Standard Movie (Стандартный

фильм). В композицию будут добавлены индикатор времени, кнопка Play/Pause
и регулировки громкости звука.

На вкладке Settings настройте ширину и высоту фильма на 720 и 480, соответ&
ственно (720 и 576 для стандарта PAL).

Если вы хотите добавить в фильм титры (например, ваше имя или коммента&
рии), то можете это сделать на вкладке Annotations (Аннотации).

Импорт ваших фильмов
Найдите файл фильма на жестком диске вашего компьютера и переместите его на
шкалу времени программы LiveStage Pro. Видео& и аудиотреки будут разделены и
обозначены как Video 1 и Sound 1. Чтобы изменить ярлык трека, дважды щелкни&
те по нему слева в окне. Откроется окно, которое позволяет вам изменить назва&
ние трека, его высоту и длину, а также другие параметры, не имеющие отношения
к текущему разделу.

Добавляем концовки
Если вы хотите создать альтернативную концовку, вам необходимо добавить
в фильм не только ее, но и оригинальную концовку. Найдите оригинальную кон&
цовку и переместите ее на шкалу времени. Затем переименуйте видеотрек
в OriginalV, а аудиотрек – в OriginalA. Повторите эти действия с альтернативной
концовкой и введите названия треков AlternateV и AlternateA.

Названия треков очень важны, потому что они позволяют системе
определить, какие именно треки следует воспроизводить.

Скорее всего, вы заметите, что ваши фильмы группируются. Если вы начнете
воспроизведение фильма сейчас, все аудиотреки перемешаются между собой, и
вы увидите только самый верхний видео трек в группе. Это не то, что вам нужно.
Следовательно, вы должны переместить концовки в конечную часть фильма.

Перемещаем концовки
Чтобы переместить концовки, вам необходимо активировать инструмент Track
Manipulation Tool: щелкните по нижней иконке слева на шкале времени. После
этого цвет всех треков сменится на серый. Теперь вы можете щелкнуть по любому
видео& или аудиотреку и переместить его в конец фильма. Как только вы перемес&
тите трек в другое место, его новое положение будет зафиксировано. На рис. 6.42
показан проект, в котором инструмент Track Manipulation Tool был активирован,
а альтернативные концовки перемещены.

Если вы хотите убедиться в том, что настройки фильма были изменены нуж&
ным образом, вы можете увеличить масштаб шкалы времени (как и в большинстве
видеоредакторов). Для этого переместите ползунок Zoom (Масштаб) в нижней
левой части окна или нажмите соответствующую клавишу на клавиатуре. После
настройки концовок щелкните по инструменту Selection (Выбор), который имеет
вид стрелки в верхней левой части шкалы времени.

Альтернативные концовки фильма, связанные со временем
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Добавляем элементы пассивной интерактивности
Итак, вы переместили концовки. А как вам «сообщить» системе, в какое время ей
необходимо воспроизводить определенный трек? Вы можете применить опцию
Sprite Track (Трек спрайта) или Text Track (Текстовый трек). Лично мне пред&
ставляется, что для решения данной задачи удобнее использовать функцию Text
Track.

Чтобы добавить текстовый трек, выберите пункты меню Movie ⇒ Create Track
⇒ Text. Если вы не увидите трек, выделенный зеленым цветом, переместитесь
в начало шкалы времени. Дважды щелкните по этому треку, чтобы открыть редак&
тор треков.

В разделе Track Events (События, связанные с треком) в левой нижней части
окна вы увидите список возможных событий. Щелкните по событию Frame
Loaded (Кадр загружен) и введите следующий скрипт:

if (LocalHours < 17)

TrackNamed(“OriginalA”).SetEnabled(True)

TrackNamed(“OriginalV”).SetEnabled(True)

TrackNamed(“AlternateA”).SetEnabled(False)

TrackNamed(“AlternateV”).SetEnabled(False)

else

TrackNamed(“OriginalA”).SetEnabled(False)

TrackNamed(“OriginalV”).SetEnabled(False)

TrackNamed(“AlternateA”).SetEnabled(True)

TrackNamed(“AlternateV”).SetEnabled(True)

Команда в первой строке проверяет, не равно ли время на компьютере 17.00.
Если этот час еще не прошел, воспроизводится оригинальная концовка. Если про&
шел – альтернативная концовка.

Если вы не хотите визуализировать белое поле текстового трека, щелкните по
названию трека (как правило, это «Text1») и переместите его под группу видео&

треков. Также вы можете выбрать вкладку Properties и активировать опцию
Keyed Text. Если вы хотите добавить текст, то можете просто его ввести. Не за&
будьте изменить параметр Duration (Воспроизведение) для текста.

Завершаем создание фильма
После подготовки всех компонентов вы можете перейти к завершающей стадии
создания фильма. Чтобы экспортировать композицию, выберите пункты меню
File ⇒ Export ⇒ QuickTime Movie и введите название фильма. Процесс займет
некоторое время, которое зависит от продолжительности воспроизведения ком&
позиции. Вот и все. Работа завершена.

Дополнительные возможности
LiveStage Pro – это очень мощная программа, которая позволяет вам решать раз&
личные задачи. Используя приложение LiveStage Pro, вы можете добавлять в свой
фильм альтернативные концовки. Например, вместо того чтобы указывать время
в часах, вы можете выбрать опцию LocalMinutes (в минутах) или LocalSeconds
(в секундах). Кроме того, эта программа поддерживает операционные системы
Macintosh и Windows, а также может работать в сети Интернет.

Если вы решите воспользоваться сложными функциями, то можете определить
IP&адрес зрителя с помощью такого ресурса, как, например, GeoIP (http://
sourceforge.net/projects/geoip/; поставляется бесплатно). Далее вы сможете выяс&
нить, какая погода стоит в данной области; воспользуйтесь возможностями, кото&
рые предлагает сайт Weather Underground (http://wunderground.com; стоит 5 дол&
ларов США в год). За дополнительной информацией обратитесь к разделу
«What’s Your Visitor’s Weather Like?» (http://hacks.oreilly.com/pub/h/999) из книги
«Spidering Hacks» Кевина Хеменвэя (Kevin Hemenway) и Тары Калишейн (Tara
Calishain) издательства O’Reilly. Ваши возможности безграничны.

В данном разделе мы затронули лишь немногие из функций, которые предлага&
ют вам такие программы, как QuickTime и LiveStage Pro.

Совет 73 Как изменить внешний вид композиции
после редактирования

Если вы установите приложение QuickTime Pro (http://www.apple.com/
quicktime/buy/; стоит 29,99 долл. США), то сможете добавлять фильтр в видео
напрямую. Эта программа содержит 14 стандартных фильтров; кроме того, вы
можете устанавливать новые фильтры, которые поставляются другими компани&
ями, например Buena Software (http://www.buena.com/; стоят от 0 до 30 долл.
США). Также вы можете выполнять копирование и вставку, создавать скины (со&
вет 76), главы (совет 49) и даже конвертировать фильмы из одного формата в дру&
гой (совет 29). На этом остановимся.

Рис. 6.42. Перемещаем треки
с помощью инструмента Track Manipulation Tool

Как изменить внешний вид композиции после редактирования
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Переходим к фильтрам
Если вы работаете с видеофайлом, который может читаться в программе QuickTime,
откройте его и выберите пункты меню File ⇒ Export (Экспортировать).

Приложение QuickTime поддерживает следующие файловые форматы:
3DMF (Mac OS 9 и Windows), 3GPP, 3GPP2, AIFF, AMC, AMR, анимиро&
ванный GIF, AU, Audio CD Data (Mac OS 9), AVI, BMP, Cubic VR, DLS,
DV, FlashPix, FLC, GIF, GSM, JPEG 2000 (Mac OS X), JPEG/JFIF,
Karaoke, MacPaint, Macromedia Flash, MIDI, MPEG&1, MP3 (MPEG&1,
Layer 1), M3U (файлы MP3 Playlist), MPEG&2 (через отдельное устрой&
ство воспроизведения), MPEG&4, M4A, M4B, M4P (звук iTunes), PDF
(Mac OS X), Photoshop, PICS, PICT, PLS, PNG, QCP (Mac OS 9
и Windows), QuickTime Image File, QuickTime Movie, SD2 (Mac OS 9
и Windows), SDP, SDV, SF2 (SoundFont 2), SGI, SMIL, System 7 Sound
(Mac OS 9), Targa, Text, TIFF, TIFF Fax, VDU (Sony Video Disk Unit),
Virtual Reality (VR) и WAV.

В ниспадающем меню Export (Экспорт) окна Export выберите пункт Movie to
QuickTime Movie (Фильм в формат QuickTime Movie). Затем нажмите кнопку
Options. Откроется окно Movie Settings (Настройки фильма). Окно Export пока&
зано на рис. 6.43.

Выбор фильтра
При нажатии кнопки Filter откроется новое окно, которое содержит список дос&
тупных фильтров, окно предварительного просмотра (отражает все внесенные
вами изменения) и набор опций. Выбор функций зависит от выбранного вами
фильтра:

• Adjustments (Изменения);
• Alpha Gain (Изменение альфа). Позволяет редактировать альфа&канал ва&

шего изображения (требует наличия альфа&канала);
• Brightness and Contrast (Яркость и контраст). Вы можете увеличивать

и уменьшать яркость и контраст соответственно;
• ColorSync (Синхронизация цвета). Изменяет спектр цветов изображения

в соответствии с заданным профилем ColorSync;
• HSL Balance. Позволяет вам изменять оттенок, насыщенность и освещен&

ность;
• RGB Balance. Позволяет вам редактировать каналы красного, зеленого и си&

него цвета;
• Blur. Дает вам возможность сделать изображение размытым;
• Filters (Фильтры);

Рис. 6.43. Экспортируем фильм
в формат QuickTime Movie

В окне Movie Settings (рис. 6.44) вы можете изменить кодек для видео (с помо&
щью кнопки Settings), внешний вид композиции (с помощью кнопки Filter –
Фильтр), а также размер или угол поворота видео (с помощью кнопки Size).

Вам необходимо лишь изменить внешний вид композиции, поэтому нажмите
кнопку Filter.

Рис. 6.44. Изменяем внешний вид фильма
в окне Movie Settings

Как изменить внешний вид композиции после редактирования
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• Edge Detection (Распознавание грани);
• Emboss (Рельеф). Формирует два смещенных изображения. Позволяет со&

здать иллюзию рельефа;
• General Convolution (Общий изгиб). Берет сетку три на три пикселя и заме&

няет центральный пиксель средним значением для окружающих пикселей;
• Sharpen (Сделать резким). Выделяет детализацию изображения, особенно

вокруг граней;
• Special Effects (Спецэффекты);
• Color Style (Стиль цвета). Позволяет вам выбирать стиль для цвета изобра&

жения;
• Color Tint (Цветовой фон). Предлагает функции, которые предназначены

для создания фильма в формате Sepia или X&Ray, а также настройки уникаль&
ного светлого или темного фона;

• Film Noise (Помехи). Добавляет в фильм такие эффекты, как царапины,
пыль и затухание;

• Lens Flare (Отблеск света в объективе). Формирует эффект отблеска света
в указанной вами точке.

Лично мне нравится фильтр Edge Detection, настроенный на самое высокое зна&
чение (7). Мне кажется, что он добавляет в видео эффект сюрреализма. На рис. 6.45
показан фильтр Edge Detection, для которого мы выбрали значение 7 и опцию
Colorize Result.

Эффект Film Noise – это еще один интересный фильтр. Он дает вам возмож&
ность добавлять в композицию такие объекты, как царапины, пыль и даже затуха&

ние. На мой взгляд, данный эффект позволяет сделать изображение более насы&
щенным. На рис. 6.46 показан фильтр Film Noise в действии.

Рис. 6.45. Фильтр Edge Detection с настройкой Colorize Result

Рис. 6.46. Функция Film Noise придает видео внешний вид,
который напоминает фильмы 30�х гг.

После выбора и настройки нужного фильтра нажмите кнопку OK, а потом
кнопку Save. Процесс экспортирования может занять много времени; это зависит
от производительности вашего компьютера и объема файла.

Сохраняем фильмы в отдельных файлах
Так как при экспортировании создается новый видеофайл, а оригинальный файл
остается неизменным, вы можете выбрать новый фильтр и повторить процесс.
Я советую вам поэкспериментировать, чтобы изучить все доступные фильтры.
Сохраните основную композицию на жестком диске вашего компьютера. Также
сохраните композиции с фильтрами в качестве справочного материала.

Совет 74 Выделяем один цвет

В фильмах «Pleasantville» и «Список Шиндлера» есть черно&белые сцены, в кото&
рых на экране выделяется один цвет, например красный. Вам не понадобится
идти на большие расходы, чтобы добавить подобный эффект в свой проект.

Очень редко из фильма приходится удалять какой&либо цвет. Впрочем, в неко&
торых проектах это совершенно необходимо. Используя описанную далее мето&

Выделяем один цвет
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дику, вы сможете создавать черно&белые сцены, в которых на экране выделяется
один цвет. На рис. 6.47 показано оригинальное изображение, а также изображе&
ние, содержащее данный эффект.

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Image ⇒ Color Effect
(Chroma ⇒ Saturation);

• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Image Control ⇒
Desaturate (Уменьшить насыщенность).

Вы сделали изображение черно&белым, однако изменения были применены
только к самому нижнему треку. Поэтому изображение по&прежнему выглядит
цветным на вашем мониторе (например, в режиме просмотра Canvas или Program
View). Не волнуйтесь; скоро все изменится.

Выбираем цвет
Далее вы должны выбрать цвет, который будет сохранен. Это можно сделать раз&
личными способами, но проще всего воспользоваться эффектом Chroma Key или
Color Key. Данный эффект нужно добавить в самый верхний слой композиции:

• Avid. Выберите пункты меню Tools ⇒ Effects Palette ⇒ Key ⇒ Chroma Key;
• Final Cut. Выберите пункты меню Effects ⇒ Video Filters ⇒ Key ⇒ Color Key.

Некоторые системы позволяют вам выбирать цвет простым щелчком по изоб&
ражению. Если ваша программа не поддерживает данную функцию, вам придется
воспользоваться доступными опциями для выбора цвета. Не старайтесь точно по&
пасть в цвет, потому что впоследствии вы сможете изменить свой выбор.

Выделяем цвет
После выбора цвета вы можете обнаружить, что результат оказался прямо проти&
воположным тому, что вы ожидали. Вы удалили цвет, а не выделили его. К счас&
тью, вы можете инвертировать эффект, то есть выделить один цвет и удалить все
прочие цвета. Выделите клип и эффект/фильтр, а затем щелкните по полю инвер&
тирования.

Когда вы выполните инвертирование, на изображении появится несколько пу&
стых точек. Воспользуйтесь масками или обрезкой, чтобы их устранить.

Дополнительные возможности
Также вы можете сохранить изображение цветным, выделив при этом определен&
ный цвет. Если вы выберете эту методику, не следует конвертировать изображе&
ние в черно&белое. Уменьшите насыщенность для нижнего слоя и увеличьте для
верхнего. В результате выбранный вами цвет будет выделяться на фоне изобра&
жения.

Рис. 6.47. Используем желтый цвет,
чтобы предупредить людей об опасности

Если вы планируете использовать эту методику, я советую вам выбрать опреде&
ленный цвет только для того объекта, к которому вы хотите привлечь внимание
аудитории. Например, если вы собираетесь сделать снимок девушки в красном
платье, не следует добавлять в кадр дополнительные объекты красного цвета.

Программа Premiere включает эффект Color Pass, который упрощает
создание подобной композиции. Вам нужно просто переместить эф&
фект Color Pass в ваш материал и выбрать нужный цвет. Этого
достаточно.

Работаем со слоями видео
Для формирования эффекта Color Pass вам необходимо создать два видеослоя.
Один слой будет содержать черно&белое изображение, а второй – только тот цвет,
который вы хотите выделить на снимке. Объединив эти два слоя, вы создадите
нужное изображение.

Методика создания двух слоев определяется вашей системой редактирования.
Как правило, вы сможете переместить материал на шкалу времени с помощью
мыши. Затем вы сможете повторить этот процесс; однако вы должны поместить
материал непосредственно над первым слоем или под ним.

Создаем черно)белое изображение
Сначала вам необходимо уменьшить до нуля насыщенность трека нижнего уров&
ня. Это позволит создать базовое черно&белое изображение для будущей компози&
ции. Выполните следующие действия:

Выделяем один цвет
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Распространение вашего проекта – это один из самых приятных и одновременно
самых нервозных этапов в процессе создания цифрового видео. Если вы распрост&
раняете видео, это значит, что ваш проект завершен. Это само по себе большое
достижение.

Если вы хотите отправить свой проект другому пользователю, вам приходится
отвечать на большое количество вопросов. Как он отреагирует? Понравится ли
ему ваша работа? Или он подвергнет ее критике? Может быть, сначала мне попро&
сить о помощи опытного оператора?

Совет 75 Копируем экран композиции

Если вы хотите добавлять примечания во время редактирования, лучше всего де&
лать это удаленно. Для решения данной задачи проще всего скопировать экран
композиции.

Во время редактирования проекта на компьютере вы можете без труда вносить
любые изменения в сцены. Это настолько просто, что вы можете случайно внести
в ваш проект ненужные изменения, отменить которые будет уже невозможно.
Один мой друг рассказал мне историю, которая очень хорошо описывает данную
проблему:

Две воспитательницы детского сада как&то сидели и разговаривали за
чашкой кофе. Одна сказала, что ее дети рисуют намного хуже, чем дети дру&
гой воспитательницы. Она попросила объяснить, почему. Ответ прозвучал
неожиданно: «Я знаю, когда нужно забирать у детей их рисунки».

Процесс съемки фильма связан как с наукой, так и с искусством. Я не собира&
юсь критиковать творчество Джорджа Лукаса (George Lucas), но сколько же се&
рий фильма «Звездные войны: эпизод 4» мы еще увидим? Это хороший пример
режиссера, который никак не может расстаться со своим проектом.

Чтобы избежать искушения, связанного с постоянным редактированием ком&
позиции, вы можете сделать ее копию и просматривать ее отдельно, на другом
компьютере. Эта копия должна содержать ссылку на временную кодировку ос&
новного проекта, чтобы вы смогли делать точные комментарии. Такой файл назы&
вается копией композиции. На рис. 7.1 показан кадр видео, который содержит окно
с временной кодировкой.

В киноиндустрии часто используется термин «дублировать»,
который является синонимом слова «копировать».

Создаем копию композиции
Самый простой способ создания копии композиции подразумевает сохранение
проекта на цифровой видеопленке с последующим копированием изображения

в формат VHS. Подготовка данной методики требует много времени; впрочем,
если вы работаете с проектом, продолжительность воспроизведения которого
превышает 30 мин, результат стоит усилий. Выполните следующие действия:
подключите ваш компьютер, камеру или деку, видеомагнитофон, а также телеви&
зор в порядке, который показан на рис. 7.2.

Рис. 7.1. Окно показывает временную кодировку 01:30:04;11

Рис. 7.2. Настройка системы для создания копии композиции
с вашего компьютера

Если вы можете подсоединить вашу камеру или деку к телевизору,
вам не нужно выполнять копирование на VHS&пленку. Просто скопи&
руйте композицию на цифровую видеопленку и просмотрите ее
на телевизоре.

Копируем экран композиции
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В данной конфигурации видеосигнал идет с компьютера на вашу цифровую
видеокамеру (или деку), затем на видеомагнитофон и, наконец, на телевизор. Те&
левизор оказывается последним звеном в цепочке, потому что вам необходимо
добиться того, чтобы сигнал прошел через все устройства в системе. Если вы не
видите изображение на экране телевизора, это значит, что видеосигнал не прохо&
дит через цепочку. Проверьте все соединения.

Некоторые цифровые видеокамеры не могут конвертировать цифровой
видеосигнал в аналоговый. Если ваша камера или дека имеет такое
ограничение, вам придется выполнить запись на цифровую видеоплен&
ку, а затем конвертировать ее в формат VHS.

Включите режим перезаписи временной кодировки для камеры. После завер&
шения процесса у вас будет в наличии цифровая копия композиции, а также ее
копия в формате VHS.

Некоторые системы редактирования не могут записывать временную кодиров&
ку на видеопленку. Чтобы обойти данное ограничение, выполните запись на кас&
сету с кодировкой (см. совет 4). Это упростит добавление примечаний в компози&
цию. Например, если ваша временная кодировка начинается в точке 01:00:00;00,
а кодировка вашей кассеты – в точке 00:00:00;00, вам придется помнить об этом
смещении во время записи примечаний.

Расслабляемся и вводим текст примечаний
После создания копии композиции оторвитесь от своего проекта на несколько ча&
сов. Ваша задача заключается в том, чтобы просмотреть свое видео в тех условиях,
в которых его будет смотреть ваша аудитория. Не следует при этом ощущать себя
автором сценария, продюсером, режиссером или редактором.

При просмотре фильма позаботьтесь о том, чтобы у вас были ручка и листок бу&
маги. Делая примечания, указывайте в них временную кодировку, которая отобра&
жается на экране. Не нужно точно записывать номер каждого кадра; копия компо&
зиции предназначена для того, чтобы вы смогли быстро найти необходимую сцену
при редактировании. Например, если вы сделаете примечание «00:35:47 – увели&
чить изображение свечи», это скажет вам о том, что в точке 00:35:47 на шкале вре&
мени проекта следует увеличить масштаб изображения.

«Я знаю, когда нужно забирать у детей их рисунки»
Если вы создадите копию вашей композиции, вы сможете постоянно следить за
своим проектом. Однако чем чаще вы будете копировать свою композицию, тем
меньше пользы это вам принесет. При каждом просмотре фильма вы будете нахо&
дить новые недостатки. Очень невелика вероятность того, что вы окажетесь пол&
ностью удовлетворены результатом.

Если вы хотите создать шедевр, а не бессмысленную композицию, вам нужно
ограничивать себя. Процесс следует повторить всего лишь несколько раз (я реко&
мендую дважды).

Дополнительные возможности
Если вы предпочитаете просматривать видео на мониторе компьютера, то може&
те создать цифровую копию композиции. Некоторые системы редактирования
предлагают видеоэффект, который может создавать ссылку на временную коди&
ровку в отдельном окне. Однако данный эффект нуждается в дополнительной
визуализации.

Чтобы создать цифровой фильм, добавьте эффект на шкалу времени, выполни&
те визуализацию и экспортируйте композицию в отдельный файл.

Совет 76 Создание скинов

Создание видеофильма само по себе является значительным достижением. Если
вы распространяете свой проект в сети Интернет, то можете придать ему уникаль&
ный внешний вид. Для этого добавьте в свой фильм скин – интерфейс, который
станет его неотъемлемой частью.

Многие аудио& и видеоплееры позволяют пользователям создавать скины, кото&
рые изменяют внешний вид отдельных приложений. Программа QuickTime под&
держивает специальную функцию, предназначенную для добавления в проекты
уникального интерфейса. Используя приложение QuickTime и текстовый редак&
тор, вы можете придать вашему фильму интересный и необычный внешний вид.

Скин QuickTime может содержать любое изображение, которое читается про&
граммой QuickTime. Следовательно, вы можете не только создавать изображения
в отдельной программе, например Photoshop, но и делать фотографии на цифро&
вую камеру, а также импортировать графические файлы со сканера. В любом слу&
чае процесс создания скина остается неизменным. Скины могут иметь любую
форму, поэтому вы можете дать полную свободу своей фантазии.

Подготовка изображения для скина
После выбора изображения, которое вы будете использовать в качестве скина,
я советую вам внести в него изменения и обозначить кадр для воспроизведения
видео. Например, если вы работаете с изображением телевизора, пометьте экран
черным или белым полем. На рис. 7.3 показано изображение с белым полем, кото&
рое соответствует скину, редактируемому в программе Stone Studio Create.

Когда вы завершите редактирование, сохраните файл в формате QuickTime,
к примеру TIFF, JPEG, PICT, GIF, PNG, BMP, PDF, Photoshop или Targa.

Добавляем изображение в фильм
Вы создали изображение для скина и выделили область композиции, в которой
будет воспроизводиться фильм. Теперь вы готовы к тому, чтобы добавить скин
в свой проект. Запустите программу QuickTime Player и выберите пункты меню
File ⇒ Open Movie in New Player (Открыть фильм в новом плеере), чтобы от&
крыть изображение скина. Вам необходимо скопировать изображение как фильм,
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поэтому выполните команды Edit ⇒ Select All (Выбрать все) и Edit ⇒ Copy (Ко

пировать).

Далее откройте фильм в программе QuickTime Player. Чтобы добавить скин,
вам следует вставить его в композицию. Но сначала вы должны настроить про&
должительность его воспроизведения в соответствии с продолжительностью вос&
произведения вашего фильма. Для этого выберите пункты меню Edit ⇒ Add
Scaled (Добавить изображение с масштабированием).

Как воспроизвести фильм
После добавления скина вы, скорее всего, заметите, что он заменил собой всю
композицию. К счастью, приложение QuickTime позволяет вам редактировать
видео различными способами, в том числе выбирать цвет, который должен быть
прозрачным. Чтобы выделить прозрачный цвет, выполните команду Movie ⇒ Get
Movie Properties (Открыть параметры фильма). Откроется окно Movie Pro

perties.

В первом ниспадающем меню выберите трек Video Track 2. Во втором ниспада&
ющем меню выберите режим Graphics Mode (Графический режим). Затем
в списке доступных режимов выберите пункт Transparent (Прозрачный). На&
жмите кнопку Color (Цвет) и выберите цвет, который используется для марки&
ровки изображения в скине (в данном примере это черный или белый цвет). Так&
же вы можете активировать инструмент Magnifying Glass и поместить его на об&

ласть воспроизведения в скине. На рис. 7.4 показано изображение до и после акти&
вации режима Transparent.

Рис. 7.3. Выделяем область,
в которой будет воспроизводиться фильм

Рис. 7.4. Воспроизводим фильм в режиме Transparent

В большинстве случаев вам придется изменить размеры и положение компози&
ции и скина.

Выравниванием композицию и скин
Из окна Properties вы можете получить доступ к параметрам композиции и скина.
Для этого выделите нужный трек (например, Video Track 1) в первом ниспадаю&
щем меню, выберите команду Size (Размер) во втором ниспадающем меню и на&
жмите кнопку Adjust (Изменить). Во время изменения размера и положения
изображения вы увидите группу красных маркеров, связанных с определенным
треком.

Чтобы изменить размеры изображения, щелкните по угловым маркерам, а для
изменения положения – по самому изображению. Чтобы наклонить изображение,
щелкните по боковым маркерам. На рис. 7.5 показан процесс изменения размеров
композиции в скине.

После завершения настройки выполните команду File ⇒ Save As и выберите
опцию Make movie self
contained (Сделать фильм завершенным).

Создаем маски для фильма со скинами
Даже несмотря на то, что вы уже объединили композицию и скин, окно програм&
мы QuickTime Player по&прежнему отображается на экране. Далее вам необходи&
мо выполнить одно простое, но важное действие, а именно создать в графическом
редакторе две маски: для области окна и для области перемещения.

Маска окна предоставляет программе QuickTime информацию о том, в какой
форме следует воспроизводить ваш фильм. Например, если скин используется
для такого объекта, как экран телевизора, маска окна будет иметь форму прямоу&
гольника. Данная маска должна полностью соответствовать изображению скина.
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Маска перемещения используется для добавления функции, которая позволя&
ет зрителю перемещать окно по экрану с помощью мыши. Эта маска должна быть
копией маски окна, а также содержать области, в которых вам будут доступны на&
стройки. На рис. 7.6 показаны маски окна и перемещения для скина телевизора.

Совмещаем файлы
Последний шаг в процессе создания скина – это совмещение трех файлов в одну
композицию. Введите в текстовом редакторе следующие команды:

<?xml version=”1.0”?>

<?quicktime type=”application/x-qtskin”?>

<skin>

<movie src=”myMovie.mov”/>

<contentregion src=”myWindow.tiff”/>

<dragregion src=”myMask.tiff”/>

</skin>

Ваши изображения могут быть сохранены в любом формате, совмес&
тимом с программой QuickTime. Совершенно необязательно использо&
вать формат TIFF; здесь он выбран исключительно в качестве примера.

Замените текст «myMovie.wav» названием файла с вашей композицией, текст
«myWindow.tiff» – названием файла с маской окна, а текст «myMask.tiff» –
названием файла с маской перемещения. Затем сохраните текстовый документ
скина в папке с тремя основными файлами. Используйте для данного документа
расширение .mov – например, mySkin.mov.

Откройте текстовый файл скина в программе QuickTime Player. Новый фильм
должен появиться в созданном вами окне. На рис. 7.7 показана завершенная ком&
позиция, которая содержит скин QuickTime. Обратите внимание: настройки
QuickTime отсутствуют.

Рис. 7.5. Изменяем размеры и положение изображения

Рис. 7.6. Маска окна (слева) и маска перемещения (справа)

После создания масок окна и перемещения сохраните их в отдельных файлах.
Теперь у вас должно быть три файла: ваш фильм и скин в одной композиции, мас&
ка окна и маска перемещения. Поместите все три файла в одну папку на вашем
компьютере. Рис. 7.7. Воспроизводится фильм со скином
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Вам больше недоступны параметры фильма, поэтому выберите режим AutoPlay
(Автоматическое воспроизведение). Откройте окно Movie Properties: выполни&
те команду Movie ⇒ Get Movie Properties и выберите во втором ниспадающем
меню пункт Auto Play. Щелкните по полю флажка Auto Play Enabled (Режим ав

томатического воспроизведения активирован).

Теперь ваш фильм сконфигурирован. Вам осталось лишь сохранить его, вы&
брать опцию Make movie self
contained и приступить к распространению.

Дополнительные возможности
Не хотелось ли вам когда&нибудь показать аудитории фильм, который имеет фор&
му восьмиугольника или звезды? Для этого вам достаточно создать границу фор&
мы. На рис. 7.8 показан процесс воспроизведения фильма в области, которая име&
ет необычную форму.

Вы можете пойти и традиционным путем: добавить в композицию скин, а также
функции воспроизведения, остановки, быстрой перемотки и обратной перемотки.
Используя такие программы, как LiveStage Pro (http://www.totallyhip.com; стоит

499,95 долл. США), GoLive (http://www.adobe.com/products/golive/; стоит
399 долл. США) или Flash MX (http://www.macromedia.com/software/flash/; сто&
ит 499,95 долл. США), вы можете создавать кнопки управления и добавлять их
в свою композицию. Эти программы обладают и другими возможностями и по&
зволяют вам создавать полноценные интерактивные фильмы.

Например, в композиции со скином в форме экрана телевизора вы можете со&
здать переключатель, который скрывает видеоизображение и отключает звук, од&
нако воспроизведение композиции при этом продолжается. Если зритель нажи&
мает переключатель, кажется, что телевизор выключается. При повторном нажа&
тии переключателя телевизор «включается» (это происходит потому, что
воспроизведение фильма не прекращается).

Совет 77 Выбираем кодек

Если вы заранее определитесь с тем, как именно вы планируете использовать или
распространять видео, это поможет вам правильно выбрать кодек.

При работе с цифровым видео вам необходимо четко понимать, что именно вы
имеете в виду: формат DV или цифровое видео в целом. Понятие «цифровое ви&
део» связано с большим количеством различных технологий, включая DVD, мо&
бильные телефоны, которые могут записывать и воспроизводить видео, демонст&
рацию видео в сети Интернет и даже спутниковое и кабельное телевидение. Лю&
бая форма цифрового видео требует использования кодека.

Как правило, под «редактированием цифрового видео» имеется
в виду формат DV. Формат DV включает MiniDV, Panasonic DVCPRO
и Sony DVCAM, но не DVD.

Что такое кодек?
Кодек – это алгоритм сжатия данных, который позволяет уменьшить объем ви&
деофайла на жестком диске компьютера. Несжатые видеофайлы требуют очень
много пространства на жестком диске и расходуют значительные системные ре&
сурсы; кодеки были созданы для того, чтобы упростить процесс воспроизведения
видео на различных устройствах. Кодек дает возможность устройству (например,
компьютеру или DVD&плееру) воспроизводить аудио/видеофайлы. На рынке су&
ществуют сотни, если не тысячи, аудио/видеокодеков.

Чтобы избежать различных проблем, связанных с конфликтами между кодека&
ми, а также с тем фактом, что некоторые программы/устройства работают исклю&
чительно с определенными кодеками, разработчики постоянно пытаются создать
единые стандарты. Многие кодеки связаны с отдельными видеоформатами. На&
пример, DV – это кодек и одновременно формат.

Некоторые стандарты, в частности стандарты, созданные группой Moving
Pictures Expert Group (MPEG), стали очень популярными. К примеру, DVD&

Рис. 7.8. Воспроизводим фильм уникальной формы
с использованием нового скина
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фильмы закодированы в стандарте MPEG&2, который распространяется компа&
нией MPEG. Официальный Web&сайт компании MPEG расположен по адресу:
http://www.chiariglione.org/mpeg/.

Вы можете себе представить, что произойдет, если каждая студия
начнет записывать свои DVD&фильмы различными кодеками? Вам
придется покупать пять DVD&плееров! Стандарты очень удобны как
для продюсеров, так и для пользователей.

Кодеки имеют очень большое значение для цифрового видео. Каждый кодек
имеет специализированное предназначение, а некоторые кодеки позволяют ре&
шать различные задачи. Например, системы редактирования Avid имеют свой ко&
дек и предназначены только для работы с приложением Avid.

В табл. 7.1 приведен список распространенных кодеков, а также файловых фор&
матов, с которыми они работают.

Таблица 7.1. Стандартные кодеки, их функции и связанные файловые
форматы

Кодек Используется для Расширение файлового
формата

MPEG/1 Video CD .mpg, .mpv, .m1v
MPEG/2 HDV, DVD, профессиональное применение .mpg, .mpv, .m2v
MPEG/4 Функция стрим (в сети Интернет), загрузка, .mpg, .mp4

бытовое применение, воспроизведение
на компьютере

DV Профессиональное и бытовое применение, .dv
редактирование, воспроизведение с кассеты

3GPP/ Воспроизведение видео на мобильном .3gp1, .3gp2
3GPP2 телефоне
H.264 Воспроизведение видео (стандартного .mp4, .264
(также его и высокого разрешения) через сеть Интер/
называют нет, HD/DVD, спутниковое телевидение
AVC,
MPEG/4
Part 10)
VC/1 Воспроизведение видео (стандартного Во время написания этой

и высокого разрешения) через сеть Интер/ книги определено не было
нет, HD/DVD, спутниковое телевидение

Если вы знаете, на каком устройстве будет воспроизводиться ваше видео, это
поможет вам определиться с выбором кодека. Как показано в табл. 7.1, если вы
собираетесь отправить видео на мобильный телефон, вам необходимо использо&
вать кодек 3GPP. Фильм в формате 3GPP может воспроизводиться на компьюте&
ре, однако качество изображения может быть намного хуже, чем в формате

MPEG&4, который предназначен именно для этой цели. В табл. 7.2 показаны раз&
меры файлов, а на рис. 7.9 вы видите различные кодеки.

Таблица 7.2. Размеры файлов для видеоклипа продолжительностью 20 с

Кодек Размер файла

DV 63,3 Мб
MPEG/1 2,4 Мб
MPEG/2 8,2 Мб
MPEG/4 2,8 Мб
3GPP 172 Кб

Рис. 7.9. Кодеки DV и MPEG
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Изображения на печати отличаются от изображений на экране
телевизора или компьютерного монитора и выглядят намного меньше.
Представленные здесь изображения следует воспринимать только
в качестве примеров.

К сожалению, при отправке файлов на компьютер у вас появляется большое
количество вопросов. Видеоматериал может воспроизводиться в различных при&
ложениях как при работе в сети Интернет, так и при загрузке или работе в форма&
те CD&ROM. Эти программы используют различные кодеки, которые несовмес&
тимы друг с другом. К самым популярным приложениям относятся QuickTime,
Windows Media и Real One.

Основные видеоплееры
QuickTime Player, Windows Media Player и Real One Player – это приложения, ко&
торые используют кодеки для воспроизведения аудио& и видеоматериала и под&
держивают операционные системы Macintosh и Windows. Каждое приложение
имеет свои преимущества и недостатки. Операционную систему Linux поддержи&
вает только программа Real One Player.

Как правило, видеофайлы, созданные в этих кодеках, являются несовместимы&
ми (вряд ли для вас это новость). Если одно приложение попробует открыть файл,
закодированный для другого приложения, результат окажется неудовлетвори&
тельным. Это может огорчить как потребителя, так и продюсера. В табл. 7.3 при&
веден список основных мультимедиа&плееров, а также соответствующих им фай&
ловых форматов.

Таблица 7.3. Основные мультимедиа/плееры, а также соответствующие
им файловые форматы

Приложение Стандартное файловое расширение

QuickTime Player .mov, .qt
Windows Media Player .wmv, .asf
Real One Player .rm, .ram

Даже если вы имеете многолетний опыт работы с цифровым видео, у вас могут
возникнуть проблемы. Кроме того, фон сцены постоянно изменяется. К счастью,
вы можете без труда конвертировать файлы из одного формата и/или кодека
в другой (см. совет 29).

Приложение QuickTime
Если вы собираетесь использовать функции программы QuickTime, например
интерактивные спрайты (см. Совет 72), вам придется создать файл в формате
QuickTime, а другим пользователям понадобится открывать его исключительно
в плеере QuickTime. Формат QuickTime предлагает большое количество встроен&
ных кодеков; кроме того, различные компании поставляют дополнительные коде&

ки. Вы можете загрузить программу QuickTime с сайта http://www.apple.com/
quicktime/download/.

В число стандартных кодеков входят такие программы, как Sorenson (удобно
использовать для работы с видео в сети Интернет), Pixlet (подходит для высоко&
качественного видео) и Photo&JPEG (применяется для видео невысокого каче&
ства). Если вы выбрали другой кодек, например On2 VP2 (http://www.vp3.com/
vp3/quicktime/index.shtml; поставляется бесплатно), вашим зрителям тоже при&
дется его установить. Как правило, данный процесс автоматизируется програм&
мой QuickTime.

Программа QuickTime устанавливается в комплекте с музыкальным
приложением iTunes. Если ваши зрители установили программу iTunes,
это значит, что по умолчанию они установили и QuickTime. Кроме
того, приложение iTunes использует программу QuickTime для форми&
рования интерфейса iTunes Music Store (см. примечания по адресу
http://weblogs.mozillazine.org/hyattt/archives/2004_06.html).

QuickTime – это очень интересная программа, которая включает и другие фун&
кции, помимо создания и воспроизведения аудио/видеофайлов. Многие пользо&
ватели ошибочно полагают, что приложение QuickTime является обычным плее&
ром для файлов мультимедиа. Однако вы можете использовать программу
QuickTime для создания трехмерных сцен, интерактивных фильмов и даже ути&
лит, например калькуляторов. Это очень мощное приложение с разнообразными
функциями, секреты которых известны только компании Apple.

Программа Windows Media
Windows Media является мультимедиа&стандартом по умолчанию для всех ком&
пьютеров, работающих в среде Microsoft Windows. Формат (новая версия 1.0)
претерпел значительные улучшения со времени выхода версии 7. Кроме того, дан&
ная программа представляет собой базу для кодека VC&1, который используется
в сети Интернет, в формате DVD, Standard и High&Definition, а также на спутни&
ковом телевидении. Вы можете загрузить приложение Window Media Player
с сайта компании Microsoft по адресу: http://www.microsoft.com/windows/win&
dowsmedia/default.aspx.

Основной задачей разработчиков стандарта Windows Media была работа с ви&
зуальным материалом; это можно определить по качеству видеофайлов. Поэтому
программы Windows Media не поддерживают многие интерактивные функции, за
исключением треков глав (совет 49) и гиперссылок (совет 84). Если вы собирае&
тесь создать проект для пользователей операционной системы Windows, формат
Windows Media является оптимальным выбором.

Программа Real One Player
Стандарт Real особенно бурно развивался во время Интернет&бума, то есть в позд&
ние 1990&е гг. С тех пор он постепенно уступает ведущее место на рынке програм&
мам QuickTime и Windows Media. Вряд ли вы будете регулярно работать в данном

Выбираем кодек
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формате. Впрочем, если вы собираетесь создать проект для пользователей опера&
ционной системы Linux, вам следует выбрать формат Real.

В середине 2002 г. компания Real объявила о том, что она открывает
для всех пользователей исходную кодировку для своего сервера, кодека
и плеера. Проект носит название Helix (http://www.helixcommunity.org);
к моменту написания данной книги у него было около 75 000 зарегист&
рированных пользователей. Проект Helix поддерживает видео в форма&
те Real и QuickTime.

Вы можете загрузить плеер Real One Player с сайта http://www.real.com.

Выбираем кодек
Так что же вам делать? Если вы собираетесь распространять свой фильм на DVD
(см. совет 79), вам достаточно воспользоваться кодеком MPEG&2 и выбрать про&
грамму, которая выполнит запись проекта на жесткий диск. Но если вы планиру&
ете загрузить свою композицию в сеть Интернет, выбор может оказаться значи&
тельно более трудным.

Основное правило можно сформулировать так: при возможности вы должны
придерживаться стандартов. Например, вам следует выбирать кодек MPEG&4 для
распространения фильмов в сети Интернет. Видео в формате MPEG&4 будет вос&
производиться практически любым плеером.

Приведу список вопросов, которые помогут упростить вашу задачу:

• подключен ли ваш компьютер к серверу с услугой стрим?
• если да, то какой формат поддерживает данный сервер?
• содержит ли ваш фильм интерактивные элементы и функции?
• используют ли ваши зрители какую&либо специализированную операцион&

ную систему?

Ответы на эти вопросы должны направить вас по верному пути. Если ваши зри&
тели работают в операционной системе Mac, выберите программу QuickTime.
Если они используют операционную систему Windows, выберите программу
Windows Media. Если вы не знаете точно, попробуйте выбрать обе программы и
оцените результат. Например, изучите полученные изображения и решите, ка&
кое из них лучше. Либо определите, с каким форматом вам будет проще всего
работать.

Альтернативные методики
Существуют альтернативы стандартным плеерам и кодекам. Такие альтернатив&
ные программы поддерживают некоторые дополнительные опции. Если ваши
зрители захотят загрузить новый плеер и кодек, они смогут с успехом применять
их для распространения видеоматериала в сети Интернет.

Плееры
Сейчас наибольшей популярностью пользуются два видеоплеера: VLC (http://
www.videolan.org/vlc/; распространяется бесплатно) и MPlayer (http://www.
mplayer.hu/; распространяется бесплатно). Эти программы отличаются универ&
сальностью, потому что они способны открывать большое количество различных
видеоформатов из сети Интернет. Кроме того, они поддерживают DVD и формат
стрим. Приложение VLC работает в среде Macintosh, Windows или Linux, а прило&
жение MPlayer – только в среде Macintosh или Linux.

Кодеки
В настоящее время весьма распространены следующие кодеки: DivX (http://
www.divx.com; бесплатно), XviD (http://www.xvid.org; бесплатно) и 3ivx (http://
www.3ivx.com; стоит 6,95–19,95 долл. США).

Эти кодеки воспроизводят видео высокого качества, а также работают со всеми
вариациями стандарта MPEG&4. Они поддерживают операционные системы
Macintosh, Windows и Linux. Основное различие между ними связано с процессом
установки: он проходит намного проще для программ DivX и 3ivx.

Ваш выбор зависит исключительно от ваших предпочтений. В любом случае,
если ваш материал интересен, зрители найдут способ его просмотреть. Если вы
хотите, чтобы ваш проект стал доступным для максимально широкой аудитории,
выбирайте общеизвестные международные стандарты, такие как Moving Pictures
Expert Group (MPEG), Society of Motion Picture and Television Engineers (SMPTE)
или International Organization for Standardization (ISO).

Совет 78 Воспроизводим видео с CD/диска
на DVD/плеере

DVD&диски стоят дорого, а CD&диски – сравнительно дешево. Сжав свою компо&
зицию кодеком MPEG&4, вы сможете записать ее на CD&диск, а затем воспроизве&
сти на DVD&плеере.

Очень приятно записать свой фильм на DVD&диск и просматривать его на
DVD&плеере. Однако подготовка DVD&проекта – это сложный процесс, который
требует высоких технических возможностей и профессиональных знаний. Во
многих случаях DVD&формат является излишеством; например, так можно ска&
зать о коротком клипе продолжительностью пять минут.

Формат Video CD (VCD) был разработан в 1993 г.; однако в CША он так и не
прижился. VCD&диск может содержать до 70 мин видеоматериала, поэтому вам не
удастся записать на такой диск полнометражный фильм. Формат VCD использу&
ет сжатие MPEG&1; следовательно, качество VCD сопоставимо с качеством запи&
си на VHS&пленке. VCD&диски могут воспроизводиться на большинстве DVD&
плееров, а также на персональных компьютерах и VCD&плеерах.

Воспроизводим видео с CD/диска на DVD/плеере
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Как записать ваш фильм на CD)диск
Формат VCD использует сжатие MPEG&1. Вы можете без труда конвертировать
свой проект в другой формат (см. совет 29). Однако если вы просто выполните
конвертирование кодеком MPEG&1 и скопируете полученный видеофайл на
CD&диск, это не приведет к созданию VCD. VCD&диск должен содержать опреде&
ленные файлы, записанные специфическим способом.

Многие приложения позволяют вам записывать VCD&диски. Программы запи&
си VCD имеются практически в любой оперативной системе. Перечислим самые
популярные:

• для среды Windows. Nero (http://www.nero.com; стоит 69,99 долл. США
при загрузке или 99,99 долл. США в комплекте);

• для среды Macintosh. Toast (http://www.roxio.com; стоит 99,95 долл. США).

Некоторые DVD&плееры могут воспроизводить видео в формате VCD
только с дисков CD&RW, но не CD&R. Если вы обнаружите, что записан&
ный вами VCD&диск не воспроизводится, попробуйте выбрать диск
CD&RW. Вы можете сразу использовать диски CD&RW, так как их
можно перезаписывать.

Плееры Nero и Toast могут записывать DVD, SVCD (super VCD), аудио CD и
другие типы дисков. Важное преимущество данных программ заключается в том,
что они позволяют вам создавать VCD&меню, которые функционируют так же,
как и DVD&меню. Разумеется, эти программы по&разному подходят к процессу
записи VCD&диска.

Используем приложение Nero
Помимо записи VCD&дисков, программа Nero содержит большое количество дру&
гих опций. Nero включает 20 различных приложений, которые позволяют без тру&
да решать определенные задачи, такие как запись музыкального CD&диска. Web&
сайт Nero (http://www.nero.com/en/Tutorials.html) предлагает вам большую кол&
лекцию файлов, в том числе 14&страничное руководство по созданию VCD&диска.
Используя приложение Nero Vision Express, вы можете записать VCD&диск следу&
ющим образом:

1. Выберите пункты меню Make a CD ⇒ Video CD (Создать CD ⇒ Видео CD).
2. Нажмите кнопку Add Video Files (Добавить видеофайлы).
3. Выделите нужные видеофайлы.
4. Нажмите кнопку Next (Далее).
5. Настройте меню.
6. Нажмите кнопку Next.
7. Протестируйте новое меню и убедитесь в том, что оно работает правильно.
8. Нажмите кнопку Next.
9. Нажмите кнопку Burn (Записать).

Используем приложение Toast
Как и Nero, программа Toast поддерживает разнообразные функции, например
позволяет вам создавать CD&диски, защищенные паролем. Используя приложе&
ние Toast, вы можете записать VCD&диск следующим образом:

1. Выберите вкладку Video (Видео).
2. Если окно Disc Options не было открыто, нажмите кнопку Disc Options.
3. Выберите опцию VCD.
4. Выберите стандарт NTSC или PAL.
5. В ниспадающем меню Video Quality (Качество видео) выберите пункт High

Quality (Высокое качество).
6. Нажмите кнопку Add (Добавить).
7. Добавьте нужные видеофайлы.
8. Нажмите кнопку Record (Записать) в углу.

Воспроизведение VCD)диска
Скорее всего, вы сможете без проблем просмотреть VCD&диск на DVD&плеере.
Однако некоторые устаревшие DVD&плееры не распознают формат VCD и не мо&
гут с ним работать. В этом случае вы сможете воспроизвести диск на персональ&
ном компьютере.

Если вы работаете в среде Windows, то сможете просмотреть диск с помощью
приложения Windows Media Player. Если у вас возникнут трудности, попробуйте
установить программу PowerDVD (http://www.gocyberlink.com; стоит 49,95 долл.
США). Пользователи операционных систем Macintosh и Linux смогут воспроизвес&
ти диск в программе VLC (http://www.videolan.org; распространяется бесплатно).

Чтобы просмотреть материал с VCD&диска, установите его в свой компьютер и
найдите папку MPEGAV. Затем дважды щелкните по файлу .dat в этой папке. Воз&
можно, пользователям операционной системы Windows понадобится выбрать
программу Windows Media Player, чтобы открыть файл. Пользователям операци&
онных систем Macintosh и Linux необходимо открывать данный файл из приложе&
ния VLC.

Если продолжительность воспроизведения вашего фильма меньше одного
часа, вы можете записать его на VCD&диск и сэкономить время и деньги, которые
вам пришлось бы потратить на запись DVD.

Совет 79 Распространение фильма на DVD

Вы можете записать свое цифровое видео на DVD&диск и воспроизвести его на
DVD&плеере.

Не так давно запись проекта на DVD&диск представляла собой очень дорогое
решение. Сейчас эта методика стала доступной как для продюсеров, так и для
пользователей. Если у вас есть видеоматериал и устройство для записи DVD, вы
сможете без труда создать DVD&диск.

Распространение фильма на DVD
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Существует техническое отличие между дисками DVD&R и DVD+R.
Устаревший формат DVD&R поддерживается большинством обычных
плееров. Если вы используете диски DVD&R, скорее всего, у вашей ауди&
тории возникнет меньше проблем с воспроизведением видео.

Подготовка композиции
Процесс подготовки видео к записи на DVD определяется форматом вашей ком&
позиции, а также тем, какое именно приложение вы используете.

Экспорт материала из вашей системы редактирования
Если вы экспортируете видео напрямую из системы редактирования, которая
поддерживает вашу программу записи DVD, решить задачу будет намного
проще:

• Avid. Выберите пункты меню File ⇒ Export;
• Final Cut. Выберите пункты меню File ⇒ Export ⇒ QuickTime Movie;
• iMovie. Выберите пункты меню File ⇒ Share ⇒ iDVD ⇒ нажмите кнопку

Share;
• Movie Maker. Выберите пункты меню Tasks ⇒ Finish Movie ⇒ Save (Сохра


нить);
• Premiere. Выберите пункты меню File ⇒ Export ⇒ Movie (Экспортировать
⇒ Фильм).

Экспортируйте видео в формате вашего материала. Это значит, что вы не долж&
ны изменять разрешение (ширину и высоту), частоту смены кадров или кодек
исходного материала. Следовательно, если вы работаете в формате NTSC DV
(720 × 480) с частотой смены кадров 29,97 кадра/с, сохраните эти настройки при
экспорте видео.

Конвертирование записи с цифровой видеопленки
Если вы экспортируете материал с видеопленки, вы можете применять различные
методики. Во&первых, вы можете выполнить оцифровку видео в вашей системе
редактирования, а затем экспортировать его так, как показано в предыдущем раз&
деле. Также вы можете конвертировать видео из аналогового формата в цифровой
(см. совет 37), выбрав при этом самое высокое из доступных разрешений. Кроме
того, некоторые программы для записи DVD поддерживают функцию оцифровки
исходного материала.

Запись видео
Итак, вы записали видео в цифровой файл. Теперь вам необходимо конвертиро&
вать его в формат DVD. Для этого следует использовать кодек MPEG&2. Некото&
рые приложения для записи DVD, например, iDVD (Macintosh) и NewVision
Express (Windows), поддерживают эту функцию. Для работы в других програм&
мах вам придется конвертировать данные до записи DVD.

Используем приложение iDVD в среде Mac OS X
Записать DVD&диск в программе iDVD (http://www.apple.com/ilife/idvd/; стоит
79 долл. США) очень просто. Сначала запустите приложение iDVD. В окне Start
вы можете выбрать опцию Create a New Project (Создать новый проект), Open an
Existing Project (Открыть существующий проект) или OneStep DVD (Быстро
записать DVD), как показано на рис. 7.10.

Рис. 7.10. Вам доступны три опции

Функция OneStep DVD импортирует материал с вашей DV&камеры и автома&
тически запишет его на DVD&диск.

Нажмите кнопку Create a New Project, чтобы создать DVD&диск из материала,
который уже был записан на ваш компьютер. Откроется окно Project (Проект), и
вы сможете выбрать тему в разделе Customize (Настроить). Если этот раздел не
отобразится на экране, нажмите кнопку Customize в левом нижнем углу окна. На
рис. 7.11 показан список тем в разделе Customize. Здесь мы выбрали тему Sliding
Panes.

Если ваша тема включает анимированные меню (обозначаются изображением в
виде идущего человека в нижнем правом углу иконки Theme), вы сможете переме&
щать объекты из списка Media в области композиции. После завершения записи
DVD области композиции станут анимированными разделами в меню DVD. Одна&
ко они не являются фрагментами вашего фильма. Вы можете считать области ком&
позиции всего лишь декоративными элементами композиции. На рис. 7.12 показа&
но, как мы поместили проект «My Great Movie» в первую область композиции.

Чтобы добавить видео для записи на DVD, переместите его из списка Media в
окно DVD.

Распространение фильма на DVD
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Если вы поместите мультимедиа&файл в область композиции,
он не будет воспроизводиться как часть DVD&проекта.

Чтобы изменить названия кнопок и пунктов меню на DVD, дважды щелкните
по ним и введите новый текст. На рис. 7.13 показана кнопка My Great Movie, ко&
торая была выбрана для изменения.

Рис. 7.11. Выбираем тему для DVD

Рис. 7.12. Добавляем видео в анимированное меню

Рис. 7.13. Композиция «My Great Movie»
была преобразована в кнопку и активирована

Если вы хотите убедиться в том, что ваш DVD&диск будет функционировать
после записи, нажмите кнопку Preview (Предварительный просмотр). При
этом программа iDVD перейдет в режим симуляции, и вы сможете управлять
процессом воспроизведения видео. Вы можете нажимать на новые переключате&
ли и отслеживать результаты. Для выхода из режима симуляции повторно
нажмите кнопку Preview. На рис. 7.14 показано приложение iDVD в режиме
Preview.

Если вы хотите внести какие&либо изменения перед записью DVD&диска, сде&
лайте это и выполните предварительный просмотр. Затем нажмите кнопку Burn
(Записать) в правом нижнем углу интерфейса (или выберите пункты меню File ⇒
Burn DVD).

После активации функции записи DVD программа попросит вас установить
чистый DVD&диск в устройство. После этого приложение iDVD автоматически
выполнит кодировку материала и запись его на диск (см. рис. 7.15). В зависимости
от скорости вашего компьютера и объема видеоматериала этот процесс может за&
нять определенное время.

После завершения записи на диск устройство откроется, и вы сможете записать
другой диск или завершить сеанс.

Распространение фильма на DVD
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Рис. 7.14. Просматриваем DVD�диск перед записью Рис. 7.15. Программа iDVD записывает диск

Используем программу Nero в операционной системе Windows
Пакет Nero Ultra Edition (http://www.nero.com; стоит 99 долл. США) включает
несколько приложений, которые предназначены для работы с аудио&, видеофай&
лами, фотографиями и данными. При создании DVD программа NeroVision
Express добавляет видеоматериал, выполняет кодировку в формате MPEG&2,
а также осуществляет запись на DVD&диск. Кроме того, это приложение может
записывать видео напрямую с камеры.

Запустите программу NeroVision Express и выберите команду Make DVD ⇒
DVD Video (Записать DVD ⇒ Видео DVD) в меню, расположенном в правой ча&
сти окна (см. рис. 7.16). Если вы хотите впоследствии редактировать материал на
DVD, выберите опцию DVD Video (VR). Однако при этом вам необходимо ис&
пользовать DVD&диск с возможностью перезаписи; кроме того, вы не можете быть
уверены в том, что ваш материал будет воспроизводиться на любом DVD&плеере.

Выберите команду Add Video Files (Добавить видеофайлы), как показано на
рис. 7.17, чтобы добавить на диск видеофайлы. Программа NeroVision выполняет
конвертирование в формат MPEG&2 автоматически, что позволяет вам выбирать
различные форматы файлов, включая Advanced Systems Format (.asf), Audio& Рис. 7.16. Начинаем процесс записи DVD�диска в программе Nero

Распространение фильма на DVD
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Video Interchange (.avi), MPEG&4 (.mp4), Windows Media Video (.wmv) и многие
другие.

После добавления видеофайлов в проект вы сможете отредактировать DVD&
меню, которое увидят другие пользователи во время воспроизведения диска.
Если вы выберете шаблон в меню справа, программа NeroVision сконфигурирует
ваше меню и при необходимости изменит его фон. Вы можете загрузить дополни&
тельные шаблоны с сайта Nero (http://www.nero.com/us/NeroVision_Express_
3_Template_Package.html или http://www.nero.com/NeroVision_Express_3_
Template_Package_2.html). На рис. 7.18 показан основной шаблон в его исходной
конфигурации.

Нажмите кнопку Edit Menu (Редактировать меню), чтобы изменить опреде&
ленные разделы меню, например фон, шрифт или кнопки. С помощью опции
Advanced вы даже можете добавить анимацию кнопок в виде отдельных фрагмен&
тов вашего видео. На рис. 7.19 вы видите процесс настройки параметров кнопки.

Когда вы завершите конфигурирование меню, нажмите кнопку Next (Далее),
чтобы вернуться в окно Menu. Повторно нажмите кнопку Next. Программа
NeroVision позволит вам протестировать ваше меню с помощью виртуального
пульта дистанционного управления (см. рис. 7.20). Поэкспериментируйте с но&
вым меню. Если вы решите что&то изменить, нажмите кнопку Back (Назад). Пос&
ле завершения изменений нажмите кнопку Next.

Вы завершили конфигурацию параметров и можете приступить к записи DVD.
В меню Burn to (Записать на) выберите опцию DVD Writer (Устройство для за


Рис. 7.17.  Добавляем один или несколько видеофайлов на DVD Рис. 7.18. Выбираем шаблон

Рис. 7.19. Настраиваем кнопку меню DVD

Распространение фильма на DVD
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писи на DVD). Вы также можете нажать кнопку Details (Детали) в левой части
окна, чтобы получить техническую информацию о вашей композиции и о процес&
се ее записи на диск. Если вы хотите изменить настройки, нажмите кнопку More
(Дополнительно) в нижней части экрана, а затем выберите функцию Video
Options. На рис. 7.21 показана опция DVD Writer, а также технические сведения о
вашей композиции.

Как только вы будете готовы к записи DVD, нажмите кнопку Burn в нижнем
правом углу окна. Программа NeroVision проверит наличие диска в вашем DVD&
устройстве. Если диск не будет найден, вас попросят его установить. После этого
начнется процесс записи (см. рис. 7.22).

Когда запись будет завершена, вы сможете записать новый диск, сохранить те&
кущую композицию в качестве проекта или создать новый проект.

Используем другие приложения
Если вашему приложению необходимо получить видео в формате MPEG&2, вам
придется выполнить конвертирование (см. совет 29). После этого выполните дей&
ствия, которые требуются для завершения процесса.

Просмотр видео
Когда вы завершите запись DVD, убедитесь в том, что ваш диск может воспроиз&
водиться DVD&плеером. Разумеется, вы можете использовать DVD&плеер вашего
компьютера; однако я рекомендую вам выбрать внешний DVD&плеер (или даже

Рис. 7.20. Виртуальный пульт дистанционного управления
и окно предварительного просмотра для DVD

Рис. 7.21. Подготовка к записи DVD�диска

Рис. 7.22. Запись DVD�диска

Распространение фильма на DVD
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несколько различных плееров). В результате вы определите, можно ли просмат&
ривать ваш диск на обычном DVD&плеере, который не обладает такими же функ&
циями, как DVD&плеер компьютера.

Совет 80 Распространение DVD/проекта
через сеть Интернет (стрим)

Вы можете отправлять свой DVD&проект различным пользователям через сеть
Интернет.

Наверное, любой человек, которому приходилось работать с цифровым видео,
имеет опыт просмотра композиций через сеть Интернет. Как правило, для ис&
пользования услуги стрим необходимо наличие файла подкачки (совет 87) или
предварительно обработанного видеофайла стрим (совет 83). Используя прило&
жение Video Lan Client (http://www.videolan.org; распространяется бесплатно),
также известное как VLC, вы можете распространять через сеть Интернет даже
DVD&проекты.

Для этого вам понадобится установить на своем компьютере программу VLC и
создать сетевое соединение. Для просмотра видео необходимо использовать ви&
деоплеер, например QuickTime Player (http://www.apple.com/quicktime; распрост&
раняется бесплатно), Windows Media Player (http://www.microsoft.com/windows/
windowsmedia/mp10/default.aspx; распространяется бесплатно) или VLC. Из трех
вышеперечисленных программ VLC отличается самым широким диапазоном под&
держиваемых видеоформатов.

Подготовка к распространению проекта через сеть Интернет
Перед тем как запускать приложение VLC, поместите в устройство компьютера нуж&
ный DVD&диск. Затем загрузите программу VLC и выберите в меню команду File ⇒
Open Disc (Открыть диск). Приложение VLC автоматически найдет DVD&диск.
Если этого не произошло, выберите диск в открывшемся меню. На рис. 7.23 показано
окно программы VLC в среде Windows XP в момент открытия DVD&диска.

Некоторые DVD&диски не будут воспроизводиться, если вы не активи&
руете опцию DVD Menu (Меню DVD). В операционной системе
Macintosh вам необходимо щелкнуть по полю флажка Use DVD Menus
(Использовать меню DVD). В операционной системе Windows нажми&
те переключатель DVD.

Однако просто открыть DVD&диск недостаточно. Чтобы воспользоваться фун&
кцией стрим, вы должны щелкнуть по полю флажка Advanced Output и включить
соответствующую опцию. В результате будет активирована кнопка Settings, ко&
торая позволяет вам сконфигурировать параметры функции стрим.

Вы заметите, что программа VLC может воспроизводить видео
в формате Video TS (файл, подготовленный к записи на DVD с жестко&
го диска компьютера), DVD, VCD и Audio CD.

Настраиваем опции стрим
В окне Settings вам доступно большое количество настроек, причем некоторые из
них достаточно сложны для понимания. На рис. 7.24 вы видите различные пара&
метры вывода данных.

Если вы хотите просмотреть DVD&диск на компьютере, выберите поле флажка
Play Locally (Воспроизводить с локального компьютера). В результате диск бу&
дет воспроизводиться непосредственно с компьютера. Следовательно, вам не&
обходимо активировать данную опцию, чтобы правильно сконфигурировать
устройство для функции стрим.

Если вы хотите отправить DVD&композицию в файл на вашем компью&
тере, выберите переключатель File (Файл) и нажмите кнопку Browse
(Найти), чтобы выделить папку для сохранения файла.

Рис. 7.23. Открываем DVD�диск в программе VLC
(для операционной системы Windows XP)
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Выберите нужный протокол.  Ваш выбор повлияет на то, какие опции будут
вам доступны в разделе Encapsulation Method (Формат сжатия данных):

• HTTP. Распространяет аудио и видео через протокол Hypertext Transfer
Protocol, который встречается во многих Web&адресах (например, «http://»).
Для просмотра видео другим пользователям понадобится установить соот&
ветствующий плеер. Если вы выберете эту опцию, вам будет доступно наи&
большее число форматов сжатия данных: MPEG PS, MPEG TS, MPEG 1, ASF
и Raw;

• MMS. Позволяет пользователям просматривать видео в программе Windows
Media Player. Это ненадежная методика, особенно в случае, если вы не рабо&
таете в операционной системе Windows. При выборе данной опции вам необ&
ходимо использовать формат ASF;

• UDP. Протокол User Datagram Protocol очень удобен для обработки данных
в режиме реального времени. Если вы выберете эту опцию, то сможете выпол&
нить просмотр на одном (Unicast) или нескольких (Multicast) компьютерах.
Вы должны использовать формат MPEG TS;

• RTP. Протокол Real&Time Transport Protocol является предпочтительной оп&
цией, потому что он представляет собой стандарт, который читается боль&
шинством плееров. Данный протокол был разработан для передачи аудио&
и видеоинформации. При работе с ним вам необходимо использовать фор&
мат Raw.

После выбора протокола и формата введите IP&адрес. Как правило, это IP&ад&
рес вашего компьютера. Если вы собираетесь использовать протокол UDP, у вас
есть две возможности. Во&первых, вы можете выбрать опцию Unicast, которая от&
правляет данные только одному пользователю. При этом вы должны указать
IP&адрес получателя. Во&вторых, вы можете выбрать опцию Multicast и выбрать
IP&адрес в диапазоне от 224.0.0.0 до 239.255.255.255.

Если вы собираетесь передавать данные через маршрутизатор,
выберите IP&адрес вне диапазона 224.0.2.0. Также выберите для пара&
метра Time To Live значение свыше 1. За подробной информацией
обратитесь по адресу: http://www.tldp.org/HOWTO/Multicast&HOWTO&
2.html#ss2.1.

Выполните следующие действия, чтобы определить IP&адрес компьютера:

• Macintosh. Выберите пункты меню System Preferences ⇒ Network ⇒ выде&
лите активное сетевое соединение;

• Windows. Выберите пункты меню Start ⇒ Settings ⇒ Control Panel ⇒
Network ⇒ Connections ⇒ выделите активное сетевое соединение.

При вводе IP&адреса запишите значения в полях Address (Адрес) и Port
(Порт), потому что они понадобятся вам для просмотра видео.

Дополнительно вы можете использовать опции Transcoding (Конвертирова

ние), Miscellaneous (Разное) и Stream Announcing. Функция Transcoding позво&
ляет вам конвертировать видео в другой кодек и файловый формат (см. совет 29).
Опция Stream Announcing дает пользователям возможность автоматически от&
крывать видео в плеере; если вы выбрали протокол UDP, вам необходимо активи&
ровать данную опцию.

После завершения настройки нажмите кнопку OK. Затем повторно нажмите
кнопку OK в окне Open (Windows) или Open Source (Macintosh). Приложение
VLC начнет воспроизведение DVD&диска. Если вы выбрали опцию Play Locally,
то видео откроется в отдельном окне.

Рис. 7.24. Здесь вы видите большое количество опций,
в которых очень легко запутаться
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Просмотр стрим
Процесс настройки мультимедиа&плееров для подключения к стрим определяет&
ся тем, какие именно опции вы выбрали в разделе Stream Settings, а также зави&
сит от специфики конкретного приложения:

• QuickTime Player. Выберите пункты меню File ⇒ Open URL in New Player
(Открыть адрес в новом плеере);

• VLC. Выберите пункты меню File ⇒ Open Network (Открыть сеть);
• Windows Media Player. Выберите пункты меню File ⇒ Open URL (Открыть

URL
адрес);

В разделе URL или Network пользователь должен ввести:

• HTTP. http://ip_address:port_number;
• MMSH. mms://ip_address:port_number;
• UDP. Unicast. udp://localhost:port_number;
• UDP. Multicast. udp://ip_address;
• RTP. rtp://ip_address:port_number.

После ввода нужной информации начнется воспроизведение DVD&диска. На
рис. 7.25 показан процесс просмотра DVD (на клиенте Mac OS X) с протоколом
UDP из операционной системы Windows XP.

Приложение VLC предлагает дополнительные функции. Как говорилось ранее,
вы можете использовать эту программу для просмотра и распространения видео
стрим, для сохранения видео (Совет 90, а также для воспроизведения цифрового
видео практически в любом формате. Если вам нужен универсальный мультиме&
диа&плеер, установите программу VLC.

Совет 81 Используем блоги

Блоги – это Web&сайты отдельных пользователей сети Интернет, которые регу&
лярно обновляются. Некоторые блоги содержат не только текст, но и видео.

Блоги представляют собой уникальную функцию сети Интернет. Все пользо&
ватели сети, начиная от подростков и заканчивая кандидатами в президенты, по&
лучили возможность свободно обмениваться своими мнениями с другими людь&
ми по всему миру. По мере распространения скоростных Интернет&соединений,
цифровых видеокамер, систем редактирования, мобильных телефонов с камера&
ми и бесплатных сайтов с блогами видеопроекты стремительно развиваются и
становятся все более популярными.

Во время съемок фильма «Кинг Конг» режиссер Питер Джексон
(Peter Jackson) вел свой видеоблог. Вы можете найти его по адресу:
http://www.kongisking.net/kong2005/proddiary/.

Создаем видеоблог
С технической точки зрения видеоблог ничем не отличается от обычного блога.
Если у вас еще нет блога, вы можете создать его на различных сайтах. Приведу
примеры популярных сайтов блогов:

• Blogger. Бесплатно: http://www.blogger.com;
• TypePad. 4,95–14,95 долл. США в месяц: http://www.typepad.com;
• Radio Userland: 39,95 долл. США в год: http://radio.userland.com.

Рис. 7.25. Воспроизводим видео из операционной системы
Windows XP в среде Mac OS X

Используем блоги
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В сети Интернет существуют и другие сайты блогов; чтобы их найти, введите
в строке поискового сервера запрос «блог хост». Каждый сайт блогов функциони&
рует по&своему. Некоторые сайты позволяют вам загружаться только с Web&сай&
та, а другие поддерживают внешние приложения. Ваш выбор зависит исключи&
тельно от ваших предпочтений.

Если у вас есть свой сервер, вы можете создать личный блог. На рынке
имеется большое количество приложений по поддержке блогов; попро&
буйте ввести запрос «программное обеспечение для блогов».

После создания блога вам необходимо изучить принципы его работы. Создайте
на блоге хотя бы одно сообщение, чтобы поэкспериментировать.

Размещаем видеоблог
Для создания видеоблога вы должны записать видео. Некоторые пользователи
даже размещают на блогах видеоклипы со своих мобильных телефонов продол&
жительностью примерно 10 с. Другие используют видеокомбинации художе&
ственного, политического или даже экспериментального стиля. Дайте полную
свободу своей фантазии.

За дополнительной информацией о видеоблогах вы можете обратиться
по адресу: http://www.videoblogging.info/. Этот сайт предлагает
руководства, список ресурсов, ссылки на недавно добавленные видеокли&
пы, а также форумы.

Вам необходимо сжать ваш видеофайл в формат сети Интернет (см. совет 82).
Если ваша служба блогов предлагает достаточно места для сохранения видео, ис&
пользуйте имеющееся пространство. Если вы работаете с сервером, который мо&
жет загружать ваше видео, разместите свои композиции на этом сервере.

Также вы можете использовать ресурсы Интернет Archive (http://www.archive.
org) или Our Media (http://www.ourmedia.org). Бесплатное приложение ccPublisher
(http://sourceforge.net/projects/cctools) значительно упрощает процесс размеще&
ния видео на сайте Интернет Archive. Вам необходимо создать учетную запись на
сайте; данная программа помогает вам найти нужный видеофайл на жестком дис&
ке, активировать учетную запись, выбрать лицензию и загрузить вашу компози&
цию. На рис. 7.26 вы видите, как следует выбирать видеофайл для загрузки в про&
грамме ccPublisher.

После загрузки видео запишите его новый URL&адрес. Чтобы разместить свой
видеоблог, воспользуйтесь инструментом, который предлагает ваша служба бло&
гов (например, Web&сайт или отдельное приложение) и введите краткое описание
вашего проекта вместо стандартного текста блога. Если вы хотите создать ссылку
на свое видео, добавьте в HTML&кодировку сайта следующую строку:

<a href=http://your.domain.tld/path/to/your/video.mpg>Click to watch</a>

Замените текст «your.domain.tld/path/to/your/video.mpg» URL&ад&
ресом вашего видео.

Просмотр видеоблога
Все, что вам нужно для просмотра видеоблога, – это Web&браузер и мультимедиа&
плеер. Вы можете воспроизводить видеоблог так же, как и любой другой видео&
клип из сети Интернет. Единственное различие связано с процессом распростра&
нения видеоблога.

Существуют приложения, которые могут подписываться на видеоблоги раз&
личных пользователей и автоматически загружать видеоклипы. Если вы работае&
те с операционной системой Mac OS X (версия для среды Windows находится
в стадии разработки), то можете установить программу подписки на видеоблоги,
которая называется ANT (http://www.antnottv.org; распространяется бесплатно).
Приложение ANT автоматически загружает все видеоклипы, которые были раз&
мещены в сети Интернет за последнее время. Вы можете добавлять комментарии
о просмотренных клипах. На рис. 7.27 показан процесс импортирования видео&
клипа Эрика Райса (Eric Rice) программой ANT.

Если вы хотите, чтобы другие пользователи приложения ANT подписа&
лись на рассылку ваших видеофильмов, а ваша служба блогов не поддер&
живает функцию RSS 2.0, то  можете воспользоваться программой
FeedBurner (http://www.feedburner.com; распространяется ограниченно
бесплатно).

В сети Интернет существует сайт MeFeedia (http://www.mefeedia.com), кото&
рый собирает информацию по видеоблогам и создает ссылки на них. Когда вы со&

Рис. 7.26. Размещаем файл в сети Интернет
с помощью приложения ccPublisher

Используем блоги
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здаете учетную запись, вы можете подписаться на различные видеоблоги и про&
сматривать их в свое удовольствие.

Благодаря видеоблогам вы имеете возможность не только отправлять свое ви&
део другим пользователям, но и просматривать снятые ими видеоклипы. Наслаж&
дайтесь!

Совет 82 Размещение видео на Web/сайте

Вы можете разместить свое видео на Web&сайте, чтобы обменяться им с другими
пользователями сети Интернет.

Сейчас многие пользователи имеют доступ к высокоскоростным Интернет&со&
единениям. Поэтому велика вероятность того, что ваш фильм будут просматри&
вать в окне Web&браузера либо загружать для последующего воспроизведения.
Однако размер исходных видеофайлов слишком велик для распространения че&
рез сеть Интернет. Следовательно, вам необходимо сжать видео.

В этом разделе мы расскажем о том, как создавать видео, которое
предназначено для загрузки с Web&сайта. Если вы собираетесь распрост&
ранять видео, продолжительность воспроизведения которого превыша&
ет 15 мин, я советую вам воспользоваться функцией стрим (совет 83).

Экспорт видео
Чтобы сжать видео для использования в сети Интернет, вы можете экспортиро&
вать его из вашей системы редактирования:

• Avid. Выберите пункты меню File ⇒ Export ⇒ Options ⇒ QuickTime Movie;
• Final Cut. Выберите пункты меню File ⇒ Export ⇒ Using QuickTime

Conversion (Используя сжатие QuickTime);
• Movie Maker. Выберите пункты меню Tasks ⇒ Finish Movie ⇒ Settings;
• Premiere. Выберите пункты меню File ⇒ Export ⇒ Movie ⇒ Settings;
• iMovie. Выберите пункты меню File ⇒ Share ⇒ QuickTime ⇒ Compress

Movie for ⇒ Web.

Некоторые редакторы содержат предварительные установки, то есть вам доста&
точно выбрать одну из таких установок, а все необходимые изменения будут вы&
полнены автоматически. Такие программы позволяют вам настроить дополни&
тельные параметры сжатия данных. Другие редакторы не содержат расширенных
функций; в таких программах вам придется вносить все изменения вручную.

Конфигурируем параметры сжатия
Если вы хотите изменить настройки сжатия, вам придется изучить список доступ&
ных кодеков (Совет 77) и файловых форматов. Помните о том, что существует
очень большое количество различных кодеков. Я рекомендую вам работать толь&
ко со стандартными кодеками; в результате ваш проект получит более широкую
аудиторию.

Процесс изменения настроек вручную может различаться в зависимости от
того, с каким редактором вы работаете. Старайтесь создавать небольшие файлы.
Для этого вы можете выполнить следующие действия:

• экспортировать видео, уменьшив его разрешение в два раза. Например, если
вы редактируете материал в формате NTSC DV (720 × 480), я советую вам
уменьшить разрешение до 360 × 240;

• снизить частоту смены кадров до 12 или 15 кадров/с;
• использовать кодек, рассчитанный на распространение видео в сети Интер&

нет, к примеру, MPEG&4.

Создание Web)страницы
Если вы хотите добиться того, чтобы другие пользователи могли просмотреть ви&
део на Web&странице, вы должны встроить его в страницу. Выбранный вами фай&
ловый формат видео определит, какую именно HTML&кодировку вам следует ис&
пользовать. Чтобы создать страницу, введите следующие команды:

<!DOCTYPE HTML PUBLIC “-//W3C//DTD HTML 4.01 Transitional//EN” http://

www.w3.org/TR/html4/loose.dtd>

<html>

Рис. 7.27. Программа ANT воспроизводит видео,
которое называется 300mph

Размещение видео на Web/сайте
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<head>

<title>My Movie Page</title>

</head>

<body>

Затем введите информацию о файле, который будет встроен в Web&страницу:

• для файлов QuickTime:
<object id=”Player” classid=”clsid:02BF25D5-8C17-4B23-BC80-

D3488ABDDC68”

width=”360”height=”240” codebase=http://www.apple.com/qtactivex/

qtplugin.cab

type=”video/quicktime:>

<param name=”src” value=”./myMovie.mov”>

<param name=”controller” value=”true”>

<embed src=”./myMovie.mov” width=”360” height=”240” controller=”1”

pluginspage=http://www.apple.com/quicktime/download/>

</embed>

</object>;

• для файлов Windows Media:
<object id=”Player” classid=”clsid:6BF52A52-394A-11D3-B153-

00C04F79FAA6”

width=”360”height=”240” codebase=http:/activex.microsoft.com/

activex/controls/mplayer/en/nsmp2inf.cab#Version=6,4,7,1112”

type=”application/x-oleobject”>

<param name=”url” value=”./myMovie.avi”>

<param name=”showcontrols” value=”true”>

<embed type=”application/x-mplayer2” src=”./myMovie.avi”

width=”360” height=”240” controller=”1” pluginspage=http://

www.microsoft.com/Windows/MediaPlayer/>

</embed>

</object>;

• для файлов MPEG:
<object data=”./myMovie.mpg” width=”360” height=”240” type=”video/

mpeg”>

</object>;

• наконец, в конце страницы введите следующую команду:
</body>

</html>

После ввода кодировки на странице сохраните ее на жестком диске вашего ком&
пьютера и введите ее имя с расширением .htm или .html.

При необходимости замените любые данные, связанные с файлом, например Src,
Url или Data. Допустим, если ваш видеофайл называется «MyGreatMovie.mov»,

замените данные в HTML&кодировке (myMovie.mov) его названием. Кроме того,
вы можете изменить ширину и высоту файла, а также добавить настройки инте&
рактивности для пользователей.

Символ «./» перед названием видеофайла сообщает Web&браузеру
пользователя о том, что видеофайл находится в той же папке,
что и HTML&файл. Вы можете заменить этот символ адресом файла
на Web&сервере, либо оставить его неизменным и загрузить HTML&
и видеофайлы в одну папку.

Размещаем файлы на сервере
Администратор вашего сервера сообщит вам о том, в какую папку вам следует заг&
рузить свои файлы. Файлы можно загружать различными способами; кроме того,
каждый администратор имеет специфическую методику работы с сервером.
Впрочем, вам нужно загрузить всего два файла: видеофайл и HTML&файл.

После сохранения файлов откройте Web&браузер и зайдите на новую Web&стра&
ницу. Через несколько минут вы (а также и другие пользователи сети Интернет из
любой страны мира) сможете просмотреть свое видео.

Совет 83 Выполняем кодировку видео
для просмотра в сети Интернет

Даже после сжатия видеофайлы занимают довольно много места, поэтому их заг&
рузка может потребовать значительного времени. Используя функцию стрим,
пользователи могут загружать видеофайлы почти мгновенно.

Сеть Интернет является идеальным средством для распространения вашего
видео. Благодаря таким устройствам, как кабельные модемы, спутниковые тарел&
ки и цифровые линии связи (DSL), скоростные Интернет&соединения стали дос&
тупными для большого количества пользователей. Однако даже при наличии по&
добного соединения для загрузки видеофайлов вам потребуется много времени.
Видеофайлы (даже сжатые) отличаются большими размерами и намного превы&
шают по объему графические Web&страницы.

Чтобы обойти это ограничение, многие компании разрабатывают различные
методики, которые позволяют отправлять видеофайлы небольшими фрагмента&
ми. Такие фрагменты отображаются мгновенно. Процесс разбивки видео на фраг&
менты носит название «стрим».

Для использования функции стрим вам понадобится установить определенные
аппаратные средства. Во&первых, это видеоклиент, с помощью которого другие
пользователи будут просматривать видео. Во&вторых, это сервер стрим (совет 85),
который используется для передачи файлов пользователям. И наконец, это ви&
деофайл, который вы должны отформатировать (или закодировать) специаль&
ным образом.

Выполняем кодировку видео для просмотра в сети Интернет
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Создаем видео для функции стрим
Вы можете создавать видеострим различными способами. Время, которое требу&
ется для кодировки видео, изменяется в зависимости от выбранной вами методи&
ки; кроме того, на продолжительность процесса может влиять и скорость вашего
компьютера. В целом кодирование в режиме реального времени выполняется бы&
стро и с невысоким качеством, экспортирование из системы редактирования –
медленнее, но с более высоким качеством, а из файла без сжатия – очень медлен&
но, однако с самым высоким качеством.

Кодировка видео в режиме реального времени
Я использую термин «видео в режиме реального времени», чтобы обозначить два
различных типа видео. Первый тип охватывает реальные события (например,
спортивные состязания), которые происходят одновременно с кодировкой. Вто&
рой тип представляет собой воспроизведение видео с камеры или деки. Независи&
мо от типа видео вы можете использовать одну методику кодировки данных. Од&
нако в данном разделе мы не будем говорить о том, как следует воспроизводить
видео в режиме реального времени (см. совет 87).

Компании Microsoft и Apple бесплатно предлагают программное обеспечение
для кодировки видео. Приложение от Microsoft называется Media Encoder; вы
можете загрузить его с сайта http://www.microsoft.com/windows/windowsmeadi/
9series/encoder/default.aspx. Приложение от Apple называется QuickTime Broad&
caster; вы можете загрузить его с сайта http://www.apple.com/quicktime/download/
broadcaster. Эти программы позволяют вам без проблем решить задачу по коди&
ровке (и даже сжатию) видео в режиме реального времени. На рис. 7.28 показан
процесс воспроизведения и архивирования видео в программе Microsoft Media
Encoder, а на рис. 7.29 – в программе QuickTime Broadcaster.

Качество вашего видео зависит от скорости загрузки данных, которую обеспе&
чивает сервер стрим. При настройке скорости передачи информации для видео
следите за тем, чтобы не превысить максимальную скорость сервера. Лично мне
удавалось добиваться оптимальных результатов при скорости 500 Кбит/с в лю&
бом из двух приложений.

Процесс кодировки и сохранения данных на диск особенно полезен
в случае, если вам необходимо быстро поместить видео в сеть Интер&
нет (потому что он происходит в режиме реального времени). Однако
добиться очень высокого качества вы не сможете.

Чтобы отправить видео в любое приложение, подключите камеру или деку
к компьютеру посредством кабеля IEEE&1394 (также его называют FireWire или
i.LINK). После установления соединения запустите программу кодировки и вы&
берите нужные параметры. Убедитесь в том, что вы правильно настроили про&
грамму для работы с функцией стрим, а также сохранили закодированный файл
на диск. Этот файл понадобится вам в дальнейшем.

Программа QuickTime Broadcaster содержит ошибку, которая проявля&
ется в случае, если вы в течение длительного периода времени ведете
запись на жесткий диск объемом свыше 2 Гб. Если вы собираетесь
закодировать видео, продолжительность воспроизведения которого
превышает 15 мин, разбейте диск на разделы объемом 2 Гб или создай&
те виртуальный диск с помощью программы Disk Utility.
Я достаточно часто с успехом применяю второй вариант.

Экспорт видео из системы редактирования
Многие системы редактирования содержат опцию, которая предназначена для
экспорта видео в файл на жестком диске вашего компьютера. Методика экспорта
видео различается в зависимости от вашей операционной системы, программного
обеспечения, а также от того, установлены ли в вашей системе некоторые обнов&
ления или нет. Убедитесь в том, что ваша система поддерживает экспорт видео
для стрим. Определитесь с кодеком, который вы собираетесь использовать (см.
совет 77).

Рис. 7.28. Программа Media Encoder
готова к кодированию видео при скорости 548 Кбит/с

Выполняем кодировку видео для просмотра в сети Интернет
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Выполните следующие действия:

• Avid. Выберите пункты меню File ⇒
Export;

• Final Cut. Выберите пункты меню File
⇒ Export ⇒ Using Compressor (В про

грамме Compressor);

• Movie Maker. Выберите пункты меню
Tasks ⇒ Finish Movie ⇒ Send to the
Web (Отправить в сеть Интернет);

• Premiere. Выберите пункты меню File
⇒ Export ⇒ Movie ⇒ Settings;

• iMovie. Выберите пункты меню File
⇒ Share ⇒ QuickTime ⇒ Compress
movie for ⇒ Web Streaming (Сжать
фильм для ⇒ Стрим);

Некоторые системы редактирования по умолчанию выполняют экспорт компо&
зиции, расположенной между точками In и Out на текущей шкале времени. Если
вы хотите экспортировать фильм целиком, вам необходимо убедиться в том, что
маркеры на шкале времени расположены верно. Вряд ли вы захотите ждать не&
сколько часов, только чтобы обнаружить, что вы забыли добавить в файл послед&
ние пять минут видео.

Выполняем кодировку в приложении Discreet Cleaner
Если вы хотите использовать для стрим видео самого высокого качества и у вас есть
время, которое вы можете потратить на настройку параметров, вы должны устано&
вить приложение, которое предназначено для кодировки видео. Примером подоб&
ной программы является Discreet Cleaner (http://www.discreet.com; стоит 549 долл.
США). Кроме того, приложение Discreet Cleaner предлагает большое количество
дополнительных функций, например поддержку URL&ссылок (совет 84).

Чтобы добиться максимально высокого качества, выполните запись видео с са&
мым высоким разрешением. Скорее всего, вы будете при этом использовать фор&
мат DV (без сжатия данных). После завершения записи запустите программу
Discreet Cleaner и переместите ваш видеофайл в окно Batch (Пакет).

Одно из преимуществ программы Discreet Cleaner заключается в том, что она
позволяет вам вручную выбрать точки In и Out. Следовательно, вы можете изме&
нить настройки, закодировать фрагмент видео между этими точками, а затем про&
смотреть результаты. На практике это означает, что вы можете постепенно повы&
шать качество вашего видео: записывать первый файл, вносить в него изменения

и проверять, не улучшилось ли качество изображения. На рис. 7.30 показаны мар&
керы In и Out на шкале времени (зеленые и красные точки), а также текущие на&
стройки для кодировки.

Рис. 7.29. Программа QuickTime
Broadcaster настроена на запись

в файл на жестком диске

Рис. 7.30. Точки In и Out выделены зеленым
и красным цветами соответственно

Процесс кодировки данных будет выглядеть примерно так:

1. Дважды щелкните по композиции, настройки которой вы хотите изменить.
2. Щелкните по вкладке Settings и внесите нужные изменения (например, от&

редактируйте частоту смены кадров).
3. Найдите точку, которая станет исходной точкой для вашего фрагмента.
4. Создайте точку In (выберите пункты меню Edit ⇒ Set In Point).

Выполняем кодировку видео для просмотра в сети Интернет
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5. Найдите точку, которая станет конечной точкой для вашего фрагмента.
Точки In и Out должны отстоять друг от друга на шкале времени на расстоя&
нии, которое не превышает 20–30 с.

6. Создайте точку Out (выберите пункты меню Edit ⇒ Set Out Point).
7. Выполните тестовую кодировку (выберите пункты меню Batch ⇒ Encode).
8. Найдите закодированный файл на жестком диске вашего компьютера и от&

кройте его в мультимедиа&плеере.
9. При необходимости повторите.

Если вы выполните вышеописанные действия, то сможете создать видео высо&
кого качества, которое будет воспроизводиться на самой маленькой скорости.
Если вы обладаете большим терпением, вы можете переместить точки In и Out,
выполнить кодировку следующего фрагмента и просмотреть его. В зависимости
от результата вам придется повторить процесс или остановиться на достигнутом.

Когда вы добьетесь нужного результата, установите маркеры In и Out в началь&
ную и конечную точки вашего видео. Выполните кодировку и наслаждайтесь.

Совет 84 Как получить пожертвования
через страницу PayPal

Добавьте в свое видео ссылку на Web&страницу, которая предназначена для сбора
пожертвований.

Программы QuickTime, Real и Windows Media могут переадресовать зрителей
на определенный URL&адрес. Используя приложение Discreet Cleaner (http://
www.discreet.com/products/cleaner), вы можете открыть Web&браузер пользовате&
ля и направить его на страницу пожертвований PayPal. Захотят люди вносить по&
жертвования или нет – это уже совсем другой вопрос.

Последняя версия Discreet Cleaner для операционной системы Windows
не поддерживает функцию EventStream. Если вы работаете в среде
Windows и вам необходим доступ к опции EventStream, я советую вам
установить устаревшую версию программы Discreet Cleaner. Разумеет&
ся, вы можете обратиться в компанию Discreet и попросить ее восста&
новить эту функцию.

Импорт вашего видео
После установки и запуска программы Discreet Cleaner вам необходимо импорти&
ровать видео для пакетирования. Вы можете переместить файл в окно Batch или
выбрать пункты меню Batch ⇒ Add Files (Добавить файлы). Затем дважды щелк&
ните по иконке фильма либо выберите композицию и выполните команду Win

dows ⇒ Project (Проект).

В окне Project перейдите к концу композиции (или к сцене фильма, в которой
вы хотите попросить пожертвование), как показано на рис. 7.31.

Рис. 7.31. Переходим к концу фильма

Лично я обычно смещаю конечную точку фильма примерно на одну
секунду, потому что я не уверен в том, что видеофайл будет функцио&
нировать нормально.

Как только вы найдете сцену фильма, в которой вы хотите попросить пожерт&
вования, щелкните по вкладке Event Stream или выберите соответствующий
пункт меню (Windows ⇒ Event Stream).

Создаем событие Event Stream
В окне Event Stream вам необходимо создать событие. Для этого нажмите кнопку
Add (Добавить). Выберите в ниспадающем меню пункт Open URL (Открыть
URL
адрес). Затем вы сможете ввести URL&адрес страницы, на которую вы хоти&
те направлять ваших зрителей (см. рис. 7.32).

Создаем URL)адрес
Страница PayPal имеет простой URL&адрес для пожертвований:

https://www.paypal.com/xclick/business=<username>%40<domain>.<tld>

&item_name=<your_item>

Символ «%40» является эквивалентом символа «@», поэтому вы должны заме&
нить текст «<username>» первой частью вашего адреса электронной почты,  текст

Как получить пожертвования через страницу PayPal
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«<domain>» – его второй частью (между символом «@» и последней точкой),
а текст «<tld>» – его последней частью. Наконец, замените текст «<your item>»
описанием пожертвования.

Все вышесказанное может показаться вам слишком сложным, поэтому я приве&
ду пример, в котором используется адрес электронной почты video@domain.com:

https://www.paypal.com/xclick/

business=video%40domain.com&item_name=Donation

После ввода URL&адреса нажмите кнопку Preview (Предварительный про

смотр), чтобы убедиться в том, что он функционирует. Если вы правильно ввели
адрес, ваш Web&браузер откроется на странице PayPal, которая дает пользователю
возможность указать сумму пожертвования. Если вы увидите сообщение об ошибке
или неправильную информацию (например, ошибку в адресе электронной по&
чты), вернитесь на шаг назад и проверьте введенный вами URL&адрес.

Интерфейс ввода URL&адресов в программе Discreet Cleaner довольно
неудобен, потому что текстовое поле слишком короткое. Поэтому на
экране вы не сможете полностью прочитать новый адрес.

Если вы хотите обойти это ограничение, я советую вам вводить URL&адреса
в отдельном текстовом редакторе, например WordPad или TextEdit, а затем копи&
ровать и вставлять их в окно Event Stream.

Настроив событие Open URL, нажмите кнопку Save (Сохранить).

Сжатие и распространение видео
Теперь вам необходимо выбрать настройки сжатия фильма. Таких настроек суще&
ствует огромное количество, поэтому я просто сделаю шаг вперед, помня о том,

что ваш выбор будет определяться форматом, в котором вы собираетесь распрост&
ранять свое видео (см. совет 77).  Вам следует использовать файловый формат
QuickTime, Windows Media или Real. После выбора настроек начните процесс ко&
дировки и дождитесь его завершения.

Найдите ваш файл и дважды щелкните по нему. Ваша композиция автомати&
чески откроется в соответствующем мультимедиа&плеере. Проверьте, правильно
ли выполняется переход по указанному вами URL&адресу.

Если вы имеете дело с продолжительным фильмом, найдите сцену со
ссылкой и протестируйте ее. Это могут сделать и другие пользователи.

Готово! Займитесь распространением своего проекта (см. совет 86) и рассчиты&
вайте на то, что зрители по достоинству оценят ваш труд.

Дополнительные возможности
Веб&сайт PayPal предлагает различные параметры, которые вы можете сконфигу&
рировать через определенный URL&адрес. Например, вы можете указать, какую
сумму пожертвования вы рассчитываете получить. Для этого воспользуйтесь пе&
ременной <amount>:

https://www.paypal.com/xclick/

business=<username>%40<domain>.<tld>&item_name=<your_item>&amount=<amount>

Кроме того, вы можете отправить посетителей, которые уже внесли деньги, на
отдельную страницу с благодарностями, получить от них сообщения и даже зап&
росить их адреса (может быть, чтобы отослать им DVD&диск с запись своего ви&
деофильма?).

Если вы собираетесь распространять файлы исключительно в формате Win&
dows Media или QuickTime, вы можете запрашивать пожертвования через редак&
тор Windows Media File Editor или QuickTime Pro, соответственно.

Используем приложение Windows Media File Editor
Благодаря программе Windows Media File Editor, которая входит в пакет Windows
Media Encoder 9 Series (http://www.microsoft.com/windows/windowsmeadia/
9series/encoder/default.aspx), вы можете добавить в видео команды скрипта. На&
пример, одна из таких команд открывает URL&адрес в Web&браузере пользователя.

После запуска программы Windows Media File Editor выполните команду File
⇒ Open и выберите видеофильм, который вы хотите добавить на страницу PayPal
URL. Затем введите адрес PayPal URL в текстовом поле Parameter (Параметр).
Нажмите кнопку OK. Выберите в меню File пункт Save and Index (Сохранить
и индексировать).

Используем приложение QuickTime Pro
Чтобы добавить адрес страницы PayPal в ваше видео QuickTime Pro, выполните
действия, указанные в руководстве Apple «HREF tracks» по адресу: http://www.
apple.com/tools_tips/tutorials/hreftracks.html.

Рис. 7.32. Событие Open URL

Как получить пожертвования через страницу PayPal
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Совет 85 Настраиваем телевизионную станцию
в сети Интернет

Используя программу Darwin Streaming Server, вы можете создать телевизион&
ную станцию в сети Интернет.

Немногие люди могут позволить себе установку своей собственной телевизи&
онной станции. Однако если вы собираетесь вести передачу видео через сеть Ин&
тернет, вы можете решить эту задачу всего лишь за несколько часов. И это ничего
не будет вам стоить. После создания и настройки станции вы сможете передавать
файлы в формате QuickTime, MPEG&4 и 3GPP.

Загружаем приложение Darwin Streaming Server
Для воспроизведения видео с компьютера вам необходимо специальное про&
граммное обеспечение стрим. Компания Apple предлагает бесплатное приложе&
ние Darwin Streaming Server, которое позволяет решить эту задачу. Кодировка
данного приложения открыта; следовательно, если вы умеете программировать,
вы можете вносить любые изменения в настройки сервера стрим.

Если вы не умеете программировать либо хотите просто установить программу
и сразу приступить к работе, вы можете загрузить пакеты параметров с сайта ком&
пании Apple. Доступны пакеты для таких операционных систем, как Mac OS X,
Windows 2000 и 2003 Server, Red Hat Linux 9 и Solaris 9. Если вы хотите получить
доступ к исходной кодировке, вам понадобится зарегистрироваться и согласиться
с правилами лицензионного соглашения Apple Public Source License (APSL).

Вы можете загрузить программное обеспечение с сайта http://developer.apple.com/
darwin/projects/streaming/.

Установка сервера
Если на вашем компьютере не была установлена программа Perl, загрузите ее пе&
ред установкой сервера стрим. Эта программа понадобится вам для запуска инст&
рументов администрирования, а не самого сервера.

Вы можете загрузить приложение Perl для операционной системы
Windows с сайта ActiveState (http://www.activestate.com).

После загрузки или создания программного обеспечения (на основе исходной
кодировки) вам нужно его установить. Пакеты сконфигурированных параметров
выполняют установку автоматически. Если вы работаете с исходной кодировкой,
внимательно прочитайте последующие разделы.

Конфигурируем сервер
Если вы уже установили сервер, вам следует его сконфигурировать. Для этого
воспользуйтесь Web&браузером и подключитесь к сайту http://hostname:1220, где

«hostname» – это название сервера стрим. Затем на экране откроется исходная
страница в процессе конфигурирования.

Если вы являетесь администратором сервера, то можете подключить&
ся к нему (http://127.0.0.1:1220). Данная функция особенно полезна
в случае, если вы установили сервер стрим на свой ноутбук.

Настройка паролей
Прежде всего вас попросят ввести имя пользователя и пароль. Выбранная вами
комбинация станет паролем администратора для сервера стрим; для внесения
любых изменений в конфигурацию сервера вам понадобится ее указать. Пароль и
имя пользователя для сервера необязательно должны совпадать с паролем и име&
нем пользователя на вашем компьютере. Более того, по соображениям безопасно&
сти они должны различаться.

На следующей странице вас попросят ввести еще один пароль. Этот пароль вы
будете использовать для отправки звуковых файлов в формате MP3 на сервер.
Данный пароль должен отличаться от пароля администратора, который вы ввели
на предыдущей странице.

Начальная конфигурация
Если ваш сервер имеет действующий сертификат безопасности (SSL) и вы хотите
управлять системой с его использованием, вы можете щелкнуть по полю флажка,
чтобы активировать настройки безопасности. На рис. 7.33 показана страница кон&
фигурации SSL.

Вам следует поместить мультимедиа&файлы в папку Media Folder. Я рекомен&
дую использовать настройки по умолчанию, причем даже несмотря на то, что вы
можете отправлять файлы из любой папки на вашем компьютере. Обратите вни&
мание на то, какую папку сервер выбирает по умолчанию. На рис. 7.34 показана
начальная конфигурация папки Media Folder.

Рис. 7.33. Активируем настройки SSL
(только при наличии сертификата)

Настраиваем телевизионную станцию в сети Интернет
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дется запустить сервер вручную. Надеюсь, что такого не произойдет. На рис. 7.36
показан работающий сервер QuickTime Streaming.

Рис. 7.34. Отправляем фильмы и аудиофайлы
из папки Media Folder

Если вы смените папку, обязательно настройте права доступа к ней
для сервера стрим. Программе Streaming Server необходим доступ
для чтения/записи.

Сервер стрим может отправлять данные через порт 80, то есть через стандарт&
ный порт для Web&страниц на сервере. Данный порт позволяет пользователям
просматривать ваш материал даже при условии наличия у них на компьютерах
защитной системы firewall (разумеется, если они вообще могут просматривать
Web&страницы). Если ваш компьютер тоже играет роль Web&сервера, не активи&
руйте эту функцию. На рис. 7.35 показана опция, которая предназначена для пе&
редачи данных через порт 80.

После завершения начальной настройки сервера вы увидите в левом верхнем
углу Web&страницы надпись «Server is Running» («Сервер запущен»). Если вы
увидите надпись «Server is Idle» («Сервер не работает»), это значит, что вам при&

Рис. 7.35. Активируем функцию стрим через порт 80
(только при необходимости)

Рис. 7.36. Сервер работает, как и должно быть

Во время написания этой книги функция запуска/остановки сервера
еще не входила в состав приложения Administration. Если вам нужно
запустить сервер вручную, вам придется активировать программу Perl:

• Mac OS X: /usr/sbin/stramingadminserver.pl;
• Windows: \Program Files\Darwin Streaming

Server\streamingadminserver.pl.

Выполните следующие действия, чтобы запустить программу
из командной строки:

• Mac OS X: откройте приложение Terminal, которое находится
в папке Utilities;

• Windows: выберите в меню Start пункт Run и введите текст
command.

Затем введите:

• Mac OS X: perl /usr/sbin/stramingadminserver.pl;
• Windows: perl \Program Files\Darwin Streaming

Server\streamingadminserver.pl.

Настраиваем телевизионную станцию в сети Интернет
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Чтобы протестировать ваш сервер, запусти&
те видеоплеер и откройте страницу rtsp://
hostname/sample_300kbit.mp4. На экране дол&
жен сразу же появиться анимированный лого&
тип QuickTime. На рис. 7.37 показан процесс
воспроизведения фильма (300 Кбит) с сервера
стрим.

Для просмотра фильмов вам необя&
зательно устанавливать программу
QuickTime Player. Все примеры клипов
в данной книге были записаны в при&
ложении QuickTime, но вы можете
использовать функцию стрим и для
видео в формате MPEG&4 или 3GPP.

Создаем список фильмов
Итак, сервер был активирован и сконфигурирован. Теперь вам нужно добавить
в программу новые фильмы. Найдите папку, которую вы ранее настроили как
Media Folder. Затем выберите фильмы и добавьте их в папку Media Folder.

Используя инструмент Administration, щелкните по ссылке Playlist. Вы заме&
тите, что в окне уже присутствует список, который называется Sample. Щелкните
по ссылке New Movie Playlist (Новый список фильмов). Вы увидите список, со&
держащий все фильмы, которые вы добавили с папку Media Folder. Для воспроиз&
ведения в режиме стрим вам необходимо закодировать эти фильмы (см. совет 83).

Сконфигурировать список фильмов достаточно просто. Параметры Name (На

звание) и Mount Point (Точка) должны полностью совпадать, за исключением
того, что для параметра Mount Point следует добавить расширение .sdp. Режим
Play предлагает три дополнительные опции: Sequential (Последовательный),
Sequential Looped (Последовательный с повтором) и Weighted Random (Произ

вольный). Чтобы добавить фильмы в список, щелкните по ним и переместите из
окна Available Content (слева) в список Playlist (справа). На рис. 7.38 показан
процесс создания списка «Monday».

Если вы выберете режим Sequential, система будет воспроизводить все филь&
мы в списке, от первого до последнего. Если вы хотите, чтобы список фильмов
воспроизводился беспрерывно, вы можете активировать одну из двух опций.
Во&первых, вы можете использовать режим Sequential Looped, в котором все
фильмы из списка воспроизводятся последовательно до тех пор, пока вы не оста&
новите процесс.

Во&вторых, вы можете переключиться в режим Weighted Random, который про&
извольно выбирает в списке фильм для воспроизведения. При работе в данном ре&

жиме система оценивает два критерия. Параметр Repetition (Повторение) ограни&
чивает количество повторов для каждого фильма заданным вами значением.

Убедитесь в том, что для параметра Repetition выбрано значение,
которое не превышает общее количество фильмов в вашем списке.

Вторая переменная, которую вы можете сконфигурировать, – это Weight
(Вес). Для изменения значения данного параметра воспользуйтесь стрелками ря&
дом с заголовком фильма в списке. Чем выше значение переменной, тем чаще бу&
дет воспроизводиться данный фильм. Вы можете выбрать значение в диапазоне
от 1 до 10.

Рис. 7.37. Фильм с сервера стрим

Рис. 7.38. Весь доступный материал
отображается в списке слева

Настраиваем телевизионную станцию в сети Интернет
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После сохранения изменений вы вернетесь на страницу Playlists. Новый спи&
сок появится в окне, но его статус будет настроен как Stopped (Остановлен). Что&
бы начать воспроизведение, нажмите кнопку Play. Статус изменится на Playing
(Воспроизводится). На рис. 7.39 показан список «Monday» в процессе воспроиз&
ведения.

Если посетитель щелкнет по ссылке, ваше видео откроется в его мультимедиа&
плеере по умолчанию. После этого он сможет спокойно просмотреть ваши компо&
зиции.

Кроме того, вам необходимо настроить, какие фильмы должны воспроизводить&
ся в определенное время. Воспроизведение начнется после того, как вы нажмете
кнопку Play на странице Playlists, поэтому вам необходимо спланировать все зара&
нее. Вы должны знать, как долго и в какой последовательности воспроизводятся
ваши фильмы (разумеется, если вы не выбрали режим Random Weighted).

Например, если вы воспроизводите пять фильмов продолжительностью 30 мин
каждый и вы начали процесс в 10 ч утра, программа будет выглядеть приблизи&
тельно так:

• «Highway America» – 10:00;
• «Gone Fishin’» – 10:30;
• «Science Today» – 11:00;
• «The Finer Things» – 11:30;
• «Come ‘n Get It!» – 12:00.

Если вы выберете режим Sequential Looped, фильм «Highway America» нач&
нется повторно в 12:30 (после завершения фильма «Come ‘n Get It!»), фильм «Come
Fishin’» начнется повторно в 1:00 и т. д. Все фильмы в вашем списке будут повто&
ряться снова и снова.

Совет 86 Используем приложение BitTorrent
для распространения видео

С помощью сетевого приложения BitTorrent вы можете распространять свои
фильмы через других пользователей.

Цифровые видеофайлы могут иметь очень большие размеры. Если вы собирае&
тесь распространять свое видео в сети Интернет, вам придется потратить доволь&
но много денег; вполне может случиться и так, что вам придется остановить про&
цесс, потому что вы израсходуете свой трафик.

BitTorrent – это сетевое (P2P) приложение, разработанное Брэмом Коэном
(Bram Cohen). Эта программа использует уникальную методику распростране&
ния файлов. В других приложениях P2P при запросе на загрузку файла этот файл
копируется только с одного компьютера. Следовательно, вы ограничены возмож&
ностями соединения на этом компьютере. А соединение может быть медленным
или быстрым, надежным или нет.

Программа BitTorrent пытается одновременно загрузить файл с нескольких
компьютеров. Данная методика позволяет пользователям получать файлы быст&
рее, потому что они поступают частями. Некоторые системы имеют более скорост&
ные Интернет&соединения, однако в комбинации с другими компьютерами они

Рис. 7.39. Вам доступны два списка:
один воспроизводится сейчас, другой был остановлен

Чтобы приступить к воспроизведению, запустите ваш мультимедиа&плеер
и откройте страницу rtsp://hostname/myPlaylist.sdp, где «hostname» – это назва&
ние вашего сервера стрим, а «myPlaylist» – это название вашего списка.

Разрешаем подключение других пользователей
Так как видео воспроизводится в режиме стрим, другим пользователям необходимо
знать, когда и куда им следует подключиться. Вы можете отправить URL&адрес на
вашу страницу по электронной почте или поместить его в сети Интернет. Если вы
хотите, чтобы другие пользователи смогли просматривать материал с Web&страни&
цы, вы можете создать базовую ссылку или встроить видео в страницу.

Лично я считаю, что добавлять видео на Web&страницу довольно
неудобно, потому что другие пользователи не смогут изменять его
размеры.

Вы можете создать ссылку на видео с помощью следующей команды:

<a href=”rtsp://hostname/myPlaylist.sdp>”Click here to tune in</a>

Используем приложение BitTorrent для распространения видео
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отправляют файлы быстрее, чем другие компьютеры. Кроме того, чем более высо&
кой популярностью пользуется файл, тем быстрее он распространяется.

Приложение BitTorrent использует небольшие файлы с расширением .torrent,
которые соответствуют полным файлам из сети Интернет. Если вы получили
файл .torrent, вы сможете затем загрузить из сети весь файл. Представьте себе, что
вы ходите по музыкальному магазину и выбираете одну из обложек для DVD, что&
бы затем продавец отдал вам на кассе полный DVD&диск.

Методика BitTorrent позволяет эффективно распространять видеофайлы.
Приведу цитату с Web&страницы BitTorrent:

«Основная задача при распространении файлов заключается в том, чтобы
полностью задействовать мощность компьютеров других пользователей.
Производительность их систем возрастает пропорционально их требовани&
ям, значит, вы можете получить неограниченные возможности за весьма
умеренную плату».

Загружаем приложение BitTorrent Client
Официально приложение BitTorrent поддерживает операционные системы
Windows, Mac OS X и Linux; вы можете загрузить его с сайта http://bittorrent.com/
download.html. Впрочем, в сети Интернет существуют и другие клиенты BitTor&
rent. Я очень рекомендую вам обратить внимание на такую программу, как Azu&
reus (http://azureus.sourceforge.net; распространяется бесплатно), которая вклю&
чает систему отслеживания (подробности – далее), а также поддерживает вне&
шние обновления.

Приложение Azureus работает с операционными системами Windows, Mac OS X
и Linux. На Web&сайте Azureus вы найдете подробные указания по установке про&
граммы. Вам необходимо установить на свой компьютер Java; обратитесь на Web&
сайт компании Sun (http://www.java.com/en/download/manual.jsp).

После установки программы Azureus вы можете приступить к загрузке видео&
файлов.

Загружаем файл с расширением .torrent
Процесс загрузки файла в программе BitTorrent можно разделить на два этапа.
Сначала вам необходимо получить файл .torrent. Затем вы открываете этот файл
в клиенте BitTorrent (в данном случае в программе Azureus) и начитаете загрузку
видео.

Для поиска файлов .torrent вы можете использовать систему отслеживания
BitTorrent. Эта система сохраняет список доступных файлов .torrent и поддержи&
вает ссылки на полные файлы, которым они соответствуют.

Я рекомендую вам использовать такие системы отслеживания,
как etree.org Community BitTorrent Tracker (http://bt.etree.org) и Legal
Torrents (http://www.legaltorrents.com).

Как только вы установите систему отслеживания, выберите файл для загрузки.
Вам необходимо выбирать только файлы с расширением .torrent. Откройте такой
файл в программе Azureus, чтобы начать его загрузку. На рис. 7.40 показан про&
цесс загрузки фильма, который называется «Panorama Ephera».

Рис. 7.40. Загружаем фильм в программе Azureus

При работе в программе BitTorrent вы одновременно загружаете
и распространяете файлы. Если вы отключите распространение
данных, процесс загрузки может значительно замедлиться. Ничто
не дается просто так.

В зависимости от размеров файла, скорости вашего Интернет&соединения и со&
единений других пользователей для завершения загрузки вам может потребо&
ваться некоторое время. Возможно, вы займетесь чем&то другим, может быть,
даже создадите свои файлы .torrent и отправите их всему миру!

Обмен файлами
Если вы хотите сделать файл доступным в сети BitTorrent, вам необходимо со&
здать файл с расширением .torrent. В отличие от других сетей P2P, которые под&
держивают только один файл, файл с расширением .torrent может состоять из не&
скольких частей. Различные приложения BitTorrent выполняют разделение фай&
лов автоматически; программа Azureus не является исключением.

Проще всего создать файл с общим доступом с помощью команды File ⇒ Share
⇒ File. В зависимости от размеров файла процесс может занять некоторое время.
Текущий статус отобразится в окне. После завершения процесса файл с расшире&
нием .torrent станет доступен в системе отслеживания Azureus.

Во время настройки общего доступа к файлу его статус на вкладке My Torrents
будет отображен как Queued (Стоит в очереди). Если вы обнаружите, что файл
стоит в очереди в течение длительного периода времени, щелкните по нему пра&
вой кнопкой мыши и выберите пункт меню Force Start (Начать процесс). В ре&
зультате ваш файл начнет загружаться в сеть BitTorrent.

Используем приложение BitTorrent для распространения видео
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П. Если на вашем компьютере установлена защитная система firewall,
вам придется открыть порты 6969 и 6881&6889. Если вы этого
не сделаете, другие пользователи не смогут подключиться к программе
Azureus и загрузить файл с расширением .torrent или полный файл
фильма. Кроме того, вам понадобится указать фиксированный
IP&адрес или динамичный DNS&адрес вашего компьютера. Вы можете
получить DNS&адрес в службе Dynamic Network Services
(http://www.dyndns.org) или No&IP (http://www.no&ip.com).

При использовании данной методики вы создаете файл .torrent (который тре&
буется другим пользователям для загрузки фильма), а также добавляете его во
встроенную систему отслеживания. На рис. 7.41 показана система отслеживания
Azureus BitTorrent Client Tracker во время загрузки файла.

Если вы хотите сделать так, чтобы ваш файл .torrent обрабатывался нескольки&
ми системами отслеживания, отметьте соответствующее поле флажка. В резуль&
тате вы сможете добавить другие системы отслеживания в новом окне.

Вы можете добавить новые системы отслеживания после создания
файла .torrent. Для этого воспользуйтесь функцией Add Tracker
(Добавить систему отслеживания) программы Azureus: щелкните
по файлу правой кнопкой мыши и выберите пункты меню Tracker ⇒
Add Tracker URL (Добавить URL�адрес системы отслеживания).
Существует большое количество бесплатных систем отслеживания,
с которыми вы можете работать.

Если вы не собираетесь использовать другие сети P2P, например Gnutella2 или
eDonkey2, то можете убрать галочку из поля «Add hashes for other networks»
(«Добавить поддержку для других сетей»).

Рис. 7.41. Пользователи могут загрузить фильм
из программы Azureus

Другие пользователи могут получить доступ к системе отслеживания через
сайт http://your.host.name:6969. Затем они смогут загрузить файл .torrent в свой
клиент BitTorrent, чтобы получить возможность скопировать полный файл филь&
ма. При желании вы можете загрузить файл на свой компьютер, а затем отправить
его по электронной почте своим друзьям, родственникам и коллегам.

Используем общую систему отслеживания
Если для публикации своего файла вы хотите воспользоваться общей системой
отслеживания, вам понадобится создать отдельный файл с расширением .torrent.
Программа Azureus позволяет решить эту задачу.

Используем мастер Creation Wizard
Открыв приложение Azureus, выберите пункты меню File ⇒ Create a Torrent (Со

здать файл .torrent). Откроется окно мастера Creation Wizard, в котором вы смо&
жете выбрать различные опции. На рис. 7.42 показан первый раздел мастера.

Рис. 7.42. Создаем файл .torrent

Используем приложение BitTorrent для распространения видео
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Если вы планируете создать файл .torrent из нескольких фрагментов, нажмите
переключатель Directory (Папка). Если нет, оставьте нажатым переключатель
«Single file» («Один файл»). Этот переключатель должен быть активен при усло&
вии, что вы не собираетесь разбивать файл на отдельные части.

Наконец, если вы хотите добавить в файл .torrent примечания, вы можете ввес&
ти их в текстовом поле Comment (Примечание).

После ввода всей необходимой информации нажмите кнопку Next (Далее).

Выделяем файл
Для того чтобы настроить общий доступ к файлу, вы должны выделить его в про&
грамме Azureus. Выбрав файл, нажмите кнопку Next. После этого вы сможете из&
менить размер фрагментов для распространения файла. Я рекомендую вам при&
менить автоматическую настройку. На рис. 7.43 показаны раздел File и окно кон&
фигурации.

значительно быстрее. На рис. 7.44 показан файл .torrent размером 24 Кб, который
был создан из видеофайла размером 573,1 Мб.

После создания файла .torrent вы должны загрузить его в выбранную ранее си&
стему отслеживания.

Файл .torrent не является видеофайлом. Он представляет собой всего
лишь указатель для вашего видеофайла, который позволяет другим
людям его найти.

Вам по&прежнему необходимо отправить свой файл в сеть Интернет. Убедитесь
в том, что программа Azureus продолжает работать. Приложение Azureus напра&
вит ваш файл другим пользователям и сообщит им о том, что теперь они могут
загружать ваш видеофильм.

Смотри также
• BlogTorrent (http://www.blogtorrent.com; распространяется бесплатно) – это

простая система отслеживания и клиент, который поставляется компанией
Downhill Battle (http://www.downhillbattle.org);

• Prodigem (http://www.prodigem.com; распространяется бесплатно) – это сис&
тема отслеживания и хостинга для файлов BitTorrent.

Совет 87 Как принять участие
в удаленной конференции

Иногда вы просто не можете посетить встречу, конференцию или лекцию. Ис&
пользуя программы Darwin Streaming Server и QuickTime Broadcaster, вы можете
просмотреть лекцию удаленно.

Независимо от того, кто вы – студент или бизнесмен, – время от времени вы не
можете посетить какое&либо важное событие. Если у вас есть друг или коллега,
который будет там присутствовать, вы сможете просмотреть это событие удален&
но. Более того, вы сможете записать архив события и воспроизвести его в любое
удобное время.

Настраиваем воспроизведение
Для воспроизведения конференции вашему коллеге понадобится загрузить и ус&
тановить приложение QuickTime Broadcaster (http://www.apple.com/quicktime/
download/broadcaster; поставляется бесплатно). Во время написания данной кни&
ги программа QuickTime Broadcaster поддерживала только операционную систе&
му Mac OS X. После завершения установки ваш коллега должен запустить прило&
жение QuickTime Broadcaster.

В правом нижнем углу окна Broadcaster появится кнопка Show Details (Показать
детали). Если вы нажмете эту кнопку, откроется панель, которая позволяет изменять

Рис. 7.43. Завершаем создание файла .torrent

Когда вы нажмете кнопку Finish (Завершить),
программа Azureus начнет процесс создания файла
.torrent. Для завершения процесса может потребо&
ваться некоторое время, которое зависит от размера
файла и скорости вашего компьютера. Файл .torrent
намного меньше, чем исходный видеофайл, поэтому
его распространение в сети Интернет происходит

Рис. 7.44. Здесь вы видите размеры
файла .torrent

Как принять участие в удаленной конференции
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настройки параметров Audio (Звук), Video (Видео) и Network (Сеть). В окне кон&
фигурации кнопка Show Details изменяется на Hide Details (Скрыть детали).
На рис. 7.45 показано окно Broadcaster с информацией о конфигурации системы.

ните настройки на определенной вкладке и выберите в ниспадающем меню пунк&
ты Preset ⇒ Save Preset (Сохранить предварительную установку).

В зависимости от скорости Интернет&соединения на компьютере вашего кол&
леги вам необходимо использовать следующие предварительные установки:

• менее 56 Кб. Модем;
• от 56 Кб до 1 Мб. Кабель/DSL;
• свыше 1 Мб. Локальная сеть (LAN).

Например, если скорость загрузки равна 512 Кб, ваш коллега должен выбрать
установку DSL/кабель.

Изменяем настройки звука
Если вы щелкните по вкладке Audio на панели Details, откроется раздел с на&
стройками звука для видеокомпозиции. Как правило, параметры звука более важ&

Рис. 7.45. Конфигурация программы QuickTime Broadcaster

Если вы хотите добиться оптимальных результатов, ваш коллега должен опре&
делить скорость своего Интернет&соединения. Для этого я советую воспользо&
ваться тестом Speed Test от компании DSLReports (http://www.dslreports.com/
stest). На рис. 7.46 показан тест на скорость Интернет&соединения, а на рис. 7.47
вы видите результаты этого теста.

Тест скорости определяет скорость распространения, то есть насколько быстро
данные отправляются с компьютера вашего коллеги в сеть Интернет. Если вы хо&
тите оптимизировать процесс, объем отправленных данных (видео) должен быть
меньше, чем скорость распространения.

Используем предварительные установки
На каждой вкладке имеется ниспадающее меню Preset (Предварительная уста

новка). Это меню содержит список заданных конфигураций для модемных, DSL/
кабельных соединений и соединений через локальную сеть (LAN). Предваритель&
ные установки Audio поддерживают опции Speed (Скорость) и Music (Музыка),
а установки Video содержат шесть опций (передача видео через модем, DSL/ка&
бель и локальную сеть). Кроме того, вы можете создавать новые установки: изме&

Рис. 7.46. Тест загрузки в процессе

Рис. 7.47. Скорость загрузки составляет 1222 Кбит/с.
Этого вполне достаточно для работы с функцией стрим
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ны, чем параметры видео. Ваш коллега должен убедиться в том, что качество запи&
си звука отвечает всем необходимым требованиям.

Качественный микрофон, например микрофон от компании Audio&Technica
(http://www.audio&technica.com) или Sennheiser (http://www.sennheiserusa.com/),
позволяет вам записывать звук с очень высоким качеством. На обычной конфе&
ренции (лектор находится перед аудиторией) вам необходимо использовать вне&
шний микрофон; встроенный микрофон более эффективен для записи звука на
деловой встрече. На рис. 7.48 показана вкладка Audio в программе Broadcaster.

Изменяем настройки видео
Чтобы изменить настройки видео, выберите вкладку Video. Ваш коллега может
изменить существующую предварительную установку или создать новую. В нис&
падающем меню Source (Источник) содержится список доступных устройств
(если к компьютеру подключено несколько камер). На рис. 7.49 показана вкладка
Video, а также параметры конфигурации.

Рис. 7.48. Используем предварительную установку LAN)Speech
для работы со звуком

Самые важные настройки на вкладке Audio относятся к разделу Compression
(Сжатие). В ниспадающем меню Compressor вам доступно большое количество
опций. Если вы собираетесь просматривать конференцию в другой программе (не
в QuickTime), вы должны убедиться в том, что ваш видеоплеер совместим со стан&
дартом MPEG&4, а меню Compressor настроено как MPEG
4 Audio.

Выбор формата зависит исключительно от ваших предпочтений. Как правило,
опции Qualcomm PureVoice и MPEG
4 позволяют вам добиваться высоких ре&
зультатов. В зависимости от выбора вы сможете изменить такие настройки, как
Rate (Частота), Size (Размер) и Mono/Stereo (Моно/Стерео). Выберите для
этих параметров значения 32 КГц, 16 бит и Mono соответственно.

Рис. 7.49. Вкладка конфигурации Video в программе Broadcaster

Настройки Width (Ширина) и Height (Высота) позволяют вам изменить вне&
шние размеры видеоизображения. Если вы уменьшите размеры изображения
(примерно в два раза), как правило, это позволит вам сохранить приемлемое ка&
чество, а также даст возможность увеличить скорость передачи данных. Напри&
мер, формат NTSC DV имеет разрешение 720 × 480; если вы уменьшите разреше&
ние в два раза, оно составит 360 × 240. Следите за тем, чтобы полученное разреше&
ние можно было разделить на четыре.

Ниспадающее меню Compressor содержит большое количество кодеков (алго&
ритмов сжатия информации). Программа QuickTime включает стандартный на&
бор кодеков; в сети Интернет вам доступны кодеки, которые поставляются дру&
гим компаниями. Из стандартных кодеков я рекомендую вам использовать
Sorenson, MPEG&4 или H.263. Некоторые кодеки содержат кнопку Options, кото&
рая дает доступ к дополнительным настройкам.

Как принять участие в удаленной конференции
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С. Новый кодек MPEG&4 Part 10 (также его называют H.264 или AVC)
обеспечивает изображение высокого качества при относительно
невысокой скорости передачи данных. Если у вас есть возможность
поэкспериментировать с этим кодеком, я советую вам так и посту&
пить.

Параметр Quality (Качество) с диапазоном от Least (Самое низкое) до Best
(Самое высокое) воздействует на общее качество изображения; при выборе зна&
чения Least эффект сжатия данных будет проявляться особенно сильно. Чем
выше значение данного параметра, тем более высокие требования предъявляются
к скорости загрузки информации.

Изменение частоты смены кадров (кадров/с) поможет вам снизить эти требо&
вания. Многих пользователей вполне устроить частота 7–8 кадров/с; значение
12–15 кадров/с позволяет сохранить неплохое качество изображения при невы&
сокой скорости передачи данных. Если скорость загрузки вашего соединения спо&
собна поддерживать частоту смены кадров 30 кадров/с для NTSC или 25 кадров/
с для PAL, не следует уменьшать значение данного параметра.

Кодек использует ключевые кадры, чтобы определить, как часто нужно семп&
лировать кадр видео, который будет применяться в последующих расчетах. Чем
больше ключевых кадров содержит композиция, тем выше качество видео. С дру&
гой стороны, чем больше ключевых кадров, тем выше требования к скорости за&
грузки данных.

Значение данного параметра зависит от частоты смены кадров; в целом я сове&
тую вам стремиться к тому, чтобы в вашем видео один ключевой кадр приходился
примерно на диапазон от 1,5 до 3 с.

Наконец, такой параметр, как скорость передачи данных, оказывает наиболь&
шее влияние на скорость загрузки для соединения. При вводе значения для дан&
ного параметра вам необходимо учитывать как скорость загрузки, так и скорость
передачи аудиоданных (помните о том, что вы передаете не только изображение,
но и звук). Я советую вам применять традиционную методику расчета: если ско&
рость загрузки составляет 1 Мб, скорость передачи данных должна ограничивать&
ся значением 500 Кбит/с.

Изменяем сетевые настройки
На вкладке Network (Сеть) вы вводите параметры сервера стрим, а также различ&
ные примечания, например сведения об авторских правах. Если у вас уже есть до&
ступ к серверу стрим, конференцию смогут просматривать одновременно не&
сколько человек. Если доступа у вас пока нет, вам придется настроить свой соб&
ственный сервер стрим (см. совет 85), получить к нему доступ или ограничиться
тем, что смотреть конференцию будет только одни пользователь. На рис. 7.50 по&
казана вкладка конфигурации Network.

Если ваш коллега собирается отправить видео в режиме стрим одному пользо&
вателю (то есть вам), выберите пункты меню Transmission ⇒ Manual Unicast (Пе

редача ⇒ Вручную), чтобы получить доступ к конференции. В поле Address (Ад


рес) введите IP&адрес компьютера&получателя (вашего), как показано на рис.
7.50. Вы можете изменить настройки Audio Port (Аудиопорт) и Video Port (Ви

деопорт) при условии, что получающий компьютер защищен системой firewall;
настройки по умолчанию должны функционировать в большинстве случаев.

Если для распределения видео ваш коллега будет использовать сервер стрим,
он должен выполнить команду Transmission ⇒ Automatic Unicast (Automatic).
Для параметра Host Name (Название хоста) введите название домена или IP&ад&
рес сервера стрим. Для параметра File выберите значение, которое соответствует
названию видео, например «mystream».

Значения параметров Username (Имя пользователя) и Password (Пароль)
должны совпадать со значениями, которые вы как администратор сервера ввели
в разделе конфигурации. Если вам нужны отдельные учетные записи пользовате&
лей, вы можете их создать на сервере стрим.

Параметр Buffer Delay (Задержка буфера) предоставляет объем памяти кэш
для обработки материала. Например, если в поле Buffer Delay вы введете значение
7, между моментом записи и моментом воспроизведения аудио и видео будет до&
бавлена задержка в семь секунд. Благодаря задержке доступный материал сохра&
няется в сети.

Начинаем воспроизведение
После настройки всех параметров ваш коллега должен нажать кнопку Broadcast
(Воспроизведение), чтобы начать воспроизведение.

Рис. 7.50. Сетевые настройки для приложения Broadcaster
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Если вы являетесь единственным зрителем, вам необходимо загрузить с основ&
ного компьютера файла с расширением .sdp. Чтобы создать такой файл, выполни&
те команду File ⇒ Export ⇒ SDP в программе QuickTime Broadcaster и введите
название полученного файла, к примеру mystream.sdp. Затем вы сможете отпра&
вить полученный файл по электронной почте или загрузить его на сервер. Когда
вы получите файл .sdp, откройте его в программе QuickTime. Файл содержит ин&
формацию, которая необходима приложению QuickTime Player для воспроизве&
дения видео в формате стрим.

Если вы используете сервер стрим, любой пользователь сможет получить к не&
му доступ по адресу: rtsp://my.host.com/mystream.sdp, где «my.host.com» – это на&
звание сервера стрим, а «mystream.sdp» – это название файла с расширением .sdp,
указанное в разделе Network программы QuickTime Broadcaster.

Разумеется, для того чтобы просмотреть конференцию, вам понадобится по&
стоянно контактировать с вашим коллегой.

Архивируем видео
Если ваш коллега работает с цифровой видеокамерой, он может записать конферен&
цию на пленку в режиме реального времени. После завершения конференции вы смо&
жете оцифровать материал и отправить его в сжатом формате на сервер стрим (совет
83). Данная методика позволяет добиться максимально высокого качества.

Если ваш коллега пользуется Web&камерой или просто забыл взять с собой кас&
сету, он может выбрать команду Record to disk (Записать на диск) в разделе пара&
метров программы QuickTime Broadcaster. Если вы запишите видео на диск, на
компьютере вашего коллеги появится тот самый файл, который отправляется на
сервер стрим. Затем ваш коллега сможет передать видеофайл на сервер стрим.

Программа QuickTime Broadcaster содержит ошибку, которая проявля&
ется в случае, если вы в течение длительного периода времени ведете
запись на жесткий диск объемом свыше 2 Гб. Если вы собираетесь
закодировать видео, продолжительность воспроизведения которого
превышает 15 мин, разбейте диск на разделы объемом 2 Гб или создай&
те виртуальный диск с помощью программы Disk Utility.

Заархивированное видео станет доступно сразу после того, как вы сохраните
его в папке на сервере стрим.

Совет 88 Воспроизведение видео на КПК

Если у вас ест КПК (мобильный телефон или органайзер), вы сможете просмат&
ривать свои видеофайлы в любой точке земного шара.

Платформа Pocket PC поддерживается устройствами PDA, мобильными теле&
фонами и КПК. Это универсальная система, которая может работать с документа&

ми в формате Microsoft Excel и Word, отправлять и получать электронную почту,
а также выполнять поиск в сети Интернет. Если вы закодируете фильм в нужном
формате, то сможете воспроизвести его на любом из вышеперечисленных уст&
ройств. Для кодировки видео в формате платформы Pocket PC я советую вос&
пользоваться приложением Windows Movie Maker.

Запись материала
Существуют две методики записи видео для последующего воспроизведения
в среде Pocket PC; выбор методики зависит от того, на какой стадии процесса ре&
дактирования вы решили записать такую композицию. Если вы только приступа&
ете к работе над проектом, который предназначен исключительно для платформы
Pocket PC, то можете выбрать для записи материала один из профилей Pocket PC.
На рис. 7.51 показано диалоговое окно Capture (Запись) для программы Windows
Movie Maker, в котором мы выбрали профиль Pocket PC.

Рис. 7.51. Был выбран профиль Pocket PC

Если вы собираетесь работать и с другими носителями информации, например
с видеопленкой, DVD (совет 79) или форматом сети Интернет (совет 82), запиши&
те исходный материал с самым высоким разрешением (допустим, DV&AVI). Это

Воспроизведение видео на КПК
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позволит вам впоследствии конвертировать ваше видео в формат с более низким
качеством. Учтите, что конвертировать видео в формат с более высоким каче&
ством без существенного ухудшения результатов невозможно.

Представьте себе ваше видео высокого качества в виде полного стакана
с водой. Если вы перельете воду в стакан меньшего размера (выполните
конвертирование со снижением качества), этот стакан тоже будет
полон. Если вы затем отдадите второй стакан кому&либо, вряд ли
у него возникнут вопросы. Но если вы возьмете небольшой стакан воды
и перельете воду из него в первый стакан (конвертирование с улучше&
нием качества), а затем отдадите его другому человеку, скорее всего,
он спросит вас, почему вы дали ему неполный стакан.
Вы, наверное, уже отпили из этого стакана и просто просите подер&
жать его? Или вы хотите, чтобы другой человек его помыл? Ваш
знакомый чувствует себя при этом некомфортно, что явно не соот&
ветствует вашим ожиданиям.

После того как вы запишите и отредактируете свой материал, вы должны его
экспортировать.

Экспорт материала для платформы Pocket PC
В главном окне программы Windows Movie Maker выполните команду Finish
Movie ⇒ Save to my computer (Сохранить на моем компьютере). Откроется диа&
логовое окно, в котором вас попросят ввести название для фильма, а также вы&
брать папку на жестком диске, в которой он будет сохранен. Введите нужную
информацию и нажмите кнопку Next. Далее вы сможете выбрать профиль для
сохранения вашего фильма. Если вы изначально записали материал с использова&
нием профиля Pocket PC, то можете сохранить настройки по умолчанию и нажать
кнопку Next.

Если вы записали видео с высоким качеством изображения, например DV&AVI,
вы должны нажать кнопку Show more choices (Дополнительно), а затем выбрать
переключатель Other settings (Другие настройки). Откроется ниспадающее
меню выбора профиля. По умолчанию это меню содержит три профиля Pocket
PC; выберите профиль в соответствии с вашим потребностями. На рис. 7.52 пока&
зан профиль Video for Pocket PC (полноэкранное изображение, 218 Кбит/с).

Выберите нужный профиль и нажмите кнопку Next. Программа Windows
Movie Maker автоматически приступит к созданию фильма. После завершения
процесса вы сможете открыть видео в приложении Windows Movie Player и прове&
рить качество изображения. Если результат является неудовлетворительным,
вам необходимо вернуться и выбрать другой профиль Pocket PC.

Выбираем кодек и файловый формат
Если у вас нет программы Windows Movie Maker, вам придется конвертировать
видео (см. совет 29) в формат, который поддерживается платформой Pocket PC.

Чаще всего для работы в среде Pocket PC используется приложение Windows
Media Player, которое может воспроизводить практически любой файл с расшире&
нием .wmv.

Существует большое количество различных мультимедиа плееров,
которые могут работать с разнообразными файловыми форматами
и кодеками, включая MPEG&4 и QuickTime. Приведу лишь несколько
примеров:
• Beta Player (http://betaplayer.corecodec.org; распространяется

бесплатно);
• PictPocket Cinema (http://www.digisoftdirect.com; стоит 39,95 долл.

США);
• PocketTV (http://www.pockettv.com; стоит 49,95 дол. США).

Рис. 7.52. Экспортируем видео для платформы Pocket PC

Воспроизведение видео на КПК
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Отправка вашего видеофайла
Существует два основных способа доставки видеофайла на ваше устройство.
Во&первых, вы можете использовать приложение ActiveSync, которое должно
входить в комплект поставки устройства. Если у вас нет этого приложения, вы
можете загрузить его с Web&сайта Microsoft Windows Mobile по адресу: http://
www.microsoft.com/windowsmobile/downloads/default.mspx.

Во&вторых, вы можете передать видеофайл на устройство с помощью карты па&
мяти. Используя устройство для чтения карт памяти, вы можете скопировать
файл на карту, а затем установить ее в свое устройство. Преимущество этого спо&
соба заключается в том, что он работает намного быстрее, чем приложение
ActiveSync, особенно для больших файлов.

Итак, если вы уже сняли видео, которым собираетесь удивить Стивена Спил&
берга (Steven Spielberg), запишите его на свое мобильное устройство. Если вы ког&
да&нибудь его встретите, успех вам обеспечен.

Совет 89 Воспроизведение фильма
на мобильном телефоне

Некоторые мобильные телефоны поддерживают функцию просмотра видео на
экране. Здесь мы поговорим о том, как вы можете конвертировать свое видео для
воспроизведения на мобильном телефоне.

Цифровые видеофайлы занимают очень много дискового пространства. В фор&
мате DV для записи одного часа материала вам потребуется 14 Гб на жестком дис&
ке. Если вы хотите воспроизвести видео на мобильном телефоне, вы должны вы&
полнить конвертирование данных в другой формат.

Используем приложение QuickTime Pro
На рынке имеется большое количество программ, которые предназначены для им&
порта и экспорта цифрового видео. Среди них я хотел бы отметить приложение
QuickTime Pro от компании Apple Computer, отличающееся весьма умеренной ценой.
Эта программа изначально разрабатывалась для операционных систем Windows и
Macintosh; после установки обновления CrossOver (http://www.codeweavers.com;
стоит 39,95 долл. США) вы сможете запустить ее в среде Linux или Solaris.

Одно из преимуществ программы QuickTime Pro состоит в том, что она может
экспортировать фильмы в формате, который поддерживается мобильными теле&
фонами. Это такие форматы, как 3GPP или 3GPP2. Данные стандарты были со&
зданы компанией 3rd Generation Partnership Project (3GPP; отсюда и пошло назва&
ние формата). Экспорт данных в формат 3GPP стал возможен после выхода об&
новления версии 6.3 программы QuickTime.

Если ваша система редактирования может работать с программой
QuickTime, значит, у вас есть возможность экспортировать шкалу
времени в формат 3GPP с помощью движка QuickTime.

Установка обновления QuickTime Pro
Даже если вы уже установили приложение QuickTime на своем компьютере, ско&
рее всего, функции обновления Pro еще не были активированы в вашей системе.
Для активации вам необходимо купить лицензионный ключ у компании Apple
(http://www.apple.com/quicktime/buy/). После оплаты вы получите свой личный
ключ, который используется для разблокировки функций Pro.

В результате вы сможете не только записывать фильмы для мобильных теле&
фонов, но и выполнять простое редактирование (совет 39), создавать скины (со&
вет 76), а также воспроизводить фильмы в полноэкранном режиме. Для этого вы
должны ввести свой личный ключ в окне QuickTime Registration (Регистрация
программы QuickTime).

Открываем фильм
Откройте в программе QuickTime Player тот фильм, который вы собираетесь кон&
вертировать. Для начала я советую вам выбрать небольшой видеоклип; это связа&
но с тем, что процесс займет определенное время. Выберите пункты меню File ⇒
Open Movie in New Player (Открыть фильм в новом плеере) и найдите нужный
файл на своем компьютере.

Конвертируем фильм
Вам необходимо экспортировать фильм. Чтобы начать процесс, выполните ко&
манду File ⇒ Export (Экспортировать). Откроется диалоговое окно, которое по&
казано на рис. 7.53. Введите название для фильма и выберите в ниспадающем
меню Export пункт Movie to 3G (Фильм в формат 3G). На рис. 7.53 показаны
выбранные настройки в диалоговом окне.

Рис. 7.53. Экспортируем видеофайл в формат 3G

Перед тем как выбрать опцию Save (Сохранить), вы должны нажать кнопку
Options и просмотреть список доступных опций.

Изменяем настройки по умолчанию
Опции экспорта данных в формат 3G включают такие опции, как Video (Видео),
Audio (Аудио), Text (Текст), Streaming (Стрим) и Advanced (Дополнительно).

Воспроизведение фильма на мобильном телефоне
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Изменение этих настроек повлияет на размеры конечного файла, а также на его
соответствие стандартам 3GPP.

Благодаря списку Conformance (Соответствие) вы сможете определить, отве&
чает ли ваш файл требованиям формата 3GPP после внесения изменений или нет.
На рис. 7.54 показано окно 3G Export Settings (Настройки для экспорта в фор

мат 3G).

Особое внимание следует уделить вкладке Advanced, которая дает вам воз&
можность добавить в фильм некоторые ограничения. Например, если вы выберете
один из форматов EZmovie, то можете сконфигурировать фильм таким образом,
чтобы он воспроизводился только на том мобильном телефоне, на который он был
установлен.

Если вы хотите создать фильм более высокого качества, проще всего увеличить
скорость передачи данных. Однако это, в свою очередь, приведет к увеличению
размеров файла. Так как данный видеоклип предназначен для воспроизведения
на мобильном телефоне, его размеры должны быть небольшими. Попробуйте по&
экспериментировать с различными настройками, чтобы определить оптимальное
соотношение качество –размер файла.

Новый кодек MPEG&4 Part 10 (также его называют H.264 или AVC)
воспроизводит достаточно качественное видеоизображение при отно&
сительно невысокой скорости передачи данных. Этот кодек является
международным стандартом. В ближайшем будущем многие мобиль&
ные телефоны смогут воспроизводить файлы в формате H.264.

После завершения изменений нажмите кнопку OK. Затем вы сможете сохра&
нить свой фильм. Вы можете выбирать различные настройки, чтобы определить,
как они влияют на размеры файла, качество изображения и звука.

Помните о том, что мобильные телефоны имеют значительные ограничения по
объему информации, которую они могут хранить. По своему опыту могу сказать:
пользователи смирятся с невысоким качеством изображения, если их устроит
звук, но не наоборот.

Ваши файлы должны быть максимально небольшого размера, но при этом ка&
чество изображения необходимо сохранить на приемлемом уровне.

Распространение вашего фильма
Итак, как же отправить фильм на мобильный телефон?

• по электронной почте. Если ваш мобильный телефон может получать элект&
ронную почту, это значит, что вы сможете отправить видеофайл на телефон
из вашего почтового клиента;

• через карту памяти. Если ваш телефон оснащен картой памяти, вы можете
скопировать на нее свой видеофайл;

• через устройство Bluetooth. Если компьютер и мобильный телефон обору&
дованы устройствами Bluetooth, вы можете отправить файл через беспровод&
ное Bluetooth&соединение;

• через сеть Интернет. Если ваш телефон подключен к сети Интернет, а у вас
есть свой Web&сайт, вы можете загрузить видео на свою Web&страницу.

Рис. 7.54. Окно 3G Export Settings

Обратите внимание на ниспадающее меню File Format (Файловый формат)
в верхней части окна 3G Export Settings. Это меню содержит следующие пункты:
3GPP, 3GPP2, 3GPP (Mobile MP4), 3GPP2 (EZmovie) и AMC (EZmovie). Вы&
брав один из пунктов меню, вы сможете активировать или отключить определен&
ные функции. Я рекомендую вам потратить некоторое время на изучение данного
меню и всех доступных опций.

Воспроизведение фильма на мобильном телефоне
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Если у вас есть сервер стрим (совет 85), который поддерживает
формат 3GPP, вы сможете поместить файл 3GPP на сервере. Затем
другие пользователи смогут воспроизводить ваш фильм по запросу.

Воспроизведение фильма
Отправив фильм на мобильный телефон, запустите мультимедиа&плеер устрой&
ства и наслаждайтесь своим небольшим по размеру, но довольно качественным
для своего формата видеоклипом.
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Ну что же, в предыдущих главах мы очень серьезно рассказали вам о процессе
создания, редактирования и распространения видеокомпозиций. Советы из дан&
ной главы можно использовать для обычных проектов, но в первую очередь они
предназначены для развлечения (я не хочу этим сказать, что другие разделы этой
книги скучные и однообразные). Получайте удовольствие!

Совет 90 Записываем видеострим

Благодаря таким устройствам, как VCR и PVR, мы теперь можем записывать ви&
деоматериал в режиме реального времени. Используя приложение VLC, вы смо&
жете записывать видео в режиме стрим.

Вы не можете постоянно сидеть и смотреть видеострим. Если воспроизведение
производится в режиме реального времени, у вас возникает проблема, потому что
вы не можете отойти и сделать паузу. С помощью программы VLC (http://www.
videolan.org; поставляется бесплатно) вы можете сохранить видеострим и про&
смотреть его в любое удобное время.

Поиск видеострим
Любой видеострим в сети Интернет имеет свой адрес. Если вы хотите, чтобы про&
грамма VLC смогла найти видео, вы должны знать его полный адрес. Такой адрес
обычно начинается с «rtp» или «rtsp» и имеет примерно такой же формат, как и
обычный URL&адрес.

Скорее всего, адрес видео также включает расширением, которое указывает на
формат файла. Например, адрес rtsp://www.domain.com/some_movie.mp4 указы&
вает на наличие видеофайла с названием some_movie.mp4. Если вы будете знать
расширение файла, это поможет вам в дальнейшем.

Как только вы определите адрес видеострим, вам понадобится настроить про&
грамму VLC таким образом, чтобы она открыла файл и сохранила его на жестком
диске вашего компьютера.

Открываем видеострим
В программе VLC выберите пункты меню File ⇒ Open Network Stream (Win&
dows) или File ⇒ Open Network (Mac). Откроется новое окно, в котором вы смо&
жете ввести информацию, необходимую для поиска видеострим. Выберите вклад&
ку Network (если она еще не была активирована).

Сначала выделите протокол, который зависит от используемого вами адреса.
Если адрес начинается с букв «rtsp://», нажмите кнопку RTSP. Затем введите ад&
рес видеострим в текстовом поле URL или Address. Вы можете ввести адрес, не
выбирая при этом протокола, однако данная методика не всегда приводит к успе&
ху. На рис. 8.1 показан процесс настройки программы VLC для видео RTSP по
адресу: rtsp://192.168.1.102:554/sample_300kbit.mp4.

После ввода адреса вы должны сохранить видеострим в файл. Для этого выбе&
рите поле флажка Stream output (Windows) или Advanced output (Mac). В ре&
зультате будет активирована кнопка Settings.

Сохраняем видеострим
Когда вы нажмете кнопку Settings, откроется новое окно, в котором вы можете
указать, что следует сделать с видеофайлом. Так как вы хотите сохранить видео,
щелкните по полю флажка File. Если вы хотите просмотреть видео во время со&
хранения (я советую вам так и поступить), щелкните по полю флажка Play locally
(Воспроизводить локально).

Для сохранения видео вам необходимо указать имя файла. Кнопка Browse
(Найти) позволяет вам выбрать папку для сохранения файла на жестком диске
вашего компьютера, а также ввести имя файла. Я рекомендую вам использовать
название, которое совпадает с названием файла в адресе. Например, если файл
называется some.movie.mp4, введите такое же название для видео при сохранении.

Затем выберите методику сжатия данных, которая должна соответствовать
файловому формату и кодеку видеострим. Здесь вам очень поможет информация
о расширении файла (совет 77). Оптимального результата можно добиться в слу&
чае, если тип сжатия совпадает с форматом файла. На рис. 8.2 показан список до&
ступных опций.

После завершения настройки нажмите кнопку OK. Повторно нажмите кнопку
OK, чтобы открыть окно Open (Открыть). Программа VLC обработает видео&

Рис. 8.1. Мы настраиваем программу VLC
для открытия видеофайла RTSP

Записываем видеострим
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стрим и сохранит его на жестком диске вашего компьютера. Если вы выбрали оп&
цию Play locally, одновременно начнется процесс воспроизведения видео.

Просмотр видео после сохранения
Вы можете просмотреть видеострим точно так же, как и любой другой видео&
файл. В зависимости от конфигурации вашего компьютера программа VLC мо&
жет не быть настроена как приложение по умолчанию для открытия различных
видеофайлов. Если вы обнаружите, что сохраненный файл не открывается в ва&
шем видеоплеере, попробуйте открыть его в программе VLC. Как правило, файл
должен открыться без особых проблем. Сохраненные файлы могут открываться
и в других приложениях, например Windows Media Player или Apple QuickTime,
однако наилучших результатов вы сможете добиться  только с помощью про&
граммы VLC.

Совет 91 Создаем фильм с помощью игрушек
LEGO

Используя специализированное программное обеспечение (и игрушки LEGO),
вы можете создать фильм с минимальными расходами.

Фильмы с остановкой анимации (stop&motion movies) содержат неподвижные
объекты, такие как модели персонажей. При съемке фильма модель постепенно
перемещается через кадр. В качестве примеров таких фильмов можно привести
такие проекты, как «Gumby and Pokey», «Wallace and Gromit» и «Celebrity Death&
match».

Даже если вы не умеете рисовать, вы сможете создать свой анимационный
фильм. Вы даже можете использовать пластмассовые модели персонажей. Для
примера возьмите мои любимые детские игрушки, LEGO.

Вместо LEGO вы можете использовать любые другие пластмассовые
игрушки.

Подготовка
Вам необходимо заранее определить жанр, в котором вы собираетесь работать.
Ковбой в научно&фантастическом фильме будет выглядеть достаточно странно
(разумеется, если вы не планируете снять научно&фантастический вестерн). Если
у вас уже есть игрушки LEGO, вы можете спланировать свой проект соответст&
вующим образом.

Одно из преимуществ использования моделей LEGO состоит в том,
что ими намного проще управлять, чем людьми. И они не едят так
много.

В зависимости от ваших амбиций (и вашего бюджета) вы можете создать рас&
кадровку (совет 6), которая значительно упростит рабочий процесс. Кроме того,
вам понадобится цифровая видеокамера, специализированное программное обес&
печение, а также место для проведения съемок. Снимать анимированные фильмы
очень трудно, поэтому выбор места съемки имеет огромное значение.

Программное обеспечение не является обязательным требованием, однако оно
сделает вашу работу более эффективной. Такое программное обеспечение доступ&
но для операционных систем Macintosh и Windows. В среде Mac OS X вы можете
использовать программу iStopMotion от компании Boinx, а в среде Windows –
программу Stop Motion Pro от компании с таким же названием.

• Boinx. Компания – издатель приложения iStopMotion для операционной си&
стемы Mac OS X (http://www.istopmotion.com; стоит 39,95 долл. США);

Рис. 8.2. Настраиваем процесс сохранения файла
в приложении VLC

Создаем фильм с помощью игрушек LEGO
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• Stop Motion Pro. Компания – издатель приложения Stop Motion Pro для опера&
ционной системы Windows 98 SE или ME, XP и 2000 (http://www.stopmotionpro.
com; стоит 249 долл. США).

Создаем обстановку для съемок
Выбор места для съемок может оказаться решающим фактором, который непосред&
ственным образом отразится на успешности вашего проекта. Если ваши друзья или
родственники будут постоянно появляться в кадре, а освещение будет нестабиль&
ным, ваша композиция окажется провальной. Представьте себе: ваша любимая
кошка неожиданно прыгает на главного персонажа и уносит его неизвестно куда.

Фоновое изображение может значительно улучшить общее впечатление от ва&
шего фильма. Учтите, что если вы собираетесь снять проект, который состоит из
нескольких сцен, вам необходимо постоянно изменять фон композиции.

Освещение
Тот факт, что вы снимаете обычные игрушки, еще не означает, что вам не нужно
заботиться об освещении сцены. Вы можете использовать ваши домашние све&
тильники, новогоднюю елку, фонарики или любые другие источники освещения.
Помните о том, что после установки этих источников перемещать их нельзя!

Из этого правила можно сделать исключение, например в случае, если
вы снимаете определенный световой эффект, такой как заход солнца.

Верите или нет, но, освещая игрушки LEGO, вы можете многому научиться.
Безусловно, вы имеете дело с небольшой композицией, однако общие правила ра&
боты с освещением сохраняются неизменными.

Камера
После выбора места для съемки и настройки освещения вы должны установить
камеру. Вот это да! Небольшие игрушки на камере кажутся огромными! Скорее
всего, вам придется изменить положение объектов в сцене в соответствии с на&
стройками вашей камеры.

Вы очень скоро заметите, что ваши предположения о том, как должна выгля&
деть сцена на камере, совершенно не соответствуют действительности. Вероятно,
вам понадобится поместить игрушки ближе друг к другу, повернуть их под дру&
гим углом, чтобы создать иллюзию того, что они «смотрят» друг на друга, и даже
заменить одни предметы обстановки другими, меньшими по размеру. Как это ни
странно, но примерно такие же изменения вам приходится вносить и в самую
обычную сцену.

Мотор!
Запаситесь терпением, потому что для съемок анимационного фильма требуется
очень много времени. Вам придется снимать композицию кадр за кадром, как по&
казано на рис. 8.3. Если вы собираетесь воспроизводить фильм на телевизионном

экране, вы должны записывать 30 кадров в секунду (или 25 в стандарте PAL). Пу&
тем несложных расчетов можно определить, что для фильма продолжительно&
стью три минуты вам необходимо записать 5400 кадров. Немало.

Вышеперечисленные программы поддерживают функцию, которая называется
«принцип тонкой бумаги» (onion skinning). Эта функция позволяет вам видеть от&
снятые кадры в процессе работы. Следовательно, вы можете быть уверенными
в том, что вы не снимите одно и то же движение дважды. Данная опция смешивает
предыдущие кадры с текущим кадром (см. рис. 8.4).

Для освоения «принципа тонкой бумаги» вам может потребоваться определен&
ное время, но результат стоит затраченных усилий.

Рис. 8.3. Для формирования этого движения вам нужны три кадра

Рис. 8.4. Благодаря «принципу тонкой бумаги»
вы можете видеть на экране предыдущие кадры фильма

Создаем фильм с помощью игрушек LEGO
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Остаемся в рамках
Программы Boinx и iStopMotion предлагают еще одну мощную функцию, нало&
жение. Данная функция рисует вокруг вашего изображения рамку (на расстоянии
примерно 15% от внешней границы кадра). В приложении Stop Motion Pro эта
рамка называется TV Safe Zone, а в приложении iStopMotion – Action Safe.

В данной области ваши зрители гарантированно увидят то, что происходит на
экране. Если вы планируете воспроизводить свой фильм на телевизионном экра&
не, вам необходимо учесть этот факт и не записывать события, которые имеют
место вне границ области Action Safe. Если вы собираетесь распространять свой
проект исключительно в сети Интернет, данное ограничение не должно вас беспо&
коить. На рис. 8.5 показано окно программы StopMotionPro с активной функцией
TV Safe Zone.

Совет 92 Как «видеть сквозь стены»

Используя переносную беспроводную видеокамеру в комплекте с переносным
телевизором, вы можете выполнять съемку из труднодостижимых мест.

X10 Corporation XCam2 (http://www.x10.com/products/vk45a_how.htm; стоит
70 долл. США) – это беспроводная цветная видеокамера, которая отправляет сиг&
нал на базу, подключенную к телевизору, видеомагнитофону или дигитайзеру.
Мне удалось найти этой камере применение, которое делает ее практически неза&
менимым устройством для домашней видеосъемки.

Когда я покупал камеру, я получил в комплекте с ней бесплатную батарею
XCam2 (http://www.x10.com/products/x10_zb10a.htm; стоит 20 долл. США);
впрочем, мне почти не пришлось ею пользоваться. Батарея устанавливается на
камере и позволяет переносить ее без необходимости подключения к источнику
питания.

Рабочий диапазон камеры XCam2 составляет около 100 м. Однако
эта камера работает на таких же частотах, что и домашние микро&
волновые печи, мобильные телефоны и оборудование WiFi. В результа&
те могут возникнуть конфликты, которые уменьшают диапазон
восприятия сигналов от камеры. Поэкспериментируйте с выбором
канала (камера имеет два канала) и определите оптимальное рабочее
сочетание.

Я использую камеру XCam2 с батареей в случае, если работаю один, веду съем&
ку из&за угла и не знаю точно, что происходит за стеной. Иногда я устанавливаю
свою камеру на штатив, чтобы ее зафиксировать (http://www.x10.com/products/
x10_zt10a.htm; стоит 17 долл. США).

Ресивер камеры XCam2 подсоединяется к LCD&телевизору диаметром 5 дюй&
мов, который я купил в Интернет&магазине за 130 долл. США. Ресивер и телеви&
зор помещаются в пластиковый корпус, в котором я просверлил отверстие для ан&
тенны. Кроме того, на корпусе установлена металлическая ручка для переноски.

Итак, теперь я могу в любое удобное время вести съемку в любой точке моего
дома. Это самое удобное устройство, которое у меня когда&либо было. Оно помо&
гает мне даже в случае, если мне нужно прикрепить листки тонкой бумаги к вен&
тиляционным отверстиям в стене. Я устанавливаю камеру таким образом, чтобы
она могла «видеть» отверстия, а затем определяю правильное положение для бу&
маги. И все это можно сделать, не покидая уютного кресла возле камина.

Данная методика может применяться и для идентификации розеток и рубиль&
ников. Подключите к цепи лампу и направьте на нее камеру. Возьмите с собой
монитор и подойдите к электрическому щитку. В результате вы сможете без труда
определить, какой именно рубильник отключает эту цепь.

Рис. 8.5. Область TV Safe Zone выделяется полем
в форме прямоугольника

Некоторые телевизоры (особенно устаревших моделей) имеют на экране кри&
вую линию, которая обрезает границу изображения. В зависимости от модели и
производителя телевизора местоположение этой кривой может различаться. По&
этому независимо от того, снимаете ли вы анимационный или полноценный ви&
деофильм, я рекомендую вам оставаться в рамках области TV Safe Zone.

Как «видеть сквозь стены»
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Более того, я использую камеру в ситуации, когда мне нужен совет другого че&
ловека. Вместо того чтобы описывать ситуацию словами, я беру камеру и отправ&
ляю изображение своему отцу через сеть Интернет. Для этого я прибегаю к помо&
щи программного обеспечения XRay Vision (http://www.x10.com/products/
xrayvision_software5.htm; поставляется бесплатно) и адаптера видео&USB (http:/
/www.x10.com/products/x10_va11a.htm; стоит 70 долл. США). Теперь у меня есть
все, что нужно: мнение эксперта и вторая пара глаз!

Совет 93 Машина, взятая напрокат,
и другие автомобильные хитрости

Видеокамера поможет вам доказать, что не вы повредили машину, взятую напро&
кат. А если вы попадете в аварию, камера зафиксирует все, что произошло.

Как вы, наверное, уже поняли, многие советы, связанные с видеокамерами, от&
носятся и к мобильным телефонам. Камера мобильного телефона уникальна тем,
что она постоянно находится с вами, даже в моменты, когда вы берете машину
напрокат или попадаете в дорожно&транспортное происшествие.

Проверка машины, которую вы берете напрокат
Во многих прокатных компаниях сотрудники вместе с вами проводят предва&

рительный осмотр автомобиля. Я советую вам достать свой мобильный телефон и
сфотографировать все царапины и повреждения на кузове машины. Обязательно
попросите сотрудника компании подписать эти фотографии, чтобы получить сви&
детельство того, что они относятся именно к этому автомобилю.

Сделайте еще несколько снимков: один для передней части автомобиля с левой
стороны и другой – для задней части автомобиля с правой стороны. Попросите
сотрудника компании подписать и эти снимки. Сфотографируйте его на фоне ав&
томобиля. Постарайтесь выполнять снимки быстро, чтобы не помешать обычно&
му рабочему процессу в компании.

Когда вы будете возвращать машину, возьмите фотографии с собой, чтобы до&
казать, что вы ее не повредили. Сфотографируйте себя рядом с автомобилем.
Если сотрудник соглашается взять машину обратно, сделайте его снимок на фоне
автомобиля. В результате вы получите документальные свидетельства того, что
вы вернули машину в хорошем состоянии.

Документация дорожно)транспортного происшествия
Никому не нравится попадать в дорожно&транспортные происшествия, однако
они случаются каждый день. После того как вы пообщаетесь с другим человеком и
обменяетесь информацией о страховках, возьмите свой мобильный телефон и
сделайте несколько снимков (см. рис. 8.6).

Сначала снимите сцену целиком, включая местоположение автомобилей, при&
чиненный ущерб, состояние дороги, разметку и прочие важные элементы. Обяза&

тельно зафиксируйте место столкновения, особенно
если один из автомобилей пересек разметку или бордюр.

Вы даже можете сделать несколько фотографий до&
рожно&транспортного происшествия, в котором вы были
свидетелем, а не участником. Свяжитесь с полицией и
сообщите о том, какой информацией вы располагаете.

Зафиксируйте время события
В любом случае отправьте хотя бы один снимок себе по
электронной почте, чтобы точно зафиксировать время
события. Если вы берете машину напрокат, вы сможете
доказать, что в этот день она была в хорошем состоянии.
Если вы попали в дорожно&транспортное происшествие
и отправили электронное сообщение через небольшой
промежуток времени, вы сможете точно определить,
когда это произошло.

Никто не хочет проблем с прокатными компаниями
или с авариями на дорогах. Однако в случае, если у вас
возникнут такие трудности, камера мобильного телефона поможет вам их быстро
устранить.

Совет 94 Сохраните ваши презентации на DVD

Вы без труда можете сохранить свой рабочие презентации на DVD или даже поме&
стить их в сеть Интернет.

Представьте себе, что вы только что провели самую великую презентацию
в своей жизни. Члены Совета директоров аплодируют, а Генеральный директор
компании хлопает вас по плечу и предлагает вам жениться на своей старшей доче&
ри. Однако есть кое&что, что несколько портит ваш успех: у вас нет с собой видео&
камеры, и вы не сможете записать свой триумф на пленку.

К счастью, все может быть совершенно по&другому. Вы можете записать свою
успешную презентацию, а затем отправить ее своим друзьям, родственникам и
вообще всем желающим. Кроме того, вы можете поместить презентацию в сеть
Интернет, чтобы ваши коллеги насладились моментом, когда вы сокрушили этого
всезнайку из финансового отдела своим блистательным анализом объемов про&
даж в третьем квартале.

Решаем мелкие жизненные проблемы
Наверное, вы думаете, что вам нужно установить в комнате камеру и нажать кноп&
ку Record. Вы можете так и сделать; однако полученный видеофильм будет вы&

Рис. 8.6. Быстрый снимок на месте аварии

Сохраните ваши презентации на DVD
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глядеть не слишком эффектно. Задумайтесь: вы пытаетесь снять фильм в темной
комнате, заполненной людьми. Нет ничего удивительного в том, что результат
оказывается неудовлетворительным.

Если ваш компьютер оснащен портом Video Out, вы можете подсоединить
к нему камеру. И вновь вам не удается достичь своей цели; после того как вы не&
сколько раз заархивируете и разархивируете презентацию, качество ее изображе&
ния ухудшается. Если вы создаете свои презентации в программе PowerPoint, вы
можете установить бесплатное приложение Microsoft Producer от компании
Microsoft (http://www.microsoft.com/office/powerpoint/producer; распространя&
ется бесплатно), которое может экспортировать их на Web&страницу, но не может
выполнить сохранение на DVD.

В текущем разделе мы создадим высококачественное видео из презентации
PowerPoint, а затем скомбинируем его с аудиозаписью речи автора. В результате
зрители будут одновременно смотреть слайды и слушать выступление человека,
который делает презентацию.

Аудио и видео
Сначала мы обработаем звуковую часть презентации. Если вы делаете презента&
цию перед аудиторией, подключите аудиовыход вашего компьютера к аудиовходу
камеры и запишите звук. Если это невозможно, установите камеру недалеко от
выступающего, чтобы микрофон смог записать его голос. Если в помещении нет
аудитории, вы можете записать звук на отдельный микрофон (либо встроенный
микрофон камеры) в отдельной тихой комнате.

Если вы хотите записать изображение выступающего, наведите на него камеру
и сделайте один снимок. Пока не думайте о том, чтобы записать презентацию це&
ликом. Этим мы займемся далее.

Затем сохраните видео на компьютере, а звук – в отдельном файле (если ваш
видеоредактор позволяет это сделать). Если ваше приложение не поддерживает
такую функцию, воспользуйтесь отдельной программой, например VirtualDub
(http://www.virtualdub.org; распространяется бесплатно), и сохраните звук
в файле с расширением .wav. В приложении VirtualDub загрузите видеофайл и
выберите пункты меню File ⇒ Save WAV (Сохранить WAV
файл). В результате
звук будет выделен и сохранен в отдельном файле.

Записываем презентацию PowerPoint на видео
Для записи презентации на видео мы воспользуемся приложением, которое по&
зволяет сохранять изображение на экране; лично я предпочитаю работать с про&
граммой SnagIt от компании TechSmith (http://www.techsmith.com; стоит 39 долл.
США). Эта программа может записать все, что отображается на экране монитора.
На Web&сайте TechSmith имеется полнофункциональная демоверсия со сроком
использования 30 дней; вы можете поработать с этой демоверсией, прежде чем
потратить деньги на покупку программы.

Вместо программы SnagIt пользователи операционной системы Mac OS X
могут применить приложение Snapz Pro X от компании Ambrosia
Software (http://www.ambrosiasw.com/utilities/snapzprox/; стоит
69 долл. США).

Используем программу SnagIt
Приложение SnagIt может записать часть изображения на экране и сохранить ее
в отдельном видеофайле. Откройте свою презентацию и настройте ее на воспро&
изведение в окне. В программе PowerPoint выберите пункты меню Slideshow ⇒
Set Up Show (Настроить слайд
шоу). Выберите тип презентации: Browsed by an
individual (В отдельном окне). В результате презентация не будет занимать весь
экран; нам это не нужно. Запустите презентацию в фоновом режиме и откройте
приложение SnagIt.

После запуска программы SnagIt (см. рис. 8.7) выберите опцию, которая запи&
сывает видео с профилем Screen&Capture. Затем выберите команду Fixed Region
(Фиксированная область) в ниспадающем меню раздела Capture Settings (На

стройки записи). В результате программа SnagIt будет настроена на запись части
изображения на экране; однако нам еще необходимо указать, какую именно часть
изображения следует сохранить. Нажмите кнопку Input Properties (справа от
меню Input) и введите значение 720 × 480 для стандарта NTSC или 720 × 586 для
стандарта PAL.

Рис. 8.7. Окно Capture Settings в программе SnagIt

Убедитесь в том, что в меню Input не была выбрана опция Include Cursor (До

бавить курсор). Таким образом, изображение курсора не будет записано вместе
с видео. После завершения настройки нажмите кнопку Capture (Записать).

Сохраните ваши презентации на DVD
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Программа SnagIt выделит область записи на экране красным полем. Перемес&
тите поле на окно презентации и щелкните, чтобы выбрать область записи. Два
окна не будут совпадать друг с другом; вы можете переместить границы окна про&
граммы PowerPoint с помощью мыши. На рис. 8.8 показано окно приложения
SnagIt перед началом записи.

Рис. 8.8. Записываем презентацию в программе SnagIt

Начинаем запись видео
Чтобы начать запись видео, нажмите кнопку Start. Если вы хотите перейти от
слайдов к записанному ранее аудиотреку, нажмите клавишу ⇐. После заверше&
ния презентации нажмите клавиши Ctrl+Shift+P. Теперь вы можете просмотреть
записанное видео в программе SnagIt. Если результат вас устроил, нажмите кноп&
ку Finish (Завершить) и сохраните файл. Если нет, нажмите кнопку Cancel (От

менить) и попробуйте снова.

Если вы хотите сделать процесс записи максимально простым и надежным,
закройте все программы, кроме PowerPoint и SnagIt. Учтите, что для одновремен&
ного воспроизведения слайда PowerPoint и сохранения изображения с экрана си&
стеме требуется много ресурсов памяти. Я советую вам выбрать максимально про&
стой дизайн презентации PowerPoint, потому что сложная анимация и переходы
могут сохраняться с ошибками.

Завершаем запись DVD
После завершения записи откройте приложение, которое вы используете для ре&
дактирования видео или записи DVD, и импортируйте видео& и аудиофайлы. До&
бейтесь синхронизации видео и аудио. Если ваша программа не поддерживает от&
дельные аудиотреки, активируйте функцию добавления фоновой музыки; вы мо&
жете импортировать звук в качестве фонового трека. Теперь вы готовы к записи
видео на DVD&диск, который вы затем сможете отправить своим друзьям, колле&
гам и другим людям.

Если вы хотите записать на DVD сложную презентацию, воспользуй&
тесь другой программой от компании TechSmith, Camtasia Studio
(http://www.techsmith.com; стоит 299 долларов США), которая позво&
ляет автоматизировать весь процесс. Эта программа стоит доста&
точно дорого и предназначена исключительно для пользователей,
которые регулярно записывают на DVD различные презентации.

Многие приложения также дают вам возможность сохранить полученное видео
в формате, который совместим с форматом Web&страниц. Некоторые программы,
например Windows Media, Real и QuickTime, могут сохранять видео в формате
фильма. После сохранения вы сможете выполнить кодировку файла (совет 29) и
конвертировать его в формат стрим (совет 83) для сети Интернет, электронной
почты или даже мобильного телефона (совет 89).

Дополнительные возможности
Если вы хотите получить настоящее удовольствие, вы можете пойти чуть дальше
и добавить в свое видео эффект «рисунок в рисунке» (picture&in&picture). Этот
эффект достаточно часто применяется в выпусках новостей: за спиной диктора на
экране появляется небольшое окно, в котором воспроизводится видео. При жела&
нии вы можете переключаться между двумя режимами просмотра, что позволит
зрителям видеть как ваше лицо, так и слайды презентации.

Совет 95 Смотрим телевизионные каналы
на устройстве Palm Pilot

Вы можете отправить на устройство Palm Pilot закодированные телевизионные
программы или видео в любом формате.

Мне очень нравится работать со службой ReplayTV (http://www.replaytv.com;
стоит 99–799 долл. США). Тому есть несколько причин, в частности то, что при
помощи определенного программного обеспечения я могу бесплатно загрузить на
свой компьютер Mac записанные телевизионные программы. После сохранения
программ на жестком диске компьютера я загружаю их на свое устройство Treo

Смотрим телевизионные каналы на устройстве Palm Pilot
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600 (http://www.handspring.com; стоит 299–479 долл. США). Благодаря этим шоу
моя дорога на работу и с работы становится более увлекательной. Кроме того,
я могу наглядно продемонстрировать своим друзьям все возможности моего уст&
ройства Treo!

Загружаем видео с сайта ReplayTV
Служба ReplayTV предлагает программное обеспечение, которое позволяет
загружать различные фотографии на устройство ReplayTV PVR (http://www.
digitalnetworksna.com/dvr/photosoftware.asp; распространяется бесплатно). Дру&
гие компании поставляют бесплатные приложения, которые могут загружать не
только фотографии, но и видео:

• DVArchive. Поддерживает операционные системы Windows, Mac и Linux.
http://www.dvarchive.org;

• ReplayTV Client. Поддерживает операционные системы Windows, Mac
и Linux. http://www.flyingbuttmonkeys.com/replay/.

Если вы работаете в среде Mac OS X, вы можете использовать программу
mReplay от компании FlyingButtMonkeys (http://www.bentpixel.com/fbm/; рас&
пространяется бесплатно), которая позволяет упростить процесс загрузки фай&
лов из службы ReplayTV. Это приложение также дает вам возможность загружать
фотографии с компьютера Mac на устройство ReplayTV PVR (служба ReplayTV
не поддерживает операционную систему Mac OS X; следовательно, с помощью
данной функции вы можете обойти это ограничение). На рис. 8.9 показана про&
грамма mReplay в действии.

Когда вы запустите программу mReplay, она выполнит поиск устройств Re&
playTV в локальной сети. Кроме того, приложение ReplayTV может подключать&

ся к устройствам ReplayTV в сети Интернет при условии, если вам известны их
IT&адреса. Для загрузки видео вам достаточно дважды щелкнуть по заголовку
файла.

Файлы загружаются в формате MPEG&2. Для воспроизведения файлов
в этом формате через программу QuickTime вам придется установить
дополнительное обновление (http://www.apple.com/quicktime/products/
mpeg2playback; стоит 19,99 долл. США).

Создаем видео для воспроизведения на устройстве Palm Pilot
Далее вам необходимо отправить видео на устройство Palm OS, например Treo
600. Существует большое количество приложений, которые предназначены для
воспроизведения видео в среде Palm 5 PDA; лично я предпочитаю использовать
программу производства компании Kinoma (http://www.kinoma.com). Эта про&
грамма состоит из нескольких приложений, которые загружают видео с компью&
тера, работающего в среде Mac OS X или Windows, а затем воспроизводят его на
устройстве Palm OS.

Приложения Kinoma Player (поставляется бесплатно) и Kinoma Player EX
(стоит 19,99 долл. США) воспроизводят видео на устройствах PDA с операцион&
ной системой Palm OS 5.0 и выше. Программа Kinoma Player может работать
с видеофайлами в формате .pdb (Palm database). Программа Kinoma Player EX
воспроизводит видео в различных форматах, включая MPEG&4 и .pdb.

Приложение Kinoma Producer (стоит 30 долл. США) конвертирует аудио&
и видеофайлы в формат, совместимый с Kinoma Player и Kinoma Player EX. Это
приложение содержит функции, которые позволяют настроить частоту смены
кадров, скорость передачи видео и качество звука. Вы можете выбрать любое дос&
тупное разрешение Palm. На рис. 8.10 показано окно программы Kinoma Producer,
в котором мы создаем фильм для устройства Treo 600.

Кроме того, приложение Kinoma Producer имеет встроенные предварительные
установки для различных устройств Palm. Это значительно упрощает конфигура&
цию программы. Выбрав устройство Palm, нажмите кнопку Convert Files (Кон

вертировать файлы). Начнется процесс конвертирования, который показан на
рис. 8.11.

Даже при разрешении Treo (120 × 160) для сохранения видеофайлов вам потре&
буется много системной памяти. Когда я записываю в память своего PDA&устрой&
ства один час видео, на моей карте памяти объемом 128 Мб остается очень мало
свободного места. Чтобы отправить видео на устройство Palm, скопируйте файл из
программы Kinoma Producer на карту памяти или воспользуйтесь опцией HotSync.

После того как вы скопируете ваш фильм на устройство Palm, вы сможете вос&
произвести его в программе Kinoma Player. На рис. 8.12 показан процесс воспро&
изведения видео на устройстве Treo 600.

Если вы собираетесь воспроизвести фильм, продолжительность которого пре&
вышает несколько минут, скорее всего, вам придется купить флэш&карту большо&Рис. 8.9. Программа mReplay в действии
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го объема. По своему опыту я знаю, что карта памяти объемом 512 Мб стоит не так
уж и дорого, а на нее можно записать почти любой фильм, кроме «Властелин ко&
лец: возвращение короля».

Как вы уже заметили, программы пакета Kinoma позволяют вам записывать
свое домашнее видео на устройство Palm так же просто, как и телевизионные про&
граммы или фильмы.

Совет 96 Резервное копирование файлов
с компьютера на цифровую пленку

Цифровая видеопленка содержит запись с аудио& и видеоинформацией. Однако
данные необязательно должны относиться к видео или аудио.

Если вы отправляете данные с цифровой видео&
пленки на компьютер, будьте готовы к тому, что для
записи одного часа материала вам потребуется 13 Гб
на жестком диске. Возможно, вы уже задумываетесь
о том, чтобы записать информацию с компьютера на
пленку. Ведь кассета MiniDV продолжительностью
60 мин стоит менее 10 долл. США.

Программное обеспечение
для резервного копирования
на цифровую пленку
В 2001 г. Тим Хьюитт (Tim Hewett) решил попробо&
вать сделать то, о чем мечтали многие из нас. Он начал
эксперименты с записью данных с жесткого диска

Рис. 8.10. Настраиваем программу Kinoma Producer
для конвертирования фильма

Рис. 8.11. Программа Kinoma Producer
в процессе конвертирования фильма

Рис. 8.12. Процесс воспроизведения видео
на устройстве Treo 600

Резервное копирование файлов с компьютера на цифровую пленку
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Рис. 8.13. Опции форматирования

Рис. 8.14. Выбираем файлы
для резервного копирования

Обратите внимание: в окне Select Files for Backup (Выберите файлы для ре

зервного копирования) вам доступны дополнительные опции. Приведу их список:

• Error Protection Level (Уровень защиты от ошибок). Доступные значения –
от 1 : 1 до «отключен»; значению 1 : 1 соответствует самый высокий уровень
защиты;

• Backup Comments (Примечания). Любые примечания, которые вы хотите
добавить; эти примечания появятся в таблице содержания;

• Compressed (Сжатие). Сжимает данные во время резервного копирования;
требует времени, но позволяет вам сохранить больше информации;

• Follow symbolic links (Следовать символическим ссылкам). Выполняет ре&
зервное копирование объектов/файлов, связанных с символическими ссыл&
ками, вместо того чтобы копировать сами ссылки;

Формат Strict уменьшает объем файлов примерно на 15%. Я рекомен&
дую использовать этот формат только в случае, если вам не удается
сохранить данные в формате Normal.

Выбираем файлы
Любая программа резервного копирования (в том числе и DV Backup) позволяет
вам выбирать файлы для сохранения. После завершения форматирования кассе&
ты нажмите кнопку Backup (Резервное копирование). Нажмите кнопку Add
(Добавить) в открывшемся окне (см. рис. 8.14).

Резервное копирование файлов с компьютера на цифровую пленку

компьютера на цифровую видеопленку. В результате Тим создал новое приложе&
ние для операционной системы Mac OS X, DV Backup.

Если вы работаете в среде Windows или Linux, то можете воспользо&
ваться программой DV Backup (http://dvbackup.sourceforge.net/;
поставляется бесплатно). Впрочем, вы должны иметь опыт работы
с командной строкой. Кроме того, вам помогут познания в области
ANCI C, языка программирования.

Приложение DV Backup может записывать данные в формате DV, DVCAM,
DVCPRO и Digital8 через интерфейс FireWire. Обычная кассета MiniDV продол&
жительностью 60 мин может содержать до 10 Гб информации. Так как программа
DV Backup поддерживает форматы DVCAM и DVCPRO, а эти форматы позволя&
ют использовать кассеты продолжительностью до 184 мин, вы сможете записы&
вать свыше 50 Гб данных на одну кассету.

На рынке существуют две версии программы DV Backup: Standard и Lite. Обе
версии содержат такие функции, как резервное копирование, проверка и восста&
новление информации. Версия Standard поддерживает дополнительные опции –
резервное копирование на жесткий диск компьютера, разбивку большого архива
на тома, а также создание графика резервного копирования.

Резервное копирование файлов
Работать с приложением DV Backup просто, так как многие функции автоматизи&
рованы. Когда вы запускаете программу, она вы&
полняет поиск подключенной цифровой видеока&
меры или деки. Если такое устройство было обна&
ружено, программа проверяет его на наличие
таблицы содержания.

П. Если вы пользуетесь цифровой видео&
камерой, переведите ее в режим Player.

Форматирование кассеты
Если вы работаете с новой кассетой, программа
DV Backup попросит вас указать ее продолжитель&
ность, название, а также выбрать формат записи:
Normal или Strict. При вводе продолжительности
воспроизведения для кассеты вам необходимо ука&
зать значение, которое дает производитель для ре&
жима SP (см. рис. 8.13).
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• SP/LP. Переключатель, который показывает, в каком режиме работает камера;
• Auto
verify (Автоматическое тестирование). Определяет, должна ли про&

грамма DV Backup проверять данные после завершения резервного копиро&
вания.

Когда вы выберите нужные файлы и настройки, нажмите кнопку Backup, что&
бы начать процесс копирования.

Восстанавливаем файлы
Процесс восстановления файлов еще проще, чем процесс резервного копирования:

1. Запустите программу DV Backup.
2. Установите в устройство кассету с файлами, которые вы хотите восстано&

вить.
3. Выберите нужные файлы.
4. Нажмите кнопку Restore (Восстановить).
5. Выберите папку, в которую вы собираетесь восстановить файлы. При жела&

нии вы можете выделить для восстановления только определенные файлы
(опционально).

6. Нажмите кнопку Restore.

После завершения процесса файлы будут записаны в папку, название которой
будет содержать дату и время восстановления. Если у вас есть DV&камера, при&
ложение DV Backup может оказаться очень полезным инструментом. Кроме
того, вы можете использовать приложение DV Backup для резервного копирова&
ния вашего проекта (кроме исходного материала), включая звуковые эффекты и
фотографии.

Совет 97 Воспроизводим «фильмы»
на устройстве iPod

Однажды я показал своим знакомым фотографию, которую я сделал на устрой&
стве iPod, и меня спросили: «А может это устройство воспроизводить фильмы?»
В общем, нет – только музыку и фотографии. Но если подумать, то на этот вопрос
можно ответить: «да, но не совсем те фильмы, к которым мы все привыкли».

В этом разделе я расскажу вам о том, как вы можете создать «фильм» из фото&
графии на устройстве iPod. Для этого необходимо экспортировать кадры фильма,
импортировать их на устройство iPod и просмотреть их вручную, а возможно,
даже переключиться в трехмерный режим. Звучит бессмысленно, не правда ли?
Будете ли вы пытаться воспроизводить короткие видеоклипы на своих устрой&
ствах iPod? Конечно, да, и я вам в этом помогу. На рис. 8.15 показаны два видео&
изображения: на камере и на экране устройства iPod.

Начинаем работу
Все, что вам понадобится для решения данной задачи, – это программы QuickTime
Pro, iTunes и фотография в формате iPod; описанная здесь методика применима
к операционным системам Mac и Windows. Далее я приведу рекомендации как
для Windows, так и для Mac OS X.

Загружаем фильм
Вам вполне подойдет практически любой фильм в формате QuickTime; в нашем
примере мы будем использовать фрагмент из фильма «Звездные войны: Эпизод 3».
Мы загрузили его с сайта Waxy.org (http://www.waxy.org). Вы можете щелкнуть по
файлу правой кнопкой мыши (Windows) или выполнить Ctrl+щелчок (Mac), чтобы
загрузить его в вашу систему. На рис. 8.16 показан фрагмент фильма «Звездные
войны: эпизод 3», который был отформатирован для программы QuickTime.

Загрузите фильм и откройте его в программе QuickTime. Возможно, у вас в си&
стеме уже установлены другие приложения, которые могут экспортировать аудио
и видео; вы можете поэкспериментировать с ними. На рис. 8.17 показан файл
QuickTime, который был сохранен на жестком диске компьютера.

Экспортируем аудиофайлы
Сначала мы выполним экспортирование звука. Затем мы добавим звук в изобра&
жение, что позволит нам слушать саунд&трек во время воспроизведения фильма.
На рис. 8.18 показано диалоговое окно Sound Settings (Настройки звука) для
операционной системы Windows.

В среде Windows: откройте файл и выполните команду File ⇒ Export. Выбери&
те пункт меню Movie to WAV, нажмите кнопку Options и выберите опции 44 КГц,
16 бит и Stereo.

Рис. 8.15. Одно и то же изображение
на двух различных экранах

Воспроизводим «фильмы» на устройстве iPod
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В среде Mac: откройте файл и выполните команду File ⇒ Export. Выберите
пункт меню Movie to AIFF, нажмите кнопку Options и выберите опции 44 КГц,
16 бит и Stereo.

Импортируйте аудиофайл в программу iTunes. Вы можете экспортировать
файл на устройство iPod сейчас или позднее; это не имеет значения.

Если вы хотите не экспортировать звук, а синхронизировать его с видео, вы
сможете это сделать. Как сказал Х. М. Уорнер (H. M. Warner): «Никто не хочет
слушать, о чем разговаривают актеры!»

Экспортируем фильм в последовательность изображений
Пришло время экспортировать все кадры видео. Частота смены кадров в фильме,
который мы загрузили, составляла 15 кадров/с, поэтому мы будем использовать
такие же настройки в программе QuickTime. На рис. 8.19 показаны настройки
в разделе Image Export (Экспорт изображения).

Рис. 8.16. Фрагмент фильма, который был отформатирован
для программы QuickTime

Рис. 8.17. Фрагмент фильма «Звездные войны: Эпизод 3»
был сохранен на диске

Рис. 8.18. Настройки экспорта для звука

Рис. 8.19. Используем формат JPEG
с частотой 15 кадров/с

В среде Windows: откройте файл и выполните команду File ⇒ Export. Выбери&
те формат JPEG, укажите частоту 15 кадров/с и нажмите кнопку Options. Для
параметра Quality (Качество) я выбрал значение Medium (Среднее); вы можете
поэкспериментировать. Опции сжатия данных для формата JPEG показаны на
рис. 8.20.

В среде Mac: откройте файл и выполните команду File ⇒ Export. Выберите
функцию Export Image Sequence (Экспортировать последовательность изобра

жений) и те же самые настройки, что и в среде Windows. На рис. 8.21 показано
диалоговое окно экспорта данных для операционной системы Mac.

Воспроизводим «фильмы» на устройстве iPod
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Я экспортировал все файлы в новую папку.
Фильм продолжительностью 1 мин, 47 с будет конвертирован в 1616 кадров

(107 кадров × 15,1 кадров/с = 1616). Процесс экспорта займет некоторое время.
В среде Mac программа QuickTime конвертировала файл в 1627 кадров (см.
рис. 8.22).

В среде Windows тот же самый фрагмент был преобразован в 1616 кадров. Чес&
тно говоря, я не знаю, почему так произошло (см. рис. 8.23).

Отправляем последовательность фотографий на устройство iPod
Теперь у нас есть 1616 кадров, и мы можем использовать новые функции програм&
мы iTunes, чтобы синхронизировать их с фотографией на устройстве iPod.

В среде Windows выполните команду Edit ⇒ Preferences ⇒ iPod, выберите
пункт меню Photos (Фотографии) и нажмите кнопку Choose Folder (Выбрать

папку). Выделите папку, в которую вы записали все изображения из программы
QuickTime. На рис. 8.24 показаны опции iTunes в среде Windows.

В среде Mac, как и в среде Windows, выполните команду Edit ⇒ Preferences ⇒
iPod. На рис. 8.25 показаны опции iTunes в среде Mac.

После выбора файлов вы увидите общее количество фотографий, которые бу&
дут импортированы. Перед отправкой изображений на устройство iPod програм&
ма iTunes оптимизирует их. Затем файлы будут отправлены; процесс потребует
некоторого времени. На рис. 8.26 вы видите окно синхронизации изображений на
устройстве iPod.

Рис. 8.20. Выбираем опции Best Depth и Medium Quality
в разделе JPEG Options

Рис. 8.21. Настройки экспорта изображения
в операционной системе Mac

Рис. 8.22. В среде Mac программа QuickTime
конвертировала файл в 1627 кадров

Рис. 8.23. В среде Windows тот же самый фрагмент
был преобразован в 1616 кадров

Воспроизводим «фильмы» на устройстве iPod
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Воспроизводим «фильм» на устройстве iPod
После завершения синхронизации отключите устройство iPod от базы. Если вы
хотите прослушивать саунд&трек во время воспроизведения фильма, выберите
пункты меню Music ⇒ Songs ⇒ Episode_III_Teaser_Trailer и нажмите кнопку
Play. Чтобы начать воспроизведение, выполните команду Menu ⇒ Menu ⇒ Pho

tos ⇒ Photo Library (Библиотека фотографий). На экране отобразятся шаблоны
фотографий. Выберите снимок, с которого вы хотите начать воспроизведение,
и нажмите кнопку. Во время просмотра фильма пользуйтесь колесиком мыши,
чтобы создать иллюзию «воспроизведения».

Попрактиковавшись, вы научитесь отображать видеоклипы, которые выглядят
так, как вы и ожидали: довольно неуклюже. Так как же все&таки смотрится «фильм»
на экране устройства iPod? Пример показан на рис. 8.27.

Рис. 8.24. Опции синхронизации фотографий
на устройстве iPod (для операционной системы Windows)

Рис. 8.25. Настройки синхронизации фотографий
на устройстве iPod (для операционной системы Mac)

Рис. 8.26. Выполняем синхронизацию фотографий.
Процесс займет некоторое время

Рис. 8.27. Воспроизводим видеоклип
на устройстве iPod

Воспроизводим «фильмы» на устройстве iPod
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У меня есть ощущение, что как в среде Mac, так и в среде Windows
изображения (кадры) импортируются в неправильном порядке. Скорее
всего, это связано с датой последней модификации файлов или с чем&то
другим. Я удалял некоторые фотографии вручную, повторно выполнял
синхронизацию, и это приводило к нужным результатам (правда,
тоже не всегда).

Дополнительные возможности
Вы можете создавать виртуальные объекты (VR) или трехмерные изображения
объектов и импортировать их на устройство iPod. В качестве примера могу приве&
сти фотографию одного устройства iPod в другом, которую сделали мои друзья из
компании Griffin и отправили мне. Выполните несколько снимков объекта под
разными углами и импортируйте их так, как и кадры фильма. На рис. 8.28 показан
процесс вращения виртуального объекта.

Рис. 8.28. Трехмерное изображение объекта

У меня пока еще не было времени документально описать эту простую, но инте&
ресную методику. В скором времени я планирую этим заняться. Разумеется, я со&
бираюсь экспортировать фильм «Волшебник из страны Оз» и воспроизвести его
под музыку с диска «Dark Side of the Moon». Если вы не понимаете, о чем я гово&
рю, зайдите на сайт http://www.everwonder.com/david/wizardoz/.

Воспроизводим «настоящие» фильмы
Экран на устройстве iPod обладает достаточно неплохими характеристиками, по&
этому теоретически воспроизведение видео могло бы оказаться очень интересной
функцией. Мы надеемся, что компания Apple учтет этот факт, но если даже она
этого не сделает, существуют и альтернативные пути. Если вам действительно

необходимо просматривать видео на мобильном устройстве, вместо iPod вы мо&
жете приобрести Archos, Creative Zen или что&то аналогичное. С другой стороны,
видео на экране устройства iPod смотрится очень эффектно. Впрочем, мне нра&
вится и Creative Zen Portable Media Center, так что выбор – это исключительно
дело вкуса.

Совет 98 Проведите домашнюю инвентаризацию

Ваш дом заполнен различными предметами, причем многие из них вам очень до&
роги, а некоторые – просто бесценны. Используя видеокамеру, вы сможете быст&
ро провести домашнюю инвентаризацию.

Ваша цифровая видеокамера необязательно должна применяться исключи&
тельно для записи домашнего видео (например, первых шагов вашего ребенка)
или видеофильмов. С ее помощью вы можете заставить других людей быть чест&
ными и порядочными (см. совет 93) или даже выполнить инвентаризацию. Это
особенно полезно делать перед тем, как вы переезжаете в другой дом или собира&
етесь обратиться за компенсацией в страховую компанию.

Этот раздел был написан под влиянием статьи Деррика Стори
(Derrick Story) «Проведите домашнюю инвентаризацию» из книги
«Digital Photography Hacks» (издательство O’Reilly).

Скорее всего, у вас дома уже есть большое количество различных вещей. Веро&
ятно, вы не сможете вспомнить, что у вас есть и где все это лежит. К счастью, вы
можете воспользоваться видеокамерой и составить точный список вещей.

Для начала возьмите новую видеокассету и промаркируйте ее: укажите месяц и
год. Затем выберите первую комнату и запишите, какие предметы в ней находят&
ся. Если какой&либо объект в комнате имеет маркировку или ярлык, сфотографи&
руйте его. На рис. 8.29 показана маркировка телевизора, которая включает компа&
нию&производителя, модель и серийный номер. Все необходимые данные были
записаны на кассету MiniDV.

На видеопленку можно записывать не только изображение, но и звук, следова&
тельно, вы можете добавлять голосовую информацию о любом предмете. Напри&
мер, если вы знаете, когда и где вы купили данный предмет и сколько вы за него
заплатили, вы можете просто сказать это в камеру. Если речь идет о вашем телеви&
зоре, вы можете произнести: «Так, мы купили его в магазине Best Buy на прошлое
Рождество. Он обошелся нам в 349 долл. США».

Переходите из комнаты в комнату и записывайте информацию о каждом объекте.
Обязательно задокументируйте все бесценные предметы, такие как семейные фото&
графии. Даже несмотря на то, что запись на видеопленке никогда не сможет полно&
стью заменить фотографии, рисунки наших детей и другие вещи, которые мы так це&
ним, в случае их потери вы сможете снова их увидеть на экране, а это уже кое&что.

Проведите домашнюю инвентаризацию
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В зависимости от размеров вашего дома и количества предметов
вы можете записать информацию для каждой комнаты на отдельной
кассете. Это очень удобно, потому что при проведении повторной
инвентаризации для одной комнаты вам не понадобится снова прохо&
дить по всему дому. Кроме того, вы сразу сможете найти нужную
запись для любой комнаты.

После завершения домашней инвентаризации поместите кассеты в отдельную
коробку. При желании вы можете переписать видеофильм на DVD (см. совет 79)
или поместить его на Web&сайте (см. совет 83), чтобы получить резервную копию
данных.

Я советую вам регулярно повторять инвентаризацию, например делать это
в январе, сразу после праздников.

Совет 99 Записываем небольшие видеофильмы
на камеру мобильного телефона

Нет, мы не будем записывать на камеру мобильного телефона церемонию вруче&
ния диплома вашему сыну. Но мы можем записать момент, когда он берет диплом
в руки.

Некоторые камеры мобильных телефонов могут записывать не только фото&
графии, но и видео. Однако по техническим причинам продолжительность каждо&
го видеоклипа обычно составляет всего лишь несколько секунд. Приведу список
ограничений, связанных с записью видео на мобильном телефоне:

• не все мобильные телефоны могут записывать звук вместе с изображением;
• видимый кадр имеет небольшие размеры;
• видеоклипы отличаются большей зернистостью по сравнению с видеофиль&

мами, снятыми на обычные цифровые камеры;
• программы видеоредактирования могут открывать файлы в формате 3GPP

(3rd Generation Partnership Project), но не могут вносить в них изменения. За
дополнительной информацией обратитесь к сайту 3GPP по адресу: http://
www.3gpp.org;

• время записи видеофрагмента обычно ограничено несколькими секундами.
Например, мобильный телефон Nokia 3650, который используется в данной
книге в качестве примера, может записывать не более 95 Кб (около 15 с) ви&
део со звуком. Из своего опыта я могу заключить, что максимальная продол&
жительность воспроизведения видеоклипа составляет 10 с.

За 10 с может произойти много событий. Самый быстрый бегун в мире может
пробежать 100 м, и у него еще останется менее секунды на отдых. Ваш ребенок
может сделать один шаг. Не забывайте о том, что вы можете объединить несколь&
ко 10&секундных клипов (совет 39), чтобы создать памятный видеофильм.

Вы можете просматривать видео в формате 3GPP в различных приложениях.
Такие программы, как Apple QuickTime (http://www.apple.ocm/quicktime/), Nokia
Multimedia Player (http://www.nokia.com) и Real Video (http://www.real.com),
поддерживают формат 3GPP.

Перед тем как приступить к редактированию файлов 3GPP, вы должны выпол&
нить некоторые подготовительные действия. Многие видеоредакторы не работа&
ют с файлами в формате 3GPP. Вы можете открывать эти файлы в программе
QuickTime или конвертировать их в другой формат, например Audio Video
Interleaved (AVI). Сначала мы расскажем о процессе конвертирования, а затем
перейдем к приложению QuickTime.

Для конвертирования видеофайлов 3GPP с мобильного телефона в формат
Raw AVI вы можете воспользоваться бесплатной программой 3gpToRawAVI для
операционной системы Microsoft Windows. Эту программу можно загрузить
с сайта: http://www.allaboutsymbian.com/downloads/3gpToRawAvi.zip.

Вам следует разархивировать файлы и установить их в отдельную папку. На&
звания папки и любых вложенных папок не должны содержать пробелы. Про&
грамма 3gpToRawAvi очень проста в установке. Для запуска приложения вам не&
обходимо открыть файл Convert3gp.vbs (файл VBScript) из установочной папки
или добавить ярлык в меню Start операционной системы Windows. После запуска
программы на экране появится интерфейс, который показан на рис. 8.30.

Рис. 8.29. Самая подробная информация,
которую вы только можете получить

Записываем небольшие видеофильмы на камеру мобильного телефона
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Импортируйте конвертированные файлы в формате AVI в программу Windows
Movie Maker (поставляется в комплекте с Windows XP). Преобразуйте несколько
видеосегментов в один видеоклип (см. рис. 8.31).

Полученный файл в формате Windows Media Video (WMV) может воспроизво&
диться на платформах, которые поддерживаются приложением Windows Media

Player: Windows 98SE/ME/2000/XP, Macintosh OS 9 и OS X, а также Pocket PC.
Разумеется, вы можете создать видеофайлы в формате MPEG для других видео&
редакторов.

Как говорилось ранее, вы можете отредактировать видеофайлы в программе
QuickTime Pro (совет 39) и экспортировать фильм в формате QuickTime (.mov),
который может воспроизводиться на любом компьютере Windows или Macintosh.
Многие системы редактирования способны импортировать видеофайлы, следова&
тельно, вы можете добавлять в них заголовки, звук и спецэффекты. Как видите,
если у вас есть нужные инструменты, вы можете сделать многое даже с короткими
видеоклипами продолжительностью 10 с.

Кроме того, вы можете отправлять видеофайлы с вашего мобильного телефона
на сайты блогов (совет 81). В результате вы создадите коллекции видеофайлов
(со звуком), которые будут доступны для просмотра вашим друзьям, родственни&
кам и всем пользователям сети Интернет.

Совет 100 Новый проект: снимите
свой документальный фильм

Используя бесплатный материал и фотографии с сайта Интернет Archive, а также
свою фантазию, вы можете записать документальный исторический фильм, кото&
рый будет достоин канала PBS.

У вас есть камера, своя система редактирования, а также время и желание запи&
сать свой шедевр. К сожалению, у вас нет сюжета, сценария, актеров и денег.
Впрочем, вы можете снять исторический документальный фильм и использовать
в нем уже записанный материал и фотографии. Актеры вам не понадобятся.

Выберите тему и изучите ее
Вам может показаться, что это очень просто, однако здесь легко ошибиться. Необ&
ходимо выбрать тему, которая действительно вас увлечет. Если данная тема вам
неинтересна, ваши зрители сразу это почувствуют (даже если у вас хватит сил на
то, чтобы завершить проект). Кроме того, вы должны выбрать тему, материал по
которой вы сможете найти. Многие удивляются тому факту, что на канале The
History Channel показывают большое количество передач, которые посвящены
Второй мировой войне. Это связано с тем, что материалов и фотографий по дан&
ной теме более чем достаточно. А представьте себе, что вы хотите сделать несколь&
ко снимков Чингиз&Хана? Вам придется нанять актеров, посадить их на лошадей
и взять в руки камеру.

Сайт Интернет Archive (http://www.archive.org) – это бесплатная цифровая
библиотека видео&, аудио& и текстовой информации. Данный сайт содержит бога&
тую коллекцию мультимедиа файлов; вы сможете записать фильм, даже не поки&
дая свою комнату (совет 35). Просмотрите архивы и выберите темы, которые вас
интересуют. Загрузите нужный материал. Если вы считаете, что у вас недостаточ&

Рис. 8.30. Пользовательский интерфейс программы 3gpToRawAvi

Рис. 8.31. Редактируем видеофайлы в формате AVI
в программе Microsoft Windows Movie Maker

Новый проект: снимите свой документальный фильм
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но изображений, не расстраивайтесь. Мы сделаем дополнительные снимки само&
стоятельно.

В процессе изучения темы вам необходимо использовать свой творческий по&
тенциал. Иногда тема, которая сначала казалась вам увлекательной, оказывается
скучной, и наоборот. Регулярно обращайтесь к поисковым системам, таким как
Google (http://www.google.com). Пользуйтесь функцией Google Image Search
(http://images/google.com), чтобы найти фотографии, которые помогут допол&
нить ваш видеоматериал. Фотографии являются бесценным источником инфор&
мации при съемках документальных фильмов; фотоаппараты способны запечат&
леть кадры, которые нельзя снять на видеокамеру. Фотографии помогут вам за&
полнить пробелы в вашей работе.

После того как вы подготовите видео и фотографии для своего документально&
го фильма, убедитесь в том, что вы достаточно много знаете о своей теме, чтобы
представить ее в интересном свете. Возможно, вам понадобится создать раскад&
ровку (см. совет 6), чтобы вы смогли визуально представить себе будущий проект.
Кроме того, вы можете загрузить свой материал (см. совет 5). Видео снимали не
вы, поэтому вы должны с ним ознакомиться.

Добавляем в изображения элементы анимации
Скорее всего, вы уже заметили, что у вас очень много фотографий, но недостаточ&
но видеоматериала. Режиссерам документальных фильмов довольно часто при&
ходится сталкиваться с этой проблемой. Она решается с помощью «методики
управления анимацией» (motion control photography), которую также называют
«эффект Кена Бернса» («Ken Burns Effect»).

Кен Бернс – это лауреат премии Оскар, режиссер документальных
фильмов. Они широко известен как автор таких сериалов, как «Граж&
данская война» и «Джаз».

Данный эффект формируется путем панорамирования и масштабирования не&
подвижных изображений на камере. В результате создается иллюзия движения.
В наше время этот эффект создается очень легко благодаря цифровым камерам и
соответствующему программному обеспечению. Если вы готовы потратить свое
время и деньги, я советую вам купить программу Adobe After Effects (http://
www.adobe.com; стоит 699 долл. США). Если вы работаете в среде Mac, вы найде&
те это приложение в составе пакета iMovie (поставляется бесплатно на новых
компьютерах Macintosh; также входит в комплект iLife по цене 79 долл. США);
установки обновлений вам не потребуется.

Импортируем фотографии в программу iPhoto
Возьмите фотографии и импортируйте их в программу iPhoto. Для этого выпол&
ните команду File ⇒ Import и найдите нужные файлы. После того как изображе&
ния будут добавлены в вашу библиотеку, создайте альбом для нового проекта и
переместите в него фотографии. Уделите должное внимание организации ваше&

го проекта. Следует сделать так, чтобы вы смогли сразу находить необходимые
файлы.

Применяем эффект в программе iMovie
Откройте программу iMovie (если вы еще этого не сделали) и создайте новый
проект для вашего документального фильма. Импортируйте ваши видеофайлы:
выполните команду File ⇒ Import и найдите их на вашем жестком диске. После
завершения процесса нажмите кнопку Photos (Фотографии). На рис. 8.32 вы ви&
дите окно программы iMovie в режиме редактирования видео.

Рис. 8.32. Применяем «эффект Кена Бернса»

Ниспадающее меню позволяет вам выбирать альбомы из библиотеки iPhoto;
выделенные снимки отображаются в отдельном поле. Если вы щелкнете по фото&
графии, в окне в верхнем правом углу начнется воспроизведение соответствую&
щего эффекта. Чтобы настроить эффект, нажмите переключатель Start (Начало).
Воспользуйтесь верхним ползунком, чтобы изменить параметры начала воспро&
изведения эффекта, а нижним ползунком – чтобы изменить продолжительность
воспроизведения эффекта. Если вы переместите курсор на окно предварительно&
го просмотра, оно примет форму руки; вы можете указать, в какой части изобра&
жения должно начинаться или заканчиваться панорамирование/масштабирова&

Новый проект: снимите свой документальный фильм



398 Прочее 399

ние. Завершив редактирование начальной точки, нажмите кнопку End и выберите
параметры (масштабирование и фокусировку) для конечной точки. Затем нажми&
те кнопку Preview (Предварительный просмотр) и просмотрите эффект. Нажми&
те кнопку Apply (Применить), и программа iMovie поместит фотографию на шка&
лу времени проекта. Нажмите кнопку Clips (Клипы) и переместите новую фото&
графию в вашу библиотеку клипов. Готово! Вы создали «эффект Кена Бернса».

Добавляем звук
Вашему документальному фильму по&прежнему кое&чего не хватает: музыки и
авторского текста. Если вы собираетесь заняться распространением своего проек&
та, я советую вам найти бесплатную музыку и избежать возможных проблем с ли&
цензированием и авторскими правами (см. совет 58). Если вы создаете фильм ис&
ключительно для личных целей, вы можете выбрать любую музыку из своей кол&
лекции. После музыки мы можем перейти к авторской речи.

Могу вас заверить: как только вы начнете записывать авторский текст для сво&
его фильма, вы сразу почувствуете себя неловко. Не обращайте внимания: до&
кументальному фильму необходима авторская речь. Это очень важно, особенно
если ваш проект содержит фотографии. Настройте параметры вашей шкалы вре&
мени и попрактикуйтесь, чтобы научиться точно рассчитывать время. Вы можете
записать свою речь с помощью программы iMovie и вашей камеры.

Добавляем заголовки и завершаем работу
После того как вы запишите авторскую речь и добавите музыку, вам останется
лишь создать заголовки. Вы можете решить эту задачу различными способами:
начиная от рисования заголовков в программе Photoshop с их последующим им&
портированием в ваш проект и заканчивая использованием различных подруч&
ных средств (см. совет 69). Так как мы уже знаем, что у вас очень маленький бюд&
жет, и вы работаете на компьютере Mac, мы попробуем применить недорогую, но
эффективную альтернативную методику.

Откройте редактор TextEdit, который находится в папке Applications, и введите
текст первого заголовка. Измените дизайн заголовка любым удобным способом.
Затем откройте приложение Grab (в папке Applications/Utilities). Выполните ко&
манду Capture ⇒ Selection (Записать ⇒ Выбранную область) и выделите заголо&
вок в вашем документе TextEdit. Оставьте немного свободного места по краям за&
головка. Сохраните изображение на вашем рабочем столе, а затем импортируйте
его в программу iPhoto, так же как и любую другую фотографию. Добавьте верти&
кальное панорамирование с «эффектом Кена Бернса», чтобы создать профессио&
нально выглядящий заголовок (см. рис. 8.33).

Поздравляю: ваш проект по созданию документального фильма завершен! Со&
храните его, сделайте несколько копий и подготовьтесь к распространению. Уда&
чи вам на будущих кинофестивалях!

Рис. 8.33. Заголовок с «эффектом Кена Бернса»
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